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General Information

Purpose

xe "Purpose"UD/MIPS is a deployable, easy-to-use, automated system that allows users to interact with the Commander's Unit Diary DataBase (CUDDB).  Whether deployed or in garrison, UD/MIPS is a PC-based, entry/retrieval point for virtually all manpower data.  This system can be used as a standalone application or as a LAN application.  UD/MIPS replaces the ADPE-FMF (Automated Data Processing Equipment - Fleet Marine Force) Unit Diary System.

Benefits

A more accurate information base for all users.

This system does not require on-line communications.  Accessibility, utilization, and benefitsxe "Benefits" are consistent in both garrison and deployed environments.

UD/MIPS provides Commanders with the following:

Accurate and timely personnel accounting.  Information noted as missing or incorrect must be corrected by an appropriate Unit Diary entry.  The use of MIPS will reduce the use of personal preference databases - for example, Lotus Smart Suite's Approach.  (These type databases, when used, may imply that MCTFS reflects identical information.  However, in all cases, it is merely the result of a typist keying the information that they believe or wish to be true.  Reports are produced that often give a false sense of security.)

A reliable means to reduce administration while increasing accuracy and productivity.

An immediate information source involving unit personnel.

A retrieval system that produces routine reports, ad hoc reports, and specific documents that assist in managing the administrative and training systems.

A way to recover some of the expended man-hours used in recording information into the Unit Diary System.  This is highlighted by the situational reporting options that 'bundle' transactions commonly reported for certain situations, example, Joins.

A standardized program that ensures constant training, consistent procedures, and compensation for inexperienced administrative personnel and/or shortage of personnel administrators.

A means to implement management techniques and training.

No manpower overhead because it uses information previously reported into the MCTFS, thereby reducing errors, and actually eliminating man-hours inherent to the maintenance of local database management applications.

A means of managing the units' individual training requirements without the production of multiple and voluminous rosters.

A means to effectively manage procedures associated with personnel accountability; promotions; dependency and variable housing allowance certifications; Basic Individual Record/Basic Training Record audits; semi-annual proficiency and conduct mark reporting, good conduct medal awards, weapons inventory, individual training, meal card issuance/recovery procedures, and the required fitness report submissions.

Key personnel within reporting units will use the entire system.  Personnel at the Manpower Information Systems Support Office (MISSO) will also have access to the entire system.  Other users not directly responsible for data input may be authorized access, with limitations.

System Goals

xe "System Goals"UD/MIPS development is ongoing.  Standards pertaining to pay, entitlements, and benefits - as dictated by official directive - necessitate change.  Real-world situations, such as computer hardware and software technology advancements, also influence development.  Considering this dynamic environment, when developing UD/MIPS, the following prominent goals are recognized:

Acknowledge that Commanders have a vested interest and a justifiable use for information reported into MCTFS via the Unit Diary System.  They should be provided a means to access and use such information in both garrison and deployed environments.

Establish an interaction between the Unit Diary System and a retrieval/processing system.  This interaction would continually encourage a local internal review of the procedures that support MCTFS.  Inherent to this goal is increasing the potential for an optimum standardization of procedures while raising the propensity to record information in a more timely and accurate fashion.

Provide a basis for continuous, progressive momentum while maintaining a consistent application of procedures.  Increase the user's self-reliance and personal initiative in locating, assimilating, and executing tasks pertaining to personnel administration.

Automate applications and procedures considered to be management tools.  This automation of techniques, when utilized by successful Commanders to accomplish administrative and manpower-related tasks can provide the basis for written guidance when teaching successful management procedures.

Hardware Requirements

xe "Hardware Requirements"The computer/server configuration for the UD/MIPS application is listed below.  These configurations take into consideration the operating environment's overhead.
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Version Control Number

The UD/MIPS application and tables and TRECONs contain a Version Control Numberxe "Version Control Number" (VCN).  The VCN is used during the Reconciliation process to inform the user that newer versions of the application or tables are available for download to their PC, that TRECON and application VCNs don't match, and whether the user is attempting to load outdated tables.  

The VCNs are also compared when the application is started.  If the Current and Available VCN are different for the application or tables, either the Application or Table Version Advisory window will open.  Click OK to continue running UD/MIPS.

The VCN format is '1999.2.00' where '1999.2' is the release number and '00' is the revision number

The UD/MIPS VCN is compared to the MCTFS mainframe VCN when couriers are processed and advisories are returned when the courier was created with an older version of the application or tables.  The advisories can be viewed on the Diary Feedback Report.

When the Reconciliation option is selected for either a TRECON or table, the following messages may appear:

The following message will appear if the difference between the current and available VCNs is due to a new release (Ex: '1999.2' vs. '2000.1').  The Trecon reconciliation will not be able to proceed until either the correct Trecon is selected or the new application version is installed.
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The following message will appear if the Current and Available VCN are different for the Application due to a revision (Ex: 'xx' is the revision number, 1999.2.xx).  The message is for information only and the user may Start the Trecon reconciliation.
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The following message will appear if the Current and Available VCN are different for the Tables. The message is for information only and the user may Start the table reconciliation.
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The Reconciliation window identifies the Current Version Information of the application and tables currently loaded on the user's PC and the Available Version Information of any application revisions and table updates included with the TRECON.  

When the user starts the reconciliation, the following messages may appear:

The tables cannot be updated if there are diaries pending.  The These Diaries Are Still Being Processed window identifies the open diaries that must be processed into couriers before the tables can be updated. The table reconciliation will not be able to proceed until the diaries are processed.
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The tables cannot be updated if the available version is older than the current version. The following message identifies the Current and Trecon Versions and informs the user that the reconciliation will terminate. The table reconciliation will not be able to proceed until the correct table Trecon is selected.
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The following message allows the user to load only the updated tables, all the tables, or no tables.  Click Yes to load only the updated tables.  Click No to load all tables.  Click Cancel to stop the table update.
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After the table update is complete, the following message informs the user how many tables were updated.
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The VCNs of all the application objects and tables can be viewed from the About window by clicking the Details button.
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See also:

Make Courier 

Reconciliation 

UD/MIPS - Navigator

The UD/MIPS - Navigator window provides a single point of access to all of the UD/MIPS installed modules and subsystems. All ELSIG's have the authority to start UD/MIPS and login. You can access the UD/MIPS - Navigator window without logging on, however, your access is limited.

The UD/MIPS - Navigator window is available at all times. If you close this window, you will exit the application.

Note: The only Modules available on the UD/MIPS server are Common Utilities and ELSIG.  When logged onto the server the title all windows will have (Server Mode) displayed after the title name.

How Do I Get Here? 

· Close any UD/MIPS module frame.  The UD/MIPS - Navigatorxe "UD/MIPS - Navigator" window opens.

OR

1. Start UD/MIPS from your Desktop. The Login window opens.

2. Do one of the following:

· To log into UD/MIPS, choose a RUC from the list box and enter the requested information.

· To go directly to the UD/MIPS - Navigator window, close the Login window. The UD/MIPS - Navigator window opens.

The Menu

The UD/MIPS - Navigator window menu reflects three options:

File

The File menu allows you to log in or out and to set your subsystem preferences. Icons for the login and logout appear on the UD/MIPS toolbar.

Window

The window menu allows you to switch between UD/MIPS modules using Modules. Switching modules via the Window menu has the same result as choosing an icon.

Help

The Help menu allows you to access the UD/MIPS help facility and technical information about the application.

The Icons

The icons identify the installed modules available in UD/MIPS. Choosing one of the icons opens the corresponding frame. These icons also appear on the UD/MIPS toolbar.

Common Utilities (Client and Server)

Allows specified users to perform maintenance on the Commander's Unit Diary Database (CUDDB)

ELSIG (Client and Server)

ELSIG Assignments are based on the types of access required. They control access to various portions of UD/MIPS for the purpose of maintaining security and continuity.

Unit Diary 

Allows user to add, edit, view, and print diaries based on their ELSIG authority.

Tickler File 

Allows Unit Diary Transactions to be held until the effective date for Unit Diary creation and processing.

DFR 

The Diary Feedback Report provides the user with a general view of a selected DFR cycle and the ability to display the overall status of a specific cycle.

MIPS 

Allows the user to view, make changes, and print the data contained in the CUDDB for the Reporting Unit Code (RUC) and the subordinate RUC's.

Intelligent Forms 

Through the use of automation of the workflow process, forms can be created from a pre-defined list.

Student Management 

Allows you to create rosters and add, delete, verify, and track students from the time they enter the recruit training program through completion of the prescribed courses.

Impromptu 

Allows the user to customize reports with information specific to the need. The user can either create their own custom report or choose a report from a template.

To Exit This Window

· From the File menu, choose Exit. The window closes and you exit the application.

UD/MIPS Login

xe "Server Login"

xe "UD/MIPS Login"This window controls access to UD/MIPS and ensures the integrity of UD/MIPS data. All ELSIGs have access to this window. When you successfully log into the UD/MIPS Server, all window titles are followed by "(Server Mode)".

In order for the automatic file transfer service to work it does not require loginxe "Login" to the server.

How Do I Get Here?

1. Begin on your Desktop.

2. Choose the UD/MIPS icon. The Login window opens.

OR

1. Begin on any UD/MIPS window.

2. From the File menu, choose Login. The Login window opens.

Note: If you or someone else is currently logged in, a message prompts you to Logout.

To Log Into UD/MIPS

1. From the RUC list, choose your RUC.

2. In the ELSIG box, type your 7-character ELSIG.

3. In the Seed box, type your 3-character seed.

4. Choose OK. The UD/MIPS - Navigator window opens.

If the ELSIG you choose is already in use, you receive a message informing you another user is already logged in as that ELSIG.

If your seed is expired, a message prompts you to change your seed and the Change Seed window opens.  Your loginxe "Login" attempts will be unsuccessful until you change your seed.

To Change Your Seed

· Choose Change Seed.  If the RUC, ELSIG, and Seed boxes contain the correct information to log you in, the Change Seed window opens. Follow the procedures in the Change Seed topic. 

To Exit This Window

· To bypass the loginxe "Login" process and have limited functionality, choose Cancel. The UD/MIPS - Navigator window opens.

See also:

About Electronic Signature System 

Import ELSIG 

Master ELSIG Login 

Oracle Login

xe "Oracle Login"This window allows you to login to the Oracle database and switch back to your local database.  If your database preferences are set to use the server, you must login to the Oracle database prior to logging into UD/MIPS. 

How Do I Get Here?

1. Begin on the Preferences window, Database tab.

2. Choose OK.  The Oracle Login window opens and the name you typed in the Server Name box on the Preferences window, Database tab displays in the Database Alias box.

OR

1. Begin on your Desktop.

2. Choose the UD/MIPS icon. The Oracle Login window opens.

To Login to Oracle

1. In the User ID box, type your user ID.

2. In the Password box, type your password.

3. If you want to change the alias in the Database Alias box, type the alias of the database you want to use. 

4. Choose OK.  The Login window opens.

To Change the Oracle Password

· Choose Change PW. The Change Database Password window opens. 

To Switch Back to Your Local Database

1. Select the Use Local Database check box.

Note: If you installed UD/MIPS without a local database, this option is not available.

2. Choose OK.  The Login window opens.

To Exit This Window

· Choose Cancel.  The UD/MIPS application closes.

Change Database Password

This window allows you to change the password used to log in to the Oracle database.

How Do I Get Here?

1. Begin on the Oracle Login window.

2. Choose Change PW.  The Change Database Passwordxe "Change Database Password" window opens and the name you typed in the Server Name box on the Preferences window, Database tab displays in the Database Alias box.

To Change Your Password

1. In the User ID box, type your user ID.

2. In the Password box, type your password.

3. If you want to change the Database Alias, type the name of the database you want to use. 

4. In the Change Password box, type a new password.

5. In the Confirm Password box, re-type the new password.

6. Choose OK.  You return to the Oracle Login window.

To Exit This Window

· Choose Cancel.  You return to the Oracle Login window. 

Logout

xe "Logout"This functionality allows you to log out of UD/MIPS without exiting the application. Log out whenever you stop work or change users. You may log in again if you wish, or you may exit UD/MIPS. When you exit UD/MIPS, the system automatically logs you off.

To Log Out of UD/MIPS

3. Begin on any UD/MIPS window.

4. Do one of the following:

· From the File menu, choose Logout. You return to the frame of the module you were in.

· From the UD/MIPS Navigator Bar in any UD/MIPS module, choose the red open hand icon.

If you attempt to close the application from the UD/MIPS Server when the Use Transfer Service option is turned on, the warning window Terminate UD/MIPS Application opens.  This window informs you that UD/MIPS is required to run the scheduled events.  You have thirty seconds to acknowledge the request or the log out process will be canceled.

See also:

Login

Preferences 

Troubleshooting

xe "Troubleshooting"Higher Headquarters units are not able to reconcile TRECONs.  Apply the following action:

a) Use one of the unit types: HHQ Active, HHQ Reserve, or HQMC.  Note that the term Higher Headquarters does not apply to HQMC.  Refer to the current edition of the MCTFSPRIM and to Common Utilities, Update Unit Address Record.

b) Define the subordinate units of the higher headquarters using this menu item.  The higher headquarters has the Command Reporting Unit Code (CRUC).  It is the senior command, with permanent change of orders writing authority.  Its Monitored Command Code (MCC) should be included in the definition as the Command Monitored Command Code.  This addition facilitates accurate Inbound Rosters for the CRUC.  Finally, add subordinate commands - division, wing, brigade, MAGTF, group, detachment, regiment, reporting unit, etc.   Refer to Common Utilities, Unit Definition.

c) Request TRECON from MISSO. The script should be coded to include the units designated by the Higher Headquarters.

d) See the Common Utilities, Reconciliation topic.
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WARNING:
IF PROCESSING A RECONCILIATION, YOU CANNOT 
EXECUTE A MAKE COURIER.

If you receive a DynaZip Error while running TRECONs, do the following:

e) The Application Error window opens and informs you that you have a DynaZip Error.   Choose OK.

f) A second Application Error window opens and informs you that it is unable to extract the TRECON header.  Choose OK.

g) The TRECON Error window opens and informs you that it is unable to recognize the TRECON Type.  Choose OK.  You return to the Common Utilities frame.  

h) Return to the directory where your TRECONs are stored, then delete the bad TRECON file.

i) Download the TRECON file from the mainframe for that RUC.

j) Begin the TRECON process again from the beginning.

Computer hangs up when selecting more than 10 SSNs for reports, i.e., REDS, Basic Training Record, Basic Individual Record, etc.

The memory on the user computer may be insufficient.  Note that data is read from the disk into main memory.  This data being read includes more than the records being requested.  Other information, like the search procedures, are being read also.  Eventually, no room is available for additional data.  See the Hardware Requirements topic for the recommended amount of memory.  The immediate solution is to select fewer SSNs.

No Deployment Status reports generated for HHQ.

Users need to ensure that they follow the guidelines in Common Utilities, Update Unit Address Record and Unit Definition.

TTC listing fails to consistently print all pages.

Ensure print driver is installed.  See UD/MIPS Installation, Printer Installation.

If the UD/MIPS Server locks up.

a) Try logging out and back in.

b) Check the c:\udmips\logs\udmips.err file for specific error information.

c) Assign a different user ID to each server user so the lock doesn't shut everyone down.

Technical Assistance

xe "Technical Assistance"Users are encouraged to call or write the Functional Manager, UD/MIPS Software Development with questions, comments, or recommendations that would assist in the improvement of this software.  The telephone numbers are DSN 278-9043/9044/9045-9046, Commercial 703-784-9043/9044/9045/9046.  The address is:

Commandant of the Marine Corps (MIS)

Headquarters, United States Marine Corps

3280 Russell Road

Quantico, VA 22134-5103

Your servicing MISSO should be your first point of contact when software problems occur. Furthermore, the MISSO should be included as a via addressee in all UD/MIPS correspondence to the Commandant of the Marine Corps.

As an aid to the user, UD/MIPS contains print window functionality via Ctrl +P keys.  Most UD/MIPS windows display an identification number.  Position any error message so the window number (example, EL202) is visible.

Should software malfunctions or erratic behavior occur and printing the windows is not possible, attempt to duplicate the error so that a sequence of events can be recorded.

DOS window prints are available by using the Print Scrn key.

Users may Paste the window image from the clipboard into a Windows word processor or its paint program.

Before Reporting A Problem

The Troubleshooting topic contains known software problems, either with UD/MIPS or within any of the supporting applications.  Before you report a problem, check the Troubleshooting topic to see if the problem is known.

Windows Primer

Understanding Windows

xe "Understanding Windows"Windows is a good environment for the passive user; Windows is a great environment for the power user.  A firm understanding of its features enhances user productivity and performance.

Windows is an operating environment that sits atop the disk operating system (DOS).  The advantages, inherent with any Windows based application, are too numerous for this manual to record.  Self-study, time, and the application of techniques will promote a greater understanding of this flexible environment. One disadvantage users may incur is the need for a computer configuration capable of handling the services of the operating environment.  Refer to the previous section, Hardware Requirements.
Advantages over DOS include:

No need to remember cryptic, command-line commands

Reduced exit/reentry into common applications

Advantages of Windows and Windows-based applications:

A graphical-user-interface (GUI) window that lets users point and click on menus and icons rather than type text-based commands.

A common user interface and consistent command structure - all applications work basically the same way.  Once you learn one Windows application others will be easier to learn.

Multitasking.  Users are able to run more than one program at a time.

Undo.  In most applications an action may be reversed.  A new state may be returned to its previous state.

Working In Windows

xe "Working In Windows"The following topics discuss some basic operations common to the Windows environment. Note that this information is available, in greater detail, through many different sources.

Many users have already benefited from Windows' common user interface.  It is found in virtually all Windows applications.  New users can bring themselves up to par quickly by concentrating on the Windows Explorer utility.  Learning resources are available through commercial outlets, the user's manual provided with any commercial Windows application, and through Windows' on-line tutorial.

The Mouse

The mousexe "The Mouse" is essential tool when working with Windows applications.  Maximum effectiveness is possible through an understanding and comfort in these mouse actions: Point, Click, Double-Click, and Drag. Most of the information in this manual will emphasize use of the mousexe "The Mouse".  Information on using the mousexe "The Mouse" can be found in the Windows' Help menu.
Most operations can be done with either the mousexe "The Mouse" or the keyboard.  Users will probably start with the mousexe "The Mouse" and add keyboard shortcuts as they become more familiar with UD/MIPS.  Personal preference and situation dictate, there is no right navigation technique.  

Pull-Down Menus

xe "Pull-Down Menus"Access a command on the menu bar by left-mouse click or the Alt + underlined key-letter combination.  To open the menu's File command either left-mouse click "File" on the menu bar or keyboard ALT+F. 

A menu's items may be executed in the same manner.  When a menu opens execute any item by clicking the left-mouse button or key press its accelerator key (the underlined character).  For example, keyboard S to Save.  A dimmed menu item is not executable and considered to be disabled.  Users may be able to execute an application by using keys such as Ctrl+O.

Arrowheads to the right of menu items indicate to the user that a cascade menu, with additional menu items, will appear if opened.

An ellipsis (. . .), following a menu item, indicates to the user that more information is required to execute that menu item.  Information will be entered into a dialog box, which will appear immediately after the item is selected.

Dialog Boxes and Buttons

xe "Dialog Boxes and Buttons"Dialog boxes may be associated with menu items.  These boxes are used when additional information is needed to complete a specific action.  The following information is provided for the common dialog box types:

Check Boxes.  Allows multiple options.  An "X" appearing inside a checkbox indicates to the user the option is in an active status.

Option Buttons (Radio buttons).  Allows mutually exclusive choices.  Only one option can be chosen.

Tabbed Dialog Box.  One dialog box provide multiple sets of options.  Each option then has a set of options on a separate tab.  Clicking a tab brings that set of options to the front of the dialog box.

Text Box.  Sometimes called a single-line edit box.  Specific data is entered in these boxes.  Some text boxes are initially empty and display a flashing vertical bar to indicate the insertion point where users will begin to enter text.

Open List Box.  A list of choices is displayed, any of which may be selected.  Users will click the desired item.

Drop-down List Box.  Shows a list of file names, drives, or other available selections.  This box conserves space.  You must click the associated arrow to expose its static list of choices.

Command Buttons.  Dialog boxes contain buttons that perform an event relative to the button name, for example, OK accepts your information and closes the dialog box. 

Install/Uninstall

About Install/Uninstall

xe "About Install/Uninstall"The UD/MIPS install and uninstall topics step you through the procedures you need to follow in order to:

· Install UD/MIPS on your PC (the Client)

· Install the Server on a server or workstation

· Connect the Client to the local or remote database

· Uninstall UD/MIPS-related software

· Uninstall the Server

This software can be copied to a network-accessible drive. The directory selected for the installation should follow the MS-DOS (8.3) file-naming format. If the MS-DOS format is not used, the installation may fail in some network operating environments.

See Also:

Before You Install 

Before You Install

Before you begin these procedures…

1. See the About Install/Uninstall topic.

2. Log in to the Client with Administrator-level access.

Before you installxe "Before You Install" UD/MIPS on your PC (the Client), you must prepare your PC as follows:

· Remove extraneous programs and files.

· De-fragment hard disks (not for Windows NT).

· Ensure your PC meets the minimum requirements identified in the Hardware Requirements topic.

· Back up important files.  

Note: Recommend exporting the following files: ELSIGs, DFR FARs, couriered diaries, DFR notes, Tickler sections, Impromptu IMR files, user fields, user field labels, and all intelligent forms. If you have information in the datalink directory, back it up in a safe location, or it will be lost after installation. If you have DBUM installed on your PC, export the DBUM user list, as well.

· Uninstall previous versions of UD/MIPS.

· Ensure the appropriate printer driver is installed and configured.

· Close all open applications.

· Know the static IP address for your Enterprise machine.

The Next Step

· Follow the procedures in the Installing UD/MIPS topic.

Installing UD/MIPS

xe "Installing UD/MIPS Enterprise Client"

xe "Installing the Client"This topic gives you step-by-step instructions on how to install UD/MIPS on your PC (the Client). The installation process varies in time depending on computer speeds.

Section 1.0—UD/MIPS Enterprise Install

Before you begin these procedures… 

3. See the Before You Install section. 

4. Log in to the PC with Administrator-level access.

Of particular importance are the following points:

· With UD/MIPS SR2003.2, Database User Manager (DBUM) cannot be installed as part of UD/MIPS. It must be installed separately, preferably as part of a client machine for a remote location. See Section 2.5 Database User Manager and Section 4.1 Uninstall DBUM.

· Back up important files. The Before You Install UD/MIPS section contains a list of recommended files.

· Know the static IP address for your Enterprise machine.

· If you currently have UD/MIPS SR2003.1.02 installed on your PC, follow the procedures in Section 4—Uninstall section.

· If you must reinitialize the database, back up your important files, uninstall UD/MIPS as described in Section 4.0 and then reinstall UD/MIPS.
· If you have problems with this installation, contact your local MISSO immediately. Be sure to take notes while you are installing UD/MIPSxe "Installing UD/MIPS" so that you can describe your problem accurately. 
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Caution:
If you have information in the datalink directory, back it up in a safe location, or it will be lost after installation.

1.1 To Install Enterprise

1. Put the CD labeled UD/MIPS SR2003-02-00 UDMIPS Disk: 1 Oracle 9I Disk: 3 in your CD-ROM drive.

2. Choose [image: image14.png]


 The Startup window opens.
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3. Choose Run. The Run window opens.
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4. In the Open box, type <CD Drive:>\setup.exe. 

5. Choose OK. The following windows open.
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6. The Preparing Setup window opens.
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7. The InstallShield Wizard, Welcome window opens.
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8. Choose Next. The Software License Agreement window opens.

[image: image21.png]tatine Integrated Personnel System

License Agreement
Flease read the following iense agresment carefuly

Fress the PAGE DOWN key o see the rest of the agieement.

Use of this or any other Department 01 Defense [DOD) interest computer system B
constiutes 2 consent to manitoing atal times. Thisis 3 DOD interest computer ystem. |
|AIIDOD interest compter systems and rlated equipment ae for cammunication,
ransmission, processing and storage of offcal 5. Goverrment or alher suthorzed
irfomaton oriy. These systems are subjectto moritoring ot 3l imes [0 ensure proper
funclioing of equipment and systems including securty devices, o prevent unautorized

use and volations of statutes or securly regulatons, o dete ciinal actviy, and for other —
similr purposes. Any uset shauld be aware thal any informalion placed n he system i
subfectto monitoring and is ot subject o any expectation of privacy. |f monitoing o this
oy other DOD) ierest compute ystem tevesls possile evidence of vilson ol |

Do you accept al the terms of the preceding License Agreement? If you slect No, the setup
willose. To nstall Urit Diary - Marine Integrated Personnel System, you mst acoept this
sgreement

<Back Yo | Mo




 

9. Choose Yes.  The Install Shield Wizard, Setup Type for Software window opens.
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10. Select UDMIPS Enterprise.

11. Choose Next.  The Install Shield Wizard, Setup Type for Options window opens.
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12. Select all the items as depicted above.

Note: If you must reinitialize the database, back up your important files, uninstall UD/MIPS as described in Section 4.0 and then reinstall UD/MIPS.
13. If you must reinitialize the database, back up your important files, uninstall UD/MIPS as described in Section 4.0 and then reinstall UD/MIPS.Choose Next. The InstallShield Wizard, Oracle Software Destination Drive Selection  window opens. 
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14. Check the drive you want to install Oracle on.

15. Choose Next. The UD/MIPS Application Destination Drive Selection window may open.
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16. Check the drive you want to install UD/MIPS on.

17. Choose Next. The Number of Concurrent Users window opens.
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18. In the Concurrent box, type the number of concurrent users.

19. Choose Next. The DB User Manager Ids window opens.
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20. In the Primary box, you must type the user ID for the person who will be the primary administrator of the Database User Management (DBUM) System.

21. In the Alternate box, type the ID number for the alternate database manager.

Note: It is best to use generic user IDs instead of an individual's name and initials. This facilitates transitions between administrators as they come and go. The graphic shows an example.

22. Choose Next. The Setup Status window opens.
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23. When the Setup Status window has completed processing, the Location of Next Disk window opens.

Note: This prompt does not display if you are installing from a network instead of CDs.
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24. Place the UD/MIPS Sr2003-02-00 UDMIPS Disk: 2 Oracle 9I Disk 1 CD in your CD-ROM drive.

25. Choose OK. You will see a series of messages informing you that Oracle software is being installed. The installation process begins and can take more than two hours.
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26. The Install page opens.
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27. Toward the end of the Oracle Installation, the Disk Location window opens.

Note: This prompt does not display if you are installing from a network instead of CDs.
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28. Place the UD/MIPS Sr2003-02-00 UDMIPS Disk: 3 Oracle 9I Disk 2 CD in your CD-ROM drive.

29. In the Path box, type <CD Drive>:\Oracle\Disk2.

30. Choose OK. You return to the Install page.

31. The Install page closes. The following prompt displays.
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Note: This prompt does not display if you are installing from a network instead of CDs.

32. Place the UD/MIPS Sr2003-02-00 UDMIPS Disk: 1 Oracle 9I Disk 3 CD in your CD-ROM drive.

33. Choose OK. A series of messages inform you that the database and UD/MIPS functionality is being installed.
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34. If Adobe Acrobat Reader 4 is not currently installed on your machine, the Install Adobe Acrobat Reader 4.05c window opens.
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35. Do one of the following:

· If you want to install Acrobat on your PC, choose Yes.

· If you do not want to install Acrobat on your PC, choose No.

36. If you choose Yes. The Acrobat Reader 4.05c window opens.
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Note: If a previous version of Adobe Acrobat Reader was installed onto your PC, select install AR4 and remove the previous version.

37. Choose Next. A message informs you that Acrobat Reader is installing.
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38. When installation is complete, the InstallShield Wizard, Complete window opens.
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39. Select Yes, I want to restart my computer now.

40. Choose Finish. The InstallShield Wizard window closes, and your computer restarts.

Note: If you experienced a problem with these procedures, proceed to the Section 4.0—Uninstall.

Section 2.0—UD/MIPS Client Install

Before you begin these procedures… 

1. See the Before You Install section. 

2. Log in to the PC with Administrator-level access.

Of particular importance are the following points:

· Back up important files. The Before You Install section contains a list of recommended files.

· If you currently have UD/MIPS SR2003.1.02 installed on your PC, follow the procedures in the Section 4—Uninstall section. You must delete UD/MIPS, Impromptu, and Oracle 8i.

· If you have problems with this installation, contact your local MISSO immediately. Be sure to take notes while you are installing UD/MIPSxe "Installing UD/MIPS" so that you can describe your problem accurately. 
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Caution:
If you have information in the datalink directory, back it up in a safe location, or it will be lost after installation.

2.1 To Install the Client

1. Put the CD labeled UD/MIPS SR2003-02-00 UDMIPS Disk: 1 Oracle 9I Disk: 3 in your CD-ROM drive.

2. Choose [image: image40.png]


 The Startup window opens.
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3. Choose Run. The Run window opens.
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4. In the Open box, type <CD Drive:>\setup.exe. 

5. Choose OK. The following windows open.
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6. The Preparing Setup window opens.
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7. The InstallShield Wizard, Welcome window opens.
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8. Choose Next. The Software License Agreement window opens.
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9. Choose Yes.  The Install Shield Wizard, Setup Type for Software window opens.
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10. Select UDMIPS Client.

11. Choose Next.  The Install Shield Wizard, Setup Type for Options window opens.

[image: image49.png]tarine Integrated Personnel Systen -

Setup Type.
Selectthe selup type that best suis yout needs.

Selectthe options you wish to nstal

¥ Enterprise Client Software
¥ Impromptu User Application
¥ UD/MIPS Appiication

Bk Gz




 

12. Select all the items as depicted above.

13. Choose Next. The following prompt displays.
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14. Choose Yes.

15. The InstallShield Wizard, Oracle Software Destination Drive Selection window opens.
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16. Check the drive you want to install Oralce on.

17. Choose Next. The Impromptu User Application Destination Drive Selection window may open.
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18. Check the drive you want to install Impromptu on.

19. Choose Next. The UD/MIPS Application Destination Drive Selection window may open.
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20. Check the drive you want to install UD/MIPS on.

21. Choose Next. The Setup Status window opens.
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22. When the Setup Status window has completed processing, the Location of Next Disk window opens.

Note: This prompt does not display if you are installing from a network instead of CDs.
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23. Place the UD/MIPS Sr2003-02-00 UDMIPS Disk: 2 Oracle 9I Disk 1 CD in your CD-ROM drive.

24. Choose OK. You will see a series of messages inform you that Oracle software is being installed. The installation process begins and can take more than two hours.
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25. The Install page opens.
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26. Toward the end of the Oracle Installation, the Disk Location window opens.

Note: This prompt does not display if you are installing from a network instead of CDs.
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27. Place the UD/MIPS Sr2003-02-00 UDMIPS Disk: 3 Oracle 9I Disk 2 CD in your CD-ROM drive.

28. In the Path box, type <CD Drive>:\Oracle\Disk2.

29. Choose OK. You return to the Install page.

30. The Install page closes. The following prompt displays.
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Note: This prompt does not display if you are installing from a network instead of CDs.

31. Place the UD/MIPS Sr2003-02-00 UDMIPS Disk: 1 Oracle 9I Disk 3 CD in your CD-ROM drive.

32. Choose OK. The TNS Names Entry Parameters window opens.
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33. In the Address box, type the physical IP address or the domain name if name resolution is available. You cannot leave this box blank.

34. Choose Next. 

35. If the TNS Alias entry already exists in your TNSNAMES file, a message prompts you to confirm if you want to overwrite the entry.

Note: Depending on the setting in registry during this process, this window may or may not open.
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36. Do one of the following:

· If you want to overwrite the entry, choose Yes. The InstallShield Wizard, Choose Destination Location window opens.

· If you do not want to overwrite the entry, choose No. You return to the TNS Names Entry Parameters window. 

37. A series of messages inform you that Impromptu software and UD/MIPS functionality are being installed. This process can take several minutes. The messages can resemble the following:
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38. If Adobe Acrobat Reader 4 is not currently installed on your machine, the Install Adobe Acrobat Reader 4.05c window opens.
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39. Do one of the following:

· If you want to install Acrobat on your PC, choose Yes.

· If you do not want to install Acrobat on your PC, choose No.

40. If you choose Yes. The Acrobat Reader 4.05c window opens.
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Note: If a previous version of Adobe Acrobat Reader was installed onto your PC, select install AR4 and remove the previous version.

41. Choose Next. A message informs you that Acrobat Reader is installing.
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42. When installation is complete, the InstallShield Wizard, Complete window opens.
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43. Select Yes, I want to restart my computer now. 

44. Choose Finish. The InstallShield Wizard window closes, and your computer restarts.

45. Do one of the following:

· After following these procedures, read Setting Up the Server Connection.

· If you experienced a problem with these procedures, proceed to the Section 4.0—Uninstall.

Section 2.5—Database User Manager

It is best to load DBUM on UD/MIPS Client machines with remote access.

This process allows you to install DBUM on your system.

To properly install Database User Manager, you must:

· Create primary and alternate Database User Manager accounts to connect to the database and assign users.

· Assign a ServerName or a name on the user's PC for the server that will be connected with Database User Manager.

Determine user IDs, passwords, and server names before server installation. During the initial installation, the password is password. Modify this password immediately after logging on. 

To Install DBUM

1. Unless you have been instructed otherwise, use your Internet browser and type the URL for the SMARTS/ODSE web site closest to you. Choose from one of the following options:

Camp Butler, MCB

https://smarts.okr.usmc.mil 
Hawaii, MCB


https://smarts.mcbh.usmc.mil 
Kansas City, DFAS

https://smarts.kct.usmc.mil 

The Manpower Support Page opens.

2. On the ODSE Updates page, choose the DB User Manager Update. A message prompts you to confirm that you want to run the file from its current location.

3. Select and save the Database User Management System Ver 2003-2-00.exe to your computer.

4. Choose Database User Management System Ver 2003-2-00.exe. The Extracting Files window opens.
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5. When the Extracting Files window closes, the following window opens:
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6. The InstallShield Wizard, Database User Manager Version Setup window opens.
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7. Choose Next. The License Agreement window opens.
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8. Choose Yes. The InstallShield Wizard, Folder window opens.
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9. Choose Next. The InstallShield Wizard, Complete window opens.
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10. If the window on your screen resembles the one above, choose Finish. You are now ready to run Database User Manager.

Section 3.0—UD/MIPS Personal Install

Before you begin these procedures… 

1. See the Before You Install section. 

2. Log in to the PC with Administrator-level access.

Of particular importance are the following points:

· Back up important files. The Before You Install UD/MIPS section contains a list of recommended files.

· If you currently have UD/MIPS SR2003.1 installed on your PC, follow the procedures in the Section 2—Uninstall section.

· If you must reinitialize the database, back up your important files, uninstall UD/MIPS as described in Section 4.0 and then reinstall UD/MIPS.
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Caution:
If you have information in the datalink directory, back it up in a safe location, or it will be lost after installation.

3.1 To Install UD/MIPS Personal

1. Put the CD labeled UD/MIPS SR2003-02-00 UDMIPS Disk: 1 Oracle 9I Disk: 3 in your CD-ROM drive.

2. Choose [image: image74.png]


 The Startup window opens.

[image: image75.png]Conliol Space Parel

Brograms
Favertes
Documents
i seling:

Eind

Help

(]
c
o
&
Al
@
z:_j
&
wy

3
2
E
H
H
g
z
S




3. Choose Run. The Run window opens.
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4. In the Open box, type <CD Drive:>\setup.exe. 

5. Choose OK. The following windows open.

[image: image77.png]BTV Stating sttt wizst
Se




 

[image: image78.png]


 

6. The Preparing Setup window opens.
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7. The InstallShield Wizard, Welcome window opens.
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8. Choose Next. The Software License Agreement window opens.
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9. Choose Yes.  The Install Shield Wizard, Setup Type for Software window opens.
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10. Select UDMIPS Personal.

11. Choose Next.  The Install Shield Wizard, Setup Type for Options window opens.
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12. Select all the items as depicted above.

Note: If you must reinitialize the database, back up your important files, uninstall UD/MIPS as described in Section 4.0 and then reinstall UD/MIPS.
13. Choose Next. The InstallShield Wizard, Drive Selection window opens.
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14. Check the drive you want to install UD/MIPS on.

15. Choose Next. The Impromptu 6.0 Destination Location window may open.
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16. Choose Next. The UDMIPS Destination Location window may open.
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17. Choose Next. The Setup Status window opens.
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18. When the Setup Status window has completed processing, the Location of Next Disk window opens.

Note: This prompt does not display if you are installing from a network instead of CDs.
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19. Place the UD/MIPS Sr2003-02-00 UDMIPS Disk: 2 Oracle 9I Disk 1 CD in your CD-ROM drive.

20. Choose OK. You will see a series of messages inform you that Oracle software is being installed. The installation process begins and can take more than two hours.
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21. The Install page opens.
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22. The Disk Location window opens.

Note: This prompt does not display if you are installing from a network instead of CDs.
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23. Place the UD/MIPS Sr2003-02-00 UDMIPS Disk: 3 Oracle 9I Disk 2 CD in your CD-ROM drive.

24. In the Path box, type <CD Drive>:\Oracle\Disk2.

25. Choose OK. You return to the Install page.

26. The Disk Location window reopens.

Note: This prompt does not display if you are installing from a network instead of CDs.
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27. Place the UD/MIPS Sr2003-02-00 UDMIPS Disk: 1 Oracle 9I Disk 3 CD in your CD-ROM drive.

28. In the Path box, type <CD Drive>:\Oracle\Disk3.

29. Choose OK. You return to the Install page.

30. The Install page closes. Once Oracle has finished installing, a series of messages inform you that the database, Impromptu software, and UD/MIPS functionality is being installed. This process can take up to one hour. The messages can resemble the following:
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31. If Adobe Acrobat Reader 4 is not currently installed on your machine, the Install Adobe Acrobat Reader 4.05c window opens.
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32. Do one of the following:

· If you want to install Acrobat on your PC, choose Yes.

· If you do not want to install Acrobat on your PC, choose No.

33. If you choose Yes. The Acrobat Reader 4.05c window opens.
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Note: If a previous version of Adobe Acrobat Reader was installed onto your PC, select install AR4 and remove the previous version.

34. Choose Next. A message informs you that Acrobat Reader is installing.
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35. When installation is complete, the InstallShield Wizard, Complete window opens.
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36. Select Yes.

37. Choose Finish. The InstallShield Wizard window closes.

38. Before you can use UD/MIPS, you must initialize the local database. Don't forget to import all the files you exported from the previous version.

39. If you have experienced a problem with these procedures, proceed to the Section 4.0—Uninstall.

Uninstalling UD/MIPS

Uninstalling UD/MIPSxe "Uninstalling UD/MIPS" Enterprise involves many separate operations.  You must uninstall the Database User Management (DBUM) System software (if installed), uninstall UD/MIPS, stop specific Oracle-related services, uninstall the current Oracle software, and shutdown and restart the PC.

If you have problems with the uninstall, contact your local MISSO immediately. Be sure to take notes while you are uninstalling UD/MIPSxe "Uninstalling UD/MIPS" so that you can describe your problem accurately step by step.

Important:
These procedures assume that no other software has been installed on your machine that uses Oracle services, e.g., web services products, FTP products, etc.  These other Oracle-related products must be removed prior to performing these procedures.  Contact your Server Administrator for assistance.

Before you begin these procedures…

1. Read the Before You Install UD/MIPS section.

2. Follow the DBUM System Uninstall instructions in the DBUM Help file.

3. Log in to the PC with Administrator-level access.

To Uninstall DBUM
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1. On the Desktop Task Bar, choose Start, select Settings, then choose Control Panel. The Control Panel folder opens.
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2. Choose Add/Remove Programs. The Add/Remove Programs Properties window opens.
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3. On the Change or Remove Programs tab, select Database User Management, then choose Change/Remove.  An ISW progress window opens, then a message prompts you to confirm the delete process.
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4. Choose OK. When the uninstall process completes, the InstallShield Wizard, Maintenance Complete window opens.
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5. Choose Finish. You return to the Add/Remove Programs window.

To Uninstall UD/MIPS 

These instructions apply to all current releases, Local and Remote installations. 
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1. On the Desktop Task Bar, choose Start, select Settings, then choose Control Panel.  The Control Panel window opens. 
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2. On the Control Panel, choose Add/Remove Programs. The Add/Remove Programs Properties window opens. 
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3. Do one of the following:

· If you are using Windows NT, on the Install/Uninstall tab, in the list, select Unit Diary— Marine Integrated Personnel System.
· If you are using Windows 2000, from the Currently Installed Programs box, select Unit Diary—Marine Integrated Personnel System.

4. Do one of the following: 

· If you are using Windows NT, choose Add/Remove. 

· If you are using Windows 2000, choose Change/Remove.

The InstallShield Wizard, Preparing Setup window opens briefly.  The progress indicator shows the status of the setup process.
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5. When the setup process completes, a message prompts you to confirm the delete process.
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6. Choose OK. The Removed Shared File window or Shared File Detected window may open.

7. You may encounter one of the following windows:
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· If the Shared File Detected window opens, select the Don't display this message again check box and choose Yes.  
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· If the Removed Shared File window opens, choose Yes To All.  A message prompts you to confirm the delete process. Choose OK. A message prompts you to confirm the delete process.

8. When the uninstall process completes, the InstallShield Wizard Complete window opens.
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9. Do one of the following:

· If you are only uninstalling UD/MIPSxe "Uninstalling UD/MIPS", select, Yes, I want to restart my computer now.

· If you intend to uninstall Cognos Impromptu or Oracle, select No, I want to restart my computer later.

10. Click Finish. The InstallShield Wizard Complete window closes.

11. Do one of the following:

· If you are uninstalling Cognos Impromptu, go to Subsection 4.3 To Uninstall Cognos Impromptu.

· If you are uninstalling Oracle 8i, go to Subsection 4.4 To Uninstall Oracle 8i.

· If you are uninstalling Oracle 9i, go to Subsection 4.5 To Uninstall Oracle 9i.

To Uninstall Impromptu

Note: If you are uninstalling UD/MIPSxe "Uninstalling UD/MIPS" Enterprise, skip this step.

1. Begin on the Add/Remove Programs Properties window. 
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2. Do one of the following:

· If you are using Windows NT, on the Install/Uninstall tab, in the list, select Cognos BI. 

· If you are using Windows 2000, from the Currently Installed Programs box, select Cognos BI. 

3. Do one of the following:

· If you are using Windows NT, choose Add/Remove. The Uninstall Wizard window opens.

· If you are using Windows 2000, choose Change/Remove. The Uninstall Wizard window opens.
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4. Choose Next. The Component Selection window opens.
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5. Select Select All to check the boxes. 

6. Choose Next. The Uninstall window opens.
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7. Choose Yes. The Uninstall Progress window indicates how the uninstall is progressing. 
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8. The Uninstallation Completed window opens.
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9. Do one of the following:

· If you are only uninstalling Cognos Impromptu, select, Yes, I want to restart my computer now.

· If you intend to uninstall UD/MIPS or Oracle, select No, I want to restart my computer later.

10. Choose Finish. You return to the Add/Remove Programs Properties window. 

11. Close the Control Panel window and proceed to the To Uninstall Oracle 8i or the To Uninstall Oracle 9i section later in this topic.

To Uninstall Oracle 8i
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1. On the Desktop Task Bar, choose Start, select Programs, select Oracle Installation Products, then choose Universal Installer. The Oracle Universal Installer window opens.
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2. Choose Deinstall Products. The Inventory window opens.

Note: The list of software on the window may not be the same as in this graphic.
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3. Expand the Independent Products item.

4. Expand the OraHome81 item.

5. Check all items for the Independent Products and OraHome81 dependent components.

6. Choose Remove. The Confirmation window opens. It prompts you to confirm the items you have selected to uninstall.
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7. Choose Yes. The Remove window opens.
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8. When the uninstall process completes, you return to the Inventory window. The Independent Products and OraHome81 items should be gone from the list.

Note: The list of software on the window may not be the same as in this graphic.

9. Choose Close. You return to the Oracle Universal Installer window.
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10. Choose Exit. The Exit window opens.
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11. Choose Yes.  The Exit window closes.

Note: When you reboot, you might encounter a Service Control Manager error. This is not a problem.

To Uninstall Oracle 9i
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1. On the Desktop Task Bar, choose Start, select Programs, select Oracle Installation Products, then choose Universal Installer. The Oracle Universal Installer window opens.
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2. Choose Deinstall Products. The Inventory window opens.

Note: The list of software on the window may not be the same as in this graphic.
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3. Expand the Independent Products item.

4. Expand the Oracle Homes item.

5. Check all items for the Independent Products and Oracle Homes dependent components.

6. Choose Remove. The Confirmation window opens. It prompts you to confirm the items you have selected to uninstall.
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7. Choose Yes. The Remove window opens.
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8. When the uninstall process completes, you return to the Inventory window. The Independent Products and OraHome92 items should be gone from the list.

Note: The list of software on the window may not be the same as in this graphic.
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9. Choose Close. You return to the Oracle Universal Installer window.
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10. Choose Exit. The Exit window opens.
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11. Choose Yes.  The Exit window closes.

12. Shutdown and Restart your machine.

Clearing the Hard Drive

You must delete the Oracle folders from your C: drive in order to successfully install or reinstall UD/MIPS. You must restart you machine before removing the folders.
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Caution:
Follow these instructions carefully so that you do not accidentally remove programs or information.

1. Open Windows Explorer by typing [image: image136.png]


 and the letter E at the same time. The Windows Explorer window opens.
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2. Choose (C:) or the disk where Oracle is installed.

3. Right click the Oracle folder. The submenu displays.

4. From the submenu, choose Delete. A message prompts you to confirm the deletion.
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5. Choose Yes. The Oracle folder is deleted. 

6. Return to (C:) or the disk where your Programs Files folder resides.

7. Choose Program Files. A warning page might display.
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8. Choose Show Files. The subfolders under the Program Files folder display.
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9. Right click Oracle. The submenu displays.

10. From the submenu choose Delete. A message prompts you to confirm the deletion.
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11. Choose Yes. The Oracle directory folder is deleted.

12. From the File menu, choose Close. Windows Explorer closes.

13. Shutdown and Restart your machine. 

Setting Up the Server Connection

xe "Setting Up the Server Connection"These instructions step you through establishing the connection between the Client software (on your PC) and the Server database using a database alias.  Before you can set up this connection, you must perform the steps in the following topics:

Before You Install the Client 

Installing UD/MIPS 

Before You Install 

Uninstalling UD/MIPS 

And, you need to know the static IP address of your UD/MIPS server.  See your UD/MIPS Server Administrator.

The graphics used in this topic are for a Windows NT operating system. 

To Create the Database Alias
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5. From the Desktop Toolbar, choose Start, then choose Programs, Oracle-OraHome81, Network Administration, and then Net8 Configuration Assistant. The Welcome window opens.
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6. Select the Local Net Service Name configuration. 

7. Choose Next.  The Net Service Name Configuration window opens.
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8. Select Add.

9. Choose Next. The Net Service Name Configuration, Database Version window opens.
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10. Select Orcle8I database or service.

11. Choose Next. The Net Service Name Configuration, Service Name window opens.
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12. In the Service Name box, type udmipsdb. 

13. Choose Next. The Net Service Name Configuration, Select Protocols window opens.
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14. Select TCP.

15. Choose Next. The Net Service Name Configuration, TCP/IP window opens.
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16. In the Host Name box, type the name or static IP address you received from your UD/MIPS server administrator.

17. Select Use the standard port number of 1521.

18. Choose Next. The Net Service Name Configuration, Test window opens.
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19. Select No, do not test. 

20. Choose Next. The Net Service Name Configuration, Net Service Name window opens.
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21. In the Net Service Name box, type udmips.

22. Choose Next. The Net Service Name Configuration, Another Net Service Name window opens.
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23. Select No. The Net Service Name Configuration Done window opens.
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24. Choose Next. The Welcome window opens.
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25. Choose Finish. The Welcome window closes. 

Switching Database Connections

xe "Switching Database Connections"The UD/MIPS database may be located on either the local PC or a remote Windows NT server. During the installation of UD/MIPS, you may select either option. You can change locations any time after you install the application. 

To Switch Between the Local PC and the Remote Server

1. Begin on the UD/MIPS - Navigator window.

[image: image154.png]o = al > @ X

Window Help

PitScreen Cawp |UnitDiay  TikirFle DR MPS  Intgligert  Student  Impromptu
Foms  Management

Fiint Setup.

Ext AlsFd





2. From the File menu, choose Preferences. The Preferences window opens.
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· Do one of the following:

· Select Local PC and choose OK. The UD/MIPS - Login window opens. Login as usual.
· Select Server Name and type the Server Name. Choose OK. The Oracle Login window opens. To log in to the server database, see the To Log in to Oracle section later in this topic.

The Server Name defaults to the last value entered.

To Switch from Remote Server to Local PC during Login
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1. On the Desktop Task Bar, choose Start, select Programs, select Udmips, and choose UDMIPS.  The Oracle Login window opens.
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2. Select Use Local Database, and choose OK. The UD/MIPS Login window opens. Login as usual.

To Log in to Oracle

1. Begin on the Oracle Login window.
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2. In the User ID box, type your User ID.

You were issued these by the Database Administrator.

3. In the Password box, type your Password.

4. In the Database Alias box, type the Database Alias. Choose OK. The UD/MIPS Login window opens. Log in as usual.

Resetting the Local Database

1. On the UD/MIPS – Navigator window, select File, and choose Database Preferences. The Preference Settings window opens.

2. Choose Reset DB and choose OK. A message warns you that all data will be lost from your local database.

3. Choose Yes. A Running window opens as the database resets. When finished, the Database Reset window opens.

4. Choose OK. The UD/MIPS application closes.

Electronic Signature System

About Electronic Signature System

xe "About Electronic Signature System"The Electronic Signature (ELSIG) System is a group of mutually dependent functions that support the security of the UD/MIPS. With this system, the Commanding Officer or ELSIG Control Officer can assign specific ELSIGs to users who perform corresponding specific duties.  Refer to the Marine Corps Total Force System Personnel Reporting Instructions Manual (MCTFSPRIM) for information pertaining to Electronic Signatures.


An ELSIG is assigned based on the type of access required. Valid ELSIGs allow a certain level of access and authority. The Valid Electronic Signature topic defines the types of ELSIGs that are available. Only one ELSIG may be assigned for any Reporting Unit Code/Social Security Number combination.

See Also:

Assign ELSIG 

Change Seed 

ELSIG Report 

Export ELSIG(s) 

Import ELSIG 

Logout 

Manage Electronic Signature 

Modify ELSIG 

UD/MIPS Login 

Valid Electronic Signatures 

Valid Electronic Signatures

xe "Valid Electronic Signatures"There are eight valid ELSIGs.  The type of ELSIGs and the authority to assign them are listed below:

User-Type ELSIGs (Abbreviation)


Assigned By

Commanding Officer (CO-ELSIG)
Master ELSIG Diskette

ELSIG Control Officer (ECO)
CO-ELSIG or ECO

Certifier (C)
CO-ELSIG or ECO

Reviewer (R)
CO-ELSIG or ECO

Preparer (P) 
CO-ELSIG or ECO

Viewer (V)
CO-ELSIG or ECO

Super Viewer (S)
CO-ELSIG or ECO

Admin Viewer (A)
CO-ELSIG or ECO

See Also:

Assign ELSIG 

Manage Electronic Signature 

Modify ELSIG 

Manage Electronic Signature

xe "Deleting an ELSIG"

xe "Manage Electronic Signature"

xe "Resetting an ELSIG"

xe "Suspending an ELSIG"

xe "Manage ELSIGs"This window allows the Commanding Officer (CO) and ELSIG Control Officer (ECO) to add, edit, reset, or delete ELSIGs and to edit the TTC list. No other ELSIGs can access this window.

If a subordinate RUC has a CO, the CONAD RUC cannot manage the ELSIGs of the subordinate RUC. If a subordinate RUC has a CO ELSIG, the parent RUC can view the ELSIGs of the subordinate RUC but cannot maintain them. 

How Do I Get Here?

3. Begin on the ELSIG frame.

4. From the Tools menu, choose Manage ELSIG. The Manage Electronic Signature window opens.

This window contains the following information:

· Unit ID

· Last Name

· Initials

· SSN

· Type of ELSIG

· Date Changed

· Suspended

· Modify TTC List

· View Other Diaries

· Date Created

· Last Accessed

UD/MIPS Access Restrictions

Access to UD/MIPS is restricted. ELSIGs are issued to either those who manage the ELSIG system or those who perform functions involving personnel data. ELSIGs that have UD/MIPS update authority are CO, ECO, Preparer, Reviewer, and Certifier. The Viewer, Super Viewer, and Admin Viewer ELSIGs have view only authority as the name implies.

To Assign a New ELSIG
· Choose New. The Assign ELSIG window opens.

To Edit ELSIG Information

5. Select the ELSIG you want to modify.

6. Choose Edit. The Modify ELSIG window opens.

Note: If you are modifying an ELSIG for a CO, the Modify ELSIG for a CO window opens.

To Suspend or Unsuspend an ELSIG

1. Select the ELSIG you want to suspend or unsuspend.

2. Do one of the following:

· If you want to suspend an ELSIG, choose Suspend. The Susp column will be set to Y. 

· If you want to unsuspend an ELSIG, choose Unsuspend. A message prompts you to confirm that you want to reset the ELSIG. Choose Yes. The ELSIG Issued window opens. 

Note: Once the assigned ELSIG and seed display, memorize them. Do not write them down. Once the ELSIG has been unsuspended, it will be reset, and a new ELSIG will be issued.

3. Choose OK. You return to the Manage Electronic Signature window.

To Authorize an ELSIG to Change the TTC List

7. Select the ELSIG you want to authorize or make ineligible to authorize.

8. Choose TTC List. The Modify TTC List column is set to Y.

Note: If you are not authorized to make changes, Mod TTC List is unavailable and the Modify TTC List column is blank. 

To Reset ELSIGs

This option deletes the current ELSIG and replaces it with a new one for the same person.

9. Select the ELSIG you want to reset. 

10. Choose Reset. A message prompts you to confirm the reset.

11. Do one of the following:

· If you want to delete the ELSIG, choose OK. The ELSIG Issued window opens and displays the Unit ID, Name, ELSIG, and seed. Choose OK. You return to the Manage Electronic Signature window.

Note: Once the assigned ELSIG and seed display, memorize them. Do not write them down.

· If you do not, choose Cancel.

To Delete an ELSIG

12. Select the ELSIG you want to delete. 

13. Choose Delete. A message prompts you to confirm the deletion. 

14. Do one of the following:

· If you want to delete the ELSIG, choose OK. The ELSIG is deleted.

· If you do not, choose Cancel.

Note: The CO can delete all subordinate ELSIGs and the CO and ECO can delete their own ELSIGs. If you delete your own ELSIG, UD/MIPS logs you off automatically.

To Assign or Edit TTC Lists for an ELSIG

15. Select the ELSIG that requires the change.

16. Choose TTC List. The Assign TTC List window opens.

To Select ELSIGs for Specific Units

· If you are logged in as a CONAD RUC, in the Available Units list, select the reporting unit code. ELSIGs associated with the selected unit and the Admin RUC display.

To Change the Unit ID

· Select the desired unit from the available units in the Available Units list.

To Exit This Window

· Choose Close. You return to the ELSIG frame.

See Also:

About Electronic Signature System 

ELSIG Issued 

ELSIG Report 

Valid Electronic Signatures 

Assign ELSIG

xe "Assign ELSIG"

xe "Assigning a New ELSIG"This window allows the Commanding Officer (CO) and ELSIG Control Officer (ECO) to add a new ELSIG or to edit information for an existing ELSIG. 

More than one ECO can be assigned from this window. Delegation of this duty should be by ELSIG issuance and appointment letter. In this capacity, the appointee will have the same capabilities as the Commanding Officer for ELSIG issuance and maintenance. 

The following sequence represents a Commanding Officer's assignment of users. Subsequent assignments can be made by the ECO, if one is appointed by the Commanding Officer.

How Do I Get Here?

17. From the UD/MIPS Navigator window, choose the ELSIG icon. 

18. From the Tools menu, choose Manage ELSIG. The Manage Electronic Signature window opens.

19. Choose New. The Assign ELSIG window opens.

To Add ELSIG Information

20. In the SSN box, do one of the following:

· If the user is a Marine, in the SSN box, after the default zero (0), type the user's 9-digit SSN without any dashes.   

· If the user is another service member, in the SSN box, overtype the default zero with the other applicable service code, then type the user's 9-digit SSN without any dashes.  

· If you want to search for a member's SSN, choose Members. The Search window opens.

21. In the Last Name box, type the name.

22. In the Initials box, type the user's initials, up to two characters.

Note: If the SSN is tied to another ELSIG already on the system for a different unit and you have already typed the SSN, the Last Name and Initials for the member displays automatically.

23. In the Type of ELSIG box, select the type of authority you want to assign to the user.

24. If you selected Electronic Signature Control Officer or Certifier as the Type of ELSIG, do the following:

a) In the Certifying Officer Title ID list, select the appropriate ID.

Note: When assigning an ECO, the Modify TTC List is checked automatically, and if the Certifying Officer Title ID is anything other than "By direction of the Commanding Officer," the ECO is not able to assign a Certifying Officer.

b) In the Certifying Officer, Grade, Comp, Title box, type the user's grade, component, and title up to 20 characters.

25. If you selected Superviewer as the Type of ELSIG, do the following:

c) Choose OK. The Assign Superviewer Drive window opens.

d) Select the target drive.

e) Insert a disk into the drive.

26. Do one of the following:

· To authorize the ELSIG to have access to a TTC list, under TTC Lists, select the appropriate TTC list.

· If you want to add, edit, or remove a TTC List from the ELSIG, choose TTC List. The Assign TTC List window opens.

27. To select a default section for the ELSIG, in the Default Section list, select the section.

28. If you want to suspend or unsuspend the ELSIG, check or clear Suspend.

29. If the current RUC is a CONAD RUC, in the Available Units list, select the appropriate RUC.

30. In the Privilege Description box, select the privileges you want to assign the member.

Note: If you want to apply privileges that have been defined by the CO or ECO, choose Privilege Defaults. The predefined default privileges are now checked.

31. Choose OK. The ELSIG Issued opens and displays the Unit ID, Name, ELSIG, and seed. 

Note: Once the assigned ELSIG and seed display, memorize them. Do not write them down.

32. Choose OK. You return to the Manage Electronic Signature window.

To Exit This Window

· Choose Close. You return to the ELSIG frame.

See Also:
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Modify ELSIG

This window allows the Commanding Officer (CO) and ELSIG Control Officer (ECO) to edit information for an existing ELSIG (other than a CO ELSIG), and to assign additional rights to it. 

How Do I Get Here?

1. From the UD/MIPS Navigator window, choose the ELSIG icon. 

2. From the Tools menu, choose Manage Electronic Signature. The Manage Electronic Signature window opens.

3. Select the ELSIG.

4. Choose Edit. The Modify ELSIG window opens.

Note: If you are modifying an ELSIG for a CO, the Modify ELSIGxe "Modify ELSIG" for a CO window opens
.

To Edit ELSIG Information

33. In the Last Name box, the user's last name is automatically populated from the initial ELSIG assignment. You may select or type the user's last name. 

34. In the Initials box, the user's first and middle initials, up to two characters, are automatically populated from the initial ELSIG assignment. You may select or type the user's first and middle initials.

35. In the Type of ELSIG box, select the type of authority you want to assign to the user's name.

36. If you select ELSIG Control Officer or Certifier as the Type of ELSIG, do the following:

· In the Certifying Officer Title ID list, select the appropriate ID.

· In the Certifying Officer, Grade, Comp, Title box, type the user's grade, component, and title up to 20 characters.

37. If you want to assign a TTC list to an ELSIG, in the TTC Lists box, select the check box for the desired list.

Note: Once you have selected or deselected a list, the user has access only to the transactions contained in the selected TTC List.

38. If you are authorized to modify TTC Lists, in the TTC Lists box, choose TTC List. The Assign TTC List window opens.

39. If you want to assign the ELSIG to a Default Section, in the Default Section list, select the section.

Note: If you are logged in as a CONAD RUC, in the Available Units list, select the appropriate RUC.

40. If you want to suspend or unsuspend the ELSIG, select Suspend.

41. In the Privilege Description and Privilege Class box, select the privileges you want to assign to the ELSIG.

42. Choose Apply. You return to the Manage Electronic Signature window and can view the changes you made to the ELSIG.

Note: If you selected a different Type of ELSIG, a new ELSIG is issued, and the ELSIG Issued window opens.

Note: If you want to apply privileges that have been defined by the CO or ECO, choose Privilege Defaults. The default privileges are now checked.

To Exit This Window

· Choose Close. You return to the Manage Electronic Signature window.

See Also:
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Modify ELSIG for a CO

xe "Modify ELSIG for a CO"

xe "Modify CO ELSIG"If you have a Commanding Officer (CO) or an ELSIG Control Officer (ECO) ELSIG, this window allows you to edit information ELSIG information for a commanding officer. This window only opens if you are editing information about a CO, and no other ELSIGS have access to this window. 

How Do I Get Here?

1. Begin on the Manage Electronic Signature window.

2. Select an ELSIG for a CO.

3. Choose Edit. The Modify ELSIG for a CO window opens.

To Edit ELSIG Information

1. In the SSN box, the user's SSN is automatically populated from the initial ELSIG assignment.

2. In the Last Name box, the user's last name is automatically populated from the initial ELSIG assignment. You may retype the user's last name. 

3. In the Initials box, the user's first and middle initials, up to two characters, are automatically populated from the initial ELSIG assignment. You may retype the user's first and middle initials.

4. In the Title ID box, the user's title identification is automatically populated from the initial ELSIG assignment. You may select the type of authority you want to assign.

5. In the Grade Comp Title box, the user's grade, component, and title (totaling up to 20 characters) is automatically populated from the initial ELSIG assignment. You may type the user's new grade, component, and title.

6. Choose OK. You return to the Manage Electronic Signature window and can view the changes you made to the ELSIG.

To Exit this Window

· Choose Close. You return to the Manage Electronic Signature window.

See Also:
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Change Seed

xe "Change Seed"

xe "Changing User Seed"This window allows you to change your seed. You should routinely change your seed and anytime your ELSIG has been compromised. UD/MIPS requires you to change your seed if you haven't changed it during the past 60 days. CO ELSIGs are excluded from this restriction.

On the 61st day, if it has not been changed a Change SEED dialog box will appear stating, "Your SEED has exceeded 60 days". Login attempts will be unsuccessful until the SEED is changed. The ELSIG may be changed prior to the 60-day limit. 

UD/MIPS will prevent you from logging in until you change your seed. All ELSIGs have access to this window but an ELSIG only has the authority to change the seed it owns. If you are logging on for the first time with a newly issued or reset ELSIG, UD/MIPS requires you to change your seed.  

Note: On the user's first login with a new ELSIG, the user will be required to change their seed.

How Do I Get Here?

From the Login window

43. From the UD/MIPS-Navigator bar and the File menu, choose Login.

44. The Login window opens. Choose Change Seed.

From the ELSIG window

45. Begin on the ELSIG window.

46. From the File menu, choose Change Seed. The Change Seed window opens.

To Change Your Seed

47. In the Current ELSIG box, type your 7-character ELSIG.  The ELSIG is not case sensitive.

48. In the Current Seed box, type your 3-character Seed.  The Seed is not case sensitive.

49. In the New Seed box, type a new 3-character Seed.

50. In the New Confirm Seed box, retype the new 3-character Seed.

51. Choose OK. The ELSIG Issued window opens and displays the Unit ID, Name, ELSIG, and seed. 

52. Choose OK. Your new seed is saved, and you return to the Manage Electronic Signature window.

To Exit This Window

· To cancel the change, choose Cancel. The UD/MIPS - Navigator window opens.

OR

· To save the change, choose OK. The ELSIG Issued opens and displays the Unit ID, Name, ELSIG, and seed.

See Also:
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Export ELSIG(s)

xe "Export ELSIG(s)"This window retrieves a list of RUCs from the ELSIG database and allows you to select the units and TTC lists you want to export for backups.

This window is available to all authorized users.

How Do I Get Here?

· From the Tools menu, choose Export ELSIG. The Export Unit(s) window opens.

This window contains the following information:

· Units

· Unit ID Number

· TTC List Name

To Export ELSIG and TTC Information

1. In the Units box, select one or more units whose information you want to export.

2. Do one of the following:

· If you want to export only the TTC list information, select TTC Lists Only.

· If you do not want to export only the TTC list information, clear TTC Lists Only.

3. If you selected TTC Lists Only, in the Unit/TTC List Name list, select the TTC lists you want to export.

4. Choose OK. The Save As window opens.

5. Name the file to be saved appropriately. 

6. Choose Save. You return to the ELSIG frame.

To Exit This Window

· Choose Close. You return to the previous window.

See Also:
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xe "Save As"This window allows you to name and save ELSIG and TTC information you selected in the Export ELSIG(s) window to a backup file with a .zip extension. You can also save a Unit Diary Status report to a text file or save a selected FTP log to a file. If you are a Reserve unit, you can export an accession.

How Do I Get Here?

53. From the UD/MIPS Navigator window, choose the ELSIG module icon. The ELSIG module opens.

54. From the Tools menu, choose Export ELSIG. The Export Unit(s) window opens. Begin in the Export Unit(s) window.

55. Choose OK. The Export ELSIG window opens.

OR

1. From the UD/MIPS Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

2. From the Reports menu, choose Export Status Report. The Time Frame Specification window opens.

3. Follow the procedures in the Time Frame Specification window. The Save As window opens.

OR

1. From the UD/MIPS Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

2. From the Transactions menu, choose Export Accession. The Save As window opens.

OR

1. From the UD/MIPS Navigator window, choose the Common Utilities module icon. The Common Utilities window opens.

2. From the Tools menu, choose Server Event Log. The Server Event Log window opens.

3. Follow the procedures for the Server Event Log window.

4. If you want to export the FTP Log file, choose Export. The Save As window opens.

To Export ELSIGs

56. In the Save In list, select the directory where you want to save the .zip file.

57. In the File Name box, type the name you want to give the file.

58. Choose Save. A message indicates if the save was successful.

59. Choose OK. You return to the ELSIG window.

To Export Unit Diary Status Report 

1. In the Save In list, select the directory where you want to save the .txt file.

2. In the File Name box, type the name you want to give the file.

3. Choose Save. A message indicates if the save was successful.

4. Choose OK. You return to the Unit Diary window.

To Export an Accession 

1. In the Save In list, select the directory where you want to save the .acc file.

2. In the File Name box, type the name you want to give the file.

3. Choose Save. A message indicates if the save was successful.

4. Choose OK. You return to the Unit Diary window.

To Export an FTP Log 

1. In the Save In list, select the directory where you want to save the .txt file.

2. In the File Name box, type the name you want to give the file.

3. Choose Save. A message indicates if the save was successful.

4. Choose OK. You return to the Common Utilities window.

To Exit This Window

· Choose Cancel. You return to the Export Unit(s) window or the Unit Diary Management window or the Common Utilities window.

Import ELSIG

This option allows you to import ELSIGs or TTC Lists that have been saved during a previous export to a file with a .zip extension. These files are often saved for backup purposes. You must be logged off to import a .zip file. UD/MIPS will not allow you to proceed until you have done so. 

How Do I Get Here?

1. From the UD/MIPS Navigator, choose the ELSIG module icon. The ELSIG module opens.

2. From the Tools menu, choose Import ELSIG. The Select Import File window opens. 

3. Do one of the following:

· In the Select Import File list, select the file to import.

· In the File Name block, type the file name.

4. Choose Open. The Import ELSIG window opens. Available RUCs display in the Units list.

This window contains the following information:

· Units

· Unit Number

· TTC List Name

Whether to Append or Overwrite a File

Before importing ELSIG information, be sure to understand the difference between appending and overwriting ELSIGs. These options are not available if you select the TTC List(s) Only radio button.

Use an Append import if you want to import only ELSIGs on the import file that are not currently resident in UD/MIPS. Any existing ELSIGs will not be overwritten.

Use an Overwrite import if you want to overwrite resident ELSIGs in UD/MIPS with the ELSIGs in the import file.

To Import ELSIGs and TTC Lists

1. Under Import Options, in the Units list, select one or more units to import.

Note: This option will not be available for UD/MIPS releases prior to 2003-1.

2. If you want to include default privilege settings based on settings that you or another CO or ECO have previously entered for the ELSIGs you import, select Include Defaults.

3. Under Type of Import, do one of the following:

· If you want to import ELSIGs that do not already exist on UD/MIPS, select Append.

· If you want to overwrite information for ELSIGs that already exist, select Overwrite.

4. Choose OK. The UD/MIPS Login window opens.

5. Complete the procedures in the UD/MIPS Login topic. After a successful login, you return to the import ELSIGxe "Import ELSIG" process.

6. If there are TTC lists with the same names as ones already associated with a RUC in UD/MIPS, the List Name Conflict window opens. This window gives you the option of merging the list with an existing one, skipping the matching list, or renaming the list from the file.

7. Complete the procedures in the List Name Conflict topic. After successfully resolving all conflicts, you return to the import ELSIGxe "Import ELSIG" process. 

8. If the total number of existing TTC lists and imported TTC lists exceeds 99, a message informs you the maximum number of lists has been exceeded. 

f) Choose OK.  A message informs you the import has failed.

g) Choose OK.  You return to the Import ELSIGxe "Import ELSIG" window.

9. If the import process did not exceed the maximum number of TTC lists, a message informs you the import was successful. 

To Import Only TTC Lists

1. Under Import Options, select the TTC List(s) only.

2. In the Unit list, select one or more lists to import.

3. Choose OK. The UD/MIPS Login window opens.

4. Complete the procedures in the UD/MIPS Login topic. After a successful login, you return to the import ELSIGxe "Import ELSIG" process.

5. If there are TTC lists with the same names as ones already associated with a RUC in UD/MIPS, the List Name Conflict window opens. This window gives you the option of merging the list with an existing one, skipping the matching list, or renaming the list from the file.

6. Complete the procedures in the List Name Conflict topic. After successfully resolving all conflicts, you return to the import ELSIGxe "Import ELSIG" process.

7. If the total number of existing TTC list and imported TTC lists exceeds 99, a message informs you the maximum number of lists has been exceeded. Choose OK. A message informs you the import has failed. 

a) Choose OK.  A message informs you the import was successful. 

b) Choose OK. You return to the Import ELSIGxe "Import ELSIG" frame.

8. If the import process did not exceed the maximum number of TTC lists, a message informs you the import was successful. 

To Exit This Window

· Choose Cancel. You return to the ELSIG frame.

See Also:
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List Name Conflict

xe "Change List Name"

xe "List Name Conflict"This window displays during the import process for ELSIGs if there are TTC lists that are named identically to lists already associated with the RUC. This window allows you to merge the list with an existing one, skip the matching list, or rename the imported list.

How Do I Get Here?

60. Begin on the Import ELSIG window. 

61. Choose OK. If an existing TTC list contains the same name as one you are importing, the List Name Conflict window opens.

To Resolve a Conflict

62. In the Action area, do one of the following:

· If you want to combine the imported list with an existing one, select Merge with existing list.

· If you want to ignore the matching list, select Skip this list (use existing list).

· If you want to change the name of the imported list, select Rename list to and in the box, type the new name for the list.

Note: If you select this option, the Apply this answer to all conflicts check box becomes unavailable.

63. If you want the action you chose to apply to all list name conflicts, select the Apply this answer to all list conflicts check box.

64. Choose OK. You return to the Import ELSIG window.

To Exit This Window

65. To cancel the change, choose Cancel. A message informs you that canceling will stop the import process.

66. Do one of the following:

· To cancel, choose Yes. You return to the Import ELSIG window.

· To continue, choose No. You return to the List Name Conflict window.

Master ELSIG Login

This window, although similar in appearance to the Login window, allows you to log in only with a Master ELSIG (M-ELSIG) and is the only window through which you can access the CO Info window. 

When requested, MISSO creates a M-ELSIG for the unit commander. This M-ELSIG is provided to the unit via diskette.  An accompanying assignment letter is also provided.  Using both diskette and letter, the Commanding Officer creates the CO-ELSIG. The M-ELSIG cannot be used for any other purpose.

How Do I Get Here?

67. From the UD/MIPS Navigator, choose the ELSIG module icon.

68. Insert M-ELSIG diskette.

69. From the Tools menu, choose Assign CO or click on the red lightning bolt icon. The Master ELSIG Login window opens.

To Log In With a Master ELSIG

70. In the Unit box, type your 5-character reporting unit code (RUC) number.

71. In the ELSIG box, type the 7-character Master ELSIG provided in the Assignment of Master Electronic Signaturexe "Master Electronic Signature" (ELSIG) letter.

72. In the Seed box, type the 3-character seed provided in the Assignment of Master Electronic Signaturexe "Master Electronic Signature" (ELSIG) letter.

73. Do one of the following:

· To continue the Master ELSIG login process, choose OK.  The CO Info window opens.

Note: If a CO already exists, you are prompted to delete the existing CO.

· To cancel the Master ELSIG loginxe "Master ELSIG Login" process and close the window, choose Cancel.

If a CO Currently Exists

· Do one of the following:

· To delete the current CO and assign a new CO, choose Yes.  The CO Info window opens.

· To retain the current CO, choose No.

To Exit This Window

· Choose Cancel. You return to the ELSIG module.

See Also:
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CO Info

xe "CO Info"This window allows you to enter the details for the Commanding Officer duties. Only the Master ELSIG has access to this window. 

How Do I Get Here?

· Do one of the following:

· Log in on the Master ELSIG Login window. The CO Info window opens, as applicable.

· From the Tools menu, choose Assign CO. The CO Info window opens, as applicable.

To Enter CO Information

1. In the SSN box, following the default zero (0), type the CO's 9-digit SSN without any dashes. 

Note: If the Commanding Officer is not a Marine overtype the zero and enter the appropriate service code, (Example: N for Navy.)

2. In the Last Name box, type in the CO's last name.

3. In the Initials box, type in the COs initial(s).

4. From the Title ID list, choose the applicable Title ID.

5. In the Grade Comp Title box, type in the CO's grade, service component, and/or title, separated by commas. (Example: LtCol, USMC, Commanding Officer) 

6. In the Seed box, type in a 3-character Seed. (Example: ATZ)

7. To continue the new assignment, choose OK. The ELSIG Issued window opens and displays the Unit ID, Name, ELSIG, and seed. 

Note: Once the assigned ELSIG and seed display, memorize them. Do not write them down.

8. Choose OK. You return to the Manage Electronic Signature window.

Note: You must enter data in all boxes before you can proceed. 

To Exit this Window

· Choose Close. You return the ELSIG frame. 

Note: If you close this window, no one will be assigned as CO.

See Also:
Commanding Officer ELSIG 

ELSIG Issued

xe "ELSIG Issued"This window displays the ELSIG and seed that has just been created when you assign an ELSIG or change your seed. 

How Do I Get Here?

74. Begin on the Change Seed, CO Info, or Master ELSIG Login window.

75. Choose OK.  The ELSIG Issued window opens.

OR

76. Begin on the Manage Electronic Signature window.

77. Do one of the following:

· Choose Reset. The ELSIG Issued window opens.

· Choose Unsuspend. The ELSIG Issued window opens.

OR

7. If you are changing the type of ELSIG, begin on the Modify ELSIG window.

8. Choose Apply. A window prompts you to confirm the change.

9. Choose Yes. The ELSIG Issued window opens.

The information displayed is as follows:

· Unit ID:
The 5-digit reporting unit code associated with the ELSIG.

· Name:
The member's last name and initials.

· ELSIG:
The ELSIG is a 7-character, alphanumeric, computed code.

· Seed:
The seed is a 3-character alpha code.

Note: You will not be able to retrieve this information after the window closes.  Be sure to memorize the ELSIG and seed now.

To Exit This Window

· Choose OK. You return to the ELSIG frame.

Assign TTC List

xe "Assign TTC List"This window allows you to modify, add, delete, rename, or modify a TTC list that can be applied to a specific ELSIG. The maximum number of TTC lists that can be associated with a RUC is 99.

How Do I Get Here?

If You Are a CO or ECO

78. Begin on the Manage Electronic Signature window.

79. Choose TTC List. The Assign TTC List window opens.

If You Are Authorized to Change

80. Begin on the ELSIG frame.

81. From the Tools menu, choose Manage TTC Lists.  The Assign TTC List window opens.

This window displays the following information:

· Associated TTC 

· Associated SEQ

· Description

To Modify a TTC List

82. In the TTC List, select a list name.

83. Choose Manage List. The Manage TTC/SEQ for List window opens.  After completing the procedures in the Add TTC List topic, you return to this window.

To Add a TTC List

· Choose Add List. The Add TTC List window opens.  After completing the procedures in the Add TTC List, you return to this window.

To Delete a TTC List

84. In the TTC List, select a list name.

85. Choose Delete List. The selection is deleted from the list.

To Rename a TTC List

86. In the TTC List, select a list name.

87. Choose Rename List. The Rename TTC List window opens.

88. Rename the TTC List and save it.

To Exit this Window

· Choose Close. You return to the Manage Electronic Signature window.

Manage TTC/SEQ For List

Depending on your ELSIG access, this window allows you to manually enter a TTC to the TTC list, to search for TTCs to add to a TTC List or to select/deselect all the TTCs found during a search. It also allows you to remove TTCs from the list.

How Do I Get Here?

If You Are a CO or ECO

89. From the UD/MIPS Navigator, choose the ELSIG module icon.

90. From the Tools menu, choose Manage ELSIG. The Manage Electronic Signature window opens.

91. Choose TTC List. The Assign TTC List window opens.

92. From the TTC List, select TTC Entry.

93. Choose Manage List. The Manage TTC/SEQ For Listxe "Manage TTC/SEQ For List" window opens.

If You Are Authorized to Change

94. From the UD/MIPS Navigator, choose the ELSIG module icon.

95. From the Tools menu, choose Manage TTC List. The Assign TTC List window opens.

96. From the TTC List, select a list.

97. Choose Manage List. The Manage TTC/SEQ For Listxe "Manage TTC/SEQ For List" window opens.

This window displays the following information:

· List Name

· TTC 

· SEQ

· Description

To Manually Add a TTC to the TTC List

98. In the TTC box, type the TTC.

99. If necessary, in the SEQ box, type the sequence code.

100. Choose the Down Arrow icon. The TTC/SEQs display in the box below.

101. Choose Apply. The TTC is added to the list.

To Search for TTC/SEQs

· Choose Search. The Search for TTC window opens.

To Select All the TTCs in the TTC SEQ Description box

· Choose Select All. 

To Deselect All the TTCs in the TTC SEQ Description Box

· Choose Deselect All. 

To Remove TTCs from the List

102. In the TTC SEQ Description box, select one or more TTCs.

103. Choose Remove. The TTC/SEQs are removed from the list

To Exit this Window

· Choose Close. You return to the Assign TTC List window.

Add TTC List

xe "Add TTC List"This window allows you to enter a name for a TTC list that can be applied to specific ELSIGs. The maximum number of TTC lists that can be associated with a RUC is 99.

How Do I Get Here?

· From the Assign TTC List window, choose Add List. The Add TTC List window opens.

To Name a TTC List

104. In the Add TTC List box, type the name, up to 30 characters.

Note: If you want the TTC list name to be the same as a corresponding section name, valid characters for naming a section are A-Z, 0-9, and space.

105. Choose OK. You return to the Assign TTC List process.

106. If you already have 99 lists, a message informs you only 99 lists are allowed. 

107. Choose OK. You return to the Assign TTC List process.

108. After a successful addition, you return to the Assign TTC List window, and the new list displays in the TTC List box.

To Exit this Window

· Choose Close. You return to the Assign TTC List window.

Rename TTC List

xe "Rename TTC List"Depending on your ELSIG access, this window allows you to rename an existing TTC list. 

How Do I Get Here?

If You Are a CO or ECO

109. From the UD/MIPS Navigator, choose the ELSIG module icon.

110. From the Tools menu, choose Manage ELSIG. The Manage Electronic Signature window opens.

111. Choose TTC List. The Assign TTC List window opens.

112. From the TTC List, select a TTC Entry.

113. Choose Rename List. The Rename TTC List window opens.

If You Are Authorized to Change

114. From the UD/MIPS Navigator, choose the ELSIG module icon.

115. From the Tools menu, choose Manage TTC Lists. The Assign TTC List Manage_Electronic_SignatureManage_Electronic_Signaturewindow opens.

116. From the TTC List, select a list.

117. Choose Rename List. The Rename TTC List window opens.

To Rename a TTC List

118. In the Rename TTC List box, type the name, up to 30 characters.

Note: If you want the TTC list name to be the same as a corresponding section name, valid characters for naming a section are A-Z, 0-9, and space.

119. Choose OK. You return to the Assign TTC List window.

To Exit this Window

· Choose Close. You return to the Assign TTC List window.

Search for TTC

xe "Search for TTC"This window allows you to search for TTC/SEQs that can be added to a TTC List. 

How Do I Get Here?

If You Are a CO or ECO

120. From the UD/MIPS Navigator, choose the ELSIG module icon.

121. From the Tools menu, choose Manage ELSIG. The Manage Electronic Signature window opens.

122. Choose TTC List. The Assign TTC List window opens.

123. From the TTC List, select a TTC entry.

124. Choose Manage List. The Manage TTC/SEQ For List window opensManage_TTC_SEQ_For_List.

125. Choose Search. The Search window opens.

If You Are Authorized to Change

126. From the UD/MIPS Navigator, choose the ELSIG module icon.

127. From the Tools menu, choose Manage TTC List. The Assign TTC List window opens.

128. From the TTC List, select a list.

129. Choose Manage List. The Manage TTC/SEQ For List window opens.

130. Choose Search. The Search window opens.

This window displays the following information:

· Current Diary

· Transaction Type

· Option

· TTC/SEQ

· Description

· English Statement

To Search by TTC Number

131. In the TTC box, type the TTC number.

132. Choose OK. Any matching TTCs display.

To Search by Keyword

133. In the Keyword box, type the keyword.

134. Choose OK. Any TTCs with matching keywords display.

To Select All the TTCs

135. Choose Select All. All TTCs are highlighted.

136. Choose OK. You return to the Assign TTC List window.

To Deselect All the TTCs

· Choose Deselect All. 

To Exit this Window

· Choose Cancel. You return to the Manage TTC/SEQ For List window.

ELSIG Report

This report lists the ELSIGS for users who are currently associated with a selected RUC. Only CO and ECO ELSIGs can access this report. If you logged in as a CONAD RUC, then this report reflects ELSIGs for the CONAD and all SUB RUCs for the CONAD.

How Do I Get Here?

137. From the UD/MIPS Navigator window, choose the ELSIG module icon.

138. Begin on the Manage Electronic Signature window.

139. From the Reports menu, choose ELSIG Report. The ELSIG Report window opens.

This report contains the following information:

Header Information

· Date

· Title (ELSIG Report)

· Page Number

· Unit ID

Report Information

· Unit ID

· Last Name

· Initials

· Social Security Number

· Type of ELSIG

· Grade

· Component Code

· Title

· Date Created

· Date Changed

· Suspended

· Last Accessed

To Print the ELSIG Reportxe "ELSIG Report"
· From the File menu, choose Print. The report prints.

To Exit This Window

· From the File menu, choose Close. You return to the previous window.

See Also:

About Electronic Signature System 

Manage Electronic Signature 

ELSIG Report with Privileges

xe "ELSIG Report with Privileges"This report lists the ELSIGS and privileges for users who are currently associated with a selected RUC. Only CO and ECO ELSIGs can access this report. If you logged in as a CONAD RUC, then this report reflects ELSIGs for the CONAD and all SUB RUCs for the CONAD.

How Do I Get Here?

1. From the UD/MIPS Navigator window, choose the ELSIG module icon. The ELSIG Frame opens.

2. From the Tools menu, choose Manage ELSIG. The Manage Electronic Signature window opens.

3. From the Reports menu, choose ELSIG Report with Privileges. The ELSIG Report with Privileges window opens.

This report displays the following information:

Header Information

· Date

· Title (ELSIG Report)

· Page Number

· Unit ID

Report Information

· Unit ID

· Last Name

· Initials

· Social Security Number

· Type of ELSIG

· Grade

· Component Code

· Title

· Date Created

· Date Changed

· Suspended

· Last Accessed

· Privilege Description

To Print the ELSIG Report

· From the File menu, choose Print. The report prints.

To Exit This Window

· From the File menu, choose Close. You return to the previous window.

See Also:

About Electronic Signature System 

Manage Electronic Signature 
ELSIG Default Privilege Management

xe "ELSIG Default Privilege Management"If you are a CO or an ECO, this window enables you to set or modify the default privileges for each type of ELSIG. Once these defaults are set, you can also modify the privileges for each individual ELSIG or an entire ELSIG class (Preparer, Certifier, etc).

How Do I Get Here?

1. From the UD/MIPS Navigator window, choose the ELSIG module icon.

2. From the Tools menu, choose ELSIG Default Privilege Management. The ELSIG Default Privilege Management window opens.

This window displays the following information:

· Privilege Description

· Privilege Class

These default privileges are optional for each type of ELSIG:

To Set Default Privileges

This option allows you to determine the privileges for each new ELSIG you assign. It does not affect existing ELSIGs.

1. From the ELSIG Type list, select the type.

2. Under Privilege Description, select the privileges you want to assign. Any privilege description or class that is grayed out cannot be selected.

Note: The Modify TTC List option is not available for the preparer ELSIG in the ELSIG Default Privilege Management window. You can only select it from the Modify ELSIG window.

3. Choose Apply to ELSIG Type. A message informs you that the changes will be applied to future ELSIGs of this type.

4. Do one of the following:

· To proceed, choose OK. You return to the ELSIG Default Privilege Management window.

· To cancel your selections, choose Close. You return to the ELSIG frame.

To Change All ELSIGs of a Type

This option allows you to determine the privileges for existing ELSIGs of a selected type.

1. From the ELSIG Type list, select the ELSIG type you want to change.

2. Under Privilege Description, select the privileges you want to assign. Any privilege description or class that is grayed out cannot be selected.

Note: The Modify TTC List option is not available for the preparer ELSIG in the ELSIG Default Privilege Management window. You can only select it from the Modify ELSIG window.

3. Choose Change All ELSIGS Of This Type. A message informs you that the changes will be applied to all current ELSIGs of this type.

4. Do one of the following:

· To proceed, choose OK. You return to the ELSIG Default Privilege Management window.

· To cancel the changes, choose Cancel. You return to the ELSIG Default Privilege Management window.

To Restore Software ELSIG Privilege Defaults from the Installation CD

1. From the ELSIG Type list, select the ELSIG type you want to change.

2. Choose Restore CD Defaults. A message confirms that your changes have been applied to the RUC. Choose OK. You return to the ELSIG Default Privilege Management window.

To Exit This Window

· Choose Close. You return to the ELSIG frame.

See Also:

Preparer 

Certifier 

Commanding Officer 

ELSIG Control Officer 

Reviewer 

ELSIG Current Privileges

xe "ELSIG Current Privileges"This window enables you to see which privileges your ELSIG has.

How Do I Get Here?

1. From the UD/MIPS Navigator window, choose any module icon except for ELSIG.

2. From the File menu, choose ELSIG Current Privileges. The ELSIG Current Privileges window opens.

This window displays the following information:

Header Information

· Yes/No

· Privilege Description

· Privilege Class

To Exit This Window

· Choose Close. You return to the previous window.

ELSIG Types

Admin Viewer ELSIG 

xe "Admin Viewer ELSIG"Admin Viewer ELSIGs may access and use all functions in the UD/MIPS, including importing and exporting ELSIGs, with the exception of:

· Unit diary preparation

· Functions associated with unit diary review and certification

· File Transfer functions

See Also:

Valid Electronic Signatures 

Certifier ELSIG

xe "Certifying Officer"

xe "Assigning:Certifying Officer"The Certifier ELSIG is responsible for ensuring the correctness of the information applied to the unit diary. The CO, ECO, and Certifier ELSIGS have Certifier-level authority. 

Standard Certifier ELSIGxe "Certifier ELSIG" Functions

· View other diaries

· Assign a diary status

ELSIG Privileges Not Available to a Certifier

· Edit or delete all transactions

Optional Certifier ELSIGxe "Certifier ELSIG" Privileges

· Modify a TTC list

· Create a diary

· Transaction Assignment

· Create a courier

· Archive or recover a diary

· Edit or delete notes

· Lock or unlock a diary

· Mass Deletion

· Remove Track Courier Log

· Turn On/Off Scheduled Events

· Remote Exec of Scheduled Events

Installation Software Default Certifier ELSIGxe "Certifier ELSIG"
· View other diaries

· Diary Status Assignments

· Create a diary

· Transaction Assignment

· Create a courier

· Archive or recover a diary

· Edit or delete notes

· Lock or unlock a diary

· Mass Deletion

· Remove Track Courier Log

· Turn On/Off Scheduled Events

· Remote Exec of Scheduled Events

See Also:

ELSIG Default Privilege Management 

Valid Electronic Signatures 

Commanding Officer ELSIG

xe "Commanding Officer ELSIG"The Commanding Officer (CO) assigns specific ELSIGs and privileges to users who perform corresponding specific duties. 

Note: The CO's ELSIG must create the first Electronic Control Officer (ECO) ELSIG for any Reporting Unit.

Standard CO ELSIG Functions

· View other diaries

· Assign a diary status

· Export and import capability

· May add, edit, and delete transactions to the Tickler file

· May certify or reject Accessions

· May print orders in Student Process

ELSIG Privileges Not Available to a CO

· Edit or delete all transactions

Optional CO ELSIG Privileges

· Modify a TTC list.

· Create a diary

· Transaction Assignment

· Create a courier

· Archive or recover a diary

· Edit or delete notes

· Lock or unlock a diary

· Mass deletion

· Remove Track Courier Log

· Turn On/Off Scheduled Events

· Remote Exec of Scheduled Events

Installation Software Default CO ELSIG

· View other diaries

· Diary Status Assignments

· Create a diary

· Transaction Assignment

· Create a courier

· Archive or recover a diary

· Edit or delete notes

· Lock or unlock a diary

· Mass Deletion

· Remove Track Courier Log

· Turn On/Off Scheduled Events

· Remote Exec of Scheduled Events

See Also:

ELSIG Default Privilege Management 

Valid Electronic Signatures 

CO Info 

ELSIG Control Officer

The ELSIG Control Officerxe "ELSIG Control Officer" (ECO) is designated by the Commanding Officer (CO) and has been given authority to assign specific ELSIGs and privileges to users who perform corresponding specific duties.

Standard ECO ELSIG Functions

· View other diaries

· Assign a diary status

· Export and import capability

· May add, edit, and delete transactions to the Tickler file

· May certify or reject Accessions

· May print orders in Student Process

ELSIG Privileges Not Available to an ECO

· Edit or delete all transactions

Optional ECO ELSIG Privileges

· Modify a TTC list.

· Create a diary

· Transaction Assignment

· Create a courier

· Archive or recover a diary

· Edit or delete notes

· Lock or unlock a diary

· Mass deletion

· Remove Track Courier Log

· Turn On/Off Scheduled Events

· Remote Exec of Scheduled Events

Installation Software Default ECO ELSIG

· View other diaries

· Diary Status Assignments

· Create a diary

· Transaction Assignment

· Create a courier

· Archive or recover a diary

· Edit or delete notes

· Lock or unlock a diary

· Mass Deletion

· Remove Track Courier Log

· Turn On/Off Scheduled Events

· Remote Exec of Scheduled Events

See Also:

ELSIG Default Privilege Management 

Valid Electronic Signatures 

Preparer ELSIG

The Preparer ELSIG is responsible for entering appropriate TTCs to adjust personnel and pay information in a member's records through the Unit Diary.

Standard Preparer ELSIGxe "Preparer ELSIG" Functions

· Export and import capability.

· May add transactions to tickler.

· May add, edit, and delete a tickler to a diary.

· May edit and prepare Accessions.

· May edit and prepare Student Process.

Optional Preparer ELSIGxe "Preparer ELSIG" Privileges

· Modify a TTC list

· View other diaries

· Assign a diary status

· Create a diary

· Assign a transaction

· Edit/delete all transactions

· Create a courier

· Archive or recover a diary

· Edit/Delete Notes

· Lock or unlock a diary

· Perform a mass deletion 

· Remove Track Courier Log

· Turn On/Off Scheduled Events

· Remote Exec of Scheduled Events

Installation Software Default Preparer ELSIGxe "Preparer ELSIG"
· View Other Diaries

· Diary Status Assignments

· Edit/Delete transactions

· Create a diary

· Transaction assignments

· Create a courier

· Archive or recover a diary

· Edit or delete notes

See Also:

ELSIG Default Privilege Management 

Valid Electronic Signatures 

Reviewer ELSIG

The Reviewer ELSIG is responsible for reviewing UD/MIPS entries for accuracy and completeness.

Standard Reviewer ELSIGxe "Reviewer ELSIG" Functions

· View other diaries

· Assign Diary Status

· Create Courier

· Archive or Recover a Diary

· Flag but not change diary transactions

· Export and import capability

· May view everything

· May add, edit, and delete transactions to tickler

· May review Accessions

ELSIG Privileges Not Available to a Reviewer

· Edit or delete all transactions

Optional Reviewer ELSIGxe "Reviewer ELSIG" Privileges

· Modify a TTC list

· Assign diary status

· Create a diary

· Assign a transaction

· Create a courier

· Archive or recover a diary

· Edit or delete notes

· Lock or unlock a diary

· Perform a mass deletion 

· Remove Track Courier Log

· Turn On/Off Scheduled Events

· Remote Exec of Scheduled Events

See Also:

ELSIG Default Privilege Management 

Valid Electronic Signatures 

Super Viewer ELSIG

xe "Super Viewer ELSIG"This ELSIG type is usually issued for inspection purposes to personnel visiting a unit. Super Viewer ELSIG session data is recorded on a disk. During login, the Super Viewer is prompted to select a drive and insert the ELSIG disk that is created when the Super Viewer ELSIG is assigned. Super Viewers have only a restricted view capability in UDMIPS. They do not have any functional capabilities.

Super Viewer ELSIGs do not have view access to the following fields in the MIPS module:

· Record of Emergency Data View on the MIPS, Report Selection View_Members window

· PRO/CON Average Enlistment (Service View)

· PRO/CON Average Grade (Service View)

· PRO/CON Average Service (Service View)

· Lump Sum Leave (Service View)

· First Normal Payday Amount (Pay/Dependent View)

· Home Telephone Number (Personal View, Basic Individual Record View)

· Street Address (Personal View, Basic Individual Record View)

· Service Spouse SSN (Basic Individual Record View).

Super Viewer ELSIGs can view but not edit Student Management.

See Also:

Valid Electronic Signatures 

Viewer ELSIG

xe "Viewer ELSIG"Viewer ELSIGS have limited capabilities and limited view access.

Viewer ELSIG's to UDMIPS do not have access to the following:

a) MIPS

· Record of Emergency Data View

· PRO/CON Average Enlistment (Service View)

· PRO/CON Average Grade (Service View)

· PRO/CON Average Service (Service View)

· Lump Sum Leave (Service View)

· First Normal Payday Amount (Pay/Dependent View)

· Home Telephone Number (Personal View, Basic Individual Record View)

· Street Address (Personal View, Basic Individual Record View)

· Service Spouse SSN (Basic Individual Record View)

b) Tickler

· Cannot add TTCs to a diary from the Tickler

c) Intelligent Forms

· Cannot add TTCs to a diary from intelligent forms

d) Student Management

· Can view but not edit Student Management

e) Unit Diary

· File Transfer functions

Informational messages are displayed as a reminder of this restricted status when attempting to log in.

Common Utilities

About Common Utilities

xe "About Common Utilities"This application is a collection of utilities that lets key users perform system maintenance on the Commanders Unit Diary Database (CUDDB).

Accessing Common Utilities

From the UD/MIPS - Navigator window, click on the Common Utilities icon.

Exiting Common Utilities

Click on File >>> Exit or Click on the X in the upper right hand corner of the Common Utilities window.

Click main menu's File, Exit or click an application icon on toolbar to switch to another application.  Logout if no further UD/MIPS activity will be performed.

Should an application operation incur a malfunction or exhibit erratic behavior, print the window (Ctrl+P) where the malfunction occurs and refer to the window when communicating with the local MISSO.

See Also:

Reconciliation 

Deleting a RUC 

Export 

Extract 

Import 

Mass Deletion 

Search 

Unit Definition 

Update Unit Address Record 

User Field Labels 

View Deleted Members 

TRECON 

Configuring the Remote ODBC Entry 

File Transfer 

Upload/Download Database 

Export

This window allows you to exportxe "Export" from the CUDDB, Intelligent Forms, or Student Management data by selection of unit specific information, one or more selected members, one or more selected forms, receiving barracks information from the Student Management module.

How Do I Get Here?

1. From the UD/MIPS – Navigator  window, choose the Common Utilities icon. The Common Utilities window opens.

2. From the Tools menu, choose Export. The Export window opens.

—OR—

3. From the UD/MIPS – Navigator  window, choose the Student Management icon. The Student Management window opens.

4. From the File menu, choose Export. The Export window opens.

To Exportxe "Export" CUDDB Information

1. In the Exportxe "Export" Type group, select CUDDB.

2. In the Exportxe "Export" CUDDB group:

· If you want to exportxe "Export" the CUDDB, select the CUDDB check box.

· If you want to exportxe "Export" the user fields with labels, select the User Fields with Labels check box.

· If you want to exportxe "Export" the user fields without labels, select the User Fields without Labels check box.

3. In the Export group, do one of the following:

· If you want to exportxe "Export" all personnel, choose All Personnel.

· If you want to exportxe "Export" by company, choose Company.

· If you want to exportxe "Export" by company and platoon, choose Company/Platoon.

Prompts will be available based on your selection.

4. In the Select group:

· If available, in the RUC list, choose the RUC you want to exportxe "Export".

· If available, in the Company list, choose the company you want to exportxe "Export".

· If available, in the Platoon list, choose the platoon you want to exportxe "Export".

5. Choose OK. You return to the previous window.

To Exportxe "Export" Intelligent Forms

140. In the Exportxe "Export" Type group, select Forms.

141. In the Export group do one of the following:

· If you want to exportxe "Export" forms for all personnel, choose All Personnel.

· If you want to exportxe "Export" forms for one or more members, choose Individual(s).

3. In the Export group, do one of the following:

· If you want to exportxe "Export" all forms, choose All Forms.

Note: If you chose the Individual(s) exportxe "Export" option, All Forms is your only available option in this group.

· If available, if you want to exportxe "Export" specific forms, choose Form(s).

4. In the Select group:

· If available, in the RUC list, choose the RUC you want to exportxe "Export".

· If available, in the form list, choose one or more form numbers you want to exportxe "Export".

· If available, in the SSN list, choose one or more SSNs you want to exportxe "Export".

5. Choose OK. You return to the previous window.

To Exportxe "Export" Receiving Barracks Information

1. In the Exportxe "Export" Type group, select Receiving Barracks.

2. In the Export group, do one of the following:

· If you want to exportxe "Export" all personnel, choose All Personnel.

· If you want to exportxe "Export" by company, choose Company.

· If you want to exportxe "Export" by company and platoon, choose Company/Platoon.

Prompts will be available based on your selection.

3. In the Select group:

· If available, in the RUC list, choose the RUC you want to exportxe "Export".

· If available, in the Company list, choose the company you want to exportxe "Export".

· If available, in the Platoon list, choose the platoon you want to exportxe "Export".

4. Choose OK. You return to the previous window.

To Exit This Window

· Choose Close. You return to the previous window.

Extract

This file operation creates a text file in one of three formats: JPAVS, MDSSII, or MCAIMS.

Click Tools >>> Extractxe "Extract".  The Create Extract Window opens.

Select a file format:

JPAVS 
Joint Personnel Asset Visibility

MDSSII 
MAGTFII Deployment Support System II

MCAIMS 
Marine Corps Automated Instruction Manual System

Click OK.  This opens a Save window.  Users will specify a file name, file type, directory, and drive.

Click Save.  When the export process is finished the Extractxe "Extract" Complete window opens >>> click OK.

Import

This window allows you to importxe "Import" to the UD/MIPS database the types of files listed on the Import/Export Files List.

You cannot use this window to importxe "Import" the CUDDB, MCRISS, or TFS Master TRECON files. Load those files using the Reconciliation process.

How Do I Get Here?

142. From the UD/MIPS - Navigator, choose the Common Utilities module icon.  The Common Utilities frame opens.

143. From the Tools menu, choose Import. The Import window opens.

—OR—

1. From the UD/MIPS – Navigator  window, choose the Student Management icon. The Student Management window opens.

2. From the File menu, choose Import. The Import window opens.

To Importxe "Import" a File

144. Do one of the following:

· In the Importxe "Import" File Name box, type the drive, directory path and file name of the file to be imported.

· Choose Browse. The Select Importxe "Import" File Select_Import_Filewindow opens. The default file location is <drive:>\UDMIPS\export.

2. Choose OK. You return to the Common Utilities frame.

Note: If the file is for the wrong RUC, has previously been imported, or is dated too far in the past, the import will not be successful.

To Exit this Window.

· Choose Cancel. You return to the Common Utilities frame.

Select Import File

This window allows you to search for one or more files to import from other disk locations by typing the file name and file type. It is available in several different UD/MIPS modules.

How Do I Get Here?

From the Common Utilities Module

· Do one of the following:

· From the Import window, choose Browse. The Select Import File window opens.

· From the Import Section window, choose Browse. The Select Import Filexe "Select Import File" window opens.

From the ELSIG Module

· From the Tools menu, choose Import ELSIG. The Select Import File window opens.

From the Unit Diary Module

· Do one of the following:

· From the Import Scheme window, choose Browse. The Select Import File window opens.

· From the Tools menu, choose Transaction Import. The Select Import File window opens.

· From the Transaction Import window, choose Browse. The Select Import File window opens.

From the Tickler File Module

· From the Import Tickler File window, choose Browse. The Select Import File window opens.

From the DFR Module

· From the Import DFR Notes window, choose Browse. The Select Import File window opens.

To Select A File To Import

1. Do one of the following:

· In the Select Import File list, select the file to import.

· In the File Name block, type the file name.

2. Choose Open. You return to the previous window or a message indicates if the import was successful.

To Exit This Window

· Choose Cancel. You return to the previous window.

Import/Export Files List

xe "Import/Export Files"The following types of files can be imported and exported from UD/MIPS:

· .azc
Accessions Courier Zip File

· .mzc
Courier Zip File

· .txt

DBUM User List

· .dfr

DFR Notes 

· .zip

ELSIGs

· .imr

Impromptu IMR Files

· .if

Intelligent Forms

· .txt

Marine Corps Recruiting Information Support System files (Import only)

· .sec
Sections

· .zip

User Field Labels

· .zip

User Fields

Mass Deletion

xe "Mass Deletion"This window allows you to delete the TFS Master File or the members from the user's RUC in mass quantities.  

CAUTION: 
For the following two types of mass deletions, care should be exercised when using these functions.  You will not be able to undelete.  Performing a Mass Deletion on the LAN will effect all users on the server.  Make sure the data being deleted is not needed by other users on the LAN.

How Do I Get Here?

145. Begin on the Common Utilities window.

146. From the Tools menu, choose Mass Deletion.  Depending on which level you are deleting from, the Mass Deletion window or the Delete Members window opens.  

To Delete At RUC Level

147. Choose one of the following options:

· To delete all members, choose TFS Master File.

· To delete members of a RUC, choose Members of RUC XXXXX.

2. Choose OK. The Delete Confirmation window opens prompting you to confirm the deletion.  Do one of the following:  

· If you want to confirm your deletion, choose Yes.  Depending on the option you chose,  the TFS Master File or all members of the selected unit type are deleted.  

· If you do not want to confirm your deletion, choose No.  The transaction is canceled.

148. Choose Cancel.  You return to the Common Utilities window.

To Delete At Higher Headquarters Level

149. Choose one of the following options:

· If you want to select all members of the RUC that you are assigned, choose All Members.

· In the RUC list, select the desired RUC.

· In the MCC list, select the desired MCC.

· In the MAGTF list, select the desired MAGTF.

· In the Detachment list, select the desired Detachment.

· If you want to delete the TFS Master File, choose TFS Master.

2. Choose OK.  The Delete Confirmation window opens prompting you to confirm the deletion.  Do one of the following:

· If you want to confirm your deletion, choose Yes.  Depending on the option you chose, the TFS Master or all members of the selected unit type are deleted. 

· If you want to confirm your deletion, choose No.  The transaction is canceled.

To Exit This Window

· From the File menu, choose Exit.  The window closes and you exit the application.

Deleting a RUC

Authorized ELSIGs, Commanding Officer, ELSIG Control Officer and the Certifier can clear all RUC (Reporting Unit Code) Unit Address(es).  The Delete RUC option through Common Utilities differs from the Mass Deletion option in Common Utilities.  The Delete RUC option clears the database of Unit and Personnel information without affecting the tables.  The Mass Deletion option actually deletes the information in the tables.

Deleting a RUCxe "Deleting a RUC"
The following steps show how to delete a RUC through Common Utilities.


1.
Select Tools from the Common Utilities window.


2.
Select the Delete RUC option.


3.
A window appears showing the various RUCs.


4.


You can delete one RUC, several RUCs or all RUCs.



If you want to delete…
Then…



One RUC
Select the RUC.

Select OK.

Select Yes



Several RUCs
Select the RUCs you want to delete by using the mouse.

Select OK.

Select Yes



All RUCs
Select the Select All button

The RUCs highlight.

Select OK

Deselecting a RUC
If you want to deselect a selected RUC
Then select the Deselect button.

Unit Definition

This menu item is enabled when the reporting unit has been identified as HHQ Active, HHQ Reserve, or HQMC.  See Common Utilities, Update Unit Address Record.  When used this option allows higher echelon command users define the unit types -- MCCs, RUCs, MAGTFs and detachments -- that make up a higher headquarters command reporting unit code.  The steps involved in creating a higher headquarters database may include the following.
Summarization of Unit Definitionxe "Unit Definition" process

Update Unit Address Record using one of the unit types provided: HHQ Active, HHQ Reserve, or HQMC.  Note that the term Higher Headquarters does not apply to HQMC.  Refer to the current edition of the MCTFSPRIM.

Define the subordinate units of the higher headquarters using this menu item.  The higher headquarters has the Command Reporting Unit Code (CRUC).  It is the senior command, with permanent change of orders writing authority.  Its Monitored Command Code (MCC) should be included as the Command Monitored Command Code in the definition to facilitate accurate Inbound Rosters.  Subordinate RUCs may vary in command: division, wing, brigade, MAGTF, group, detachment, regiment, etc.

Request TRECON from MISSO.

Reconcile per Common Utilities, Reconcile.

Click Tools >>> Unit Definitionxe "Unit Definition".  The Unit Definitionxe "Unit Definition" window opens.  These commands are available:

Close:
Terminates session.

Add Unit:
The Add Unit Window will open.  Choose one of the following unit types:


RUC
Add Reporting Unit Code, Click OK.


MCC
Add MCC, Click OK.


MAGTF
Add a MAGTF identification code, Click OK.


Detachment
Add a descriptive detachment title, no more than 30 characters.



Click OK. Add new Members window opens asking if the user wants to add members to the detachment.  Click Yes.



Detachment Name window opens.



Click Add. Enter SSN window opens.



Enter SSN.  Do not over type the zero for Marine members.  For non-Marine members, backspace to erase the zero, type a service code, then type the SSN.



If the SSN is database resident, the additional information (last name, first name, rank, and middle initial) will be captured and presented on window.



If the SSN is not database resident, supply the remaining information (last name, first name, rank, and middle initial).

Delete Unit:
Click the Delete Unit button to remove selected unit(s) from definition.  The Delete Confirmation window appears.  Click Yes or No.

Modify:
For detachments only.  Users can add or delete members to or from detachments.  Click the Modify command button.  The Detachment Window opens.  The following commands are available:


Close
Terminates session


Add
See Enter SSN guidelines.


Delete
Select a member.  Click the Delete command button.  The Delete Confirmation Window opens.  Click OK or Cancel.

Update Unit Address Record

The Unit Address is updated during every reconciliation with information from the TRECON file.  You can manually update Unit Address Records through Common Utilities.

Updating
The following steps show you how to update the Unit Address.

1.
Select Tools from the Common Utilities window.

2.
Select the Update Unit Address Recordxe "Update Unit Address Record" option.

3.
The Update Unit Address Record window appears displaying the RUC Unit Address.

4.
If applicable, change the Unit Address information on the respective line.


If you want to change…
Then type the…


Unit Name
Unit Name (Maximum 32 characters, Example: 1st Battalion, 4th Marines)


Address Line 1
Address Line 1 (Maximum 32 characters, Example: 1st Marine Division)


Address Line 2
Address Line 2 (Maximum 32 characters, Example: Camp Pendleton, California)


Zip Code
Zip Code (Unit Zip Code, Example: 92055-5432)

5.
Select the Juris Code from the drop down list. (See Juris Code Selections following this table.)

6.
Select the Unit Record Type from the drop down list. (See Unit Record Types following this table.)

7.
Select OK.

Updating
8.
You have the option to either save the changes or cancel the entry.



If you want to…
Then select…



Save the changes 
OK from the Unit Diary window that prompts "Unit Address has been updated.  Report the appropriate Unit Diary EVENT in accordance with the MCTFSPRIM to update the Unit Address information."
Your Unit's Address appears on the signature page of printed diaries.  Your selected Jurisdiction Code is printed at the top of each page.



Cancel the entry
Reset

The original information displays in the Update Unit Address window.

Note:  If the EVENT transaction is not processed, the manual changes are overwritten and lost during the         next reconciliation.

Juris Code Selections

(Must be populated)
The list below shows the options available for the Juris Codes:

MISSO-02 MCB CAMP LEJEUNE NC 28542

MISSO-03 MCB CAMP PENDLETON CA 92055

MISSO-06 MCBH BOX 63062 KANEOHE BAY HI 96863

MISSO-09 3280 RUSSELL RD QUANTICO, VA 22134

MISSO-11 HQMC (MI) FPO AP 96608

MISSO-16 KANSAS CITY MO 64197 **(ACTIVE)** 

MISSO-17 KANSAS CITY MO 64197 **(RESERVE)** 

MISSO-27 MCB CAMP BUTLER FPO AP 96373

Unit Record Types


The list below shows the options available for the Unit Record Types:

Active RUC

Reserve RUC 

HHQ Active

HHQ Reserve

HQMC

User Field Labels

Click Tools >>> User Field Labelsxe "User Field Labels". When the User Field Maintenance window opens.  A maximum number of twenty user-defined labels can be defined.  These labels will identify data fields not found in the CUDDB and are deemed essential to unit efficiency and/or operations.  (Example:  Boot Size, weapon serial #'s, etc.)  Care should be exercised when performing actions that write to data locations, see Tools, Import.

Type, or over type, no more than 20 alphanumeric characters in each user field.

Mouse click, tab, or shift-tab to navigate within the twenty, user-field range.

Click OK.

View Deleted Members

xe "View Deleted Members"When a unit reports a Transfer or a Drop transaction on the Unit Diary, the member's record affected by the transaction is automatically deleted during the make courier process.  That record will remain in the database flagged as deleted.  That record will remain in this status until after each update and extract (U&E).  

Note: The record will revert to its former status if any diary transaction activity occurs prior to the actual database drop.  (Users should anticipate two cycles.)  The records of members deleted under Tools, Locate Members will be in this file also.

How Do I Get Here?

150. From the UDMIPS - Navigator, choose the Common Utilities icon.

151. From the Tools menu, choose Deleted Members.  The Deleted Members window opens.

152. When the Deleted Members window opens, all deleted records are displayed for the selected RUC.  If deleted records exceed window size, use the window scroll bar to reveal hidden records.  The SSN or the Deleted On column may sort these records. 

The following options perform action on one or more records.

RUC.  Lists the deleted members assigned to the selected subordinate or CONAD RUC.

Delete.  The Search window opens. Select one or more records to be removed from the CUDDB. Choose OK.

Undelete.  Restores a selected record to the CUDDB.

Restore. The Confirm Mass Undelete window opens.  Confirm UN-deletion of all members displayed by clicking OK.

Close.  Terminates operation.

File Transfer

A unit may obtain a TRECON by two means.  The first way a unit may obtain their TRECON is from the MISSO itself.  Once the unit receives the TRECON diskette, they can perform their reconciliation of the CUDDB.

The second way in which a unit may obtain their TRECON is by File Transferxe "File Transfer".  This is a procedure that does require some type of Emulation File Transferxe "File Transfer" (3270) software, such as Attachment/EXTRA, CXI, TC Link or Banyan Vines.  The concept of File Transferxe "File Transfer" is the same with all software packages. Procedures, however, may vary slightly depending on the type of file transferxe "File Transfer" software being used.  The user manual that comes with the software will detail guidelines on how to install the file transferxe "File Transfer" programs on a particular computer.

The concept of file transferxe "File Transfer" involves taking a file resident on the computer and uploading it to or downloading it from a host mainframe through a dataset.  A user may file transferxe "File Transfer" a variety of different files, but as it relates to the UD/MIPS, the type of file being referred to will either be a courier file (Unit Diary) or a TRECON.

In order to get the most use out of a file transferxe "File Transfer", the user should have a mainframe connection resident on the same computer that the UD/MIPS is installed on.  This is not a requirement, but within the UD/MIPS there are options that were designed to provide a benefit to the user who elects to file transferxe "File Transfer" both courier files and TRECONs from their hard drive where UD/MIPS is installed while having a mainframe connection.

Ensure when downloading that the Carriage Return Line Feed and ASCII format options are turned off.  If these options are on the download will not be compatible with the UD/MIPS reconcile process.

If UD/MIPS is installed on a computer that does not have a mainframe connection and you desire to utilize file transferxe "File Transfer" to upload/download files, write those files to a diskette, then take that diskette to the computer that has the file transferxe "File Transfer" software installed to perform the transfer.

When the TRECON is downloaded to diskette, it is not in backup format and must be copied to the hard drive of the personal computer that contains UD/MIPS, thus requiring the reconciliation process to be performed from the hard drive.

In addition to having the file transferxe "File Transfer" software resident on a computer, other requirements are necessary for a successful file transferxe "File Transfer".

Access to Timesharing Option (TSO).  A mainframe application that acts as an interactive host that lets users access their mainframe dataset for uploads/downloads.  Access to TSO is granted by the local RASC security department, and is based on the individual User ID.

Access to a mainframe dataset for uploading and downloading.  The local RASC will create one dataset to upload and one to download.  Local security grants access to those datasets based on the individual's User ID.  With regard for access to TSO and to the mainframe datasets, contact the local MISSO, as they may have set procedures in coordinating the required access with Security.

See also:

Upload/Download Database 

Upload/Download Database

xe "Upload/Download Database"This functionality copies the Unit Definition and User Fields information from the source drive to the destination drive. The menu option label is determined by where the user is currently logged in.

If the user is connected to the server database, selecting Upload Database from the Tools menu will copy the CUDDB data from the PC to the server.

Note: If you installed UD/MIPS without a local database, this option is not available.
If the user is connected to the local database, selecting Download Database from the Tools menu will copy the CUDDB data to the user's PC.

For either option, the user must provide the login information for the destination database.

Click OK.

Calendar

This window allows you to enter a date in a date input box other than by typing the date. The Calendar is available in several different windows and modules.

How Do I Get Here?

1. Begin on any window with a date input box.

2. Choose the Calendar Icon. The Calendarxe "Calendar" window opens.

To Select A Date

1. In the month list, choose a month. In the upper left corner of the calendarxe "Calendar" the month displays. 

2. In the year list, choose a year. The year displays to the right of the month you chose.

3. From the day graphic, choose day. The selected calendarxe "Calendar" day darkens.

4. Choose OK. The date you chose displays in the applicable date box in YYYY/MM/DD format.

To Exit This Window

· Choose Cancel.

Local Datalink Account

This window will allow you to establish a local datalink accountxe "Local Datalink Account".

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the Common Utilities icon. The Common Utilities window opens. 

2. From the Tools menu, click Datalink Account.  (This option is not available to ELSIGs without Preparer or Certifier authority or while working from a Remote Database.)

3. In the Datalink Account window, type a password in the Password box.

4. Choose OK.

Section Maintenance

xe "Section Maintenance"This window allows you to add and delete sections used in various UD/MIPS modules.

If you import section names into a file where those names already exist, a message informs you that the name is already in your current section list and asks you to type a new name for the incoming section.

How Do I Get Here?

1. From the UD/MIPS Navigator, choose the Common Utilities or Diary Feedback Report module icons. The Common Utilities or Diary Feedback Report module opens.

2. From the Tools menu, choose Section Maintenance. The Section Maintenance window opens.

To Create a New Section
· Choose New Section. The Add New Section window opens.

To Assign TTCs to a Section
· Choose DFR TTC Assignment. The Section TTC Assignment window opens.

To Delete Section Names

1. In the Section list, select one or more sections you want to delete.

2. Choose Delete Section. A message prompts you to confirm the delete process and informs you that, if you continue, any transactions assigned to those sections will be unassigned. 

3. Do one of the following:

· To continue the delete process, choose Yes. The selected sections are deleted and you return to the Section Maintenance window.

· To cancel the delete process, choose No. You return to the Section Maintenance window.
To Export Section Names

1. Select Export. The Export Sections window opens.

2. After completing the steps in the Export Sections topic, you return to the Section Maintenance window.

To Import Section Names When The Section List Is Empty

41. Choose Import Sections. The Import Section window opens.

42. After completing the steps in the Import Section topic, the imported sections are added to the list and you return to the Section Maintenance window.

To Import Section Names when The Section List Is Not Empty

1. Choose Import Sections. The Import Section window opens.

2. After completing the steps in the Import Section topic, the imported sections are added to the list and you return to the Section Maintenance window.

To Exit

· Choose Close. You return to the Common Utilities frame.

Export Sections

xe "Export Sections"This window allows you to export your section names file to a floppy disk or a hard drive. Sections for filtering information in various UD/MIPS modules.

How Do I Get Here?

1. Begin on the Section Maintenance window.

2. Choose Export Sections. The Export Sections window opens.

To Export Section Names

1. Do one of the following:

· In the Export Sections list, select the file to export.

· In the File Name block, type the file name. 

2. Choose Save. A message informs you that the file has been exported.

3. Choose OK. You return to the Section Maintenance window.

Import Section

xe "Import Section"This window allows you to import your section names file from a floppy disk or a hard drive.

How Do I Get Here?

1. Begin on the Section Maintenance window.

2. Choose Import Sections. The Import Section window opens.

To Import a Section Name

1. Do one of the following:

· In the Import File Name block, type the file name. 

· Choose Browse. The Select Import File window opens.

2. When you have selected the desired file, choose Open. The import of section names begins.

3. If a name being imported matches a name already in the section list, the New Section Name window opens.

4. Complete the steps in the New Section Name box.


5. Choose OK. A message informs you that the file has been imported.

6. Choose OK. You return to the Section Maintenance window.

Add New Section

xe "Add New Section"This window allows you to name a new section for filtering information in various UD/MIPS modules.

How Do I Get Here?

1. From the UD/MIPS Navigator, choose the Common Utilities or Diary Feedback Report module icons 

2. From the Tools menu, choose Section Maintenance. The Section Maintenance window opens.

3. Choose New Section. The Add New Section window opens.

To Add A New Section

1. In the Section box, type the new section name, up to 30 characters.

Note: Valid characters are A-Z, 0-9, and space.

2. Choose OK. You return to the Section Maintenance window.

To Exit This Window

· Choose Cancel. You return to the Section Maintenance window.

New Section Name

This window appears during the import of Section Names and allows you to rename sections that are being imported and match section names already in the listing in Section Maintenance. Sections for filtering information in various UD/MIPS modules.

How Do I Get Here?

1. From the UD/MIPS Navigator, choose the Common Utilities or Diary Feedback Report module icons 

2. From the Tools menu, choose Section Maintenance. The Section Maintenance window opens.

3. Choose Import Section. The Import Section window opens.

4. Do one of the following:

· If you know the drive name and the file name, in the Import File Name box, type the drive name and the file name.

· If you don't know the file name, choose Browse. The Select Import File window opens.

5. When you have selected the desired file, choose Open. The import of section names begins.

6. If a name being imported matches a name already in the Section list, The New Section Name window opens.

To Change A Section Name

1. In the New Section Name box, overtype the highlighted section name with a new section namexe "New Section Name", up to 30 characters.

Note: Valid characters are A-Z, 0-9, and space.

2. Choose OK. A message informs you the import was successful.

3. Choose OK. You return to the Section Maintenance window.

Automated File Transfer Service

Automated File Transfer and Reconciliation Process

xe "Automated File Transfer and Reconciliation Process"Secure file transfer protocol (FTP) and MQ Series allows UD/MIPS to schedule the automatic transmission of courier files, the receipt of TRECON and Tables TRECON files, the reconciliation of TRECON and Tables TRECON files, the receipt and load of Diary Feedback Report files and the receipt of tracer information.  These data transmissions execute through the UD/MIPS Server, Collection Serverxe "Collection Server" (Kansas City), and the Mainframe (St. Louis) according to scheduled events that are set by the individual unit.  You would normally schedule the auto transfer events after work hours to minimize downtime during the workday.

Note: Tables TRECON must be reconciled manually if there is any TTC impact and an open diary status.
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UD/MIPS Server

This server is accessed by local workstations and has a limited version of the UD/MIPS Client loaded on it.  The only available Modules are Common Utilities and ELSIG.  

The UD/MIPS Server performs the following functions:

· Transmits courier files to the Collection Serverxe "Collection Server"
· Receives TRECON and Tables TRECON files from the Collection Serverxe "Collection Server"
· Reconciles TRECON and Tables TRECON files

· Receives and stores tracer file information on sent/received files

· Receives Diary Feedback Report files from the Collection Serverxe "Collection Server"
· Loads Diary Feedback Report files

· Receives MCRISS data sets from the Collection Serverxe "Collection Server"
· Initiates all of the sessions with the Collection Serverxe "Collection Server".

Note: When the Use Transfer Service is turned on from the Preferences window, File Transfer Service tab, these events execute as scheduled on the Preferences window, Scheduled Events tab.

Note: UD/MIPS must be running for the process to work. If the server is shut down or UD/MIPS is not running, nothing can be sent or received.

Collection Serverxe "Collection Server"
This server is a centralized collection point for use by the UD/MIPS Server and Mainframe in securely transferring data. This server allows a more dynamic way of transferring data from the mainframe.  In addition, it provides more security by limiting users who can access the mainframe every time they need to run a process. The Collection Serverxe "Collection Server" does this for them.  It minimizes the use of the mainframe for sending and receiving data to and from UD/MIPS Servers.  Both the UD/MIPS Server and Mainframe initiate the login process to the Collection Serverxe "Collection Server". The UD/MIPS server uses Port 443 (SSL) to initiate the session. To avoid timing out issues, Port 443 must be open. 

The Collection Serverxe "Collection Server" performs the following functions:

· Receives Courier receipts from the Mainframe

· Receives Full and Touched TRECON and Tables TRECON files from the Mainframe

· Receives Diary Feedback Report files from the Mainframe

· Receives MCRISS Data Sets from the Mainframe

· Transmits courier files to the Mainframe upon request for processing via MQ Series

· Allows the UD/MIPS Server to establish a session so courier files can be sent FTP to the Collection Serverxe "Collection Server" using Port 443

· Transmits tracer information to the UD/MIPS Server

Mainframe

This node performs its data transmissions per Marine Corps Total Force Systems (MCTFS) guidelines. Files are sent through MQ Series via the Collection Serverxe "Collection Server". Units that use the standalone version of UD/MIPS continue uploading diaries to the Mainframe via Host on Demand. 

Note: Units using the Automated File Transfer and Reconciliation Process can still upload diaries via Host on Demand as a backup.

Courier Transmissions

1. Couriers are made at the Workstations.  

2. Couriers are saved to the UD/MIPS Server.

Note: These files are not sent to the Collection Serverxe "Collection Server".

3. Couriers are automatically sent to the Collection Serverxe "Collection Server" via FTP at the scheduled time and the tracer information is sent to the Server Event Log. 

Note: The two file types sent to the Collection Serverxe "Collection Server" during the FTP process are the Courier file (.dcf) and the Marker file (.dmf). The .dcf file contains the data while the .dmf file tells the Collection Serverxe "Collection Server" that the entire file was sent.

4. The Collection Serverxe "Collection Server" transmits the couriers to the Mainframe via MQSeries. Once the Mainframe receives couriers, a Receipt file (.rcp) is sent back to the UD/MIPS Server. The Receipt file provides the date/time on which the Mainframe received the courier. 

Note: If the UD/MIPS Server has received an .rcp file, the courier processes in the next cycle.

TRECON Transmissions

1. The Mainframe creates Full/Touched TRECONs after each cycle.

2. The Mainframe sends TRECONs to the Collection Serverxe "Collection Server" via MQSeries.

3. The UD/MIPS Server automatically downloads the TRECONs from the Collection Serverxe "Collection Server" via FTP at the scheduled time. 

4. The UD/MIPS Server automatically runs a reconciliation at the scheduled time and sends the tracer information to the Server Event Log and the TRECON Reconciliation Log. Trecons run one after the other until all are completed. To see when a Trecon has completed, check your Trecon file extension. When it has changed from .MFT to .OLD, it is complete.

5. If you receive a DynaZip Error, none of the other TRECONs or Reconciliations will run until the file that produced the error has been deleted. See the Troubleshooting topic about DynaZip errors.

Tables TRECON Transmissions 

1. The Mainframe creates Tables TRECON files weekly at a minimum.

2. The Mainframe sends Tables TRECON files to the Collection Serverxe "Collection Server" via MQSeries.

3. The UD/MIPS Server automatically downloads the Tables TRECON files from the Collection Serverxe "Collection Server" via FTP at the scheduled time. 

4. The UD/MIPS Server automatically runs a reconciliation at the scheduled time and sends the tracer information to the Server Event Log and the TRECON Reconciliation Log. Trecons run one after the other until all are completed. To see when a Trecon has completed, check your Trecon file extension. When it has changed from .MFT to .OLD, it is complete.

Note: The Tables TRECON reconcile will fail and must be manually reconciled if there is any TTC impact and an open diary status. See the Reconciliation topic.

Preferences

xe "File Directories Preferences"xe "Database Preferences"

xe "File Transfer Service Preferences"

xe "Scheduled Events Preferences"This window allows you to work from a local or remote workstation, choose default directories to perform certain options, request access to transfer files, check status of transfer files requests, and schedule events for automatic and immediate processing. This topic is written for the client. Any Server impact is indicated in parentheses after the section name. 

When you install UD/MIPS, it overlays all approval data and resets them to their default states. 

How Do I Get Here?

1. Begin on the UD/MIPS - Navigator window. Choose the Unit Diary icon. The Unit Diary Management window opens.

2. From the File menu, choose Preferences. The Preferences window opens.

Tab Summary

· Do any of the following:

· To set whether you want to work on the server or your local drive, choose the Database tab. 

· To set where to retrieve your data from, choose the File Directories tab (Client and Server).

· To request file transfer servicexe "Preferences:File Transfer Service" authority, check on file transfer status or set your file transfer options, choose the File Transfer Service tab (Server only). 

· To schedule events to process automatically during a range of time, and to activate events to process immediately, choose the Scheduled Events tab (Server only). 

Database

To Use the Local Database
1. If you want to work on UD/MIPS without being connected to a server, choose Local PC.

Note: If you installed UD/MIPS without a local databasexe "Preferences:Database", this option is not available.

2. If you want to clear all records in the databasexe "Preferences:Database" or the databasexe "Preferences:Database" structure, choose Reset DB.

3. Complete the steps in the To Apply Preferencesxe "Preferences" section later in this topic.

To Use the Server Databasexe "Preferences:Database" (Client and Server)

1. If you want to work on UD/MIPS connected to a server, choose Server Name.  Type the name of the server you want to work on.

2. Choose OK. The Oracle Login window opens.

File Directories (Client and Server)

To Specify Default File Directoriesxe "Preferences:File Directories"
When the databasexe "Preferences:Database" is reset during the UD/MIPS install process, this data returns to its default value.  

1. Do one of the following:

· If you want to change the default file directory for couriers on the Server only, in the Courier File box, type the full path or choose the ellipsis icon (…) to browse for the path.

· If you want to change the default file directory for TRECONs on the Server only, in the TRECON Files box, type the full path or choose the ellipsis icon (…) to browse for the path.

· If you want to change the default file directory for export files, in the Export Files box, type the full path or choose the ellipsis icon (…) to browse for the path.

2. Complete the steps in the Apply Preferencesxe "Preferences" section later in this topic.

Note: When you are performing file processing functions within the UD/MIPS Application, such as exporting or importing files, and you browse to change the file path from the default, the File Directories tab data will change.

File Transfer Servicexe "Preferences:File Transfer Service" (Server only)

To Select File Transfer Servicexe "Preferences:File Transfer Service"
The Status area displays the following information regarding your request for access to this functionality:

· Unit (Login RUC)

· Approval Status

· Request Date

· Approval Date

· Rejection Date

The Log Message Level setting controls the amount of trouble-shooting information written to the UD/MIPS activity log for all units on the UD/MIPS Server. 

When the databasexe "Preferences:Database" is reset during the UD/MIPS install process, this data returns to its default state.

To Restore Your Request Status

If the databasexe "Preferences:Database" was reset, your request status information returns to its default state.

· Choose Manage.  All data pertaining to your request status updates.

Note: To request access, see the To Request Access for File Transfer section later in this topic.  To check your request's status, see To Check the Status of Your Request section later in this topic.

To Request Access for File Transfer

153. Choose Manage.  The File_Transfer_Service window opens.

154. After completing the steps in the File Transfer Service topic, under Status, Approval Status changes from No Information to Pending.
To Check the Status of Your Request

· Choose Check.  One of the following will apply:

· PENDING: If your request has not been acted upon yet, under Status, Approval Status displays Pending, and the Request Date displays the date of initial request. 

· REJECTED: If your request is rejected, under Status, Approval Status displays Rejected, and the Rejection Date displays the rejected date.  You will need to submit a new request. See the To Request Access for File Transfer section earlier in this topic.

Note:  The Scheduled Events tab is unavailable when the request is in a Rejected status. 

· APPROVED: If your request is approved, under Status, Approval Status displays Approved, and the Approval Date displays the approved date.  The Use Transfer Service check box is selected.

Note: The Status box on the File Service Transfer tab displays the current status information. If the status of the unit changes, the previous status information will be updated. If the status changes from Rejected to Approved, the Rejection Date will no longer be displayed.

To Turn the File Transfer Servicexe "Preferences:File Transfer Service" On or Off

Note: If the file transfer servicexe "Preferences:File Transfer Service" is turned off for your unit and turned on for another unit then the Use Transfer Service check box will appear dimmed, but still available.

1. Do one of the following:

· To turn the automated file transfer functionality on for your unit, choose the Use Transfer Service check box. 

· To turn the automated file transfer functionality off for your unit, clear the Use Transfer Service check box.  A message prompts you to confirm your selection.  Choose Yes.

Note: The Scheduled Events tab is unavailable when the Use Transfer Service To_Select_File_Transfer_Service option is turned off.

2. Complete the steps in the Apply Preferencesxe "Preferences" section later in this topic.

To Change your Log Message Level

Note: Do not change this option unless directed by your MISSO.

155. From the list, choose a Log Message Level.  Status Only is the default value.

156. Complete the steps in the Apply Preferencesxe "Preferences" section later in this topic.

Scheduled Events (Server only)

This tab is unavailable until your File Transfer Service request has been approved. It is also unavailable for input from the Client.

In order for managers to remotely manage the Automated File Transfer and Reconciliation Process the ECO must assign the following ELSIG privileges to the User: TurnOn/Off Scheduled Eventsxe "Preferences:Scheduled Events" and Remote Execute of Scheduled Eventsxe "Preferences:Scheduled Events". If these privileges are not set, then all managing must be done from the Server. See the ELSIG Default Privilege Management topic.

To Schedule Events for Automatic Execution

This process checks every 15 minutes between the start and end times when the Use File Transfer Servicexe "Preferences:File Transfer Service" functionality is turned on. See File Transfer Service tab information.

Note: If you desire more than one event to run at the same time, schedule the events at night because the machine slows down and may appear to be locked.

When the databasexe "Preferences:Database" is reset during the UD/MIPS install process, this data returns to its default values.

The following events are available:

· Send Courier looks for new courier files and sends them to the Collection Serverxe "Collection Server".

· Receive TRECONs logs in to the Collection Serverxe "Collection Server", looks for new TRECON files and downloads them to the UD/MIPS Server.

· Reconcile TRECON looks for downloaded TRECON, Tables TRECON, and MCRISS files and begins the reconciliation process.

Note: TRECONs run one after the other until all are completed. Your TRECON file extension changes from .MFT to .OLD when it is complete. See the TRECON Reconciliation Log.
Note: The Tables TRECON must be manually reconciled if there is any TTC impact AND an open diary status. See the TRECON Reconciliation Log and Reconciliation topics.

· Send Accession looks for new Reserve accessions and sends them to the Collection Serverxe "Collection Server".

· Get Accession logs RUC 88888 in to the Collection Serverxe "Collection Server", looks for new Reserve accessions and downloads them to the MISSO.

· Receive DFR logs in to the Collection Serverxe "Collection Server", looks for new Diary Feedback Report files and downloads them to the UD/MIPS Server.

· Load DFR automatically loads the downloaded DFR files to the UD/MIPS Server.

· Receive MCRISS logs in to the Collection Serverxe "Collection Server", looks for new MCRISS files and downloads them to the UD/MIPS Server.

· Receive Tables logs in to the Collection Serverxe "Collection Server", looks for new Tables TRECON files and downloads them to the UD/MIPS Server.

1. Do one of the following:

· To activate one or more Events for execution, under Turn ON/OFF select the check boxes for the desired events. 

· To deactivate one or more events so that they do not execute at the scheduled time, under Turn ON/OFF clear the check boxes.

2. To set the time to automatically execute the Event(s), type a time in the coinciding Start and End boxes in HH:MM format using a 24-hour clock. The Last Exec box is automatically populated with the time the event was last executed.

Note: All times typed in these fields are local times of your UD/MIPS server location.

Note: It is highly recommended that Units do not change the default start/end times. These times are set to ensure maximum performance and to ensure certain events do not conflict.

3. Complete the steps in the Apply Preferences section later in this topic.

To Execute a Manual Event

This process checks for file transfers to be executed upon demand when the Use File Transfer Servicexe "Preferences:File Transfer Service" functionality is turned on. See File Transfer Service tab information.

157. To activate one or more Events for execution, under Turn ON/OFF select the check boxes for the desired events. Choose Exec Event.

· If requested from the Server, the events are executed immediately.

· If requested remotely, an icon displays under Remote Flag to indicate the events to be executed within the next 15 minutes.

158. Do one of the following:

· A message asks you to confirm your selection. Choose Yes. One of the event processing windows listed below opens when executed, displays processing information and closes automatically when complete.

Event                                          Processing Window Name
Send Courier                             Process Couriers

Receive Trecons                        Process TRECONs

Send Accession                         Process Accession

Get Accession                            Process Accession
Receive DFR                              Process DFR

Load DFR                                   Load DFR

Receive MCRISS                        Receive MCRISS
Receive Tables                          Process Tables Trecon

· If you choose Reconcile TRECON, a message asks you to confirm your selection.  Choose Yes. The Reconciliation window opens, performs the reconciliation and closes automatically when complete. 

Note: TRECONs run one after the other until all are completed. Your TRECON file extension changes from .MFT to .OLD when it is complete. See the TRECON Reconciliation Log.
Note: The Tables TRECON reconcile will fail and must be manually reconciled if there is any TTC impact AND an open diary status. See the Reconciliation topic.

159. Complete the steps in the Apply Preferencesxe "Preferences" section later in this topic.

To Apply Preferencesxe "Preferences"
· Do one of the following:

· To accept the changes and return to the previous window, choose OK.

· To accept the changes without closing this window, choose Apply.

To Exit This Window

· To ignore all changes and return to the previous window, choose Cancel.

File Transfer Service

This window allows you to prepare, submit, and check on a request for access to do automated file transfers. This window is available only on the server. 

How Do I Get Here?

1. Begin on the Preferences window.

2. Choose the File Transfer Servicexe "File Transfer Service" tab, then choose Manage.  The File Transfer Servicexe "File Transfer Service" Request window opens.

To Request Access for File Transfers

1. Choose New.

2. If you want to change the unit information in the Point of Contact area, Unit box, type a new unit designation.  The unit designation is automatically populated with the data you entered on the Update Unit Address Record window.

3. In the Name box, type the point of contact's name.

4. In the Phone Number box, type the point of contact's telephone number in (xxx)xxx-xxxx format.

5. Choose Submit.  A message informs you that the request was successfully submitted and you must manually restart the application. 

6. After completion, the New button becomes unavailable and the Check button is available for status checks.

7. Choose Close.  You return to the Preferences window.

Note: In order to get final authorization you must inform your MISSO that the request was sent.

To Check the Status of Your Request

· Choose Check. This updates the status information and returns you to the Preferences window. After approval and restart of the application, the Scheduled Events tab is available.

Note: You must check the status from the Server to see if the request has been approved. The status cannot update until you complete this step.

To Exit This Window

· Choose Close. 

Reconciliation

xe "CUDDB Reconciliation"The reconciliationxe "Reconciliation" process is an important feature of UD/MIPS. It overlays the Commanders Unit Diary Database (CUDDB) with processed data retrieved from the mainframe. It also allows you to retrieve Marine Corps Recruiting Information Support System (MCRISS) TRECON files, CUDDB TRECON files, and the TFS MASTER TRECON files.

Units should perform the reconciliations, at a minimum, on a weekly basis.  Note that a late reconciliation does not inhibit unit diary transaction reporting.  If a weekly reconciliation cannot be performed, users should reconcile at the earliest opportunity, checking for transferred members that may have been added back to the CUDDB.  Transferred members should then be deleted, if found. See the Search topic, To Search for A Member section.

Units who desire the reconciliationxe "Reconciliation" more frequently should contact their servicing MISSO.  An alternative reconciliationxe "Reconciliation" method may be arranged utilizing the "touched record" concept.  This concept produces faster reconciliationxe "Reconciliation" times for the unit because only those records that have been updated by processed diary transactions are retrieved.  

If your unit has received approval from the MISSA to access the automated file transfer service functionality, you can schedule the reconciliationxe "Reconciliation" to run automatically. See the To_Schedule_EventsAutomated File Transfer and Reconciliationxe "Reconciliation" Process topic for more information.

Note: If the Tables TRECON automatic reconciliationxe "Reconciliation" fails due to potential TTC impact or an open diary status, it must be manually reconciled.

If you run a tables TRECON, all scheduled event times reset according to the table data. You can change this data after the reconciliationxe "Reconciliation" process completes. If the tables are current, the update stops. See the Preferences topic, To Schedule Events section for more information.

The MCRISS dataset includes members assigned to a depot and members who have not been assigned to a specific depot because their future training monitored command codes are missing or incorrect.

How Do I Get Here?

· From the UD/MIPS - Navigator window, choose the Common Utilities module icon.  The Common Utilities frame opens.

To Perform a Reconciliation:
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WARNING:
IF PROCESSING A RECONCILIATIONxe "Reconciliation", YOU CANNOT 
EXECUTE A MAKE COURIER.
Only one user at a time is authorized to log onto the server to reconcile a trecon. If you try to reconcile a trecon when another user is already processing, a message informs you that another user is currently reconciling a trecon.  You must wait until the current reconciliationxe "Reconciliation" is completed or try again at a later time.

1. From the Tools menu, choose Reconcile.  The Reconciliationxe "Reconciliation" wizard opens and guides you through the process.  

2. Type the TRECON filename or click the Browse button to select a TRECON file. The default file location for the TRECON file is <drive:>\UDMIPS\TRECONS.  

Note: The TRECON file name is in XXXXXY.MFT format.  'XXXXX' is the RUC, for example, 36000. 'Y' is the type of TRECON, that is, 'T' for Tables Trecon and 'R' for Touched Records. '.MFT' is the file extension.

3. If you want to delete the source TRECON file after the successful reconciliationxe "Reconciliation", choose Delete TRECON file after Reconciliation. 

4. If you want to delete the unit's information prior to reconciling, choose Empty existing unit before reconciliation. 

5. To continue, choose Next.

Note: If a lock is encountered, the reconciliationxe "Reconciliation" process goes into a wait state.  A message displays listing the machine name that currently has control of the server resources and what process is being run.  The wait state checks every thirty seconds for free resources, and continues the reconciliationxe "Reconciliation" process once they become available.  The message prompt allows you to cancel out of the wait state, at which point Trecon Reconciliationxe "Reconciliation" stops without processing the Trecon.

6. If there are differences between the application and TRECON Version Control Number, a series of messages display.

7. When the Reconciliationxe "Reconciliation" window opens, it will display TRECON and application information to inform the user of the current and available versions, choose Start.

8. If errors occur, do one of the following:

· If the version of UD/MIPS is not the same as the file being reconciled, a message warns you the versions are not compatible.  Choose OK. The reconciliationxe "Reconciliation" process stops.

· If you are doing a tables trecon and diaries are still open, the Unclosed Diaries window opens. You must close the diaries before proceeding with the reconciliationxe "Reconciliation".

· As the reconciliationxe "Reconciliation" process proceeds, your PC may appear to be locked up or inactive.  This is a result of more internal activity that doesn't require user intervention.  To reassure yourself that the application is responding, check the drive indicator light on your CPU.  The light should be flickering. 

9. When complete, the user will be provided the following information: 

· Elapsed reconciliationxe "Reconciliation" time

· Number of records processed 

· Number of members in unit  

10. TRECONs run one after the other until all are completed. Your TRECON file extension changes from .MFT to .OLD when it is complete.  To see if a TRECON has completed, check your TRECON file extension or see the TRECON Reconciliationxe "Reconciliation" Log, whichever is applicable. 

11. The Missing Members CUDDB Records will open if reconciliationxe "Reconciliation" inconsistencies occur.

Note: Reconciliationxe "Reconciliation" time will vary because of computer speed and database size.  Subsequent reconciliationxe "Reconciliation" times are substantially reduced because tables do not have to be rebuilt.

See Also:

Version Control Number 

TRECON 

File Transfer

Server Event Log

xe "Server Event Log"This window allows you to view and print an activity log for a selected type of file transfer using a specific date range. The activity logs can be viewed from the RUC server or the remote desktop. This includes logs for the following types individually or all types combined: Accession FTP, Application, Courier FTP, CUDDB FTP, CUDDB Trecon, DFR FTP, DFR Load, Get Accession FTP, MCRISS FTP, MCRISS Trecon, Request Log, Tables Trecon or Tables Trecon FTP. The primary use of this window is for problem resolution along with tracking pertinent information needed to manage the Automated File Transfer and Reconciliation Process. The Export option is also available in order to aid in forwarding review documents to MISSO/MISSA.

When a trecon contains invalid data, the automatic process stops, logs the error and renames the file to .bad.

Key Log Files are as follows:

· Courier FTP – This log shows courier activity between the UD/MIPS Server and the Collection Serverxe "Collection Server".

· DFR FTP – This shows EDFR activity between the UD/MIPS Server and the Collection Serverxe "Collection Server". You can verify receipt of EDFRs.

· DFR Load – This log shows the EDFRs loaded to the UD/MIPS Server.

· TRECON FTP – This log shows TRECONs received by the UD/MIPS Server.

· Tables TRECON – This log shows the reconciliation of the automatic Tables TRECON process.

· CUDDB TRECON – This log shows the reconciliation of the Full and Touched TRECONs.

· ALL – This shows all activity between the UD/MIPS Server and the Collection Serverxe "Collection Server".

How Do I Get Here?

1. From the UD/MIPS - Navigator window, choose the Common Utilities icon. The Common Utilities frame opens.

2. From the Tools menu, choose Server Event Log. The Server Event Log window opens.

To View an FTP Log

1. In the Enter From Date box, type the begin date of the desired log file in YYYYMMDD format.

2. In the Enter To Date box, type the end date of the desired log file in YYYYMMDD format.

3. In the User box the login RUC is displayed and not editable.

4. In the Computer box the Server name is displayed and not editable.

5. From the Log Files box, select the type of log files you want to view.

6. Choose OK. The window is refreshed with the requested information in the Description box.

To Print an FTP Log

· Choose Print. The desired log file is printed.

To Export an FTP Log

1. From the Log Files box, select All.

2. Choose Export. The Save As window opens.

3. Follow the procedures in the Save As topic, To Export an FTP Log section.

4. View the file using Windows Explorer before e-mailing to MISSO/MISSA for review.

To Review an Exported FTP Log

1. Using Windows Explorer, open the exported log to review.

2. From the Edit menu, choose Find. The Find window opens.

3. Enter the search text. Choose the Find Next button.

Note: To verify the Courier Date/Time stamps, refer to the Couriers, Remote folder on the Unit Diary Management window. See the Unit Diary Couriers topic.

To Exit This Window

· Choose Close. You return to the Common Utilities frame.

See Also

Trecon Reconciliation Log 

TRECON

The TRECON (Transaction Reconciliation) process provides the capability to access information input from other sources, such as HQMC (Headquarters Marine Corps), MISSO (Manpower Information Systems Support Office), or TAD/FAP (Temporary Additional Duty/Fleet Assistance Program) units, on their personnel.  It involves the use of a MCTFS Master File application that extracts information from the CUDDB.

Although a vast majority of transactions automatically update the CUDDB (Commanders Unit Diary Database - from the local computer systems) upon certification of a diary, there are some that do not because of complex editing and processing logic associated with that particular transaction.  Although the unit may have a current database, it may not always be an accurate one in relation to the MCTFS Master File. If a unit reports a transaction that automatically updates the CUDDB, but subsequently fails with an error at the MCTFS Master File level, an out-of-sync condition will exist between the Marine's record on the MCTFS Master File and the Marine's record on the CUDDB.

UD/MIPS allows you to upload couriers and download and reconcile TRECONs manually or via an automated process.  The manual processes are documented in the related topics.  The automated process is explained in the Automated File Transfer and Reconciliation Process topic.  

The TRECON and the unit's reconciliation process are inherent to maintaining an accurate database.  Normally, each MISSO submits the TRECON job the first working day of each week.  This job builds a TRECON record for each member within a unit, and the Unit Address including all subordinate RUCs.  Upon completion of the job a TRECON may be downloaded by tape or diskette and provided to units in the MISSO's jurisdiction so that they may perform their reconciliation.  This file(s) should be stored in the <drive:>\UD/MIPS\TRECON directory.  See the File Transfer topic.

Ensure that the units are defined on the unit's computer prior to running the Reconcile option in Common Utilities.

For units not defined, or non-reconciled records, refer to the Common Utilities, Unit Definition topic. 

Higher Headquarters TRECONxe "TRECON"  

Higher Headquarters users can obtain a TRECON from their local MISSO.  A Higher Headquarters TRECON has the same data elements on it as does the reporting unit TRECON, with the addition of inbound personnel.  If a Higher Headquarters TRECON is desired, contact the local MISSO to coordinate how the TRECON is to be created.  Once the Higher Headquarters TRECON is created, the user may obtain the TRECON by file transfer from the MCTFS Master File to the user's computer.

See Also:

Reconciliation 

Make Courier 

TRECON Reconciliation Log

This window allows you to view all logged events that have occurred on the UD/MIPS Server involving an automated FTP session or a TRECON reconciliation.  This information is provided by file receipts from the respective platforms. 

TRECONs run one after the other until all are completed. Your TRECON file extension changes from .MFT to .OLD when it is complete.

The Tables TRECON reconcile will fail and must be manually reconciled if there is any TTC impact and an open diary status.

How Do I Get Here?

1. From the UD/MIPS - Navigator window, choose the Common Utilities icon. The Common Utilities frame opens.

2. From the Tools menu, choose Reconciliation Log.  The TRECON Reconciliation Logxe "TRECON Reconciliation Log" window opens.

Fields

· Reconciled:  The date and time the TRECON reconciliation process ran.

· TRECON Created:  The date the TRECON was created by the mainframe.

· TRECON Type:  The type of TRECON processed.

· Reconcile Time: The duration of the TRECON reconciliation process.

· Starting #: The beginning record number of the TRECON reconciliation process.

· Ending #: The ending record number of the TRECON reconciliation process.

To Exit This Window

· Choose Close. You return to the Common Utilities frame.

See also:

Reconciliation 

Preferences 

Automated File Transfer and Reconciliation Process 

Server Event Log 

Unclosed Diaries

xe "Unclosed Diaries"This window displays when performing a manual tables treconxe "Tables Trecon" reconciliation containing diaries in an open status. These diaries must be closed before successfully completing the reconciliation.

How Do I Get Here?

1. From the UD/MIPS - Navigator window, choose the Common Utilities module icon.  The Common Utilities frame opens.

2. From the Tools menu, choose Reconcile.  The Reconciliation wizard opens.

3. If there are open diaries, the reconciliation will not complete, and the Unclosed Diaries window opens. The diary items must be closed before continuing.

This window displays the following information sorted by TTC Sequence and then Diary Number:

· Trecon RUC

· Entry Date Time

· Diary Type

· Preparer

· Certifier

· TTC Sequence

· Diary Number

To Perform a Successful Reconciliation

1. To change the diary status, follow the procedures in the Diary Status/Notes topic.

2. To start the reconciliation process again, follow the procedures in the Reconciliation topic.

To Exit This Window

· Choose Close.  

Security Certificates

Security certificatesxe "Security Certificates", also called digital passportsxe "digital passports", digital IDsxe "digital IDs" or public-key certificatesxe "public-key certificates", are special files that identify a computer. Security certificatesxe "Security Certificates" allow the computer to send and receive encrypted information. Certificates are issued by certificate authorities which are companies that set up and sell these IDs. Each certificate is "signed" by the authority that created it, and it contains information about when it was created and its owner.

How Do I Get Here?

· From your Internet browser window, type the URL https://udmips.kct.usmc.mil in the website address box. Press the Enter key. The Security Alert (1) window opens.
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To Check for a Successful Connection

1. From the Security Alert (1) window, choose OK. The Security Alert (2) window may open.
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2. Choose Yes. The UD/MIPS Collection Server Successful Connection window opens.
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3. Using the mouse, choose the padlock in the lower right section of the UD/MIPS Collection Server Successful Connection window. The Certificate window opens on the General tab. Other information is available on the Certification Path tab. 
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4. If the certificate is expired, not valid or has a red x, then it must be reloaded. Follow the procedures in the To Install the Certificate section.

OR

1. From your Internet browser window, type the URL https://udmips.kct.usmc.mil in the website address box. Press the Enter key.

2. From the Tools menu, choose Internet Options. The Internet Options window opens.

3. From the Content tab, choose Certificates. The Certificates window opens.

4. Choose the Trusted Root Certification Authorities tab. The following information is displayed: Issued To, Issued By, Expiration Date, Friendly Name.
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5. Select the certificate for IAD Development, then choose View. The Security Certificate is displayed.

6. If the certificate is expired, not valid or has a red x, then it must be reloaded. Follow the procedures in the To Install the Certificate section.

To Install the Certificate

1. Do one of the following:

· From the Certificate window, General tab, choose Install Certificate. The Certificate Import Wizard (1) window opens.

OR

· From the Security Alert (2) window, choose View Certificate. The Certificate Import Wizard (1) window opens.
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2. Choose Next. The Certificate Import Wizard (2) window opens displaying Certificate Store information.
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3. Select Place all certificates in the following store. Then choose Browse. The Select Certificate Store window opens.
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4. Do the following:

f) Check the Show physical stores box.

g) Expand Trusted Root Certification Authorities, then select Local Computer.

h) Choose OK. You return to the Certificate Import Wizard (2) window with the Certificate store location displayed.
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5. Choose Next. The Certificate Import Wizard (3) window opens displaying completion information.
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6. Choose Finish. The Certificate Import Wizard (4) window opens displaying a successful import message. 
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7. Choose OK. You return to the Certificate window. 

8. Choose OK. You return to the UD/MIPS Collection Server Successful Connection window.

9. From the File menu, choose Close to exit your Internet browser.

To Verify a Successful Certificate Install

1. From your Internet browser window, type the URL https://udmips.kct.usmc.mil in the website address box. Press the Enter key. The Security Alert (1) window opens.

2. Choose OK. The UD/MIPS Collection Server Successful Connection window opens.

Note: The Security Alert (2) window does not open because the problem has been resolved.
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3. From the File menu, choose Close to exit your Internet browser.

Troubleshooting Automated Processes

xe "Troubleshooting Automated Processes:Before Calling MISSO/MISSA"

xe "Troubleshooting Automated Processes"

xe "Automated Processes Troubleshooting"The Collection Serverxe "Collection Server" Security Certificate is installed with the UD/MIPS CD. However, it can expire, become overwritten with bad data, or be deleted by a number of different sources, such as the Network Operations Center (NOC), the Marine Corps Information Technology and Network Operations Center (MITNOC) or the user. If this happens, the RUC Server will not be able to connect with the Collection Serverxe "Collection Server". Therefore, no connection can be made to submit diaries, receive TRECONs or receive EDFRs. All Collection Serverxe "Collection Server" Managers should check their Security Certificatesxe "Troubleshooting Automated Processes:Security Certificates" on a regular basis. This should also be one of the first steps in troubleshooting, prior to contacting your MISSO/MISSA.

Before Calling MISSO/MISSAxe "Before Calling MISSO/MISSA"
The following steps need to be taken prior to calling your local MISSO:

1. Ensure the server is turned on and UD/MIPS is loaded.

2. Ensure the Server name has not changed from the original request. If it has changed, a new request must be submitted after the old request is deleted. Contact MISSO.

3. Ensure that you can connect to the Collection Serverxe "Collection Server" Website – https://udmips.kct.usmc.mil.

· Verify that the Browser is using 128-bit encryption.

· If you cannot connect, try connecting from another computer.

· If another computer can connect, then reload the security certificate.

· Ensure the security certificate was loaded to the Trusted Root Certification Authorities/Local Computer on the Server.

· If a connection still cannot be established, contact your local G-6 for connectivity/firewall issues.

· Verify with the G-6 that Port 443 is not restricted.

· Ensure that most current patch/updates have been applied recently. If they have been, then contact MISSO.

4. Refer to other applicable topics.

5. Call MISSO and request a RUC/Collection Server Information spreadsheet to complete.

Security Certificatesxe "Troubleshooting Automated Processes:Security Certificates"
It has been identified that from time to time the security certificate that the Collection Serverxe "Collection Server" uses can expire, become overwritten with bad data, or deleted by a number of different sources (ISC, G6, NOC or MITNOC, User). When this occurs the RUC Server will not be able to connect with the Collection Serverxe "Collection Server". Therefore no connection can be made to submit diaries, receive TRECONs or receive EDFRs. All Collection Serverxe "Collection Server" Managers need to check their Security Certificatesxe "Troubleshooting Automated Processes:Security Certificates" on a regular basis. If a problem is found then reload the certificate. See the Security Certificates topic.

Port 443/Firewall Issuesxe "Troubleshooting Automated Processes:Port 443/Firewall Issues"
This port must be open for units prior to requesting authorization to use the process. Many "Time Out" issues are associated with Firewall restrictions on Port 443. If you receive a valid Security Alert but red x's appear on the certificate when viewing, a firewall issue may exist. Contact your local G-6 to resolve before attempting to gain access.

Server Computer Namexe "Troubleshooting Automated Processes:Server Computer Name"
Only one RUC can be authorized to use the Automated File Transfer and Reconciliation Process. Therefore, during the authorization process the computer name is captured and stored within a table inside UD/MIPS that the Collection Serverxe "Collection Server" validates. If the Collection Serverxe "Collection Server" does not recognize the computer name, it will not allow a connection to be made. The MISSO should reject the unit and the unit should initiate a new request from the new computer.

128 Bit Encryptionxe "Troubleshooting Automated Processes:128 Bit Encryption"
The browser must be using 128-bit encryption to be able to connect to the Collection Serverxe "Collection Server". Your unit can check their encryption as follows:

· From your Internet Browser Help menu, choose About Internet Explorer. Cipher Strength should equal 128-bit.

If the Server/Workstation does not have 128-bit encryption, then it must be updated in order to make the connection. Do not assume that just because the browser is IE 5.5 that the workstation is using 128-bit. On Windows 2000 a patch is needed to upgrade the operating system to 128- bit. The browser and workstation both must be 128-bit.

Microsoft Website: http://www.microsoft.com/windows/ie/downloads/recommended/128bit/default.asp
Note: Internet Explorer 5.5 includes 128-bit encryption. If you already have Internet Explorer 5.5 installed, you do not need to upgrade your browser with the Internet Explorer High Encryption Pack. If you are running Windows 2000, installing Internet Explorer 5.5 will not change the current level of encryption on your computer, you will need to install the Windows 2000 High Encryption Pack.

Unit Diary Size Limitationxe "Troubleshooting Automated Processes:Unit Diary Size Limitation"
Although there is a size limitation of 9,999 transactions that can be processed on the mainframe, there is also a size limitation for MQ Series. Couriers should not exceed 4,000 when sending diaries through the Collection Serverxe "Collection Server". If your unit does large diaries, you should manually upload it through Host of Demand. In addition, you should manually delete it from the remote courier tab.

G-6 Involvementxe "Troubleshooting Automated Processes:G-6 Involvement"
The local G-6/NOC needs to be made aware that the Collection Serverxe "Collection Server" utilizes Internet Port 443 to send and receive data. Units that have established a good relationship with the G-6 seem to experience less or no problems with the Collection Serverxe "Collection Server". Due to filters/restrictions that are put on Port 443, large couriers can time out and prevent other couriers from being sent (RUC Server Issue).

Server Not Correctly Configuredxe "Troubleshooting Automated Processes:Server Not Correctly Configured"
Ensure that the C:\ drive is installed with only the operating system.

Ensure UD/MIPS along with ORACLE are installed on a drive other than C:\. 

Do not install ORACLE or UD/MIPS on the C:\ drive.

If this is not the current setup, it is recommended that you fix the configuration prior to requesting access. UD/MIPS, DBUM, and ORACLE are three separate applications that use a lot of the server resources. Therefore, no other application should be on the server. See the Installing UD/MIPS topic.

ELSIG Privileges Not Setxe "Troubleshooting Automated Processes:ELSIG Privileges Not Set"
If you do not have the ability to remotely administer the process, then the ELSIG privileges have not been set. In order for managers to remotely manage the Automated File Transfer and Reconciliation Process, the ECO must assign the following ELSIG privileges to the User: Turn On/Off Scheduled Events and Remote Exec of Scheduled Events. If these privileges are not set, then all management must be done from the Server. See the ELSIG Default Privilege Management topic.

Request for Approval stays in Pending Statusxe "Troubleshooting Automated Processes:Request for Approval stays in Pending Status"
You must check the status from the Server to see if the request has been approved. It will not update unless you physically log into the Server. This is the only way to go from pending to approved. See the File Transfer Service topic. 

File Descriptions

JPAVS

xe "JPAVS"Position
Field Name
Width
Type Class

1
Marital status code
1
CHAR

2
primary mos
4
CHAR

6
first additional mos
4
CHAR

10
second additional mos
4
CHAR

14
last name
20
CHAR

34
first name
10
CHAR

44
mid initials
2
CHAR

46
race
1
CHAR

47
sex
1
CHAR

48
ethnic group
1
CHAR

49
religion
2
CHAR

51
Rotation tour date
8
DATE

59
security type invest code
1
CHAR

60
security clearance held
1
CHAR

61
self professed language code1
2
CHAR

63
self professed language code2
2
CHAR

65
self professed language code3
2
CHAR

67
self professed language code4
2
CHAR

69
ssn
9
CHAR

78
Billet description
20
CHAR

98
billet mos
4
CHAR

102
blood type
1
CHAR

103
Custody status code
1
CHAR

104
Citizenship code
2
CHAR

106
citizen cntry orig geo code
2
CHAR

108
Component code
2
CHAR

110
current active duty began date
8
DATE

118
date current tour began
8
DATE

126
date of birth
8
DATE

134
Deployment status code
1
CHAR

135
Deployment return date
8
DATE

143
Duty status code
1
CHAR

144
expiration of active service
8
DATE

152
expiration of current contract
8
DATE

160
school special skill code01
3
CHAR

163
school special skill code02
3
CHAR

166
school special skill code03
3
CHAR

169
school special skill code04
3
CHAR

172
school special skill code05
3
CHAR

175
school special skill code06
3
CHAR

178
school special skill code07
3
CHAR

181
school special skill code08
3
CHAR

184
school special skill code09
3
CHAR

187
school special skill code10
3
CHAR

190
school special skill code11
3
CHAR

193
school special skill code12
3
CHAR

196
government operators permit
10
CHAR

206
present grade
3
CHAR

209
individual county location
3
CHAR

212
indiv loc state cntry code
2
CHAR

214
individual location city code
4
CHAR

218
first extension number
1
CHAR

219
total length all extensions
2
CHAR

220
Total



MCAIMS

xe "MCAIMS"Position
Field Name
Width
Type Class

1
mctfs.ssn
9
CHAR

10
mctfs.last_name
20
CHAR

30
mctfs.first_name
10
CHAR

40
mctfs.mid_initials
2
CHAR

42
mctfs.present_grade_code
3
CHAR

45
mctfs.marital_status_code
1
CHAR

46
mctfs.date_of_birth
8
DATE

54
mctfs.blood_type
1
CHAR

55
mctfs.number_of_dependents
2
CHAR

57
mctfs.primary_mos
4
CHAR

61
member_service.date_enlistment_or_acceptance
8
DATE

69
mctfs.expiration_of_current_contract
8
DATE

77
mctfs.expiration_of_active_service
8
DATE

85
mctfs.expiration_obligated_service
8
DATE

93
mctfs.present_reporting_unit_code
5
CHAR

98
mctfs.duty_status_code
1
CHAR

99
personnel_information.security_clearance_held
1
CHAR

100
personnel_information.security_invest_agency_code
1
CHAR

101
personnel_information.security_invest_complete_date
8
DATE

109
personnel_information.security_eligibility_code
1
CHAR

110
mctfs.present_rank_date
8
DATE

118
mctfs.future_monitored_command_code
3
CHAR

121
member_service.detached_last_command_date
8
DATE

129
mctfs.estimated_arrival_date
8
DATE

137
mctfs.pay_entry_base_date
8
DATE

145
mctfs.current_tour_begin_date
8
DATE

153
mctfs.overseas_control_date
8
DATE

161
mctfs.sex
1
CHAR

162
mctfs.civilian_educ_left_school_dt
4
DATE

166
mctfs.civilian_graduation_cd
1
CHAR

167
mctfs.civilian_years_compl
2
CHAR

169
mctfs.civilian_education_certificate
1
CHAR

170
mctfs.civilian_ed_major_subject_code
2
CHAR

172
personal_test_information.army_radio_code_test_score
3
CHAR

175
personal_test_information.electronic_dp_test_score
3
CHAR

178
mctfs.race
1
CHAR

179
mctfs.ethnic_group
1
CHAR

180
mctfs.platoon_number
4
CHAR

184
mctfs.armed_forces_act_du_base_date
8
DATE

192
mctfs.bst_est_final_score_qy
2
CHAR

194
mctfs.bst_est_task_attempted_cd
3
CHAR

197
mctfs.bst_est_task_performed_cd
3
CHAR

200
mctfs.bst_est_year_date
6
CHAR

206
filler
3
CHAR

209
personnel_information.composite_score
4
CHAR

213
personnel_information.conduct_average_enlistment
3
CHAR

216
personnel_information.conduct_average_grade
3
CHAR

219
personnel_information.conduct_average_service
3
CHAR

222
mctfs.duty_limit_status_code
1
CHAR

223
personal_test_information.gct_total
3
CHAR

226
mctfs.physical_fitness_class_cd
1
CHAR

227
mctfs.physical_fitness_score_qy
3
CHAR

230
mctfs.physical_fitness_semi_ann_code
1
CHAR

231
mctfs.physical_fitness_test_dt
6
CHAR

237
mctfs.physical_risk_code
1
CHAR

238
mctfs.current_pistol_qual_dt
6
CHAR

244
mctfs.current_pistol_qual_score_cd
3
CHAR

247
mctfs.current_pistol_qual_class_cd
1
CHAR

248
training_information.current_pistol_qual_its1_cd
1
CHAR

249
training_information.current_pistol_qual_its2_cd
1
CHAR

250
personnel_information.proficiency_average_enlistment
3
CHAR

253
personnel_information.proficiency_average_grade
3
CHAR

256
personnel_information.proficiency_average_service
3
CHAR

259
mctfs.current_rifle_qual_dt
6
CHAR

265
mctfs.current_rifle_qual_score_cd
3
CHAR

268
mctfs.current_rifle_qual_class_cd
1
CHAR

269
training_information.current_rifle_qual_its1_cd
1
CHAR

270
training_information.current_rifle_qual_its2_cd
1
CHAR

271
training_information.current_rifle_qual_its3_cd
1
CHAR

272
training_information.current_rifle_qual_its4_cd
1
CHAR

273
personnel_information.grade_select_officer_enlisted
1
CHAR

274
personnel_information.grade_select_pay_scale
1
CHAR

275
personnel_information.grade_select_special_code
1
CHAR

276
mctfs.strength_category_code
1
CHAR

277
mctfs.water_survival_code
1
CHAR

278
mctfs.water_survival_requal_date
6
CHAR

284
personal_test_information.army_radio_code_test_date
8
DATE

292
mctfs.driver_improvement_school
1
CHAR

293
personnel_information.duty_preference_first_choice
3
CHAR

296
personnel_information.duty_preference_second_choice
3
CHAR

299
personnel_information.duty_preference_third_choice
3
CHAR

302
personal_test_information.elec_data_proc_test_date
8
DATE

310
mctfs.gas_chamber_training_date
4
CHAR

314
geol_type_code
5
CHAR

319
geol_renewal_expiration_dt
8
DATE

327
geol_type_code
5
CHAR

332
geol_renewal_expiration_dt
8
DATE

340
geol_type_code
5
CHAR

345
geol_renewal_expiration_dt
8
DATE

353
geol_type_code
5
CHAR

358
geol_renewal_expiration_dt
8
DATE

366
geol_type_code
5
CHAR

371
geol_renewal_expiration_dt
8
DATE

379
personal_test_information.defense_lang_apt_battery_date
8
DATE

387
mctfs.leadership_training_level_date
5
CHAR

392
personnel_information.security_clear_curr_awd_date
8
DATE

400
mctfs.security_lecture_training_dt
4
CHAR

404
mctfs.estimated_departure_date
8
DATE

412
mctfs.component_code
2
CHAR

413
Total



MDSSII

xe "MDSSII"Position
Field Name
Width
Type Class

1
service code
1
CHAR

2
Ssn
9
CHAR

11
last name
20
CHAR

31
first name
10
CHAR

41
middle initials
2
CHAR

43
blood type
1
CHAR

44
Sex
1
CHAR

45
present grade
3
CHAR

48
billet description
20
CHAR

68
billet mos
4
CHAR

72
primary mos
4
CHAR

76
first additional mos
4
CHAR

80
second additional mos
4
CHAR

84
present reporting unit code
5
CHAR

89
temporary reporting unit code
5
CHAR

94
platoon number
4
CHAR

98
Company code
1
CHAR

99
table of organization number
5
CHAR

104
tmr t o line number
5
CHAR

109
work telephone number
10
CHAR

119
Security clearance
1
CHAR

120
Government operators permit
5
CHAR

125
Filler
5
CHAR

129
Total



Tickler

About Tickler File

xe "About Tickler File"The Tickler File module allows you to create and hold unit diary transactions until the appropriate effective date for Diary creation and processing. From the list of tickler transactions, you can export and import tickler files; create, edit, delete, import, and export member's transactions and duty sections; display ticklers due on current date upon login; refresh the window; and create a Pending Tickler Transactions Report. Ticklers are sometimes generated from the Intelligent Forms module.

See Also:

Pending Tickler Transactions Report 

Tickler Alert 

Tickler Export 

Tickler Import 

Tickler Transaction List 

Section Maintenance 

UD/MIPS - Navigator 

Intelligent Forms 

Tickler Alert

This window opens after you log in and displays a summary of all ticklers due on the current date. You can turn the display on startup functionality on and off. You can go directly into the Tickler File module from this window.

How Do I Get Here?

1. Begin on the UDMIPS Login window. After you type in the required information, Choose OK. If the display alert on startup function is on, the Tickler Alert window opens.

2. The Tickler Actions Due Today list displays the following information:

· SSN   Member's Social Security Number

· Name   Member's name

· TTC   Indicates whether or not a TTC is attached to the tickler

· Action Description   Either the TTC English statement, if applicable, or a 'note to self' for future action to take on the member.

To Prevent the Tickler Alertxe "Tickler Alert" Window from Automatically Displaying on Startup

· Select the Do not show this message on startup check box.

To Turn the Display On Startup Function On or Off

160. Begin on theTickler_File About Tickler File frame.

161. From the Tools menu, select Preferences, then choose Display Alert On Startup. A check mark next to Display Alert On Startup indicates that the function is on.

To View Tickler Entries Due Today

· Choose Go to Tickler. The Tickler Transaction List opens. 

To Exit This Window

· Choose Close. You return to the UD/MIPS - Navigator window.

See Also:

About Tickler File 
Tickler Transaction List

This window displays a summary of all transactions included as tickler entries for the selected RUC. The CONAD RUC sees all ticklers for all subordinate RUCS. Several filter functions allow you to control the view of tickler transactions available to you in the list. From this window you can view, refresh, add, edit, or delete tickler entries and add an associated TTC to a diary or the transaction pool.

How Do I Get Here?

1. Begin on the UD/MIPS - Navigator window.

2. Choose Tickler File. The Tickler Transaction List window opens. 

OR

5. Begin on the Tickler File frame.

6. From the File menu, choose Open Tickler Transaction List. The Tickler Transaction List window opens.

Tickler Date

The date the entry is due to be completed.

SSN


The member's Social Security Number of the subject member.

Name


The member's name 

Section

The section a tickler entry is assigned.

TTC
An asterisk (*) that indicates a TTC transaction is attached to the 
transaction.

Action Description
Either the TTC English description of a future action to be taken on the member or a note to self.
To Filter the Available Tickler Transactions

7. In the RUCs list, select the desired RUC.

8. In the Tickler Date box, type the desired Tickler Date in YYYY/MM/DD format.

9. In the List Transactions list, select the desired range of ticklers based on the Tickler Date.

10. In the Section list, select the applicable section. ALL is the default selection.

Note: As you set each filter, the list and Transaction Count automatically update.

To Edit a Tickler Transaction

· Select a tickler transaction, then choose Edit. The Tickler Transaction Detail window opens.

Note: The Action Description box is unavailable if a TTC is attached.

To Create a New Tickler Entry

· Choose New. The Tickler Transaction Detail window opens.

To Add One or More Tickler Transactions to a Diary or the Transaction Pool (Preparer ELSIG only)

11. Select one or more tickler transactions. All selections must reflect the TTC flag.

12. Choose Add to Diary. The Select Diary window opens.

Note: If you select a Tickler Transaction without a TTC attachment, you will get an information message stating that it is an Invalid Attachment.

Note: If you do not make at least one selection, a message will appear informing you to select at least one row.

Note: If you cancel while in Add to Diary an information window appears.

To Delete One or More Tickler Entries

13. Select one or more tickler transactions.

14. Choose Delete. A message prompts you to confirm the delete.

15. Do one of the following:

· If you want to delete the selected transactions, choose Yes.

· If you do not want to delete all of the selected transactions, choose No.

To Refresh The Tickler Transaction Listxe "Tickler Transaction List"
· From the View menu, choose the Refresh option. The Tickler Transaction List window is refreshed.

To Exit This Window

· Choose Close. The Tickler Transaction List window closes and you return to the Tickler File frame.

See also:

Calendar 
Tickler Transaction Detail

This window allows you to add or modify the tickler transaction to include the tickler date, the section and notes pertinent to the tickler, and attach a TTC to the tickler. You may also edit, or delete the diary entry or add the diary entry to a diary tickler. 

How Do I Get Here?

1. Begin on the UD/MIPS - Navigator window.

2. Choose Tickler File. The Tickler Transaction List window opens. 

3. Choose New or Edit. The Tickler Transaction Detail window opens in either Add mode or Edit mode, respectively.

Note: Whether you are in add mode or edit mode determines the command buttons and available input fields and whether or not you attach a TTC to the tickler.

The Tickler Transaction Detailxe "Tickler Transaction Detail" window has four modes; Add or Edit and TTC Attached or TTC Not Attached. The first two modes are possible with either of the last two modes and vice versa.

Each mode affects the window as follows:

Add Mode 


The SSN box is available

The Members command button displays to the right of the SSN box.

Edit Mode


The SSN box is unavailable.

TTC Attached Mode
The Transaction Attached status is Yes.

The Action Description box is unavailable.

The Save, Edit Diary Entry, Add to Diary, Delete Diary Entry,
and Close command buttons display.

TTC Not Attached Mode
The Transaction Attached status is No.

The Save, Create Diary Entry, Action Complete, and Close command buttons display.

To Add or Edit a Tickler Transaction

1. If available, in the SSN box, do one of the following:

· Type the member's SSN. 
· Choose Members. The Search window opens. Complete the steps in the Search topic.

2. In the Tickler Date box, type the desired tickler date in YYYY/MM/DD format.

3. In the Assigned to Section list, select a section.

4. If available, in the Action Description box, type your note to self-information.

Note: If you intend to add a TTC to this tickler, it is recommended that you put this information in the Note box.

5. In the Note box, make appropriate comments for the tickler, if applicable.

6. Choose Save. The tickler entry information is saved to the tickler file. If you have not attached a TTC to the tickler, Action Complete becomes available.

Note: If you attempt to create a new entry and the transaction already exists in either the Ticker or Unit Diary module, a message informs you that a duplicate entry was found.

To Attach a TTC to the Tickler

1. If available, in the SSN box, do one of the following:

· Type the member's SSN. 
· Choose Members. The Search window opens. Complete the steps in the Search topic.

2. In the Tickler Date box, type the desired tickler date in YYYY/MM/DD format.

3. In the Assigned to Section list, select a section.

4. If available, in the Action Description box, type your note to self information.

Note: If you intend to add a TTC to this tickler, it is recommended that you put this information in the Note box.

5. In the Note box, make appropriate comments for the tickler, if applicable.

6. Choose Create Diary Entry. The Select Diary window opens. See the Transaction Detail and Add Transaction topics for more information.

7. After completing the steps in these topics, the window changes to the TTC attached mode.

To Add the TTC to a Diary (TTC Attached mode)

1. Choose Add to Diary. The Select Diary window opens.

2. After completing the steps in the Select Diary topic, you return to the Tickler Transaction Detail window. The next tickler transaction displays if available.

To Delete a Diary Entry (TTC Attached mode)

1. Choose Delete Diary Entry. A message prompts you to confirm you want to delete the diary entry.

2. Choose Yes. The window changes to the TTC Not Attached mode.

To Complete A Tickler Transaction (TTC Not Attached mode)

1. Choose Action Complete. A message prompts you to confirm you want to complete the change.

2. Do one of the following:

· If you want to remove the tickler entry from the Tickler Transaction List, choose Yes. You return to the Tickler Transaction List window. The next tickler transaction displays if available.

· If you do not want to change the status, choose No. You return to the Tickler Transaction Detail window.

To Exit This Window

· Choose Close. You return to the Tickler Transaction List window.

See Also:

Calendar 

Add Tickler

xe "Add Tickler"This window allows you to attach TTCs generated from Intelligent Forms or a generic transaction import file to a tickler file. From this window, you set the tickler date and type comments.

How Do I Get Here?

1. Do one of the following:

· Begin on the New Form window.

· Begin on the Transaction Import window

2. Choose Add to Tickler. The Add Tickler window opens.

To Create A Tickler

1. In the Tickler Date box, do one of the following:

· Type the date.

· Select the Calendar icon.

2. In the Note box, type the appropriate 'note to self' information.

3. Choose OK. You return to the New Form window.

To Cancel a Transaction

1. Choose Cancel. A message informs you that the Add to Tickler action has been canceled.

2. Choose OK. You return to the New Form window.

Tickler Export

xe "Tickler Export"This window allows you to export either all or a range of ticklers to a file that you specify. A header file identifies the file type and stores the RUC, so the file can only be imported by that RUC. To prevent losing data, export all tickler files before resetting the database and before UD/MIPS installs and uninstalls.

How Do I Get Here?

16. Begin on the Tickler File window.

17. From the Tools menu, choose Export Tickler File. The Tickler Export window opens.

To Export a Tickler File

1. Do one of the following:

· If you want to export all ticklers, in the Choose Tickler Files area, choose All.

· If you want to export tickler files in a range of dates, in the Choose Tickler Files area, choose From/To, then type a From date and a To date, both in YYYY/MM/DD format.

2. Choose OK. The Export Tickler window opens.

3. Do one of the following:

· In the File Name box, type the name of the file.

· In the Save As Type list box, select the name of the file.

5. Choose Save. A message informs you the export was successful.

6. Choose OK. You return to the Tickler Transaction List window.

To Exit This Window

· Choose Cancel. You return to the previous Tickler File window.

Import Tickler File

xe "Import Tickler File"This window allows you to import tickler files for your RUC into the tickler database.

How Do I Get Here?

43. Begin on any Tickler File window.

44. From the Tools menu, select Import Tickler File. The Import Tickler File window opens.

To Import a Tickler File

1. Do one of the following:

· To import a known tickler file, type the name of the tickler file you want to import.

· To locate a tickler file name to import, choose Browse for a listing of current tickler files.

2. Choose OK. The Select Import File window opens.

3. After completing the steps in the Select Import File topic, you return to the Tickler Transaction List window.

To Exit This Window

· Choose Cancel. You return to the previous Tickler File window.

Pending Tickler Transactions Report

This report lists tickler transactions that are still pending as of the current date. The report may be sorted on one or more columns and can be viewed on the monitor or printed if desired.

How Do I Get Here?

162. Begin on the Tickler File window.

163. Select Reports, then choose Pending Tickler Transactions Report. The report opens.

Header

· Current Date

· Title (Pending Tickler Transactions Report)

· Page Number

· Report Date

· Total (Transactions in the Report)

· RUC

Columns

· Tickler Date

· SSN

· Last Name

· Initials

· Section

· TTC-SEQ

· Action Description

To Print

· From the File menu, select Print. The report prints.

To Sort The Report Columns

· Select Tools menu, then choose Sort. The Multiple Column Sort window opens. 

To Exit the Pending Tickler Transactions Reportxe "Pending Tickler Transactions Report"
· From the File menu, choose Close. You return to the Tickler Transaction List window. 

Unit Diary

About the Unit Diary

xe "About the Unit Diary"The Unit Diary Module, depending on your ELSIG level, allows you to view, create, edit, or delete transactions and to place them in either a transaction pool or a diary. You can also import transactions from .xml files and place existing diaries into couriers so that the transactions can be processed. Unit Diary is closely related to the Diary Feedback Report, Intelligent Forms, Tickler File, and Student Management modules.

See Also:

Create A New Diary 

Transaction Detail 

Unit Diary Management 

Diary Status/Notes 

Make Courier 

Certify a Diary 

Commanding Officer ELSIG 

ELSIG Control Officer 

Preparer ELSIG 

Certifier ELSIG 

Reviewer ELSIG 

Viewer ELSIG 

Admin Viewer ELSIG 

Super Viewer ELSIG 

ELSIG Current Privileges 

ELSIG Default Privilege Management 

TTC Reports 

CUDDB Postings 

Unit Diary Management

xe "Edit a Transaction"

xe "Highlight All Transactions"

xe "Place in a Unit of Work"

xe "Import Transactions"

xe "Change the Status of Diaries"

xe "Courier List"

xe "View Courier Reports for a Single Courier"

xe "Restore Couriers"

xe "CART Edit"

xe "MultiZip Couriers"

xe "Delete a Courier"

xe "Sort Columns"

xe "Select the Columns You Want to Display"

xe "Add or Edit a Note on a Diary or a Courier"

xe "View and Print TTC Reports"

xe "View and Print Reports of CUDDB Postings"

xe "View and Print Rough Reports"

xe "Filter Data"

xe "Recover an Archive"

xe "Create New Diary"

xe "Track Courier"

xe "ECCO Accession"

xe "Unit Diary Archives"This window manages all transactions. Depending on your ELSIG authority, it allows you to view transactions, change the status of transactionsxe "Change the Status of Transactions", add notes for transactions, flag transactionsxe "Flag Transactions", create diaries, assign transactionsxe "Assign Transactions" to diaries, perform courier and archive/recover functions, and import or export courier transactions.

Transactions and diaries can be created and certified independently of each other.

How Do I Get Here?

· From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

—OR—

· In the Unit Diary frame, from the File menu, choose Open Unit Diary Management. The Unit Diary Management window opens.

This window consists of the following sections:

· Transaction Tree 

· Preview Pane 

· Unit Diary Menus
Transaction Tree

The Transaction Tree listview is available in the upper left side of the window. This shows a semi-detailed listing of objects in the current treeview item. Through a menu option, you can add or remove columns from the listview as needed. All columns have sort and filter capabilities and can be resized and moved using the mouse or the Multiple Column Sort window. 

· Transaction Pool—Depending on your ELSIG authority, this listview allows you to add, edit, delete, and manage Unit Diary transactions before they are assigned to a Unit Diary. The Transaction Poolxe "Transaction Pool" is not available for Event or Accession transactions.

· Diary Lists—This list includes all diaries, separated by type. You cannot move a transaction from one type of diary to another.

· Couriers—Each branch in this listview contains the individual couriers, the diary that made up the courier, and the transactions assigned to the diary.

· Archive —Each branch in this treeview lists the archive, the diary that made up the courier in the archive, and the transactions assigned to the diary.

Preview Pane

The preview pane on the lower right side of the window contains information about transactions, diaries, couriers or archives that varies depending on where your cursor is located in the Unit Diary Management window.
Unit Diary Menus

· Unit Diary Tools—Use this menu to import a transaction, refresh the window, sort and select windows, apply a filterxe "Apply a Filter", and change column orderxe "Change Column Order".  

· Unit Diary Reports—The Reports menu allows you to view and print TTC Reports, the CUDDB Posting Report, the Unit of Work Report, and the Research Diary Report.

· Unit Diaries—If you have certifier-level access, you can use the Diary menu to add, edit, or delete diariesxe "Delete Diaries". You can also use it to reopen, reject, or certify a diary.

· Unit Diary Transactions—If you are a preparer, the Transactions menu allows you to add, modify or delete transactionsxe "Delete Transactions" or to assign them to a diary or to the Transaction Poolxe "Transaction Pool".

· Unit Diary Couriers—The Courier menu enables you to track the number of couriers created and currently in the local and remote drives, and allows you to view and print Diary Transmittal Letters, CUDDB Statistics, and Exceptions reports through the Courier Reports window. You can archive courier diaries and indicate the number of accepted, rejected, and total transactions. In addition, you can create a multiple courier zip (*.MZC) file, delete couriers, filter the list of couriers, resend couriers, and import and export courier diaries. Any authorized user can modify information within the courier. During the creation of a courier file, it is zipped-up to prevent unauthorized tampering.

· Unit Diary Archives—The Archive menu allows you to restore diary information for an archive file (with a .dar extension) or to delete an archive. 

Transaction Poolxe "Transaction Pool" Information

Transactions in the Transaction Poolxe "Transaction Pool" or in a diary display the following information.

· Type

· Status

· Section

· Preparer

· SSN

· Name

· English Statement

· Option (not displayed by default)

· H (History flag)

· TTC SEQ

· Certifier (not displayed by default)

· Unit of Work (not displayed by default)

Diary Listsxe "Diary Lists"
The following diary types are available:

· Regular—A regular diary consists of numerous entries that affect an individual or a group. These entries are categorized as normal, delete as erroneous, or delete/add type statements. Situational Reporting groups frequently use individual transactions and generate diary transactions through a more user-friendly interface. 

· Event—An event transaction applies to all members of a RUC except for the SSN's in the exception report. Only one event should be placed in this type of diary. 

· Accession—Accession transactions can be added to a unit diary for processing from the Student Management or Unit Diary module. After you have added a record to an available diary, you must manage those changes in the Unit Diary Managementxe "Unit Diary Management" window. This includes rejecting a transaction from a diary.

Each dairy in the list contains the following information:

· Diary Number

· Status

· Class

· Diary Date 

· Last Update

· Opened by 

Accession diaries have the following subcategories. The folder visibility is determined by the user's RUC.

· HAMS (Active)

· ECCOxe "Accession:ECCO" (Reserve)

Note: The Transactions folder under the ECCOxe "Accession:ECCO" folder contains ECCOxe "Accession:ECCO" transactions at the reserve unit and MISSA level.

· Depot (Student Management)

Note: Depot RUCs still create Accessions in the Student Management module. 

· Retiree

Each transaction in the Accession diary list contains the following information:

· Status

Note: Transmission status is displayed only to Reserve Units doing ECCOxe "Accession:ECCO" Accessions.

· Preparer

· Certifier

· SSN

· Name

Couriers

Each branch in this listview contains the individual couriers, the diary that made up the courier, and the transactions assigned to the diary. This courier treeview displays the following information:

· Diary Number

· Diary Date

· Class

· Status

· Local Status Date (Status Date in the Remote folder)

· Trans Sent

· Accepted

· Rejected

· Total Trans

· TFS Cycle

· CART Source

· MultiZip Date

· MultiZip File

Once a diary has been moved to the courier branch, you cannot open or modify the transactions or the diary.

There are two couriers tabs:

· Local—couriers on a specific diskette or from your hard drive

· Remote—couriers on the UD/MIPS Server

You can only view the Local Tab if you are logged on to the Client. You can only view the Remote Tab if you are logged on to the Server at a remote location.

This tab displays information you use to track couriers that were sent utilizing the Automated File Transfer and Reconciliation Process. Couriers display in reverse chronological order in the list. Couriers with a blank creation date display at the top of the list.

Archive

Each branch in this treeview lists the archive, the diary that made up the courier in the archive, and the transactions assigned to the diary.

· Diary Number

· Diary Date

· Class
Right Click Options for Unit Diaryxe "Right Click Options for Unit Diary"
In addition to choosing items from the menus at the top of the window, you can also use the right mouse button to choose the tasks you want to perform.

The options you select vary depending on where you click the mouse. If you are in the Transaction Tree, you will see items from the Transaction menu when you choose the right mouse button. If you have clicked in the Courier treeview, from Courier menu display.

To Exit This Window

· From the File menu, choose Close. You return to the Unit Diary frame.

Reject an Accession Diary Transaction

xe "Reject an Accession Diary Transaction"This functionality allows you to reject accession diary transactions from a diary.  Once the transaction is rejected, the recruit is automatically removed from the battalion, company, and platoon folders.  In the Student Management module, once you correct the accession data, you can assign the records back to the proper platoon prior to being added to a unit diary.

To Reject a Transaction

3. Begin on the Transactions window.

4. In the Accession Diary list, select one or more transactions you want to reject.

5. Choose Reject.  A message prompts you to confirm that you want to reject the transaction.

6. Do one of the following:

· If you want to reject the transactions, choose Yes.  The transactions are deleted from the diary and you return to the Transactions window.  

· If you do not want to reject the transactions you selected, choose No.  You return to the Transactions window.

See Also:

Accessions 

Add to Diary 

Creating a Remote ODBC Entry

xe "Creating a Remote ODBC Entry"To create an ODBC entry to access a Remote Database:

7. Select the Start button on the Windows Status Bar.  Select the Settings option, select the Control Panel.  The Control Panel window opens.

Note: For Windows NT users select Data Sources (ODBC).  For Windows 2000 users select Administrative Tools and then Data Sources (ODBC).

3. The ODBC Data Source Administrator window opens.  Select the System DSN tab.  Choose Add. The Create New Data Source window opens.

4. Select the ODBC Driver.  Choose Finish.  The Oracle8 ODBC Driver Setup window opens.

5. In the Data Source Name box, type the data source name.  (ex: RemoteUDMIPS)

6. In the Description box, type the description of the data source names.  This field is optional.

7. In the Service Name, use the name used in Setting Up the Server Connection.  The defaults used during the install is UDMIPS.

8. In the UserID box, type the user ID provided by your user manager.

9. In the remaining boxes accept all other defaults.

10. Choose OK.  You return to the ODBC Data Source window.

11. Choose OK.  You have completed the remote ODBC Configuration. 

Accessions

Create New Diary

xe "Create New Diary"This window allows you to create a new unit diary or add an Accessions diary. Only a Preparer ELSIG has the authority to create a new unit diary, and in order to add accession diaries, the login RUC must have accession privileges.

How Do I Get Here?

8. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

9. From the Transaction Tree under Diaries, select the type of diary you want to create. Do one of the following:

· From the Diary menu, choose Create New Diary. The Create New Diary window opens.

· Using the right mouse button, choose Create New Diary. The Create New Diary window opens.

OR

10. From the UD/MIPS - Navigator window, choose the DFR icon. The Diary Feedback Report Summary window opens.

11. Select the cycle with the transactions you want to put in the diary.

12. Choose Edit. The Diary Feedback Report window opens.

13. Do one of the following:

· Choose Part II Rejected Transactions tab. The Rejected Transactions tab opens.

· Choose Part III Advisory/PUREX tab. The Advisory/PUREX tab opens.

14. Choose the transaction you want to place in a new diary. The Part II Transaction Detail or the Part III Transaction Detail window opens.

15. Choose Diary Entry. The Select Diary window opens. 

16. Choose Create Diary. The Create New Diary window opens.

OR

17. From the UD/MIPS - Navigator window, choose the DFR icon. The Diary Feedback Report Summary window opens.

18. Select the cycle with the transactions you want to put in the diary.

19. Choose Edit. The Diary Feedback Report window opens.

20. Do one of the following:

· Choose Part II Rejected Transactions tab. The Rejected Transactions tab opens.

· Choose Part III Advisory/PUREX tab. The Advisory/PUREX tab opens.

21. From the available transactions, select the transactions you want to include in a volume transaction.

22. From the Tools menu, choose Create Volume Transaction. The Select Diary window opens. 

23. Choose Create Diary. The Create New Diary window opens.

OR

24. From the UD/MIPS – Navigator window, choose Tickler File. The Tickler Transaction List window opens. 

25. Choose Add to Diary. The Unit Diary Management window opens.

26. From the Diary menu, choose Create New Diary. The Create New Diary window opens.

OR

27. From the UD/MIPS – Navigator window, choose Intelligent Forms. The Intelligent Forms Selection window opens. 

28. In the Intelligent Forms Selection window, choose New. The New Record window opens.

29. Follow the instructions in the To Create a New Form section, then choose OK. The New Form window opens.

30. Choose Add to Diary. The Unit Diary Management window opens.

31. From the Diary menu, choose Create New Diary. The Create New Diary window opens.

To Create a New Diary

164. In the Number box, type the diary number if you want a number different from the default number.

165. In the Date box, type the date in YYYY/MM/DD format if you want a date different from the default date.

166. In the Class box, do one of the following:

Note: If you entered this window from the Transaction Tree, the Class type is pre-selected based upon your Transaction Tree selection.

· If you want to add an individual, situational, REDS, group, or volume transaction, select Regular.

· If you want to add an event transaction or an exclusion transaction for a RUC, select Event.

Note: If you accessed this window through the Tickler Files, Intelligent Forms or Accessions modules, this box is unavailable because only individual transactions are allowed.

· If you want to add an accessionxe "Add an Accession" diary for a RUC, select Accession. The type of accession diary you chose on the Transaction Tree is displayed but not editable.

Note: Only RUC 88888 can create a Diary under the Accession Diaries/ECCO folder.

4. If available, in the RUC list, select the desired RUC.

5. Choose OK.

· If the Class was a Regular or Event Diary, the Add Transaction window opens.

· If the Class was an Accession Diary, the diary is created. You return to the Unit Diary Management window with the diary displayed.

To Exit This Window

· Choose Close.  You return to the previous window.

See Also:

Unit Diary Transactions 

Transaction Detail 

Volume Transaction 

Transaction Import 

ECCO Accession 

HAMS Accession 

Retiree Accession 

Member Information 

Member Information

xe "Add an Accession"This window allows you to identify the member's SSN in order to initiate creation of an ECCO, HAMS, or Retiree accession transaction if your login RUC has the appropriate accession privileges.

How Do I Get Here?

2. From the UD/MIPS – Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

3. From the Transaction Tree under Accession Diaries, select the accession diary to which you want to add a transaction. Do one of the following:

· From the Transaction menu, choose New Transaction. The Member Information window opens.

· Using the right mouse button choose New Transaction. The Member Information window opens.

The following information is automatically populated, if available, for identity verification after typing the member's SSN, Reserve Component Code and Date of Enlistment, based upon the type of accession. 
· Last Name

· First Name

· Middle Initial

· Record Status 

· Reserve Record Status

To Search for Member Informationxe "Member Information"
32. Do one of the following:

· If you want a HAMS or Retiree accession, in the box, type the Member's SSN.

· If you want an ECCO accession, type the Member's SSN, Rsv Comp Code, and Enlistment Date.

33. Choose Retrieve. Do one of the following:

· If the SSN is found and the status is valid, the fields automatically populate for confirmation.

· If the SSN is not found, a warning message notifies you the SSN is not found. All fields except SSN are blank. Do one of the following:

· If you want to create a new accession record for this SSN, choose Yes. The appropriate Accession window opens with a blank record created and the default values set.

· If you want to check the SSN accuracy or enter another SSN, choose No. You stay on the Member Information window.

· If the SSN is found and the status is invalid, a warning message notifies you to contact the MISSO because the SSN has been found with an Invalid Status. 

Note: For a valid status the Record Status must equal E or null and the Reserve Record Status must equal 9 or null.

34. Do one of the following:

· If the SSN is found and the status is valid, choose Continue. The appropriate Accession window opens with a record created, fields populated if available, and the default values set.

· If the SSN is not found and you want to create a new accession record for this SSN, choose Continue. The appropriate Accession window opens with a blank record created and the default values set.

Note: If the SSN is found and the status is invalid, the Continue button is unavailable.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

See Also:

ECCO Accession 

HAMS Accession 

Retiree Accession 

HAMS Accession

xe "Add an Accession"

xe "Accession:HQMC"xe "HAMS Accession"This window allows you to create a Headquarters Officer or Enlisted accession record if you are in an authorized login RUC or the Headquarters RUC.

How Do I Get Here?

35. From the UD/MIPS – Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

36. From the Transaction Tree under Accession Diaries, select the HAMSxe "Accession:HAMS" accession diary to which you want to add transactions.

Note: If you need to create the diary, see Create New Diary.

37. Do one of the following:

· From the Transaction menu, choose New Transaction. The Member Information window opens.

· Using the right mouse button choose New Transaction from the list. The Member Information window opens.

38. Complete the steps in the Member Information topic using Login RUC privileges for Active accessions. The HAMS Accession window opens.

To Enter/Change the Accession Data

If the member's data resides on the ODSE database, various fields in the accession record are automatically populated from the ODSE DB and are editable unless indicated otherwise.

The dates cannot be future dates or greater than the diary date except for the following: EAS, Enlisted Expiration Obligated Service, Officer Service from Date, Officer Date Accepted 1st Commission, Officer Date of Rank 1st Commission.

39. Under Member ID
i) In the SSN box, the member's Social Security Number is automatically populated. It is not editable.

j) In the Last Name box, type the member's last name (up to 20 characters not including spaces, hyphens, numbers or special characters).

k) If applicable, in the Cadency box select the code and description representing the member's cadency.

l) In the First Name box, type the member's first name (at least one alphabetic character and up to 20 characters).

m) If applicable, in the Middle Name box, type the member's middle name (at least one alphabetic character and up to 20 characters).

40. Under Member Information
n) In the Sex box, select the member's sex code. 

o) In the Race box, select the code and description representing the member's race. 

p) In the Race Aggregate box, select the code representing the member's race.

q) In the Ethnic Code box, select the code and description representing the member's ethnic group.

r) In the Religion box, select the code and description representing the member's religion.

s) In the Date Of Birth box, type the member's birth date in YYYY/MM/DD format. The member's age must be 17 or greater.

t) In the PEBD box, type the member's pay entry base date in YYYY/MM/DD format. 

u) In the DOEAF box, type the date the member entered the armed forces in YYYY/MM/DD format. If automatically populated, it is not editable.

v) In the Present Grade Code box, select the code and description representing the member's current rank.

w) In the Present Grade Effective Date box, type the date the member's current rank is effective in YYYY/MM/DD format.

x) In the Date of Rank box, type the date the member's rank was established in YYYY/MM/DD format.

y) In the Primary MOS Code box, select the member's primary military occupational specialty code and description.

z) In the Primary MOS Assignment Date box, type the date on which the primary military occupational specialty was assigned in YYYY/MM/DD format. 

aa) In the Component Code box, select the member's component code and description. The default value is 11.

ab) In the Citizenship Code box, select the code and description representing the member's citizenship.

ac) In the Source of Entry box, type the member's current source of entry.

ad) In the Future MCC box, select the member's future monitored command code and description.

ae) In the Present Reporting Unit Code box, the default value is the login RUC. It is not editable.

af) In the Current Active Dutyxe "Accession:Active Duty" Began Date box, type the date on which the member's current active dutyxe "Accession:Active Duty" began in YYYY/MM/DD format.

ag) In the Current Tour Begin Date box, type the begin date of the member's current tour in YYYY/MM/DD format. 

ah) In the Date of Enlistment box, type the member's enlistment date in YYYY/MM/DD format. 

ai) In the EAS box, type the expiration date of the member's active service in YYYY/MM/DD format. If the member is an Officer, this field is unavailable only if the Component Code equals '11'. 

41. Under Home of Record
aj) In the State/Country box, select the code and description representing the state of the member's legal residence at the time of enlistment.

ak) In the County box, select the code and description representing the county of the member's legal residence at the time of enlistment. If State/Country equals "01" through "59", County Code is required.

al) If applicable, in the City box, type the four-digit number of the city of the member's legal residence at the time of enlistment. The value '0000' is acceptable.

42. Do one of the following:

Depending upon what Present Grade Code you select in the Member Information box, either the Enlisted Service or the Officer Service box displays:


If the Present Grade Code is E9 or less, the Enlisted Service box displays:

am) In the Term of Enlistment box, select the number of years of the member's term of enlistment.

an) If applicable, in the EFT Select Indicator Code box type the member's electronic file transfer indicator code.

ao) In the Armed Forces Act Du Base Date, type the date the member started active dutyxe "Accession:Active Duty" in YYYY/MM/DD format. 

ap) In the Expiration Obligated Service box, type the member's End of Obligated Service date in YYYY/MM/DD format.

· If the Present Grade Code is greater than E9, the Officer Service box displays:

aq) In the Contract Legal Agreement box, select the officer's contract/legal agreement code and description.

ar) In the Officer Service from Date box, type the officer's active dutyxe "Accession:Active Duty" base date in YYYY/MM/DD format.

as) In the Date Accepted 1st Commission box, type the date on which the officer accepted the first commission in YYYY/MM/DD format. If automatically populated, it is not editable.

at) In the Date of Rank 1st Commission box, type the date on which the officer's first commission date of rank was effective in YYYY/MM/DD format. If automatically populated, it is not editable.

43. Under Civilian Education
au) In the Level Code box, select the code and description that corresponds to the member's level of education.

av) In the Certificate Code box, select the code and description of the highest education certificate the member has received.

aw) In the Major Subject Code box, select the code and description of the major study area performed by the member.

ax) In the Left School Year box, type the 4-digit year the member left the school.

ay) In the Graduation Code box, select the code to indicate whether the member graduated.

44. Under Status, do one of the following:

· If you are a Preparer and you want to verify that the accession data is valid, complete the steps in the To Finalize Accession Data section later in this topic. 

· If you are a Certifier and you want to review the accession data for certification, follow the steps in the To Certify Accession Transaction Data later in this topic.

To Save Unverified Data

You may save changes at any time during input. If a field has invalid data, a warning message displays when leaving that field. You are allowed, however, to save the data as typed. Then you can research the data, if needed, but also retain what you have already entered.

45. Under Status, select the Open check box. Choose OK. A message prompts you to verify that you want to save your changes.

46. Do one of the following:

· If you want to save your changes, choose Yes. Your changes are updated and you return to the Unit Diary Management window.

· If you do not want to save your changes, choose No. Your changes are not updated and you return to the Unit Diary Management window.

To Finalize Accession Data

All required fields must contain valid data for successful verification. The first field not meeting validation is automatically selected and must be corrected to pass validation before the next invalid field is automatically selected. This continues until no error conditions exist.

47. Under Status, select the Finalized check box. Choose OK. A message prompts you to save the changes.

48.  Do one of the following:

· If you want to save your changes, choose Yes. The transaction status is changed to Finalized and you return to the Unit Diary Management window.

· If you do not want to save your changes, choose No. The transaction status remains Open and you return to the Unit Diary Management window.

To Certify Accession Transaction Data

This option is available for Certifier ELSIGs only.

49. Do one of the following:

· If you want to certify the accession, do one of the following:

· If you want to certify the individual transaction, follow the steps in the Transaction Status/Notes topic. Only the transaction status is changed to Certified.

· If you want to certify the diary and all corresponding transactions, follow the steps in the Diary Status/Notes topic.

· If you want to indicate that the accession is not ready for certification, from the Status box, choose the Open check box. The transaction status returns to Open.

12. Choose OK. You return to the Unit Diary Management window.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

See Also

Create New Diary 

ECCO Accession 

Retiree Accession 

ECCO Accession

xe "Accession:HQMC"

xe "Add an Accession"

xe "Transmit ECCO Accession"This window allows you to create a Reservexe "Accession:Reserve" accession if you are using an authorized login RUC or the Headquarters RUC.

ECCOxe "Accession:ECCO" Accessions are input and processed in UD/MIPS at the Reservexe "Accession:Reserve" unit and sent to a collection serverxe "Collection Server".

Note: This option is currently not available to the standalone user because it requires a UD/MIPS Server. Collection serverxe "Collection Server" access from the local MISSO is also necessary.

MISSO 17 retrieves Reservexe "Accession:Reserve" Accession records from the collection serverxe "Collection Server" to formulate and certify a diary and make the courier. 

The ECCOxe "Accession:ECCO" accessions for these RUCs are created under the Accession Diaries\ECCO\Transactions folder on the Unit Diary Management window. RUC 88888 can access Reservexe "Accession:Reserve" and Enlisted. RUC 88888 is the only RUC that can create a diary under the Accession Diaries\ECCO folder on the Unit Diary Management window. Other RUCs with Reservexe "Accession:Reserve" Accession privileges can access those with Present Grade Code less than or equal to E9S. Headquarters RUC 89999 can only create Transactions under the Accession Diaries\ECCO\Transactions folder. RUC 89999 can also transmit a Reservexe "Accession:Reserve" Accession.

How Do I Get Here?

4. From the UD/MIPS – Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

5. Do one of the following:

· From the Transaction Tree under Accession Diaries, then ECCO, select Transactions.

· If your RUC is 88888, do one of the following:

· If you need to create the diary, see Create New Diary.

· From the Transaction Tree under Accession Diaries, then ECCO, select the diary to which you want to add transactions.

· From the Transaction Tree under Accession Diaries, then ECCO, select Transactions.

6. Do one of the following:

· From the Transaction menu, choose New Transaction. The Member Information window opens.

· Using the right mouse button, choose New Transaction from the list. The Member Information window opens.

7. Complete the steps in the Member Information topic using Login RUC privileges for Reservexe "Accession:Reserve" accessions. The ECCO Accession window opens.

To Enter/Change the Accession Data

If the member's data resides on the ODSE database, various fields in the accession record are automatically populated from the ODSE DB and are editable unless indicated otherwise.

The dates cannot be future dates or greater than the diary date except for the following: Reservexe "Accession:Reserve" ECC, Exp Obligated Svc, Anniversary Date.

50. Under Member ID
If ECCOxe "Accession:ECCO" Member ID fields are automatically populated, they are not editable.

a) In the SSN box, the member's Social Security Number is automatically populated. It is not editable.

b) In the Last Name box, type the member's last name (up to 20 alphabetic characters not including spaces, hyphens, numbers or special characters). 

c) If applicable, in the Cadency box select the code and description of member's cadency.  

d) In the First Name box, type the member's first name (at least one alphabetic character and up to 20 characters).   

e) If applicable, in the Middle Name box type the member's middle name (at least one alphabetic character and up to 20 characters). 

51. Under Member Information
f) In the Sex box, select the sex code. If automatically populated, it is not editable. 

g) In the Race box, select the code and description of the member's race. If automatically populated, it is not editable. 

h) In the Ethnic Code box, select the code and description of the member's ethnic group. If automatically populated, it is not editable. 

i) In the Race Aggregate box, select the code and description of the member's race.

j) In the Religion box, select the code and description of the member's religion.

k) In the Date of Birth box, type the member's birth date in YYYY/MM/DD format. The member's age must be 17 or greater. If automatically populated, it is not editable. 

l) In the Birth State/Country box, select the state code and description of the member's place of birth. If automatically populated, it is not editable. 

m) In the Marital Status box, select the code and description of the member's marital status.

n) In the # of Dependents box, type the member's number of dependents.

o) In the Present Rank box, select the code and description of the member's current rank. If automatically populated, it is not editable. 

p) In the Reserve Comp Code box, select the member's Reservexe "Accession:Reserve" component code and description.

q) The Date of Enlistment box is automatically populated from the Member Information window. It is not editable.

r) In the Term of Enlistment box, select the number of years of the member's term of enlistment. 

s) In the Date Of Rank box, type the date the member's rank was established in YYYY/MM/DD format. The default value is zeroes. 

t) In the Primary MOS box, select the primary military occupational specialty code and description.

u) In the PMOS Assignment Dt box, type the date the primary military occupational specialty was assigned. The default value is zeroes

v) In the Billet MOS box, select the billet military occupational specialty code and description.

w) In the Source of Entry box, type the member's current source of entry code.

x) In the Pay Entry Base Date box, type the member's pay entry base date in YYYY/MM/DD format. The default value is zeroes. 

y) If available, in the Reservexe "Accession:Reserve" ECC box, type the date the Reservexe "Accession:Reserve" current contract expires in YYYY/MM/DD format. 

z) In the Reservexe "Accession:Reserve" RUC box, select the member's Reservexe "Accession:Reserve" reporting unit code. The default value is the login RUC.

aa) In the Date Joined SMCR box, type the date the member joined the Reservexe "Accession:Reserve" Forces. 

ab) In the DOEAF box, type the date the member entered the Armed Forces in YYYY/MM/DD format. If automatically populated, it is not editable.

ac) In the Exp Obligated Svc box, type the Expiration of Obligated Service date in YYYY/MM/DD format. 

ad) In the Duty Limit box, select the code and description representing a limit of member's duty. The default value is zero. If automatically populated, it is not editable.

52. Under Misc 

ae) If applicable, in the AFQT ID box type the Armed Forces Qualification Test identification number. Zero zero zero is the default value. If automatically populated, it is not editable. 

af) If applicable, in the AFQT Score box type the Armed Forces Qualification Test score. Zero zero is the default value. If the AFQT ID has a 000 value, AFQT Score is unavailable unless a non-zero ID is entered. If automatically populated, it is not editable. 

ag) If applicable, in the Regular PEF Code box, select the code and description of the program for which the member enlisted. The default value is zero zero.

ah) In the Physical Risk Code box, select the risk code and description. The default value is A.

ai) In the Initial Entry Rsv Forces box, type the date the member first entered the Reserves. If automatically populated, it is not editable.

aj) In the Training Group box, type the member's training group. If automatically populated, it is not editable.

ak) In the Anniversary Date box, type the member's anniversary date. If automatically populated, it is not editable. 

Note:  This field is visible to MISSA only.

al) In the Citizenship Geo Loc Code box, select the geographical location code and description representing the member's citizenship.

am) In the Citizenship Code box, select the member's citizenship code and description. If the Citizenship Geo Loc Code equals US, the default value is CA.

53. Under Current Address
az) In the Street box, type the street address at which the member currently resides (up to 30 characters).

ba) In the City box, type the city in which the member currently lives (up to 30 characters).

bb) In the State box, select the code of the state in which the member currently resides.

bc) In the Zip Code box, type the five-digit or nine-digit zip code of the member's current residence.

54. Under Civilian Education
bd) In the Level Code box, select the code and description that corresponds to the member's level of education.

be) In the Certificate Code box, select the code and description of the highest education certificate the member has received.

bf) In the Major Subject box, select the code and description of the major study area performed by the member.

bg) In the Left School Year box, type the four-digit year the member left the school.

bh) In the Graduation Code box, select the code to indicate whether the member graduated.

55. Under Home of Record
bi) In the State/Country Code box, select the state code and description of the member's legal residence at the time of enlistment.

bj) In the County Code box, select the code and description of the county of the member's legal residence at the time of enlistment. If State/Country equals "01" through "59", County Code is required.

56. Under Status, do one of the following:

· If you are a Preparer and you want to verify that the accession is valid, complete the steps in the To Finalize Accession Data section later in this topic.

· If you are a Certifier and you want to indicate the accession data has been reviewed, follow the steps in the To Review Accession Data later in this topic.

To Save Unverified Data

You may save changes at any time during input. If a field has invalid data, a warning message displays when leaving that field. You are allowed, however, to save the data as typed. Then you can research the data, if needed, but also retain what you have already entered.

Note: The record is not available for transmission to the Collection Serverxe "Collection Server" until it has been successfully finalized and reviewed.

57. Under Status, select the Open check box. Choose OK. A message prompts you to verify that you want to save your changes.

58. Do one of the following:

· If you want to save your changes, choose Yes. Your changes are updated and you return to the Unit Diary Management window.

· If you do not want to save your changes, choose No. Your changes are not updated and you return to the Unit Diary Management window.

To Finalize Accession Data

All required fields must contain valid data prior to being forwarded to the Collection Serverxe "Collection Server". The first field not meeting validation is automatically selected and must be corrected to pass validation before the next invalid field is automatically selected. This continues until no error conditions exist.

59. Under Status, select the Finalized check box. Choose OK. A message prompts you to save the changes.

60. Do one of the following:

· If you want to save your changes, choose Yes. Your changes are updated and you return to the Unit Diary Management window.

· If you do not want to save your changes, choose No. Your changes are not updated and you return to the Unit Diary Management window.

To Review Accession Data

The accession data must be reviewed prior to being forwarded to the Collection Serverxe "Collection Server". This option is available for Certifier ELSIGs only.

61. Do one of the following:

· If you want to indicate that the accession is ready to be forwarded to the Collection Serverxe "Collection Server", from the Status box, select the Reviewed check box.

· If you want to indicate the accession is not ready, from the Status box, select the Open check box. 

62. Choose OK. You return to the Unit Diary Management window.

To Transmit the ECCOxe "Accession:ECCO" Accessionxe "ECCO Accession"
After the ECCOxe "Accession:ECCO" Accessionxe "ECCO Accession" is finalized and reviewed successfully, you can transmit the ECCOxe "Accession:ECCO" Accessionxe "ECCO Accession" to the collection serverxe "Collection Server" for processing by the MISSO. If your unit preferences do not include transfer capability but your unit functions include transmit, you can also export an .acc zipped file to the drive of your choice.

Note: The Transmit option is currently not available to the standalone user. Otherwise, request server access from the local MISSO.

This option is available for Certifier ELSIGs only.

63. Follow the steps in the Preferences topic, To Schedule Events section.

64. Do one of the following:

· Choose Transmit. Do one of the following:

· A status message notifies you that some SSNs will not be transmitted due to status. Choose OK. You return to the Unit Diary Management window.

· A message notifies you that the accessions will be transmitted to the Collection Serverxe "Collection Server" in fifteen minutes. Do one of the following:

· If you want to continue, choose Yes. The Reservexe "Accession:Reserve" Accession is forwarded to the Collection Serverxe "Collection Server". You return to the Unit Diary Management window.

· If you do not want to transmit the accession, choose No. You return to the Unit Diary Management window.

OR

· See the Unit Diary Transactions, To Transmit an ECCOxe "Accession:ECCO" Accessionxe "ECCO Accession" section.

OR

· See your local MISSO to upload ECCOxe "Accession:ECCO" Accessionxe "ECCO Accession" Couriers via C-List.

OR

· If you want to export a zipped file to a specified drive, choose Export. The Save As window opens. Follow the procedures in the To Export an Accession section. A zipped .acc file is written to the drive of your choice. 

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

See Also

Create New Diary 

HAMS Accession 

Retiree Accession 

Retiree Accession

xe "Accession:HQMC"

xe "Add an Accession"This window allows you to create a Retireexe "Accession:Retiree" Accessionxe "Retiree Accession". Your login RUC must be a Headquarters RUC or a RUC with authorization to process Retireexe "Accession:Retiree" accessions.

How Do I Get Here?

8. From the UD/MIPS – Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

9. From the Transaction Tree under Accession Diaries, select the Retireexe "Accession:Retiree" Accession diary to which you want to add transactions.

Note: If you need to create the diary, see Create New Diary.

10. Do one of the following:

· From the Transaction menu, choose New Transaction. The Member Information window opens.

· Using the right mouse button choose New Transaction from the list. The Member Information window opens.

11. Complete the steps in the Member Information topic using Login RUC privileges for Retireexe "Accession:Retiree" accessions. The Retiree Accession window opens.

To Enter/Change the Accession Data

If the member's data resides on the ODSE database, various fields in the accession record are automatically populated from the ODSE DB and are editable unless indicated otherwise.

The dates cannot be future dates or greater than the diary date.
65. Under Member ID
h) In the SSN box, the member's Social Security Number is automatically populated. It is not editable.

i) In the Last Name box, type the member's last name (up to 20 alphabetic characters not including spaces, hyphens, numbers or special characters).

j) If applicable, in the Cadency box select the code and description representing the member's cadency.

k) In the First Name box, type the member's first name (at least one alphabetic character and up to 20 characters).

l) If applicable, in the Middle Name box type the member's middle name  (at least one alphabetic character and up to 20 characters).

13. Under Member Information
bk) In the Sex box, select the code representing the member's sex.

bl) In the Race box, select the code and description representing the member's race.

bm) In the Primary MOS box, select the primary military occupational specialty code and description.

bn) In the PMOS Assignment Date box, type the date the primary military occupational specialty was assigned in YYYY/MM/DD format.

bo) In the Pay Entry Base Date box, type the member's pay entry base date in YYYY/MM/DD format.

bp) In the Date Of Birth box, type the member's birth date in YYYY/MM/DD format. The member's age must be 17 or greater.

bq) In the Ethnic Code box, select the code and description representing the member's ethnic group.

br) In the Race Aggregate box, select the code representing the member's race group.

bs) In the Reserve Component Code box, select the member's Reserve component code and description. The only allowable values are A1, A8, A9 or AR.

bt) In the Present Grade Code box, select the code and description representing the member's current rank.

bu) In the Date of Rank box, type the date the member's rank was established in YYYY/MM/DD format.

bv) In the Marital Status box, select the code and description representing the member's marital status.

bw) In the DOEAF box, type the date the member entered the Armed Forces in YYYY/MM/DD format. If automatically populated, it is not editable.

bx) In the Retired Date box, type the date the member retired in YYYY/MM/DD format. 

by) In the Reserve RUC box, select the member's Reserve reporting unit code and description.

bz) In the Duty Limit box, select the code and description representing a limit of member's duty. The default value is zero.

6. Under Home of Record
an) In the State/Country Code box, select the state code and description representing the member's legal residence at time of enlistment.

ao) In the County Code box, select the code and description representing the county of the member's legal residence at time of enlistment. If State/Country equals "01" through "59", County Code is required.

ap) If applicable, in the City Code box, type the four-digit number of the city of the member's legal residence at the time of enlistment. The value '0000' is acceptable.

7. Under Current Address
a) In the Street box, type the street address at which the member currently resides (up to 30 characters).

b) In the City box, type the city in which the member currently lives (up to 30 characters).

c) In the State/Country Code box, select the code and description of the state in which the member currently resides.

d) In the Zip Code box, type the nine-digit zip code of the member's current residence.

8. Under Status, do one of the following:

· If you are a Preparer and you want to verify that the accession data is valid, complete the steps in the To Finalize Accession Data section later in this topic.

· If you are a Certifier and you want to review the accession data for certification, follow the steps in the To Certify Accession Transaction Data later in this topic.

To Save Unverified Data

You may save changes at any time during input. If a field has invalid data, a warning message displays when leaving that field. You are allowed, however, to save the data as typed. Then you can research the data, if needed, but also retain what you have already entered.

66. Under Status, select the Open check box. Choose OK. A message prompts you to verify that you want to save your changes.

67. Do one of the following:

· If you want to save your changes, choose Yes. Your changes are updated and you return to the Unit Diary Management window.

· If you do not want to save your changes, choose No. Your changes are not updated and you return to the Unit Diary Management window.

To Finalize Accession Data

All required fields must contain valid data for successful verification. The first field not meeting validation is automatically selected and must be corrected to pass validation before the next invalid field is automatically selected. This continues until no error conditions exist.

68. Under Status, select the Finalized check box. Choose OK. A message prompts you to save the changes.

69.  Do one of the following:

· If you want to save your changes, choose Yes. Your changes are updated and you return to the Unit Diary Management window.

· If you do not want to save your changes, choose No.  Your changes are not updated and you return to the Unit Diary Management window.

To Certify Accession Transaction Data

This option is available for Certifier ELSIGs only.

70. Do one of the following:

· If you want to certify the accession, do one of the following:

· If you want to certify the individual transaction, follow the steps in the Transaction Status/Notes topic. Only the transaction status is changed to Certified.

· If you want to certify the diary and all corresponding transactions, follow the steps in the Diary Status/Notes topic.

· If you want to indicate that the accession is not ready for certification, from the Status box, choose the Open check box. The transaction status returns to Open.

71. Choose OK. You return to the Unit Diary Management window.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

See Also

Create New Diary 

HAMS Accession 

ECCO Accession 

Validation Report

xe "Validation Audit Report"

xe "Validation Report"

xe "Accession Validation Report"This window allows you to view or print validation reports for ECCO, HAMS, or Retiree accessions.

How Do I Get Here?

1. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

2. From the Reports menu, choose Validation Report. The Select Diary window opens.

3. Follow the steps in the To Select an Existing Accession Diary section. The Validation Report window opens.

This window contains the following information:

Report Heading

· Title (Validation Audit Report)

· Reporting Unit Code

· Date

Column Headings

· Last Name

· First Name

· Middle Initial

· Social Security Number

· Component Code

· Rank

· Date of Birth

· Date of Rank

· Term of Enlistment

· Source of Entry

· Pay Entry Base Date

· Date of Enlistment

· Regular Program Enlisted For

To Print a Report

· Choose Print.

To Exit this Window

· Chose Close. You return to the Unit Diary Management window.

Inbound Roster Report

xe "Inbound Roster Report"This report displays members in the Inbound in alphabetical order by last name that are ready to be validated with having to go through every record.

How Do I Get Here?

167. Begin on the Officer Accession window.

168. From the Reports menu, choose Inbound Report.  The Inbound Roster Report displays.

The following information displays:

Roster Heading

· Title (Inbound Roster)

· Date

· RUC (Reporting Unit Code)

· Page X of Y

Column Headings

· Social Security Number

· Name

· Sex

· Company

· Platoon

· Status

Footer

· Total Number of Records

To Print This Report

· Choose Print.  The Inbound Roster report prints.

To Exit This Window

· Choose Close.  You return to the Accessions window.

See Also:

Accession Reports 

Situational Reporting

Situational Reporting

This window allows you to create Unit Diary transactions that use preformatted reporting schemes for specific situations. 

You can also create your own additional reporting schemes and make notes about the transactions without leaving the diary.

Where applicable, transaction fields are populated with data from the CUDDB and updated with previously entered data from the open unit diary. This window also repopulates TTC prompts with CUDDB data to enable you to determine if an entry should be changed. 

When you have completed setting up a transaction, in the Type column of the Unit Diary Management window, UD/MIPS assigns a three-digit number value after the SITREP prefix.

How Do I Get Here?

4. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

5. Select an open Regular Open Unit Diary or the Transaction Pool.

6. From the Transaction menu, choose New Transaction. The Add Transaction window opens.

7. Select Situational Transaction. 

8. Choose OK. The Situational Reportingxe "Situational Reporting" window opens.

To Select A Member Account

· Do one of the following:

· In SSN box, type the member's SSN. The member's account displays below. 

· Choose Members. The Search window opens.

To Select a Reporting Option

· In the options list, select one of the following:

· Dependents: Allows you to add or remove dependents. 

· Join (active users only): Allows you to join a new member to their unit based on a specific join situation.

· FAP/TAD (active users only): Allows you to select transactions from a pre-formatted list that contains the most relevant transactions in relation either to TAD, FAP, or to attachment.

· REDS: A sample user-defined scheme that can be modified or deleted.

To Enter a Transaction History Statement

· If you want to type a note about the transaction without leaving the diary, from any transaction, choose the history button, usually placed after each [TTC/SEQ] designation with two dots [..]. The Transaction History Statement window opens. 

To Exit This Window

· Choose Close. You return to the Unit Diary Management window.

DEPENDENT (Active or Reserve) Situational

This window allows you to add or remove dependents from Situational Transactions.

How Do I Get Here?

9. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

10. Select an open Regular Open Unit Diary or the Transaction Pool.

11. From the Transaction menu, choose New Transaction. The Add Transaction window opens.

12. Select Situational Transaction. 

13. Choose OK. The Situational Reporting window opens.

14. Do one of the following:

· In SSN box, type the member's SSN 

· Choose Members. The Search window opens.

Note: If the SSN is entered without a preceding service code, the SSN Error dialog box will display a notification that the SSN is incomplete.  If the SSN isn't found in the CUDDB, the SSN Not Found in CUDDB dialog box appears and the user is allowed to enter the individual's last name and initials. 

15. In the Reporting Option list, choose Dependent. The Dependent (Active or Reserve) Situationalxe "DEPENDENT (Active or Reserve) Situational" window opens. 

A list of the Dependents folders and group icons (arrowed folders) appears on the left of the window. Yellow file folders indicate system-defined Groups. Green file folders indicate user-defined Groups.

Clicking on a group icon will reveal additional lists related to the group icon subject matter. Bold text appearing in the list indicates a pending transaction in the current diary. 

Consult the MCTFSPRIM (www.missa.manpower.usmc.mil) to determine what to enter for each transaction. Some transactions are not available to all users and will be disabled if not available for your RUC.

When you have completed setting up a transaction, in the Type column of the Unit Diary Management window, UD/MIPS assigns a three-digit number value after the SITREP prefix.

Note: Date of Action defaults to the diary date and is located at the lower right hand corner of each transaction group box.  Date of Action is editable via the Edit DOA button.

To Save Changes

· Choose Save. The changes are saved.

To Edit the Date of Action

16. Choose Edit DOA. The Edit DOA button now reads Edit Trans. All other fields in the window are now write protected except for DOA.

17. In the DOA box, type the new date.

18. To return to the transaction, chose Edit Trans. You can now edit the other fields.

To Restore Field Values to the Last Save

· Choose Reset. The fields return to the values before the last save, not the default values.

Note: Moving to another folder commits any entered data as a pending transaction and bold the folder text in the list. A message prompts you to confirm each time you modify a page that creates a transaction. 

Dependent Add/Loss:

This option is available from the Dependents Situational Reporting window and enables the user to modify a member's dependent information.

When the Dependent Add/Loss page first displays, it is populated with the member's current CUDDB dependent information.  From this page, dependent information can be added, deleted, or changed.  

When the Dependent Add/Loss page is displayed after modifications have been made in the open Unit Diary, it is populated with the member's current CUDDB dependent information as it will appear after applying the dependent transactions on the open unit diary.  

Add a dependent.  Tab to or click an available dependent line (all fields are blank or zero-filled) in the Relationship field.  A drop down list of available relationship entries appears. You may select and enter the desired relationship code or type the code in the field.  A valid date that is not future-dated is required for the Date of Birth field.  Enter the County, State, and City codes.

Delete a dependent. Tab to or click an available dependent line (all fields are blank or zero-filled) in the Relationship field. A drop down list of available relationship entries appears. You may select and enter the desired relationship code or type the code in the field for a reason loss code. A valid date that is not future-dated is required for the Date of Birth field. Enter the County, State, and City codes.

Change a dependent.  Tab to or click in the field you want to change.  Select the appropriate code from the drop down list for the Relationship field or type over the current data with the change data.

Number of transactions.  Adding a dependent results in one new transaction on the open unit diary. Deleting a dependent results in one new transaction on the open unit diary.

Moving to another folder commits any entered data as a pending transaction and bold the folder text in the list.  A message prompts you to confirm each time you modify a page, which creates a transaction.  
To Exit This Window

· Choose Close. You return to the Unit Diary Management window.

See also:

Situational Reporting 

JOIN (Active or Reserve) Situational

 This window allows you to select transactions from a pre-formatted list that contains the most relevant transactions in relation either to Active or Reserve Joins or to attachments.

How Do I Get Here?

19. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

20. Select an open Regular Open Unit Diary or the Transaction Pool.

21. From the Transaction menu, choose New Transaction. The Add Transaction window opens.

22. Select Situational Transaction. 

23. Choose OK. The Situational Reporting window opens.

24. Do one of the following:

· In SSN box, type the member's SSN 

· Choose Members. The Search window opens.

Note: If the SSN is entered without a preceding service code, the SSN Error dialog box will display a notification that the SSN is incomplete. If the SSN isn't found in the CUDDB, the SSN Not Found in CUDDB dialog box appears and the user is allowed to enter the individual's last name and initials. 

25. In the Reporting Option list, choose Join. The JOIN (Active or Reserve) Situationalxe "JOIN (Active or Reserve) Situational" window opens. 

A list of the FAP/TAD lists and group icons (arrowed folders) appears on the left of the window.  Yellow file folders indicate system-defined Groups. Green file folders indicate user-defined Groups.  

Clicking on a group icon reveals additional lists related to the group icon subject matter. Bold text appearing in the list indicates a pending transaction in the current diary. 

Information requested is as indicated below:

Moving to another folder commits any entered data as a pending transaction and bolds the folder text in the list. A message prompts you to confirm each time you modify a page that could change a transaction.

Consult the MCTFSPRIM (www.missa.manpower.usmc.mil) to determine what to enter for each transaction. Some transactions are not available to all users and are disabled if not available for your RUC.

When you have completed setting up a transaction, in the Type column of the Unit Diary Management window, UD/MIPS assigns a three-digit number value after the SITREP prefix.

Note: Date of Action defaults to the diary date and is located at the lower right hand corner of each transaction group box.  Date of Action is editable via the Edit DOA button.

To Save Changes

· Choose Save. The changes are saved.

To Edit the Date of Action

26. Choose Edit DOA. The Edit DOA button now reads Edit Trans. All other fields in the window are now write protected except for DOA.

27. In the DOA box, type the new date.

28. To return to the transaction, choose Edit Trans. You can now edit the other fields.

To Restore Field Values to the Last Save

· Choose Reset. The fields return to the values before the last save, not the default values.

Note: Moving to another folder commits any entered data as a pending transaction and bold the folder text in the list. A message prompts you to confirm each time you modify a page that creates a transaction. 

To Exit This Window

· Choose Close. You return to the Unit Diary Management window.

See also:

Situational Reporting 

FAP/TAD Situational

This window allows you to select transactions from a pre-formatted list that contains the most relevant transactions in relation either to TAD, FAP, or to attachments.
How Do I Get Here?

29. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

30. Select an open Regular Open Unit Diary or the Transaction Pool.

31. From the Transaction menu, choose New Transaction. The Add Transaction window opens.

32. Select Situational Transaction. 

33. Choose OK. The Situational Reporting window opens.

34. Do one of the following:

· In SSN box, type the member's SSN 

· Choose Members. The Search window opens.

Note: If the SSN is entered without a preceding service code, the SSN Error dialog box will display a notification that the SSN is incomplete. If the SSN isn't found in the CUDDB, the SSN Not Found in CUDDB dialog box appears and the user is allowed to enter the individual's last name and initials. 

35. In the Reporting Option list, choose FAP. The FAP/TAD Situationalxe "FAP/TAD Situational" window opens. 

A list of the FAP/TAD lists and group icons (arrowed folders) appears on the left of the window.  Yellow file folders indicate system-defined Groups.  Green file folders indicate user-defined Groups.  

Selecting a group icon reveals additional lists related to the group icon subject matter. Bold text appearing in the list indicates a pending transaction in the current diary. 

Information requested is as indicated below:

Moving to another folder commits any entered data as a pending transaction and bold the folder text in the list. A message prompts you to confirm each time you modify a page that could change a transaction. 

Consult the MCTFSPRIM (www.missa.manpower.usmc.mil) to determine what to enter for each transaction. Some transactions are not available to all users and are disabled if not available for your RUC.

When you have completed setting up a transaction, in the Type column of the Unit Diary Management window, UD/MIPS assigns a three-digit number value after the SITREP prefix.

Note: Date of Action defaults to the diary date and is located at the lower right hand corner of each transaction group box.  Date of Action is editable via the Edit DOA button.

To Save Changes

· Choose Save. The changes are saved.

To Edit the Date of Action

36. Choose Edit DOA. The Edit DOA button now reads Edit Trans. All other fields in the window are now write protected except for DOA.

37. In the DOA box, type the new date.

38. To return to the transaction, chose Edit Trans. You can now edit the other fields.

To Restore Field Values to the Last Save

· Choose Reset. The fields return to the values before the last save, not the default values.

Note: Moving to another folder commits any entered data as a pending transaction and bold the folder text in the list. A message prompts you to confirm each time you modify a page that creates a transaction. 

To Exit This Window

· Choose Close. You return to the Unit Diary Management window.

See Also:

Situational Reporting 

Situational Maintenance

Situational Maintenance

This window allows you to create a customized reporting situation for your use by adding, deleting and copying user-defined schemes, groups, and lists. Situational maintenancexe "Situational Maintenance" also gives you the flexibility to export a scheme and its treeview to other PCs or import a scheme created by another user. Installation schemes, groups, and lists are system-supplied elements that cannot be modified or deleted. 

Note: Although it is similar in appearance to the Situational Reporting window, you cannot add, edit, or delete a diary transaction in this window.

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the Unit Diary icon. The Unit Diary Management window opens.

2. From the Tools menu, select Situational Tools, and then choose Open. The Situational Maintenance window opens.

OR

3. Begin in the Transaction Detail window. 

4. From the Tools menu, select Situational Tools, and then choose Open. The Situational Maintenance window opens.

To Create a New Scheme, Group, or List

· From the treeview, select New, and then choose Scheme, Group, or List. Follow the instructions in the New Scheme/Group/List topic.

To Copy a Scheme, Group, or List

· From the treeview, select Copy, and then choose Scheme, Group, or List. Follow the instructions in the Copy Scheme/Group/List topic.

To Rename a Scheme, Group, or List

· From the treeview, select Rename, and then choose Scheme, Group, or List. Follow the instructions in the Rename Scheme/Group/List topic.

To Delete a Scheme, Group, or List

· From the treeview, select Delete, and then choose Scheme, Group, or List. Follow the instructions in the Delete Scheme/Group/List topic.

To Import a Scheme

· From the treeview, select Import. Follow the instructions in the Import Scheme topic.

To Export a Scheme

· From the treeview, select Export. Follow the instructions in the Export Scheme topic.

To Exit This Window

· Choose Close. You return to the Unit Diary Management window.

New Scheme/Group/List

This window allows you to add a user-defined scheme, group or list to your UD/MIPS application.  You cannot modify the Installation Scheme, Group or List, but you can add a group or list to a copy of an Installation Scheme.  

· Adding a scheme will add your user-defined scheme in alphabetical order to the situation list. 

· Adding a group will insert your new group below the selected user-defined scheme or group.  You can nest groups inside other groups. 

· Adding a list will insert your new list below the selected user-defined scheme or group.  A list cannot exist without at least one TTC/SEQ.  So, you will be required to identify a TTC/SEQ before you can save the new list. 

How Do I Get Here?

5. Begin on the Situational Maintenance window. 

6. If you want to add a new group or list, in the treeview, select the user-defined Scheme or Group you want the new group or list to appear under.

7. From the Tools menu, select Situational Tools, then select New.

To Add a New Scheme/Group/Listxe "New Scheme/Group/List"
8. Do one of the following:

· Choose Scheme. The New Scheme window opens. In the New Name box, type the new scheme name. 

· Choose Group. The New Group window opens. In the Name box, type the new group name.

· Choose List. The New List window opens.  In the List box, type the list name. 

Note: The page name displays in the tile bar of the page when accessed. The default page name is the name of the new list. If you want the page name to be different than the list name, in the Page box type the name you want.  Follow the procedures in the Edit List topic.

9. Do one of the following:

· To save the new scheme, group, or list, choose Save. The window closes and the new object appears in the treeview.   

· To cancel the new scheme, group, or list, choose Cancel. The New Scheme, New Group or New List window closes and the treeview displays unchanged.

Rename Scheme/Group/List

xe "Rename Scheme/Group/List"This window allows you to rename the selected user-defined scheme, group or list from the treeview.  User-defined lists can also be renamed through the Edit List window, but to rename a scheme or group the Rename window is the only available way. 

Note: Rename is unavailable for an Installation Scheme, Group or List.

How Do I Get Here?

10. Begin on the Situational Maintenance window. 

11. In the treeview, select the user-defined Scheme, Group or List you want to rename. 

12. From the Tools menu, select Situational Tools, then choose Rename.  The Rename window opens. 

To Rename a Scheme, Group or List

13. In the New Name box, type the new name.  

14. Do one of the following:

· To accept the new name, choose Save.  The Rename window closes and the selected treeview item name is changed. 

· To keep the original name, choose Cancel.  The Rename window closes and the selected treeview item name is unchanged. 

To Exit This Window

· Choose Cancel.

Copy Scheme/Group/List

xe "Copy Scheme/Group/List"This functionality allows you to create a copy of a selected scheme, group or list in the treeview, and then paste it into the desired destination.   

To Copy a Scheme, Group, or List

15. Begin on the Situational Maintenance window.

16. In the treeview, select the Scheme, Group, or List you want to copy. 

17. From the Tools menu, select Situational Tools, then choose Copy.

18. If you copied a scheme, it displays in the treeview as Copy of  "name of scheme".

Note: Recommend that you rename the pasted scheme.  

19. If you copied a group or list, select the Group or List you want to Copy.

ca) Select the Destination Scheme or Group.

cb) Choose Paste. The copied Group or List displays below the destination scheme or group.

See also:

Rename Scheme/Group/List 

Delete Scheme/Group/List

xe "Delete Scheme/Group/List"This functionality allows you to delete the selected user-defined scheme, group or list from the treeview.  Delete is unavailable for an Installation Scheme, Group or List.

To Delete a Scheme, Group or List

20. Begin on the Situational Maintenance window. 

21. In the treeview, select the user-defined Scheme, Group or List you want to delete.

22. From the Tools menu, select Situational Tools and choose Delete.   A message prompts you to confirm the delete. 

23. Do one of the following:

· To confirm the deletion, choose OK. The message closes and the selected treeview item is deleted.

· To cancel the deletion, choose Cancel.  The message closes and the selected treeview item remains in the treeview.

To Exit This Window

· Choose Cancel.

Export Scheme

xe "Export Scheme"This window allows you to export user-defined schemes from a list of available schemes to a file location of your preference.  The file is zipped and saved with an *.SXP extension.  Multiple schemes are zipped into one file but are still separate schemes when you import the file.    

How Do I Get Here?  

169. Begin on Situational Maintenance window. 

170. From the Tools menu, select Situational Tools, then choose Export.  The Export Scheme window opens.

To Export a Scheme

24. From the list of available situational schemes, select one, some, or all schemes.

25. Choose Export.  A second Export Scheme window opens.

26. In the Save in box, select the destination path for the scheme being exported.  

27. In the File name box, type the name of the scheme. 

28. Do one of the following:

· To export the scheme, choose Export. 

· To cancel the export, choose Cancel.

Note: If you export more than one scheme at this time, all the schemes will display individually in the treeview when you import the file. 

To Exit This Window

· Choose Cancel. 

See also:

Import Scheme 

Import Scheme

xe "Import Scheme"This window allows you to import previously exported user-defined situational schemes from the location of the zipped exported schemes (*.SXP) file.  If the file contains multiple schemes, each scheme will display individually after you import the file.   

How Do I Get Here?  

171. Begin on the Situational Maintenance window.

172. From the Tools menu, select Situational Tools, then choose Import.  The Import Scheme window opens.

To Import a Scheme

29. Do one of the following:

· In the Import File Name box, type the path where the *.SXP file is located.  

· To browse for the path, choose Browse. 

30. Do one of the following:

· To start the import process, choose OK.  The *.SXP file imports. 

· To cancel the import process, choose Cancel. 

To Exit This Window

· Choose Cancel. 

See also:

Export Scheme 
Edit List

xe "Edit List"This window allows you to add, delete and move TTC/SEQs to, from, and within a list.  You can type the TTC/SEQ or use a search utility to find a TTC/SEQ accessed though the browse button (magnifying glass icon).

This same window allows you to add TTC/SEQs to a brand new list when you first create it.  The only difference is that the window title is New List. 

How Do I Get Here?

31. Begin on the Situational Maintenance window. 

32. In the treeview, select the user-defined List you want to edit. 

33. From the Tools menu, select Situational Tools, then choose Edit List.   The Edit List window opens.  The List and Page boxes display the list and page names of the item you selected in the treeview. 

Note: If you are creating a new list, follow the How Do I Get Here? steps in the New Scheme/Group/List topic. 

Window Icons

· Magnifying Glass icon – functions as a browse button.

· Right Pointed Triangle icon – functions as an add button.

· Up Pointed Triangle icon – functions as a move up button.

· Down Pointed Triangle icon – functions as a move down button.

· Ax icon – functions as a delete button. 

To Add a TTC/SEQ to the List 

34. Do one of the following:

· In the TTCSEQ box, type the TTC/SEQ.

· Choose the browse button to search for the TTC/SEQ you want. 

35. Choose the add button. The TTC/SEQ and it's title display in the list.

To Move a TTC/SEQ in the List

36. In the list, select the TTC/SEQ you want to reposition.  

37. Do one of the following:  

· To move the TTC/SEQ up in the list, choose the move up button until the TTC/SEQ is in the position you want. 

· To move the TTC/SEQ down in the list, choose the move down button until the TTC/SEQ is in the position you want.

To Delete a TTC/SEQ in the List

38. In the list, select a TTC/SEQ

39. Choose the delete button.

To Edit the List or Page Name

· In the List and/or Page box, type the name you want.

Note: You can change both the list and page name, or you can edit just the list or just the page name as needed.  

To Exit This Window

· Do one of the following:

· To save changes, choose OK. 

· To cancel changes, choose Cancel. 

See also:

Rename Scheme/Group/List 

REDS Situational

xe "REDS Situational"When selected, this option will bring up the Record of Emergency Data Situational (REDS) window. Users enter information they wish to change or add. This will automatically generate the TTCs for the information entered, generating the transaction for the Unit Diary.

How Do I Get Here?

12. Begin on the Add Transaction window. 

13. Select REDSxe "REDS" Transaction. 

14. If available and if the current SSN is the one you intend to use, select Same SSN. 

15. Choose OK. If you selected Same SSN, the Red Situational window opens. If not, the Enter SSN window opens.

To Enter REDSxe "REDS" Data

The REDSxe "REDS" information is contained on six tabbed pages. Complete applicable information on the following pages.

Page 1

Spouse

16. In the Name box, type the spouse's name.

17. In the Address box, type the spouse's home address.

Children

18. For each child, enter the following information:

19. In the Name (DOB) box, type the child's name and date of birth.

20. In the Address box, type the child's home address.

Page 2

Guardian

40. For each guardian, enter the following information:

41. In the Name box, type the guardian's name.

42. In the Phone box, type the guardian's home telephone number, beginning with the area code.

43. In the Address box, type the guardian's home address.

44. In the Relationship box, type or select the guardian's relationship to the dependent.

Father

45. In the Name box, type the father's name.

46. In the Address box, type the father's home address.

Mother

47. In the Name box, type the mother's name.

48. In the Address box, type the mother's home address.

Page 3

Death Gratuity Beneficiary (ies)

49. For each beneficiary, enter the following information:

50. In the Name (Relation) (Pct) box, type the beneficiary's name, relationship, and the percentage of the gratuity.

51. In the Address box, type the beneficiary's home address.

Pay Arrears

52. Pay Arrears is any pay and allowances that are due the member at the time of death. The member can elect a person to be the beneficiary of these monies, or if no one has been selected, the monies will be distributed as determined by law.

53. In the Name box, type the name.

54. In the Address box, type the address.

Page 4

Do Not Notify Due to Ill Health

55. For each Do Not Notify designee, enter the following information:

56. In the Name /Relation box, type the name.

57. In the Address box, type the address.

Insurance Companies

· In the Name/Policy Number box, type the insurance company name and policy number. Up to five companies can be listed.

Page 5

Next of Kin

58. In the Relationship box, type or select the relationship to the member.

59. In the Phone box, type the telephone number, beginning with the area code.

SGLI Information

60. In the Election box, type or select the amount desired.

61. In the Date box, type the date the insurance is elected.

62. In the Beneficiary box, select the desired beneficiary.

63. In the Pay Designation box, select the method of payment.

64. In the Date box, type the date the beneficiary was selected.

Next of Kin Directions

· Type the directions for how the next of kin should be notified.

Spouse SGLI Information

65. In the Date box, type the date the insurance is elected.

66. In the Spouse SGLI Election Code box, select the desired election code.

Page 6

MIA Notify Name

67. In the First Name box, type the name of the designee to be notified if the member becomes missing in action.

68. In the Middle Initial box, type the designee's middle initials.

69. In the Last Name box, type the designee's last name.

MIA Notify Relationship and Phone

21. In the Relationship box, type or select the designee's relationship to the member.

22. In the Phone box, type the designee's phone number, beginning with the area code.

MIA Notify Directions

· In the Directions box, type directions for how the designee should be notified.

To Exit this Window

· Do one of the following:

· To save the changes and return to the Add Transaction window, choose OK.

· To cancel the changes and return to the Add Transaction window, choose Cancel.

See also:

Situational Reporting 

Unit Diary Transactions

Unit Diary Transactions

xe "Unit Diary Transactions"

xe "Transmit ECCO Accession"This menu in the Unit Diary Management window allows you to select, add, edit, delete, and flag transactions. You can also assign them to a Unit of Work, the Transaction Pool, or another Unit Diary.

How Do I Get Here?

· From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

—OR—

· In the Unit Diary frame, from the File menu, choose Open Unit Diary Management. The Unit Diary Management window opens.

To Highlight All Transactions

· Type CTRL-A. All of the transactions are selected.

To Lock or Unlock a Diary

· Type CTRL-A. All of the transactions are selected.

To Add a Transaction

· From the Transaction menu, choose New Transaction. The Add Transaction window opens.

Note: If an identical transaction already exists, a message prompts you to cancel the new transaction or to continue processing.

To Add an Accession Transaction

70. Select the diary you want to which you want to add the transaction. See Create New Diary.

71. Do one of the following:

· From the Transaction menu, choose New Transaction. The Member Information window opens.

· From the Transaction Tree, using the right mouse button, choose New Transaction. The Member Information window opens.

To Edit a Transaction

23. Select the transaction you want to edit.

24. Do one of the following:

· From the Transaction menu, choose Edit Transaction. The Transaction Detail window or the appropriate accession window opens. See also HAMS, ECCO, Depot or Retiree.

· Using the right mouse button, choose Edit Transaction. The Transaction Detail window or the appropriate accession window opens.

· Choose the desired transaction. The Transaction Detail window or appropriate accession window opens.

Note: If the transaction was generated through the Diary Feedback Report module and the cyclic DFR is not found, a message informs you the DFR has been deleted or archived.

Note: If the transaction has been certified, a message informs you that you have to reopen the transaction to be able to edit. Only certifier-level ELSIGs (certifier, CO, ECO) can reopen a certified transaction.

To Delete Transactions

25. From the Transaction Pool or inside one of the diaries, select the transactions you want to delete.

26. Do one of the following:

· From the Transaction menu, choose Delete. A message prompts you to confirm you want to delete the selected members.

· Press the Delete key. A message prompts you to confirm you want to delete the selected members.

· Right click on the transaction and choose Delete Transaction from the popup menu. A message prompts you to confirm you want to delete the selected members.

27. Do one of the following:

cc) To delete the transaction, choose Yes. The transaction is deleted, and you return to the Unit Diary Management window.

cd) To cancel the transaction, choose No. You return to the Unit Diary Management window.

aq) If the transaction was generated through the Diary Feedback Report module, a message reminds you that deleting the transaction will change its status back to open. If the cycle for the DFR transaction no longer exists, the transaction will be deleted.

To Flag Transactions or Remove Flags

Flagging a transaction or group member prevents the diary from entering a finalized status. Selecting a group or an exclusion home row flags all transactions and members not currently flagged. If all transactions and members within the group or exclusion are currently flagged then all flags are removed. This option is not available for Accession transactions.

28. Select the transactions you want to flag or that have flags you want to remove.

29. From the Transaction menu, choose Flag Transaction. The Flag Transactions window opens.

To Assign to a Unit of Work

You can use the Unit of Work option to indicate which transactions can be labeled as part of a group. This option is useful for organization and tracking. It is not available for Accession transactions. The Unit of Work Label remains on all the associated transactions until they are sent to the courier.

30. Select the transactions you want to place in a unit of work.

31. From the Transaction menu, choose Assign to Unit of Work. The Assign to Unit of Work window opens.

To Change the Status of Transactions

For ECCO accession transactions, only the MISSO can assign the status.

32. Select the transactions you want to change.

33. From the Transactions menu, choose Transaction Status/Notes. The Transaction Status/Notes window opens.
Note: If you select more than one transaction, a message prompts you to confirm that you want to modify all the transactions. Choose Yes. The transactions will be modified.

To Assign or Move Transactions to a Diary

There are different ways to move or assign a transaction to a diary, but you cannot move transactions from one type of diary to another (like moving regular diary transactions to an event diary) or from the Transaction Pool to the Transaction Pool. In addition, you cannot assign unauthorized transactions to an event diary. 

Note: Accessions transactions can not be moved to or from the Transaction Pool. For ECCO accession transactions, only the MISSA can move transactions.

· Do one of the following:

· Select the authorized transactions you want to assign and drag them into the diary.

Note: If the diary already has transactions or if the transactions have a different status than the diary, a message prompts you to confirm that you want to add transactions to the diary. Choose Yes. The transactions are added. 

· From the Transaction menu, choose Move Transaction. The Select Diary window opens.

· Using the right mouse button, choose Move Transaction. The Select Diary window opens.

Note: If you try to move part of a volume, situational, or group transaction, a message prompts you to confirm that you want to move the entire transaction to the Transaction Pool or a different Unit Diary.

To Transmit an ECCO Accession

Only the Reserve units can transmit transactions. This option is available for Certifier ELSIGs only.

34. Follow the steps in the Preferences topic, To Schedule Events section.

35. If you are a Reserve unit, select the ECCO transactions you want to transmit.

36. From the Transaction menu, choose Transmit Transaction. Do one of the following:

· A status message notifies you that some SSNs will not be transmitted due to status. Choose OK. You return to the Unit Diary Management window.

· A message notifies you that the accessions will be transmitted to the Collection Server in fifteen minutes. Do one of the following:

· If you want to continue, choose Yes. The Reserve Accession is forwarded to the Collection Server. You return to the Unit Diary Management window.

· If you do not want to transmit the accession, choose No. You return to the Unit Diary Management window.

To Export an ECCO Accession

If you are a Reserve unit and do not have the transmit function, you can export an ECCO accession.

37. Select the ECCO transactions you want to export.

38. From the Transaction menu, choose Export Transaction. The Save As window opens.

39. Follow the procedures in the To Export an Accession section.

To Exit the Unit Diary Management Window

· From the File menu, choose Close. You return to the Unit Diary Frame window.

Transaction Detail

xe "Transaction Pool"

xe "Enter Transaction Dates"

xe "Select a Group"

xe "Tickler Tab in Transaction Detail"

xe "Type a History Statement as a Separate Transaction"

xe "Add Members to a New Group"

xe "Failed Transactions"This window allows you to view basic information about a Unit Diary transaction. All columns have sort and multiple-sort functionality. Logical columns contain filter capabilities.

This window displays the following information:

· Unit Diary Type

· Unit Diary Date

How Do I Get Here?

72. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

73. From the Transaction menu, choose New Transaction. The Add Transaction window opens.

74. Do one of the following:

· Select Individual Transaction.

· Select Group Transaction.

75. Choose OK. The Transaction Detail window opens.

—OR—

76. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

77. From the Transaction Pool or a diary, select the transaction you want to change.

78. From the Transactions menu, choose Edit Transaction. The Transaction Detail window opens.

Note: The Transaction Detailxe "Transaction Detail" window only appears for individual or group transactions.

To View or Edit a Transaction

· Do one of the following:

· To edit or view Transaction information, choose the Transaction—Tab 1 tab.

· To edit or view Notes, choose the Notes—Tab 2 tab.

· To edit or view Activity information, choose the Activity—Tab 3 tab. 

· To edit or view Tickler information, choose the Tickler—Tab 4 tab.

Transaction—Tab 1

This tab contains the current transaction and the following information:

· Entry Option

· TTC Sequence

· Social Security Number

· Last Name

· Initials

· English Explanation

· Transaction Type

· Transaction Flag

· History Statement Flag

To Add an Individual Transaction

This option allows you to add or modify an individual transaction. 

40. In the Status list, select either Open or Pending Review.

41. Do one of the following:

· In the TTC SEQ box, type the TTC and sequence number. The fields applicable to the transaction display.

· Choose Search. The Search for TTC window opens. Once you have selected the TTC, the applicable fields display. 

42. Type the transaction information into the applicable fields. A description of the fields for each transaction can be found in the MCTFSPRIM (www.missa.manpower.usmc.mil).

43. Choose OK. You return to the Unit Diary Management window.

To Add a Group Transaction

This option allows you to add or modify transaction information for a group transaction. 

79. In the TTC SEQ box, type the TTC and sequence number.

80. Enter the transaction information in the prompts provided for the selected TTC.

81. Choose Members. The Add Members to New Group opens.

82. Do one of the following:

· Choose Members. The Search window opens.

· Click Add. The Enter SSN window opens.

6. After completing entries in the previous windows, in the Status list, select either Open or Pending Review.

7. Choose OK. You return to the Unit Diary Management window.

To Type a History Statementxe "Type a History Statement"
History Statements include information that is processed with the transactions. Such information can include explanations of why a transaction is late or can indicate why a transaction was performed ("In accordance with…," and so on.). 

Note: If you want to make an internal note that is not processed with the transaction, use the Notes tab. 

83. In the History box, type the information you want to include with the transaction. 

84. Choose OK. If you are using the Unit Diary module, you return to the Add Transaction window. Same SSN is the default selection. If you are using the Diary Feedback Report module, you return to the Transaction Detail window. The transaction is copied to Current Notes.

Notes—Tab 2

This tab allows you to view, add, modify or delete notes for a transaction. Notes are used for internal communication that is not to be included with transaction processing. If you want to record information to be processed with the transaction, see To Type a History Statement.

To Add a Notexe "Add a Note"
· Choose New. The Add Note window opens.

To Edit a Notexe "Edit a Note"
85. Select the note you want to edit. 

86. Choose Modify. The Edit Note window opens. 

To Delete a Notexe "Delete a Note"
87. In the Notes box, select the note you want to remove.

88. Choose Delete. A message prompts you to confirm the deletion.

89. Choose Yes. The note is deleted. 

Note: System generated notes cannot edited or deleted.

Automatic Notesxe "Automatic Notes"
Under the following conditions, the software automatically applies permanent transaction notes that cannot be edited:

· Opened by **Name Initials** on **System Date**

· Reopened by **Name Initials** on **System Date**

· Ownership taken by **Name Initials** on **System Date**

· Finalized by **Name Initials** on **System Date** 

· Reviewed by **Name Initials** on **System Date** 

· Certified by **Name Initials** on **System Date**

· Flag added by **Name Initials** on **System Date**

· Flag removed by **Name Initials** on **System Date**

· Entry by **Name Initials** on **System Date**

· Created by Generic Import on **System Date**

Activity—Tab 3

This tab lists all of the active unit diary transactions in the system for the member. The Activity tabxe "Activity Tab" is unavailable for event transactions. It displays the following information:

· Section

· Preparer

· Diary Number

· Diary Date

· Status

· DOA

· TTC-SEQ

· English Description

Tickler—Tab 4

This tab lists all of the pending tickler entries in the system for the member. The Tickler tab is unavailable for event transactions. It displays the following information:

· Section

· Tickler Date

· Action Description

· Type Transaction Code-Sequence Number

The default sort should be by Section, Tickler Date, and TTC-SEQ.

To Edit an Individual Type Transactionxe "Edit an Individual Type Transaction"
44. From the Transactions list, select the individual transaction you want to edit.

45. From the Transaction menu, choose Edit Transaction. The Transaction Detail window opens.

To Add or Edit a Transaction from the Diary Feedback Reportxe "Add or Edit a Transaction from the Diary Feedback Report"
90. From the UD/MIPS Navigator window, choose the Diary Feedback Report icon. The Diary Feedback Report Summary window opens.

91. Select a cycle.

92. Choose Edit. The Diary Feedback Report window opens. Four tabs display.

93. Do one of the following

· Choose Part II—Rejected Transactions. The Part II—Transaction Detail window opens.

· Choose Part III—Advisory/PUREX. The Part III—Transaction Detail window opens.

94. Choose Diary Entry. The Select Diary window opens.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

Add Transaction

xe "Add Transaction:REDS Transaction"

xe "Add Transaction"

xe "Add an Accession"If you are a preparer, this window allows you to create Individual, Situational, REDS, Group, and Volume transactions for Regular diaries and Event and Exclusion transactions for Event diaries. Your options will vary depending on the type of diary.

How Do I Get Here?
95. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

96. From the Transaction menu, choose New Transaction. The Add Transaction window opens.

To Add an Individual Transactionxe "Add Transaction:Add an Individual Transaction"
If you are adding this transaction for a Regular diary, this option enables you to add a transaction specific to one member.

97. Select Individual Transaction. 

98. If you have entered another transaction immediately before this one, the Same TTCSEQ and the Same SSN check boxes become available. Select them if appropriate.

99. Choose OK. The Transaction Detail window opens.

To Add a Situational Transactionxe "Add Transaction:Add a Situational Transaction"
If you are adding this transaction for a Regular diary, this option enables you to add a transaction for a specific situation.

100. Select Situational Transaction. 

101. If you have entered another transaction immediately before this one, the Same SSN check box becomes available. Select it if appropriate.

102. Choose OK. The Situational Reporting window opens.

To Add a Record of Emergency Data System Transaction

If you are adding this transaction for a Regular diary, this option enables you to add a Record of Emergency Data System (REDS) transaction.

103. Select REDS Transaction. 

104. If you have entered another transaction immediately before this one, the Same SSN check box becomes available. Select it if appropriate.

105. Choose OK. If you have not entered another transaction, the Enter SSN window opens. After selecting an SSN, the REDS Situational window opens. If you selected to enter a transaction for the same SSN, choose OK. The REDS Situational window opens.

To Add a Group Transactionxe "Add Transaction:Group Transaction"
If you are adding this transaction for a Regular diary, this option enables you to add one or more reportable transactions for a group of members where all TTC/SEQ prompts are the same for each group.

106. Select Group Transaction. 

107. Choose OK. The Transaction Detail window opens.

To Add a Volume Transactionxe "Add Transaction:Add a Volume Transaction"
If you are adding this transaction for a Regular diary, this option enables you to add a transaction where more than one member of the reporting unit may require the same Unit Diary transaction but each member does not need all of the same information in each prompt.

108. Select Volume Transaction. 

109. Choose OK. The Volume Transaction window opens.

To Add an Event Transaction

If you are adding this transaction for an event diary, this option enables you to add a transaction that applies to all members of a RUC except the SSNs in the exception report. Only one Event transaction should be placed on a diary. 

110. Select Event Transaction. 

111. Choose OK. The Transaction Detail window opens. The words "Add" and "Event" appear in the title bar.

To Add an Exclusion Transaction

If you are adding this transaction for an event diary, this option enables you to exclude SSNs from an event transaction. 

112. Select Exclusion Transaction. 

113. Choose OK. The Transaction Detail window opens. The words "Add" and "Event" appear in the title bar.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

See Also:

Transaction Detail 

Situational Maintenance 

REDS Situational 

Unit Diary Management 

Add Note

xe "Add Note"This window allows you to add a note to a transaction.

How Do I Get Here?

114. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

115. In either the Transaction Pool or the Unit Diary of your choice, edit an existing transaction. The Transaction Detail window opens.

116. Choose the Notes tab. The Notes portion of the Transaction Detail window displays.

117. If you want to add a new note, choose New. The Add Note window opens.

To Add a Note

118. In the Add Note box, type the note, up to 250 characters.

119. Do one of the following:

· To save the note, choose OK. You return to the Transaction Detail window, and the note is visible in the Notes tab.

· To delete your changes, choose Cancel. You return to the Transaction Detail window. 

To Exit This Window

· Choose Cancel. You return to the Transaction Detail window.

Edit Note

This window allows you to edit a note for a transaction.

How Do I Get Here?

120. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

121. In either the Transaction Pool or the Unit Diary of your choice, edit an existing transaction. The Transaction Detail window opens.

122. Choose the Notes tab. The Notes portion of the Transaction Detail window displays.

123. Select the note you want to modify.

Note: System generated notes cannot be edited.

124. Choose Modify. The Edit Notexe "Edit Note" window opens.

To Edit a Note

125. In the Edit Note box, type your changes to the note.

126. Do one of the following:

· To save the note, choose OK. You return to the Transaction Detail window, and the changes to the note are visible in the Notes tab.

· To cancel your changes, choose Cancel. You return to the Transaction Detail window. 

To Exit This Window

· Choose Cancel. You return to the Transaction Detail window.

Volume Transactions

xe "Edit Volume Transactions for Diary"This window enables you to add or edit volume transactionsxe "Volume Transactions" from the Unit Diary module and the Diary Feedback module. These are similar to the Group Transaction, where more than one member of the reporting unit may require the same Unit Diary transaction. It differs from Group Transactions in that each member does not need all of the same information in each prompt.

Information can be edited for each selected member individually. This window also enables you to add TTC/SEQs, members, SSNs, history statements, complete transactions, and to change between name, grade, company, and platoon views.

Volume Unit Diary transactions must be entered into or edited from a diary and are limited to 9,999. If the number of component transactions in a diary exceeds this amount, you can create another diary to process the remaining items.

How Do I Get Here?

46. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

47. Select the desired volume transaction.

48. From the Transaction menu, choose Edit Transaction. The Volume Transaction window opens.

OR

49. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

50. From the Transaction Menu, choose New Transaction. The Add Transaction window opens. 

51. Select Volume Transaction.

52. Choose OK. The Volume Transaction window opens.

OR

53. From the UD/MIPS - Navigator window, choose the Diary Feedback Report module icon.  The Diary Feedback Report window opens.

54. Choose the Part II-Rejected Transactions or Part III—Advisory/PUREX tab. The applicable window opens.

55. From the available transactions, select the transactions you want to include in a volume transaction.  

56. From the Tools menu, choose Create Volume Transaction. The Select Diary window opens. After selecting the diary you want or the Transaction Pool, the Volume Transactionsxe "Volume Transactions" window opens.

This window displays the following information:

· TTC-SEQ

· Default prompts

· Default Date

· English Statement

· Select

· SSN

· Name

· Grade

· Number of Service members selected

To Search for Specific Members

· Choose Members.  The Search window opens.  After completing the steps in the Search topic, the member's you selected display in the Edit Volume Transaction for Diary list.

To Search for Members by Organization

· Choose Organization.  The Select Organization window opens.  After completing the steps in the Select Organization topic, the member's you selected display in the Edit Volume Transaction for Diary list.

To Add Members

· Choose Add Member.  The Enter SSN window opens.  After completing the steps in the Enter SSN topic, the members you selected display in the Edit Volume Transaction for Diary list.

To Enter or Edit a Volume Transaction

57. In the TTC/SEQ box, type TTC and SEQ.

58. In the Default box, select the desired prompt description.

59. To make the select box and prompt description editable, select Editable.

60. If applicable, make desired changes. Choose OK. A message prompts you to confirm your changes. Do one of the following:

· To update the transaction, choose Yes. Your changes are updated.

· To cancel the transaction, choose No. Your changes are canceled.

61. You return to the Edit Volume Transaction for Diary window.

To Add a History Statement

· Choose History.  The History Statement window opens.  After completing the steps in the Transaction History Statement topic, you return to the Edit Volume Transaction for Diary window.

To Complete a Transaction

· Choose OK.  A message informs you the transaction was successful.

To Change a View

This option allows you to select which columns can be viewed in the list of members in the transaction.

· From the Tools menu, choose Window View.  The Transaction View window opens.

Large Volume Transaction

If the user selects more than 50 members for a transaction input, a message informs you that a large number of transactions could cause delays to your system. To reduce the size of your volume transaction, do one of the following:

· Choose Yes. You return to the Input window. At this time you can reduce the size of the volume transaction and continue with the transaction.

· Choose No. The transaction continues.

To Exit This Window

· Choose OK. You return to the previous window.

Transaction View

xe "Transaction View"This window enables you to select which columns display in the members list in the Volume Transactions window. 

How Do I Get Here?

62. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

63. Select the desired volume transaction.

64. From the Transaction menu, choose Edit Transaction. The Volume Transaction window opens.

65. From the Tools menu, choose Window View.  The Transaction View window opens.

OR

66. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

67. From the Transaction menu, choose New Transaction. The Add Transaction window opens.

68. Select Volume Transaction.

69. Choose OK. The Volume Transaction window opens.

70. From the Tools menu, choose Window View.  The Transaction View window opens.

OR

127. From the UD/MIPS - Navigator window, choose the Diary Feedback Report module icon.  The Diary Feedback Report window opens.

128. Choose the Part II-Rejected Transactions or Part III—Advisory/PUREX tab. The applicable window opens.

129. From the available transactions, select the transactions you want to include in a volume transaction.  

130. From the Tools menu, choose Create Volume Transaction. The Select Diary window opens. After selecting the diary you want or the Transaction Pool, the Volume Transactions window opens.

131. From the Tools menu, choose Window View.  The Transaction View window opens.

The columns you can add or remove from the Volume Transactions window include:

· Name

· Grade

· Company

· Platoon

To Add Columns

132. Check the box next to the name of the column.

133. Choose OK. You return to the Volume Transactions window, and the new columns display.

To Remove Columns.

134. Clear the box next to the name of the column.

135. Choose OK. You return to the Volume Transactions window, and the selected columns no longer display.

To Exit This Window

· Choose Cancel. You return to the Volume Transactions window.

Add Members to New Group

xe "Add Members to New Group"This window allows the user to add, search, and flag members in a new group.

How Do I Get Here?

136. Begin on the Transaction Detail window.

137. Choose Members.  The Add Members to New Group window opens.

To Add Members 

· Choose Add.  The Enter SSN window opens.

To Flag Members

138. Select a transaction.

139. Choose Flag.  A flag appears in the Flag column of the transaction you chose.

Note: This button is unavailable for an automated check or EFT payments.

To Delete a Transaction

140. Select a transaction.

141. Choose Delete. A message prompts you to confirm the deletion.

Note: This button is unavailable for an automated check or EFT payments diary.

142. Do one of the following:

· To Delete the transaction, choose Yes.  

· To Cancel the delete request, choose No. The transaction remains in the diary.

To Exit This Window

· Choose Close.  You return to the Transaction Detail window.

Enter SSN

xe "Enter SSN"This window allows you to add a new Social Security Number not currently in the CUDDB database or search for an existing Social Security Number in the database.

How Do I Get Here?

143. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

144. Do one of the following:

· Add or Edit a group transaction. The Transaction Detail window opens.

· Choose Members. The Members of Group window opens.

145. Choose Add. The Enter SSN window opens.

To Search for SSN

146. In the SSN box, type the member's SSN. 

· If the SSN is found, the transaction automatically selects the corresponding last name and initials information. The Members of Group window opens.

· If the SSN is not found, the SSN Not Found window opens. 

147. In the Last Name box, type the member's last name. 

148. In the Initials box, type the member's first and middle initials.

149. Choose OK. You return to the Members of Group window.

OR

· Choose Members. The Search window opens.

To Exit This Window

· Choose Close.  You return to the Transaction Detail window.

Transaction Status/Notes

This window allows you to change the status of transactions or add notes to them.

How Do I Get Here?

71. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

72. Select the transaction that you want to modify.

73. From the Transaction menu, choose Transaction Status/Notes. The Transaction Status/Notesxe "Transaction Status/Notes" window opens.

To Modify the Status

150. In the Status box, do one of the following:

· If you are a preparer, select Open or Finalized.

· If you are a reviewer, select Open, Finalized or Reviewed.

· If you have certifier-level access (CO, ECO, Certifier), select Open, Finalized, Reviewed, or Certified.

· If you only want to add a note to the transaction or transactions, select No Status Change.

14. Do one of the following:

· To proceed, choose OK. You return to the Unit Diary Management window.

· To cancel, choose Cancel. You return to the Unit Diary Management window.

Note: If the transaction has been certified, a message informs you that you have to reopen the transaction to be able to edit. Only certifier-level ELSIGs (certifier, CO, ECO) can reopen a certified transaction.

To Modify the Accession Status

For ECCOxe "Accession:ECCO" accessionxe "ECCO Accession" transactions, only the MISSO can assign a status. The Notes option is unavailable for accession transactions.

· In the Status box, do one of the following:

· If you are a preparer, select Open. A change of status notification message displays. You return to the Unit Diary Management window.

· If you are a reviewer, select Open. A change of status notification message displays. You return to the Unit Diary Management window.

· If you have certifier-level access (CO, ECO, Certifier), do one of the following:

· If you want to return the accession to an open status, select Open. A change of status notification message displays. You return to the Unit Diary Management window.

· If you want to certify the accession transaction, select Certified. A change of status notification message displays. You return to the Unit Diary Management window.

· If you want to certify all accession transactions in the accession, follow the steps in the Diary Status/Notes topic.

To Make a Transaction Note

You can make notes, up to 450 characters, on a transaction even if you are not going to change its status. You cannot edit previous notes and must only enter notes for your ELSIG authorization.

74. If you want to make a note about the transaction, in the Note box, type the note.

75. Do one of the following:

· To submit the note, choose OK. You return to the Unit Diary Management window.

· To cancel, choose Cancel. You return to the Unit Diary Management window.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

See Also:

Unit Diary Transactions 

HAMS Accession 

Retiree Accession 

ECCOxe "Accession:ECCO" Accession 

Transaction History Statement

xe "Transaction History Statement"This window allows a statement to be included for each transaction when added or updated.  This allows any user to provide important information or change the existing information about an individual. 

How Do I Get Here? 

151. Begin on the Situational Reporting window. 

152. From the treeview, choose a transaction on a selected member.

To Add a New History Statement

153. From any transaction, choose the history button, usually placed after each area with two dots.  The Transaction History Statement window opens. 

154. In the blank area, after the HIST:, type the information you want entered.

155. Do one of the following:

· To save your statement, choose OK. 

Note: The history button will now have an H in it, indicating that there is a statement for review.   

· To cancel, choose Cancel.  The Transaction History Statement window closes. 

To Edit a History Statement

156. From any transaction choose the history button with an H in it, usually placed after each area.  The Transaction History Statement window opens. 

157. After the HIST:, edit the information by typing in what you want entered.

158. Do one of the following:

· To save your statement, choose OK.  

· To cancel, choose Cancel.  The Transaction History Statement window closes. 

To Exit This Window

· Choose Cancel.

Flag Transactions

Use this window to flag transactionsxe "Flag Transactions" or to remove a flag from transactions.

Note: This functionality is not available for Accession transactions.

How Do I Get Here?

159. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

160. From the Transaction Pool or an open diary, select the transactions you want to flag or transactions with flags you want to remove.

161. From the Transaction menu, choose Flag Transaction. The Flag Transactions window opens.

To Flag Transactionsxe "Flag Transactions"
Flagging a transaction prevents the diary from being finalized. You cannot make a courier for a Unit Diary with a flagged transaction.

162. Under Choose Action, select Flag Transactions.

163. Choose OK. A message prompts you to confirm that you want to flag the selected transactions.

164. Do one of the following:

· To proceed with flagging the transactions, choose Yes. You return to the Unit Diary Management window, and the transactions are flagged.

· To cancel the flagging, choose No. You return to the Unit Diary Management window.

To Remove Flags

165. Under Choose Action, select Remove Flag.

166. Choose OK. A message prompts you to confirm the removal.

167. Do one of the following:

· To continue removing the flags, choose Yes. You return to the Unit Diary Management window, and the selected flags are removed.

· To cancel the removal, choose No. You return to the Unit Diary Management window.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

Assign to Unit of Work

xe "Assign to Unit of Work"This window enables you to label a group of transactions as a Unit of Work. If a transaction has been selected for one unit by a previous user, you can change the label and make it part of your unit.

The Unit of Work label remains on all the associated transactions until they are sent to the courier.

Note: This functionality is not available for Accession transactions.

How Do I Get Here?

168. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

169. Select the transactions you want to assign to a Unit of Work.

170. From the Transaction menu, choose Assign to Unit of Work. The Assign to Unit of Work window opens.

To Enter a Name

76. In the Unit of Work box, type the name you want to assign to this Unit of Work. The name must be alphanumeric (no special characters allowed), up to 30 characters.

77. Choose OK. A message prompts you to confirm that you want to label the transactions.

78. Choose Yes. A message confirms your selection.

79. Choose OK. You return to the Unit Diary Management window, and the label is applied to all of the selected transactions. 
To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

Identify Unit of Work

xe "Identify Unit of Work"This window enables you to select the name of a Unit of Work for the Unit of Work Report. A Unit of Work is a collection of similar or related transactions. 

How Do I Get Here?

80. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

81. From the Reports menu, choose Unit of Work Report. The Identify Unit of Work window opens.

To Select a Unit of Work

171. From the Unit of Work list, select the name.

172. Do one of the following:

· If you want to proceed, choose OK. The Unit of Work Report window opens.

· If you want to cancel, choose Cancel. You return to the Unit Diary Management window.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

Unit Diary Tools

Unit Diary Tools

xe "Unit Diary Tools"The Tools menu in the Unit Diary Management window allows you to import a transaction, refresh the window, sort and select windows, apply a filter, and change column order.

How Do I Get Here?

· From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

—OR—

· In the Unit Diary frame, from the File menu, choose Open Unit Diary Management. The Unit Diary Management window opens.

To Import a Transaction

· From the Tools menu, choose Transaction Import. The Transaction Import window opens.

To Perform Situational Maintenance

· From the Tools menu, choose Situational Tools. The Situational Maintenance window opens.

To Refresh the Window

This option enables you to update the window to display the most current information.

· Do one of the following:

· From the Tools menu, choose Refresh. The most recently entered information displays.

· Press the F5 key. The most recently entered information displays.

To Sort Columns

You can sort all of the columns. 

Single Column Sorts

· Using the left mouse button, select the heading for column you want to sort. Select the heading again to reverse the sort.

Multiple Column Sorts

· Do one of the following:

· From the Tools menu, choose Sort. The Multiple Column Sort window opens.

· Right click on the column heading. The Multiple Column Sort window opens.

Note: To ensure the accuracy of column sorts involving group transactions, after selecting the sort option, press the F5 key. 

To Select the Columns You Want to Display

82. Using the left mouse button, select the portion of the treeview that you want to view. 

83. From the Tools menu, choose Choose Columns. The Choose Columns window opens.

To Apply a Filter

A filter can help you narrow the lists of transactions, diaries, couriers, or recovered archive items to show only the items you want to view, modify, or delete.

· From the Tools menu, choose the Filter. The Filter window opens.

To Change Column Order

· Using the left mouse button, select the desired column and drag it to the proper location.

To Exit the Unit Diary Management Window

· From the File menu, choose Close. You return to the Unit Diary Frame window.

Transaction Import (Generic Import)

This window allows you to select and import Unit Diary Transaction (Generic Import) import files (*.dif) so that individual transactions can be added to a diary, added to the tickler, edited, or deleted. These draft diary import files are generated by a source outside of UD/MIPS. Only individual transactions can be imported. This option does not support group or volume transactions.  The file specifications for generic importxe "Generic Import" are located in the document directory of UD/MIPS.

How Do I Get Here?

173. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

174. From the Tools menu, choose Transaction Import.

175. After following the steps in the Select Import File window, choose Open. The Transaction Importxe "Transaction Import" Window opens.

This window displays the following information:

· Transaction Number

· Type Transaction Code/Sequence Number

· Social Security Number

· Name

· Status

To Select a Different File

176. Choose Browse. A window prompts you to confirm that you want to discard the current transactions and load another file.

177. Choose OK. The Select Import File window opens.

To Add Transactions to a Diary

178. If you have an authorized ELSIG, do one of the following:

· Select one or more transactions.

· Select Select All.

179. Choose Add to Diary. The Create a New Diary window opens. 

Note: If any of the transactions have errors, a message informs you that one or more of the selected transactions are invalid. These transactions will not be added to the diary. Choose OK.

To Add Transactions to the Tickler

180. If you are a CO, ECO, certifier, preparer, or reviewer, do one of the following:

· Select one or more transactions.

· Select Select All.

181. Choose Add to Tickler. The Add Tickler window opens. 

To Edit Transactions

182. If you have an authorized ELSIG, do one of the following:

· Select one or more transactions.

· Select Select All.

183. Choose Edit. The Transaction Detail window opens.

To Delete Transactions

184. If you are a CO, ECO, certifier, preparer, or reviewer, do one of the following:

· Select one or more transactions.

· Select Select All.

185. Choose Delete. A message prompts you to confirm that you want to delete the transactions.

186. Choose OK. The transactions are deleted.

To Deselect All Transactions

· Choose Deselect All. The transactions are no longer selected.

Multiple Column Sort

This window allows you to change the sort order of the columns on the list of transactions.

How Do I Get Here?

84. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

85. From the Tools menu, choose Sort. The Multiple Column Sortxe "Multiple Column Sort" window opens.

To Add a Column to the Sort

86. From the Available Sort Columns list, select the column you want to sort.

87. Choose the right arrow (>) icon. The column name displays in the Selected Sort Columns box.

To Remove a Column from the Sort

88. From the Selected Sort Columns box, select the column you do not want to sort.

89. Choose the left arrow (<) icon. The column name is removed from the Selected Sort Columns box.

To Set up a Descending Sort for a Column

· In the Selected Sort Columns box, clear the Ascending box for each column you want to sort in descending order.

To Clear the Sort Columns

· Choose Reset. The Selected Sort Columns box is now blank.

To Proceed with the Sort

· Do one of the following

· If you want to change the sort order of the columns, choose OK. You return the Unit Diary Management window, and the columns are sorted.

· If you do not want to change the sort order of the columns, choose Cancel. You return the Unit Diary Management window.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window, and the sort order remains unchanged.

Choose Columns

xe "Choose Columns"This window allows you to select the columns you want to display for an item in the Transaction Tree.

How Do I Get Here?

187. From the UD/MIPS Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

188. Select an item in the Transaction Tree. 

189. From the Tools menu, choose Choose Columns. The Choose Columns window opens.

To Select the Columns

190. Select the columns you want to display.

191. Do one of the following:

· If you want to proceed, choose OK. You return to the Unit Diary Management window, and the selected columns display.

· If you want to cancel your selections, choose Cancel. You return to the Unit Diary Management window.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

Filter

This window allows you to determine what Unit Diary and transaction information is displayed by applying filterxe "Filter" criteria to available unit diary data.

How Do I Get Here?

90. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

91. Select the Transaction Pool or a Unit Diary.

92. From the Tools menu, choose Filter. The Filter window opens.

This window displays the following information:

· Select Transactions Where

To Create a Filterxe "Filter"
93. In the Fields box, select the field you want to use in the filterxe "Filter".

94. Choose Where Condition. The Where (Condition) window opens. After following the instructions in the Where (Condition) window, the selected field and condition displays in the Select Transactions Where box.

To Save a Filterxe "Filter"
This option allows you to save a filterxe "Filter". The saved filters are available in the Select Filter list.

· Choose Save As. The Filterxe "Filter" Name window opens.

To Select and Apply a Filterxe "Filter"
95. In the Select Filter list to the right of the Fields box, select the desired filterxe "Filter".

96. Choose Apply Filter. You return to the Unit Diary Management window, and the filterxe "Filter" is applied.

To Reset the Column to Be Filtered

· Choose Reset. The Current Filterxe "Filter" box is cleared, and the Unit Diary list in the previous window is restored to its original format.

To Exit This Window

· Choose Cancel. You return to the previous window.

Filter Name

This window allows you to enter the name of a filter. The saved filters are available in the Select Filter list in the Filter window.

How Do I Get Here?

97. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

98. Select the Transaction Pool or a Unit Diary.

99. From the Tools menu, choose Filter. The Filter window opens.

100. Choose Save As. The Filter Namexe "Filter Name" window opens.

To Name a Filter

192. In the Filter Name box type a name for the filter using only alphanumeric characters.

193. Do one of the following:

· To save the filter, choose OK. The filter is saved, and you return to the Filter window.

· To cancel the save, choose Cancel. The filter is not saved, and you return to the Filter window.  

To Exit This Window

· Choose Cancel. You return to the Filter window.

Where (Condition)

xe "Where Condition"This window allows you to select conditions for a filter to be used in the Unit Diary Management window. The filter option you choose determines the window title and how the window is laid out.

How Do I Get Here?

101. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

102. Select the Transaction Pool or a Unit Diary

103. From the Tools menu, choose Filter. The Filter window opens.

104. In the Fields box, select the field you want to use for a filter.

105. Choose Where Condition. The Where (Condition) window opens.

Fields that can be used for a filter include:

Transaction Filters

· Certifier

· Name

· Preparer

· Section

· Social Security Number

· Status

· Type Transaction Code-Sequence Number

· Unit of Work

Diary Filters

· Class

· Diary Date

· Diary Number

· Last Update

· Opened By

· Status

To Set a Condition

The process for entering conditions varies depending on what fields you select for a filter. The following examples explain how different conditions can be set.

To Set a Name Condition

194. In the Where Name list, do one of the following:

· To select a range of names, select Between
· To view accounts that do not contain a selected name, select Does Not Equal.

· To view accounts that contain a selected name, select Equals.

195. Do one of the following:

· If you selected Equals or Does Not Equal, do one of the following:

ar) To search for a last name, in the Name Equals box, type the member's last name.

as) To search for a last name that begins a selected letter, type the first letter of the name and a star (for example, to search for or eliminate "Smith," type S*).

at) To search for a last name that ends with a selected letter, type a star and the last letter of the name (for example, to search for or eliminate "Smith," type *H).

au) To search for a combination of letters in a name, type a star, the letters, and another star (for example, to search for or eliminate "Smith," type *MIT*). 

· If you selected Between, do the following:

av) In the Name Between box, type the beginning part of the filter range.

aw) In the And box, type the ending part of the filter range.

196. Choose OK. You return to the Filter window, and the criteria and conditions you selected display in the Select Transactions Where box.

To Set a Social Security Number Condition

197. In the Where SSN list, do one of the following:

· To select a range of number, select Between.

· To view accounts that do not contain a selected number, select Does Not Equal.

· To view accounts that contain a selected number, select Equals.

198. Do one of the following:

· If you selected Equals or Does Not Equal, do one of the following:

ax) To search for a Social Security Number, in the Name Equals box, type the member's last name.

ay) To search for a Social Security Number that begins with a selected digit, type the first digit and a star (for example, to search for or eliminate "555-55-5555," type 5*).

az) To search for a Social Security Number that ends with a selected digit, type a star and the last digit (for example, to search for or eliminate "555-55-5555," type *5).

ba) To search for a combination of digits in a Social Security Number, type a star, the digits, and another star (for example, to search for or eliminate "555-55-5555," type *555*). 

· If you selected Between, do the following:

bb) In the SSN Between box, type the beginning part of the filter range.

bc) In the And box, type the ending part of the filter range.

199. Choose OK. You return to the Filter window, and the criteria and conditions you selected display in the Select Transactions Where box.

To Set a Diary Date Condition

200. In the Date, do one of the following:

· To view diaries created after a selected date, select After.

· To view diaries created before a selected date, select Before.

· To select a range of diary dates, select Between.

· To view diaries that weren't created on a specific date, select Does Not Equal.

· To view diaries that were created on a specific date, select Equals.

201. Do one of the following:

· If you selected After, Before, Equals or Does Not Equal, type the date you want in YYYYY/MM/DD format.

· If you selected Between, do the following:

bd) In the Diary Date Between box, type the beginning date for the range in YYYY/MM/DD format.

be) In the And box, type the ending date of the range in YYYY/MM/DD format.

202. Choose OK. You return to the Filter window, and the criteria and conditions you selected display in the Select Transactions Where box.

To Exit This Window

· Choose Cancel. You return the Filter window.

Diary Reports

Unit Diary Reports

xe "Unit Diary Reports"The Reports menu in the Unit Diary Management window allows you to view and print TTC Reports, the CUDDB Posting Report, the Unit of Work Report, and the Research Diary Report. It also allows you to export a status report for a particular time range.

How Do I Get Here?

· From the UD/MIPS Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

To View and Print TTC Reports

· From the Reports menu, choose TTC List. The TTC Reports window opens.

To View and Print Reports of CUDDB Postings

· From the Reports menu, choose CUDDB Postings. The CUDDB Posting Report window opens.

To View and Print Reports about a Unit of Work

· From the Reports menu, choose Unit of Work Report. The Unit of Work Report window opens.

To View and Print Research Reports

106. From the Reports menu, choose Research Diary. The Select Diary window opens. 

107. After completing the process in the Select Diary window, choose OK. The Research Diary Report window opens.

To Export Status Reports

You can export a status report as a text file containing the following fields: Diary Number, Diary Date, Local Status Date, Class, Status, Trans Sent, Accepted, Rejected, Total Trans, TFS Cycle and CART Source.

· From the Reports menu, choose Export Status Report. The Time Frame Specification window opens.

To Exit the Unit Diary Management Window

· From the File menu, choose Close. You return to the Unit Diary Frame window.

TTC Reports

This window allows you to view or print TTC reportsxe "TTC Reports" for active duty, reserve, HOMC, or all units in TTC/SEQ or English statement order. You can also generate reports by matching specific TTCs or keywords.

How Do I Get Here?  

108. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

109. From the Reports menu, choose TTC List. The TTC Reports window opens.

This window contains the following information:

· Manpower Management System

· TTC SEQ

· Regular/Reserve/Headquarters

· Flag

· Status Date

· Delete/Delete as Erroneous/Event Entry

· English Statement

· Page Number

To a Generate a Custom Report

110. Under Types, select the type of units you want to use to filter the report. Active Duty is the default selection.

111. Under Match, do one of the following. All is the default selection.

· If you want to select all units, select All. 

· If you want to select a specific TTC:

ce) Select TTC.

cf) In the TTC box, type a TTC number.

· If you want to match a keyword:

bf) Select Keyword.

bg) In the Keyword box, type the keyword.

112. Under Sort By, select a sort option. TTC / Sequence is the default selection.

113. Choose Refresh Report. The report window displays the selected information.

To Print a Report

45. Choose Print. UD/MIPS prints the report, and a message box indicates if the report was printed successfully.

46. Choose OK. You return to the TTC Reports window.

To Exit This Window

· Chose Close. You return to the previous window.

CUDDB Postings

xe "CUDDB Postings"This window contains a report that lists all of the TTCs that will update the local database. This report is printable.

How Do I Get Here?  

203. Begin in the Unit Diary Management window.

204. From the Reports menu, choose CUDDB Postings. The CUDDB Postings window opens.

This report contains the following information:

· TTC SEQ

· Prompt

· Table

· Column

· SEQ Number

· Type

· Length

· Encoded Flag

To Print the Report

· Choose Print. The report prints.

To Exit This Window

· Choose Close. You return to the Unit Diary Management window.

Unit of Work Report

xe "Unit of Work Report"This report lists all of transactions that have been assigned to a specific unit of work.

How Do I Get Here?

114. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

115. From the Reports menu, choose Unit of Work Report. The Identify Unit of Work window opens.

116. Select the Unit of Work title.

117. Choose OK. The Unit of Work Report window opens.

This report lists the following information:

Header Information

· Title (Unit of Work)

· Base Address

· RUC

· Unit of Work

· Page Number

Transaction Information

· Diary Number

· Record ID

· Transaction Status

· Flag

· Name

· Social Security Number

· TTC/SEQ

· Remarks

Footer Information

· Total Number of Transactions/Dates of Transactions

· Local Address

To Print the Report

205. From the File menu, choose Print. A message informs you if the printing was successful.

206. Choose OK. You return to the Unit of Work Report window.

To Save a Text File of the Report

· Do one of the following:

· Type Ctrl-T. The Save As window opens.

· From the File menu, choose Save As. The Save As window opens.

To Exit This Window

· From the File menu, choose Close. You return to the Unit Diary Management window.

Research Diary Report

xe "Research Diary Report"

xe "View and Print Research Diary Report"This report lists all of transactions for a selected diary.

How Do I Get Here?

207. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

208. From the Reports menu, choose Research Diary. The Select Diary window opens.

209. Select the diary or transaction pool. Choose OK. The Research Diary window opens and displays the report.

This report lists the following information:

Header Information

· Title (Research Diary)

· Base Address

· Reporting Unit Code

· Diary Number or Pool

· Diary Date

· Page Number

Transaction Information

· Record ID

· Transaction Status

· Flag

· Name

· Social Security Number

· TTC/SEQ

· Remarks

Footer Information

· Total Number of Transactions/Dates of Transactions

· Local Address

To Print the Report

210. From the File menu, choose Print. A message informs you if the printing was successful.

211. Choose OK. You return to the Unit of Work Report window.

To Save a Text File of the Report

· Do one of the following:

· Type Ctrl-T. The Save As window opens.

· From the File menu, choose Save As. The Save As window opens.

To Exit This Window

· From the File menu, choose Close. You return to the Unit Diary Management window.

Courier Reports

xe "Courier Reports"This window enables you to view or print the Diary Transmittal Letter, Smooth Print, CUDDB Statistics, and Exception reports, which are generated whenever a Unit Diary courier is made. These reports are not available for Accessions accounts. 

How Do I Get Here?

118. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

119. Select the certified diary you want to place in courier.

120. From the Diary menu, choose Make Courier. The Make Courier window opens.

121. After completing the steps in the Make Courier window, choose OK. The Courier Reports window opens.

OR

122. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

123. From the Courier menu, choose View Courier Reports. The Courier Reports window opens.

Tab Summary

Do one of the following:

· To view the letter that informs the MISSO that the diary has been generated each time a courier has been made, choose Diary Transmittal Letter. 

· To view the report that is sent with the Diary Transmittal Letter to indicate who has certified and prepared the diary and lists the members affected by the transactions, choose Smooth Print.
· To view the report that is sent with the Diary Transmittal Letter to indicate how the diary has affected the CUDDB, choose CUDDB Statistics.
· To view the report that is sent with the Diary Transmittal Letter to list transactions that have been flagged or have been rejected from the CUDDB, choose Exceptions.
Dairy Transmittal Letter

The letter is generated every time a courier is generated it informs the MISSO that the diary has been generated. This letter displays the following information: 

· Reporting Unit Code Number

· Manpower Management System

· Date of Report

· Title (Diary Transmittal Letter)

· Sender Address

· Recipient Address

· Diary Number

· Diary Date

· Diary Statistics File Total

· Number of Events

· CUDDB Status

Smooth Print Report

This report is sent with the Diary Transmittal Letter and indicates who has certified and prepared the diary and the members affected by the transactions. This report displays the following information:

· Title (Reprint)

· Name of Recipient

· Address of Recipient

· Reporting Unit Code Number

· Diary Number

· Diary Date

· Page Number

· Last Name

· Initials

· Social Security Number

· Remarks

· Sender Address

· Sender Signature Blank

CUDDB Statistics

This report lists transactions that have been flagged or have been rejected from the CUDDB. This report displays the following information:

· Date of Report

· Manpower Management System

· Page Number

· Reporting Unit Code Number

· Title (Unit Diary Update of CUDDB)

· Diary Number

· Transactions Processed

· CUDDB Records Added

· CUDDB Records Deleted

· Total CUDDB Updates

· Total CUDDB Records

Courier Exceptions Report

This report lists transactions that have been flagged or have been rejected from the CUDDB. This report displays the following information:

· Date of Report

· Manpower Management System

· Page Number

· Reporting Unit Code Number

· Title (CUDDB Update Exception Report)

· Diary Number

· Social Security Number

· Name

· Identification Code

· TTC SEQ

· Exception Code

To Print the Reports

· Choose Print. The Print Courier Reports window opens.

To Exit This Window

· Choose Close. You return to the previous window.

Print Courier Reports

Depending on your ELSIG level, this window enables you to print Courier Reportsxe "Print Courier Reports".

How Do I Get Here?

212. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

213. Select the diary you want to place in courier.

214. From the Diary menu, choose Make Courier. The Make Courier window opens.

215. Choose OK. The Courier Reports window opens.

216. Choose Print. The Print Courier Reportsxe "Print Courier Reports" window opens.

—OR—

217. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

218. Select a courier from the Couriers folder.

219. From the Courier menu, choose View Courier Reports. The Courier Reports window opens.

220. Choose Print. The Print Courier Reports window opens.

To Print Reports

221. In the Available Reports box, do one of the following:

· If you want to print one or more of the reports, select the report names you want.

· If you want to print all of the reports, choose Select All. All of the report names are selected.

· If you want to deselect all of the report names, choose Deselect All. The reports are no longer selected.

222. Choose OK. The reports are printed.

To Exit This Window

· Choose Close. You return to the Courier Reports window.

Unit Diaries

Unit Diaries

xe "Unit Diaries"Depending on your ELSIG level, you can use the Diary menu in the Unit Diary Management window to add, edit, or delete diaries. You can also use it to finalize, reopen, or certify a diary.

How Do I Get Here?

· From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

—OR—

· In the Unit Diary frame, from the File menu, choose Open Unit Diary Management. The Unit Diary Management window opens.

To Create a New Diary

· From the Diary menu, choose Create New Diary. The Create New Diary window opens.

To Change the Status of Diaries

Use this option to finalize, reopen, or certify diaries.

124. Select the diaries you want to change.

125. From the Diaries menu, choose Diary Status/Notes. The Diary Status/Notes window opens.

To Lock or Unlock Diariesxe "Lock or Unlock Diaries"
If you have an authorized ELSIG, you can lock a diary to prevent others from adding, editing, or removing transactions. You can also unlock a diary so that other authorized users can update it.

126. Select the diaries you want to lock or unlock.

127. From the Diary menu, choose Lock/Unlock Diary. A message indicates the diary is locked or unlocked.

To Make a Courier

223. Select a certified diary.

224. From the Diary menu, choose Make Courier. The Make Courier window opens.

To Delete Diaries

This option is available to authorized ELSIG types. A Certifier may delete any diary. When an accession diary is deleted, the members in the diary are placed in a rejected status and their records can be found in the Rejected folder on the Accessions window. You cannot delete a certified diary.

128. Select the diaries you want to delete.

129. From the Diary menu, choose Delete Diary. A message prompts you to confirm the deletion.

130. Choose Yes. The diaries are deleted.

To Exit the Unit Diary Management Window

· From the File menu, choose Close. You return to the Unit Diary Frame window.

Diary Status/Notes

Depending on your ELSIG authority, this window enables you to prepare, view, or change the status of a diary, view the history of the diary, and type notes about the diary. If you have a certifier-level ELSIG (CO, ECO, Certifier), you can use this window to certify a diaryxe "Certify a Diary", which means that you have verified its contents and that it is ready to be sent to the courier. 

How Do I Get Here?

225. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

226. Select the diary.

227. Do one of the following:

· From the Diary menu, choose Diary Status/Notes. The Diary Status/Notesxe "Diary Status/Notes" window opens.

· Using the right mouse button, choose Diary Status/Notes. The Diary Status/Notes window opens.

This window displays the following information:

· Diary Type

· Diary Number

· Diary Creation Date

· Preparer Social Security Number

· Preparer Name

· Last Updated Date and Time

Status History

· User Access Level

· Date/Time of Change

· User SSN

· User Name

Each diary has the following status options:

· Open. Usually applied to new, not finalized or certified, diaries. 

Note: If you delete or edit a transaction from a certified or finalized diary, the status reverts to open. You receive a notification window.

· Finalized. All entries have been committed to the diary, and it is ready for review. 

· Certified. The diary is certified to be correct and is ready for courier. 

To Prepare a Diary for Certificationxe "Prepare a Diary for Certification"
Use this option if you are ready to submit a diary for certification.

228. From the Status list, select Finalized.

Note: All accession transactions must be Finalized.

229. If you want to make a note about the diary, type the note in Reviewer Notes or Preparer Notes box, depending on your ELSIG.

230. Do one of the following:

· To submit the changes to the diary, choose OK. You return to the Unit Diary Management window.

· To stop your changes, choose Cancel. You return to the Unit Diary Management window.

To Reopen a Diaryxe "Reopen a Diary"
231. If you have ELSIG authority, from the Status list, select Open.

232. If you want to make a note about the diary, do one of the following:

· If you are a preparer, in the Preparer Notes box, type the note.

· If you are a reviewer, in the Reviewer Notes box, type the note.

· If you are a certifier, in the Certifier Notes box, type the note.

233. Do one of the following:

· To proceed with the changes, choose OK. You return to the Unit Diary Management window.

· To stop your changes, choose Cancel. You return to the Unit Diary Management window. 

To Certify a Diaryxe "Certify a Diary"
Certifying a diary means that you have indicated that all the transactions are accurate. When a diary is certified, all of the transactions in the diary are certified as well.

234. If you want to make a note about the diary, in the Certifier Notes box, type the note.

235. From the Status list, select Certified.

236. Do one of the following:

· To submit the diary, choose OK. You return to the Unit Diary Management window.

· To stop your changes, choose Cancel. You return to the Unit Diary Management window.

To Make a Diary Notexe "Make a Diary Note"
You can make notes on a diary even if you are not going to change its status. You cannot edit previous notes and can only enter notes for your ELSIG authorization.

131. If you want to make a note about the diary, do one of the following:

· If you are a preparer, in the Preparer Notes box, type the note.

· If you are a reviewer, in the Reviewer Notes box, type the note.

· If you are a certifier, in the Certifier Notes box, type the note.

132. Do one of the following:

· To submit the note, choose OK. You return to the Unit Diary Management window.

· To stop your changes, choose Cancel. You return to the Unit Diary Management window.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

See Also:

HAMS Accession 

Retiree Accession 

Unit Diary Couriers

Unit Diary Couriers

xe "Import Couriers"

xe "Unit Diary Couriers"

xe "Export Couriers"The Courier menu in the Unit Diary Management window enables you to track the number of couriers created and currently in the local and remote drives, and allows you to view and print Diary Transmittal Letters, CUDDB Statistics, and Exceptions reports through the Courier Reports window. You can archive courier diaries and indicate the number of accepted, rejected, and total transactions. In addition, you can create a multiple courier zip (*.MZC) file, delete couriers, filter the list of couriers, resend couriers, and import and export courier diaries.

Any authorized user can modify certain information regarding the courier. 

How Do I Get Here?

· From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

—OR—

· In the Unit Diary frame, from the File menu, choose Open Unit Diary Management. The Unit Diary Management window opens.

To View Courier Reports for a Single Courier

237. Select the couriers you want to see in the report.

238. From the Courier menu, choose View Courier Reports. The Courier Reports window opens.

To Archive Courier Diaries

133. Select the diary you want to archive.

134. From the Courier menu, choose Create Archive. A message prompts you to confirm that you want to archive the diary.

Note: The archive file cannot be created until the TFS Cycle, Transactions Accepted, Rejected, and Total (CART) fields are populated from the Collection server, DFR module, or manually by the user for the respective diary.

135. Choose Yes. The Browse for Folder window opens.

136. Once you have selected a folder and the process completes, a message informs you that the process was successful. Choose OK. The courier is archived to the specific location in file with a .DAR (or diary archive) extension. You return to the Unit Diary Management window.

To Import Courier Diaries

This window allows you to import courier diaries from the UD/MIPS database.

239. Select the diary you want to import.

240. From the Courier menu, choose Import Courier.  A message prompts you to confirm that you want to import the diary.

241. Choose Yes.  The Browse for Folder window opens.

242. Once you have selected the folder and the process completes, a message informs you that the process was successful.  Choose OK.  The courier is imported from the specific location.  You return to the Unit Diary Management window.

To Export Courier Diaries

This window allows you to export courier diaries from the UD/MIPS database that cannot be archived due to unknown Cycle Accepted Rejected Total (CART) information.

243. Select the diary you want to export.

244. From the Courier menu, choose Export Courier.  A message prompts you to confirm that you want to export the diary.

245. Choose Yes.  The Browse for Folder window opens.

246. Once you have selected the folder and the process completes, a message informs you that the process was successful.  Choose OK.  The courier is exported from the specific location.  You return to the Unit Diary Management window.

To CART Edit

The CART editing process allows you to indicate the number of accepted, rejected, and total transactions and the TFS Cycle Number.

137. Select the courier you want to edit.

138. From the Courier menu, choose Cart Edit. The CART Edit window opens.

To MultiZip Couriers

If you are authorized, you can upload multiple Unit Diaries within the same courier file to the mainframe for processing. During the MultiZip process, you can create multiple couriers and add them to the zipped courier file. This process creates a text (*.MZC) file that contains information for all Unit Diaries contained on the created zipped courier file. 

Information on this text file includes:

· RUC

· Unit Diary Number

· Unit Diary Date

· MultiZip Courier Name (default or user-defined) 

· From the Courier menu, choose MultiZip. The MultiZip window opens.

To Delete a Courier

139. Select the courier you want to delete.

140. From the Courier menu, choose Delete Courier or Delete FTP Courier. A message prompts you to confirm the deletion.

141. Do one of the following:

· To delete the courier, choose Yes. The courier is deleted, and you return to the Unit Diary Management window.

· To cancel the deletion, choose No. The courier is not deleted, and you return to the Unit Diary Management window.

Note: This is not available for floppy drives.

To Filter the List of Couriers

247. In the Status box, select the check boxes of the status you want displayed and clear the check boxes of the status you do not want displayed.

248. Choose Force Update or Refresh.

Status Types:

· If you want to view courier tracking information with only a Creation Date, choose Initial.

· If you want to view courier tracking information that is ready to be sent, choose Prepared.

· If you want to view courier tracking information with a Sent Date, choose Sent.

· If you want to view courier tracking information with unknown data, choose Unknown.

· If you want to view courier tracking information that has completed the send courier process, choose Completed.

· If you want to view courier tracking information that has exceeded the expiration time limits of the MISSO, choose Dropped.

To Resend a Courier

249. From the Transaction Tree box under Couriers, Remote, select the courier to resend.

250. Do one of the following:

· From the Courier menu, choose Resend FTP Courier. If successful, the status changes to Resent.

· Using the right mouse button, choose Resend FTP Courier. If successful, the status changes to Resent.

To Exit the Unit Diary Management Window

· From the File menu, choose Close. You return to the Unit Diary Frame window.

Make Courier

This window displays all certified diaries and enables you to write the contents of a certified diary to either a diskette or to a file on the local hard drive. Only authorized ELSIGs are authorized to perform this procedure.  

If the courier Version Control Number is outdated, the Mainframe will generate an advisory message.

How Do I Get Here?

142. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

143. Select the diary.

144. Do one of the following:

· From the Diary menu, choose Make Courier. The Make Courierxe "Make Courier" window opens. 

· Using the right mouse button, choose Make Courier. The Make Courier window opens.

To Make a Courier
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WARNING:
IF PROCESSING A COURIER, YOU CANNOT 
EXECUTE A RECONCILIATION.
Only one user at a time is authorized to log onto the server to make courierxe "Make Courier".  If you try to create a courier when another user is already creating one, a message informs you that another user is currently creating one.  You must wait until the current courier process is completed or try again at a later time.

145. In the Certified Diaries box, do one of the following: 

cg) To select one or more diaries, select one or more certified diaries.

ch) To select all diaries, choose Select All. All of the diaries are selected.

ci) To select no diaries, choose Deselect All. All of the diaries are deselected.

146. In the Target box, do one of the following:

m) If you want to write the courier(s) to your hard drive, select Hard Drive.

cj) If you want to write the courier(s) to a disk, insert a disk in your A: drive and select Diskette.

147. In the View Reports checkbox, do one of the following:

n) If you want to view the document on screen, select the View Reports box.

ck) If you want to print the document without viewing, clear the View Reports box.

Note: Users selecting single or multiple diaries will view courier reports after the courier is made. 

148. Choose OK.  The courier is saved.  The diary is removed from the Certified Diary list, and the Unit Diary Management window is refreshed to show the removal of the courier diary. A message informs you the courier has been created. If there are any courier report files generated, the Courier Reports window opens instead.

Note: When you select diaries and choose OK in order to make the courier, other users cannot make any additional changes because they are locked out. If server resources are not available to make courierxe "Make Courier", the Courier process enters a wait state. A message prompt indicates the name of the machine that controls the resources. Every 30 seconds, the wait state checks for free resources and continues courier processing once they become available. The message prompt allows you to cancel out of the wait state, at which point the Make Courierxe "Make Courier" process stops without making the courier and unlocks the selected diaries.

149. If there were no courier report files, choose OK. You return to the Unit Diary Management window.

To Exit This Window

· Choose Close. You return to the Unit Diary Management window.

CART Edit

This window allows you to indicate the number of accepted, rejected, and total transactions and the TFS Cycle Number (Cycle Number, Accepted Transactions, Rejected Transactions, Total Transactions). You must enter all of the requested information.

How Do I Get Here?

251. From the UD/MIPS Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

252. Choose the Courier treeview. The local and remote folders display.

253. Select the courier you want to edit.

254. From the Courier menu, choose CART Edit. The CART Editxe "CART Edit" window opens.

To Edit CART Information for a Courier

255. Under Transactions, in the Accepted box, type the number of accepted transactions.

256. In the Rejected box, type the number of rejected transactions.

257. In the Total box, type the total number of transactions.

258. Under TFS, in the Cycle box, type the cycle number.

259. Do one of the following:

· Choose OK. You return to the Unit Diary Management window.

· Choose Cancel. You return to the Unit Diary Management window.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

MultiZip (Courier Batch File)

xe "Courier Batch File"If you are authorized, you can use this window to upload multiple Unit Diaries within the same courier file to the mainframe for processing. During the MultiZipxe "MultiZip" process, you can create multiple couriers and add them to the zipped courier file. This process creates a *. AZC text file for accession diaries and a *. MZC text file for other types of diaries. These files contains information for all Unit Diaries contained on the created zipped courier file.

How Do I Get Here?

260. From the UD/MIPS Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

261. In the Couriers treeview, select the Local folder.

262. Select the couriers you want to place in the MultiZipxe "MultiZip" filexe "MultiZip File".

263. From the Courier menu, choose MultiZip. The MultiZip window opens.

Note: You must select more than one Unit Diary Courier file for this option to work.

Information on this text file includes:

· RUC

· Unit Diary Number

· Unit Diary Date

· MultiZipxe "MultiZip" Courier Name (default or user-defined) 

To Make a Batch File

264. Select the folder where the MultiZipxe "MultiZip" filexe "MultiZip File" should go.

265. Do one of the following:

· Choose OK. You return to the Unit Diary Management window.

· Choose Cancel. You return to the Unit Diary Management window.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

Unit Diary Archives

Unit Diary Archives

xe "Unit Diary Archives"

xe "Archive Unit Diary"The Archive menu allows you to restore archived diary information files (with a .dar extension) or to delete an archive.

How Do I Get Here?

· From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

—OR—

· In the Unit Diary frame, from the File menu, choose Open Unit Diary Management. The Unit Diary Management window opens.

To Restore an Archive

· From the Archive menu, choose Restore. The Select Archive window opens.

To Delete an Archive

266. Select the archive you want to delete.

267. From the Archive menu, choose Delete Archive. A message prompts you to confirm the deletion.

268. Do one of the following:

· To delete the archive, choose Yes. The archive is deleted, and you return to the Unit Diary Management window. 

· To cancel the deletion, choose No. The archive is not deleted, and you return to the Unit Diary Management window.

To Exit the Unit Diary Management Window

· From the File menu, choose Close. You return to the Unit Diary Frame window.

Select Archive

xe "Select Archive"This window enables you to select a courier archive to restore.

How Do I Get Here?

269. From the UD/MIPS Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

270. From the Archive menu, choose Restore. The Select Archive window opens.

To Restore an Archive

150. In the Look in box, select the folder where the archive resides.

151. From the list of files, select the archive file you want to restore. The archive files have a .DAR extension.

152. Do one of the following:

· Choose Open. You return to the Unit Diary Management window, and the restored courier displays.

· Choose Cancel. You return to the Unit Diary Management window.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

Browse for Folder

This window enables you to select the folder where the files you want to use are located.

How Do I Get Here?

153. From the UD/MIPS - Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

154. From the Archive menu, choose Restore. The Browse for Folderxe "Browse for Folder" window opens.

This window displays the following information:

· Your User ID

To Select a Folder

271. From the list, select the folder you want.

272. Choose OK. You return to the Unit Diary Management window.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

Export Courier Status Report

Time Frame Specification

xe "Time Frame Specification"This window allows you to enter the time range for the Unit Diary Management Status Report to be exported. It contains the status indicator and the local date time stamp.

How Do I Get Here?

1. From the UD/MIPS Navigator window, choose the Unit Diary module icon. The Unit Diary Management window opens.

2. From the Reports menu, choose Export Status Report. The Time Frame Specification window opens.

To Specify the Time Range

155. In the Enter From Date box, type the beginning date of the range in MM/DD/YYYY format.

156. In the Enter To Date box, type the ending date of the range in MM/DD/YYYY format.

157. Do one of the following:

· Choose OK. The Save As window opens.

· Choose Cancel. You return to the Unit Diary Management window.

To Exit This Window

· Choose Cancel. You return to the Unit Diary Management window.

See Also:

Unit Diary Reports 

Diary Feedback Report

About the Diary Feedback Report

xe "About the Diary Feedback Report"The following highlights the Electronic Diary Feedback Report significant capabilities and features:

5. The Electronic Diary Feedback Report consists of two primary areas: The Diary Feedback Report Summary which provides the user with an abstract view of a selected DFR cycle as well as being designed as a management aide and the Diary Feedback Report which displays overall status of a specific cycle.

6. One or more designated users may work the DFR.  Entities may be defined as one or more users.  These users may be assigned to work the DFR, or portions of the DFR, by TTC/SEQ or by a range of unit diary numbers.

7. Individual DFR transactions may be flagged as opened, worked, worked with notes, rejected, or certified.  This iterative DFR completion method creates a management tool that allows the user to visualize a selected cycle's level of completion in one place, the opening DFR module's summary window.

8. Unit diaries may be created in conjunction with the DFR transaction annotation.  This just-in-time (JIT) feature eliminates or reduces transcription error by providing UD/MIPS' unit diary module with the DFR transaction information.  The unit diary module returns the correcting diary entry(s) as a comment to the DFR module.

9. A DFR may be filtered by user-defined entities or by subordinate RUC.  This filtering feature may be used in conjunction with the Export and Import utilities.  Filtered data, utilizing these two utilities, provide the user with the capability to move DFR information among workstations.  Filtering may also be applied during the on-screen DFR viewing.

The DFR module utilizes UD/MIPS' Electronic Signature (ELSIG) management system.  The following lists the privileges of the user types:

Preparer:
Apply comments to a selected DFR transaction.

Apply a corrective unit diary entry to a selected DFR transaction.

Designate a selected DFR transaction as Worked or Open.

Certifier:
Apply comments to a selected DFR transaction.

Designate a selected DFR transaction as Worked, Open, Rejected, or Certified.

Set the DFR cycle to Finalized, or Certified.

Reviewer:
Apply comments to a selected DFR transaction.

Viewer:
Apply comments to a selected DFR transaction.

Superviewer:
View the DFR.

CO and ECO:
Same as Certifier.

a) A DFR cycle may be archived to a location and storage medium of the user's choice.  The archived DFR will exist in a compressed state until the user recovers the cycle or deletes it.  Note that recovered DFRs are noneditable thereby integrity is maintained throughout the filing requirement period.  Recovered DFRs will appear in summary lists with a Cycle Status of "Closed".

b) The Oracle Load Ready File Format (OLRFF) file, created by the Reporting Unit Code (RUC) Qualified Download process, will be used to reconcile the DFR information into the user's database.

Diary Feedback Report Summary

xe "Diary Feedback Report Summary"This window displays a summarized view of the DFR cycles currently loaded in the server's database.  Date information, cycle status, percentage worked, and whether the cycle has notes against it are shown and can be filtered by status.  

You can filter the window to show cycles of a specific work status, sort the DFR cycle domain by column header in descending order, and work with one or more DFR cycles that vary in completion state.  Users may also edit, review, filter DFR cycles by the status they hold, and set the status for the entire DFR.

Utilities specific to the DFR are located in this window on the Tools menu.  You may Load DFR, Delete DFR, Export Notes, Import DFR Notes, Archive DFR, and Recover Archived DFR.  Also located in this window and in other DFR windows are the Functional Areas of Responsibility, Work Group and Sort utilities.

This window also includes the exception report.  Exceptions are defined as recycled transactions or a transaction that would prevent the Electronic Diary Feedback Report process from successfully loading into UDMIPS.

How Do I Get Here?

1. Begin on the UD/MIPS Navigator.UD_MIPS_Navigator 

2. Choose DFR.  The Diary Feedback Report Summary window opens.

This window displays the following information:

· Cycle

· Started Date

· Complete Date

· Cycle Status

· Download Date

· Exception Report

· Notes

· Worked

· Not Worked

· Percentage

· View

· Open

· Finalized

· Certified

· Close

To Edit a Cycle

3. Select the desired cycle transaction.  

4. Choose Edit.  The Diary Feedback Report window opens.

To Edit Status Notes

5. Select the desired cycle transaction.  

6. Choose Status Notes.  The DFR Cycle Notes window opens.

To View Cycles

· In the View box do one of the following:

· If you want to view open DFR cycles that have one or more transactions in a worked or certified status, choose Open.

· If you want to view finalized DFR cycles in either a worked or certified status, or a combination of both, choose Finalized.

· If you wanted to view certified DFR's that have had their status changed by a certifying officer, choose Certified.

· If you want to view closed DFR's that have been moved to the server database, choose Closed.

To Toggle Between Ascending and Descending Sorts 

7. Choose the column header for the desired sort.

8. If you want to sort in the opposite manner, choose the column again.

To View the Most Recent Changes to the Transaction

· From the Tools menu, choose Refresh. The latest information displays, including the most recent changes that other users on the same server database have saved.

To Exit This Window

· Choose Close.  You return to the previous window.

See Also:

Archive DFR 

Delete DFR 

DFR Cycle Reconciliation Log 

DFR Cycle Tracking 

Export DFR 

Exception Report 

Import DFR 

Load DFR 

Recover Archived DFR 

Section Maintenance 

Section Reports 

Sort 

Section Report Criteria Selection

This window allows you to select the cycle, section, and DFR section for which to generate a DFR Report. 

How Do I Get Here?

1. Begin on the Diary Feedback Report Summary window.

2. From the Reports menu, choose Section Reports. The Section Report Criteria Selectionxe "Section Report Criteria Selection" window opens.

This window displays the following information:

· Cycle Number

· Cycle Started Date

To Generate a DFR Report

1. In the Cycle List, select the desired cycle.

2. In the Section list, select the desired section.

3. In the DFR Section list, select the DFR section.

4. Choose OK. The DFR Report window opens.

To Exit this Window

· Choose Cancel. You return to the Diary Feedback Report Summary window.

DFR Report

xe "DFR Report"This window allows you to view or print the DFR Cycle Tracking Report or the DFR Section Reports.

How Do I Get Here?

1. Do one of the following:

· Begin on the Cycle Tracking Criteria Selection window.

· Begin on the Section Report Criteria Selection window.

2. Choose OK. The DFR Report window opens.

To Print the Report

· From the File menu, choose Print. The report prints.

To Exit this Window

· From the File menu, choose Close. You return to the Diary Feedback Report Summary window.

See Also:

Part II-Transaction Detail 

Part III-Transaction Detail 

Part IV-Transaction Detail 

DFR Cycle Notes

xe "DFR Cycle Notes"This window allows you to set the status for and to view or attach notes to a DFR cycle. It also allows you to change the status of a cycle, to line out erroneous notes, or to view the latest changes to the cycle on the server database. 

All ELSIGs can view notes and, with the exception of Super Viewers, can add notes to a DFR cycle. Only CO, ECO, or Certifier ELSIGs can change the status of a cycle and only if all of the transactions have been worked.

How Do I Get Here?

· From the Diary Feedback Report Summary window, choose Diary Status/Notes. The DFR Cycle Notes window opens.

This window displays the following information:

· Status

· Cycle Notes

· Current Note

To Change the Status of a Cycle

This box is not available until the DFR is in a finalized status. Once finalized, certifiers may change the status to Certified or Open. This list is unavailable to all users in non-administrative units. 

1. In the Status list, select the desired status.

2. Choose Save. The selected status is saved.

To Add a Note to the Cycle

1. In the Current Note list, type a note that is 2,000 characters or less. 

2. Choose Save. The new note is visible in the Cycle Notes block.

To Line Out a Cycle Note

If a note is incorrect, you can line it out and enter another note with the correct information.

1. In the Current Notes list, select the note you want to line out.

2. From the Tools menu, choose Line Out Note. The selected note is lined through, and below it, a new note indicates that you have lined out the previous one.

To View the Most Recent Changes to the Transaction

· From the Tools menu, choose Refresh. The latest information displays, including the most recent changes that other users on the same server database have saved.

To Exit this Window

· Choose Close. You return to the Diary Feedback Report Summary window.

DFR Cycle Reconciliation Log

xe "DFR Cycle Reconciliation Log"This window allows you to view all logged events that have occurred on the UD/MIPS Server involving an automated DFR Cycle reconciliation. This tracer information is received from the Collection Serverxe "Collection Server". 

How Do I Get Here?

1. From the UD/MIPS - Navigator window, choose the DFR icon. The Diary Feedback Report Summary window opens.

2. From the Reports menu, choose Load Notes. The DFR Cycle Reconciliation Log window opens.

This window displays the following information:

· Cycle Number: The number of the DFR cycle.

· Event Date/Time: The date and time that the DFR event occurred.

· Load Type: The type of DFR processed.

· User: The name of the user.

· Message: The message information indicating DFR cycle events during reconciliation process.

Note: The information is listed in Cycle Number then Event Date order.

To Exit This Window

· Choose Close. You return to the Diary Feedback Report Summary window.

DFR Cycle Tracking Report

xe "DFR Cycle Tracking Report"This report allows you to track status dates of MCTFS processing cycles. The Cycle Tracking Criteria Selection window determines the content of this report.

This report contains the following information:

Header Information

· Date

· Title (DFR Cycle Tracking Report)

· Page

· Reporting Unit Code

Report Information

· Diary Feedback Report Calendar Year-Cycle

· Cycle Started Date

· Cycle Completed Date

· Cycle Loaded Date

· Cycle Finalized Date

· Cycle Certified Date

See Also:

DFR Report 
DFR Section Reports

xe "DFR Section Reports"This report contains the following information for an individual transaction that is displayed in the Part II, Part III, and Part IV transaction detail windows. This report is sorted by the generating TTC.

Header Information

· Date

· Title
(Part II–Rejected Transactions)


(Part III–Advisories/PUREX)


(Part IV–General Advisory Transactions)

· Page Number

· Section

· Reporting Unit Code or Disbursing Station Symbol Number.

· Data Processing Installation

· Cycle Number

Report Information

· Social Security Number

· Diary Number

· Payroll Date

· Effective Date

· Action Date

· Disbursing Officer RUC

· Advisory TTC

· Advisory Error

· Analyst Code

· Member's Name

· Generating TTC-SEQ

· English Statement

· History Statement

· Advisory Description Code Number and English Description

· Status

· Notes 

End of Report Information

· Total Transactions

See Also:

DFR Report 

Part II-Transaction Detail 

Part III-Transaction Detail 

Part IV-Transaction Detail 

Exception Report

This report allows you to view and print recycled transactions contained within a current cycle.  Exceptions are recycled transactions, or transactions that prevent the Electronic Diary Feedback Report (EDFR) from successfully loading into UD/MIPS.  The exception reportxe "Exception Report" is contained as a part of the cyclic EDFR file.  This report can be imported, exported, archived, and retrieved along with the cyclic EDFR.

If there are no transactions to report, the Exception Reportxe "Exception Report" option will be unavailable.

How Do I Get Here?

9. Begin on the UDMIPS Navigator.

10. Choose the DFR module icon.  The Diary Feedback Report Summary window opens.

11. From the Reports menu, choose Exception Reports.  The DFR Report window opens.

This window displays the following information:

· Date

· Title (Exception Report)

· Page

· RUC

· DSSN

· Data Processing Installation

· Cycle

· Social Security Number

· Reporting RUC

· Diary Number

· Payroll Date

· Effective Date

· Action Date

· Advisory Type Transaction Code

· Advisory Error

· Analyst Code

· Name

· Type Transaction Code-Sequence Number

· History

· Advisory Data Control-Number

To Print the Report

· From the File menu, choose Print.  The report prints.

To Exit This Window

· From the File menu, choose Close.  You return to the previous window.

Cycle Tracking Criteria Selection

xe "Cycle Tracking Criteria Selection"This window allows you to select which cycle dates to use when generating the DFR Cycle Tracking Report. 

How Do I Get Here?

1. Begin on the Diary Feedback Report Summary window.

2. From the Reports menu, choose DFR Cycle Tracking. The Cycle Tracking Criteria Selection window opens.

To Generate a Report

1. Do one of the following:

· To generate a report for all cycles, choose All Cycles.

· To generate a report for selected cycles within a date range, choose Cycles from/to and type the date range in the boxes in YYYY/MM/DD format.

2. Choose OK. The DFR Report window opens. This window contains the DFR Cycle Tracking Report.

To Exit This Window

· Choose Cancel. You return to the previous window.

Diary Feedback Report

xe "Changing the Status of Multiple Transactions"

xe "Sorting Columns for a Diary"xe "Adding Notes to Multiple Transactions"This window displays four tabs that list information for a DFR cycle, including daily statistics, rejected transactions, advisory/PUREX transactions, and general advisory transactions. You can select records from these lists for detail viewing, changing the status of the records, or adding comments. All ELSIG authorities can view this window. 

How Do I Get Here?

1. Begin on the Diary Feedback Reportxe "Diary Feedback Report" Summary window.

2. Select a cycle.

3. Choose Edit. The Diary Feedback Report window opens.

The title displays the following information:

· Cycle Number

Tab Summary

· Do one of the following:

· If you want to list unit diaries processed in the DFR cycle and to display a summary of transaction statistics from the cycle, select the Part 1-Dairy Statistics Report tab.

· If you want to list diary transactions that failed to process, select the Part II Rejected Transactions tab.

· If you want to list advisory/PUREX transactions, select the Part III Advisory/PUREX tab.

· If you want to list general advisory transactions, select the Part IV-Advisory Transactions Advisory_Transactions tab.

Filter By Functionality for Part II and Part III

1. If you filter transactions by a section:

· Transactions whose TTC(s) have been associated with a section via the Section TTC Assignment window are displayed. 

· Transactions that have been explicitly assigned to a section by selecting a desired section from the list box within either Part II or Part III Transaction Detail window(s) are displayed.

2. If you filter transactions that are unassigned:

· Only those transactions that have not been associated with a section are displayed. 

To Filter the List of Transactions

(Applies to Part II, Part III, and Part IV tabs.) 

· In the Filter By list, select the desired section. Applicable transactions display.

To Change the Status of or Add Notes to Multiple Transactions

(Applies to Part II, Part III tabs.)

1. Select the desired transactions.

2. From the Tools menu, choose Multiple Status/Note Change. The Multiple Status and Note Change window opens.

To Toggle Between Ascending and Descending Sorts 

1. Choose the column header for the desired sort.

2. If you want to sort in the opposite manner, choose the column again. 

To Exit this Window

· From the File menu, choose Close. You return to the Diary Feedback Reportxe "Diary Feedback Report" Summary window.

Diary Statistics Report

xe "Adding Notes to a Diary"This tab lists unit diaries processed by MCTFS and displays a summary of transaction statistics from each cycle. You can determine if the total diary entries submitted are equal to the total diary transactions processed. 

How Do I Get Here?

1. Begin on the Diary Feedback Report window.

2. Choose the Part I-Diary Statistics Report tab. The Diary Statistics Reportxe "Diary Statistics Report" tab opens.

This tab displays the following information:

Diary

· Number: Unit diary number.

· Status: Indicates current status of the unit diary. Only the first character displays. These first characters represent the following: open, certified, and processed.

· Administrative Control Unit (ACU): This column displays as an asterisk if the unit diary was prepared by the local MISSO.

· Date: The calendar date that the diary was made.

· Notes: The presence of an '*' in this column denotes that a note or comment is present in the Diary Notes window. 

Date

· Opened: The date the entry was made.

· Certify: The date the diary was certified by the certifying officer.

Transactions

· Number of Accepted Transactions: Number of diary transactions within a unit diary that have been accepted for processing.

· Number of Rejected Transactions: Number of diary transactions within a unit diary that were not accepted for processing.

· Total: The total transactions reported on the selected unit diary.

To View, Add, or Modify Notes to a Diary

· Choose the desired diary. The Diary Notes window opens. 

To Exit This Window

· From the File menu, choose Close. You return to the Diary Feedback Report Summary window.

Diary Notes

xe "View the Most Recent Changes to the Data in Diary Notes"This window allows you to add notes to a selected unit diary for future reference and to maintain a historical record of notes for individual diaries. It also allows you to line out erroneous notes and to view the latest changes to the transaction on the server database.

How Do I Get Here?

1. Begin on the Diary Feedback Report window, Diary Statistics Report tab.

2. Choose the record you want to view. The Diary Notes window opens.

This window displays the following information:

· Diary Notesxe "Diary Notes"
To Add a New Note to the Diary

1. In the Current Note box, type a note that is 2,000 characters or less. 

2. Choose Save Entry. The new note is visible in the Diary Notes block.

Note: If you want to add the same note to multiple transactions, see the Multiple Status and Note Change topic.

To Line Out a Diary Note

If a note is incorrect, you can line it out and enter another note with the correct information.

1. In the Diary Notes list, select the note you want to line out.

2. From the Tools menu, choose Line Out Note. The selected note is lined through, and below it, a new note indicates that you have lined out the previous one.

To View the Most Recent Changes to the Transaction

· From the Tools menu, choose Refresh. The latest information displays, including the most recent changes that other users on the same server database have saved.

To Exit This Window

· Choose Close. You return to the Diary Feedback Report window.

Part II Rejected Transactions

xe "Part II Rejected Transactions"This tab displays a list of transactions that failed to process and provides a brief description of the error. You can create a volume transaction from this window.  This information appears in a tabular format.

How Do I Get Here?

1. From the UD/MIPS Navigator window, choose the Diary Feedback Report icon. The Diary Feedback Report Summary window opens.

2. Select a cycle.

3. Choose Edit. The Diary Feedback Report window opens.

4. Choose Part II Rejected Transactions tab. The Rejected Transactions tab opens.

This tab displays the following information:

· Type Transaction Code and Sequence Code: The generating TTC for the diary entry.

· Diary Number: Identifies the specific diary in which a transaction occurs.

· Analyst Code: This code indicates which clerk is assigned to a block of social security numbers. An asterisk indicates all clerks. This column applies primarily to reserve SuperRUCs and not to active units. 
· Transaction Assignment: Displays the section that has been explicitly assigned by the user, selecting the desired section within either the Part II or Part III Transaction Detail windows.

· Social Security Number: The member's Social Security Number.

· Member's Name: Identifies the specific member by last name and initials.

· Status: Values include: O-Open (no actions taken), W-worked (preparer or certifier has taken action), R-Rejected (worked but rejected by certifier), C-certified, N-note applied 

· Error Description Statement: Describes the problems encountered in various diary entries.

To View Transaction Details

· Choose a transaction. The Part II Transaction Detail window opens. 

To Change Status, Add Notes, or Assign Sections

1. Select the open transactions you want to include. 

2. Do one of the following:

· From the Tools menu, choose Multiple Status/Notes Change. The Multiple Status and Note Change window opens.

· Type CTRL-M. The Multiple Status and Note Change window opens.

To Create a Volume Transaction

You can create a volume transaction from failed transactions that share the same TTC and sequence. You must choose more than one transaction for this option to be available.

1. From the list of transactions, select the transactions you want to include in the volume transaction.  

Note: If the transactions you select do not have the same TTC and sequence, an error message displays.

Note: If you select more than one transaction with the same Social Security Number, an error message displays.

2. Do one of the following:

· From the Tools menu, choose Create Volume Transaction. The Select Diary window opens. After selecting a diary and following the steps in the Volume Transactions window, you return to the Part II Transaction Detail window.

· Type CTRL-U. The Select Diary window opens. After selecting a diary and following the steps in the Volume Transactions window, you return to the Part II Transaction Detail window.

To Exit This Window

· From the File menu, choose Close. You return to the Diary Feedback Report Summary window.

Part II Transaction Detail

xe "Part II Transaction Detail"This window displays the details of a rejected transaction. From this window you can create a New Unit Diary, add a transaction to an existing open Unit Diary, add a transaction to the Transaction Pool, and track the progress of a transaction. You can also view notes, type notes, line out erroneous notes, view the latest changes to the transaction, assign the transaction to another section, and change the status of a transaction.

How Do I Get Here?

1. From the UD/MIPS Navigator window, choose the Diary Feedback Report icon. The Diary Feedback Report Summary window opens.

2. Select a cycle.

3. Choose Edit. The Diary Feedback Report window opens.

4. Choose Part II Rejected Transactions tab. The Rejected Transactions tab opens.

5. Choose the transaction you want to view. The Part II Transaction Detail window opens.

This window displays the following information:

· RUC/DSSN: Reporting Unit Code/Disbursing Station Symbol Number.

· DPI: A unique number assigned to a specific processing center.

· Cycle: Cycle number.

· SSN: The member's Social Security Number.

· Diary Number: Identifies the specific diary in which a transaction occurs.

· Unit Diary Date: The date the diary was prepared.

· Effective Date: The calendar date a specific action becomes effective.

· Action Date: Used for determining sequence of processing.

· DO-RUC: The disbursing office for the RUC.

· Advisory TTC: The advisory transaction code, generated by the system to indicate a recommended code for the transaction.

· Advisory Error: Identifies the transaction error code.

· Analyst Code: This code indicates which clerk is assigned to a block of social security numbers. An asterisk indicates all clerks. This column applies primarily to reserve SuperRUCs and not to active duty units. 
· Name: Identifies the specific member by last name and initials.

· TTC (TTC-SEQ w/English Statement): Transaction Type Code.

· Section: Identifies the section assigned for the transaction.

· Preparer ID: The identification number (SSN) for the preparer.

· Certifier ID: The identification number (SSN) for the certifier.

· Hist: Displays any existing statement submitted with the transaction.

· ADC-NR (Advisory Description Code Number): The file number assigned to this particular advisory message and the English description of the message.

· Transaction Notes: Contains previously entered notes from the Current Note box. 
To Add or Correct a Transaction

1. If you have logged in with a preparer ELSIG, choose Diary Entry. The Select Diary window opens. 

2. After completing the steps in the Unit Diary Management topic, the corrected diary transaction displays in the Current Notes box.

3. Choose Save. The note displays in the Transaction Notes box.

To Add a Note to the Transaction

1. In the Current Note box, type a note up to 2,000 characters. 

2. Choose Save. The new note displays in the Transaction Notes box. 

To Change the Status of the Transaction

1. Do one of the following:

· If you have logged in with a preparer ELSIG, in the Status area, select Open or Worked.
· If you have logged in with a certifier ELSIG, in the Status area, select Open, Worked, Rejected, or Certified.

2. Choose Save. The new status displays in the Flag column of the Diary Feedback Report window Part II Rejected Transactions tab.

To Line Out a Transaction Note

If you enter a note incorrectly, you can line out the incorrect note and enter another note with the correct information.

1. In the Transaction Notes box, select the note you want to line out.

2. From the Tools menu, choose Line Out Note. The selected note is lined through, and below it, a new note indicates that you have lined out the previous one.

Associating Transactions

You can associate transactions with section(s) in two distinct ways:

1. Use the Section TTC Assignment window to associate TTC(s) with Section(s).

Note: Once the transactions have been assign with a section, they no longer show under UNASSIGNED.

2. To explicitly assign the transaction to a different section, do the following:

a) In the Assign Transaction to Section list, select the new section.

b) Choose Save. The transaction is reassigned and displays on the Diary Feedback Report under the Transaction Assignment column.

To View the Most Recent Changes to the Transaction

· From the Tools menu, choose Refresh. The latest information displays, including the most recent changes that other users on the same server database have saved.

To Exit This Window

· Choose Close. You return to the Diary Feedback Report window.

See Also:

Transaction Detail 

Part III Advisory/PUREX

xe "Part III Advisory/PUREX"This window displays the details of an advisory and PUREX transaction. From this window you can create a New Unit Diary, add a transaction to an existing open Unit Diary, add a transaction to the Transaction Pool, track the progress of a transaction, and create a volume transaction. You can also view notes, type notes, line out erroneous notes, view the latest changes to the transaction on the server database, assign the transaction to another section, and change the status of a transaction.

How Do I Get Here?

1. From the UD/MIPS Navigator window, choose the Diary Feedback Report icon. The Diary Feedback Report Summary window opens.

2. Select a cycle.

3. Choose Edit. The Diary Feedback Report window opens.

4. Choose Part III Advisory/PUREX tab. The Advisory/PUREX tab opens.

This tab displays the following information:

· Type Transaction Code and Sequence Code: The generating TTC for the diary entry.

· Diary Number: Identifies the specific diary in which a transaction occurs.

· Analyst Code: This code indicates which clerk is assigned to a block of social security numbers. An asterisk indicates all clerks. This column applies primarily to reserve SuperRUCs and not to active units. 
· Transaction Assignment: Displays the section that has been explicitly assigned by the user, selecting the desired section within either the Part II or Part III Transaction Detail window(s).

· Social Security Number: The member's Social Security Number.

· Member's Name: Identifies the specific member by last name and initials.

· Status: Values include: O-Open (no actions taken), W-worked (preparer or certifier has taken action), R-Rejected (worked but rejected by certifier), C-certified, N-note applied 

· Error Description Statement: Describes the problems encountered in various diary entries.

To View Transaction Details

· Choose a transaction. The Part III Transaction Detail window opens. 

To Change Status, Add Notes, or Assign Sections

1. Select the open transactions you want to include. 

2. Do one of the following:

· From the Tools menu, choose Multiple Status/Notes Change. The Multiple Status and Note Change window opens.

· Type CTRL-M. The Multiple Status and Note Change window opens.

To Create a Volume Transaction

You can create a volume transaction from failed transactions that share the same TTC and sequence. You must choose more than one transaction for this option to be available.

1. From the list of transactions, select the transactions you want to include in the volume transaction.  

Note: If the transactions you select do not have the same TTC and sequence, an error message displays.

Note: If you select more than one transaction with the same Social Security Number, an error message displays.

2. Do one of the following:

· From the Tools menu, choose Create Volume Transaction. The Select Diary window opens. After selecting a diary and following the steps in the Volume Transactions window, you return to the Part II Transaction Detail window.

· Type CTRL-U. The Select Diary window opens. After selecting a diary and following the steps in the Volume Transactions window, you return to the Part II Transaction Detail window.

To Exit This Window

· From the File menu, choose Close. You return to the Diary Feedback Report Summary window.

Part III Transaction Detail

xe "Part III Transaction Detail"This window displays the details of an advisory and PUREX transaction. From this window you can create a New Unit Diary, add a transaction to an existing open Unit Diary, add a transaction to the Transaction Pool, and track the progress of a transaction. You can also view notes, type notes, line out erroneous notes, view the latest changes to the transaction, assign the transaction to another section, and change the status of a transaction.

How Do I Get Here?

1. From the UD/MIPS Navigator window, choose the Diary Feedback Report icon. The Diary Feedback Report Summary window opens.

2. Select a cycle.

3. Choose Edit. The Diary Feedback Report window opens.

4. Choose Part III Advisory/PUREX tab. The Advisory/PUREX tab opens.

5. Choose the transaction you want to view. The Part III Transaction Detail window opens.

This window displays the following information:

· RUC/DSSN: Reporting Unit Code/Disbursing Station Symbol Number.

· DPI: A unique number assigned to a specific processing center.

· Cycle: Cycle number.

· SSN: The member's Social Security Number.

· Reporting RUC: The RUC that originated the transaction.

· Diary Number: Identifies the specific diary in which a transaction occurs.

· Unit Diary Date: The date the diary was prepared.

· Effective Date: The calendar date a specific action becomes effective.

· Action Date: Used for determining sequence of processing.

· Advisory TTC: The advisory transaction code, generated by the system to indicate a recommended code for the transaction.

· Advisory Error: Identifies the transaction error code.

· Analyst Code: This code indicates which clerk is assigned to a block of social security numbers. An asterisk indicates all clerks. This column applies primarily to reserve SuperRUCs and not to active duty units. 
· Name: Identifies the specific member by last name and initials.

· TTC (TTC-SEQ w/English Statement): Transaction Type Code.

· Section: Identifies the section assigned for the transaction.

· Preparer ID: The identification number (SSN) for the preparer.

· Certifier ID: The identification number (SSN) for the certifier.

· Hist: Displays any existing statement submitted with the transaction.

· ADC-NR (Advisory Description Code Number): The file number assigned to this particular advisory message and the English description of the message.

· Transaction Notes: Contains previously entered notes from the Current Note box. 
To Add or Correct a Transaction

1. If you have logged in with a preparer ELSIG, choose Diary Entry. The Select Diary window opens. 

2. After completing the steps in the Unit Diary Management topic, the corrected diary transaction will display in the Current Notes box.

3. Choose Save. The note displays in the Transaction Notes box.

To Add a Note to the Transaction

1. In the Current Note box, type a note up to 2,000 characters. 

2. Choose Save. The new note displays in the Transaction Notes box. 

To Change the Status of the Transaction

1. Do one of the following:

· If you have logged in with a preparer ELSIG, in the Status area, select Open or Worked.
· If you have logged in with a certifier ELSIG, in the Status area, select Open, Worked, Rejected, or Certified.

2. Choose Save. The new status displays in the Flag column of the Diary Feedback Report window Part II Rejected Transactions tab.

To Line Out a Transaction Note

If you enter a note incorrectly, you can line out the incorrect note and enter another note with the correct information.

1. In the Transaction Notes box, select the note you want to line out.

2. From the Tools menu, choose Line Out Note. The selected note is lined through, and below it, a new note indicates that you have lined out the previous one.

Associating Transactions

You can associate transactions with section(s) in two distinct ways:

1. Use the Section TTC Assignment window to associate TTC(s) with Section(s).

Note: Once the transactions have been assign with a section, they no longer show under UNASSIGNED.

2. To explicitly assign the transaction to a different section, do the following:

a) In the Assign Transaction to Section list, select the new section.

b) Choose Save. The transaction is reassigned and displays on the Diary Feedback Report under the Transaction Assignment column.

To View the Most Recent Changes to the Transaction

· From the Tools menu, choose Refresh. The latest information displays, including the most recent changes that other users on the same server database have saved.

To Exit This Window

· Choose Close. You return to the Diary Feedback Report window.

See Also:

Transaction Detail 

Select Diary

This window allows you to add transactions to the Transaction Pool, add or move transactions to and from the Transaction Pool or to or from an open Regular Unit Diary. In addition, this window allows you to select Accession Diaries for viewing of corresponding validation reports.

Only Preparer ELSIGS have access to this window in most cases. 

How Do I Get Here?

1. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

2. From the Transaction menu, choose Move Transaction. The Select Diary window opens. 

OR

1. From the UD/MIPS - Navigator window, choose the Unit Diary icon. The Unit Diary Management window opens.

2. From the Reports menu, choose Validation Report. The Select Diary window opens.

OR

1. From the UD/MIPS Navigator window, choose the Diary Feedback Report icon. The Diary Feedback Report Summary window opens.

2. Select a cycle.

3. Choose Edit. The Diary Feedback Report window opens.

4. Do one of the following:

· Choose Part II Rejected Transactions tab. The Part II-Rejected Transactions tab opens.

· Choose Part III Advisory/PUREX tab. The Part III-Advisory/PUREX tab opens.

5. Choose a diary. The Part II-Transaction Detail or the Part III-Transaction Detail window opens.

6. Choose Diary Entry. The Select Diaryxe "Select Diary" window opens.

OR

1. From the UD/MIPS - Navigator window, choose the DFR icon. The Diary Feedback Report Summary window opens.

2. Select the cycle with the transactions you want to put in the diary.

3. Choose Edit. The Diary Feedback Report window opens.

4. Do one of the following:

· Choose Part II Rejected Transactions tab. The Rejected Transactions tab opens.

· Choose Part III Advisory/PUREX tab. The Advisory/PUREX tab opens.

5. From the available transactions, select the transactions you want to include in a volume transaction.

6. From the Tools menu, choose Create Volume Transaction. The Select Diaryxe "Select Diary" window opens. 

OR

1. From the UD/MIPS - Navigator window, choose the Tickler File icon. The Tickler Transaction List window opens. 

2. Choose Add To Diary. The Select Diary window opens. 

OR

1. From the UD/MIPS - Navigator window, choose the Tickler File icon. The Tickler Transaction List window opens. 

2. Select a diary.

3. Choose Edit. The Tickler Transaction Detail window opens.

4. Choose Add To Diary. The Select Diary window opens. 

OR

1. From the UD/MIPS Navigator window, choose the Intelligent Forms Selection module icon. The Intelligent Forms Selection window opens.

2. Choose New. The New Record window opens.

3. Select the form and the member for whom the form is intended.

4. Choose OK. The New Form window opens with the selected form partially completed.

5. Choose Add to Diary. The Select Diary window opens. 

This window contains a treeview with the following information:

· Transaction Pool

· Diaries 

· Regular Diaries

To Move a Transaction to a Different Diary

1. Do one of the following:

· In the Regular list, select the diary where you want to place the transaction.

· Select the Transaction Pool.

2. Do one of the following:

· If you want to proceed, choose OK. The transaction is now in the desired location, and the Unit Diary Management window opens.

· If you do not want to move the transactions, choose Cancel. The transaction remains in the same location, and you return to the Unit Diary Management window.

To Select an Existing Diary

1. In the Available Diaries box, do one of the following:

· In the Regular list, select the diary you want to view or edit.

· Select the Transaction Pool.

2. Do one of the following:

· If you want to proceed, choose OK. The Unit Diary Management window opens.

· If you want to cancel your selection, choose Cancel. You return to the Unit Diary Management window.

To Select an Existing Accession Diary

1. In the Available Diaries box, select the diary you want.

2. Do one of the following:

· If you want to proceed, choose OK. The Validation Report window opens.

Note: If the selected diary contains no transactions, a notification message displays.

· If you want to cancel your selection, choose Cancel. You return to the Unit Diary Management window.

To Recreate a Previous Transaction

This option allows you to recreate a previous transaction in the Diary Feedback Report in order to correct it. 

1. Select a diary or the Transaction Pool.

2. Select Recreate Transaction. 

3. Choose OK. The Transaction Detail window opens, and the TTC-SEQ, the SSN, and the prompts display.

To Exit This Window

· Choose Cancel. You return to the previous window.

Advisory Transactions

This tab displays generic information on a member. This information is for viewing only and cannot be edited or modified. This information appears in a tabular format. 

How Do I Get Here?

1. From the UD/MIPS Navigator window, choose the Diary Feedback Report icon. The Diary Feedback Report Summary window opens.

2. Select a cycle.

3. Choose Edit. The Diary Feedback Report window opens.

4. Choose the Part IV Advisory Transactions tab. The Part IV Advisory Transactions tab opens.

This tab lists general advisoryxe "General Advisory" transactionsxe "Advisory Transactions".

· Type Transaction Code and Sequence Code: The generating TTC for the diary entry.

· Diary Number: Identifies the specific diary in which a transaction occurs.

· A Cd: Analyst Code
· Section: Identifies the section assigned for the transaction.

· Preparer ID: The identification number (SSN) for the preparer.

· Certifier ID: The identification number (SSN) for the certifier.

· Social Security Number: The member's Social Security Number.

· Member's Name: Identifies the specific member by last name and initials.

· Description Statement: Describes the problems encountered in various diary entries.

To View Transaction Details

· Choose a transaction. The Part IV Transaction Detail window opens. 

To Exit this Window

· From the File menu, choose Close. You return to the Diary Feedback Report Summary window.

Part IV Transaction Detail

xe "Part IV Transaction Detail"This window displays detailed information for the selected DFR Part IV transaction. This window is view only and there is no status associated with it. Notes cannot be appended to the transactions.

How Do I Get Here?

1. From the UD/MIPS Navigator window, choose the Diary Feedback Report icon. The Diary Feedback Report Summary window opens.

2. Select a cycle.

3. Choose Edit. The Diary Feedback Report window opens.

4. Choose the Part IV Advisory Transactions tab. The Part IV Advisory Transactions tab opens.

5. Choose the transaction you want to view. The Part IV Transaction Detail window opens.

This window displays the following information:

· RUC/DSSN: Reporting Unit Code/Disbursing Station Symbol Number.

· DPI: A unique number assigned to a specific processing center.

· Cycle: Cycle number.

· SSN: The member's Social Security Number.

· Reporting RUC: The RUC that originated the transaction.

· Diary Number: Identifies the specific diary in which a transaction occurs.

· Unit Diary Date: The date the diary was prepared.

· Effective Date: The calendar date a specific action becomes effective.

· Action Date: Used for determining sequence of processing.

· DO-RUC: The disbursing office for the RUC.

· Advisory TTC: The advisory transaction code, generated by the system to indicate a recommended code for the transaction.

· Advisory Error: Identifies the transaction error code.

· Analyst Code: This code indicates which clerk is assigned to a block of social security numbers. An asterisk indicates all clerks. This column applies primarily to reserve SuperRUCs and not to active duty units. 
· Name: Identifies the specific member by last name and initials.

· TTC (TTC-SEQ w/English Statement): Transaction Type Code.

· Section: Identifies the section assigned for the transaction.

· Preparer ID: The identification number (SSN) for the preparer.

· Certifier ID: The identification number (SSN) for the certifier.

· Hist: Displays any existing statement submitted with the transaction.

· ADC-NR (Advisory Description Code Number): The file number assigned to this particular advisory message and the English description of the message.

To Exit this Window

· Choose Close. You return to the Diary Feedback Report window.

Multiple Status and Note Change

xe "Changing the Status of Multiple Transactions"xe "Adding Notes to Multiple Transactions"This window allows you to change the status of, add notes to, or assign sections to multiple diary transactions.

How Do I Get Here?

1. Begin on the Diary Feedback Report window, Part II Rejected Transactions, or Part III Advisory/PUREX tab.

2. From the Tools menu, choose Multiple Status/Note Change. The Multiple Status and Note Changexe "Multiple Status and Note Change" window opens.

To Change Status, Add a Note, or Assign a Section

1. If you want to change the status, in the Status group, select a status. 

2. If you want to add a note, in the Note box, type the information.

3. If you want to assign a section, in the Sections list, select a section.

4. Choose OK. You return to the Diary Feedback Report window.

To Exit this Window

· Choose Close. You return to the Diary Feedback Report window.

Section TTC Assignment

xe "Section TTC Assignment"

xe "Deleting TTCs from the List of Assigned TTCs"

xe "Selecting a TTC List to Assign to the Current Section"This window allows you to assign type transaction codes from a predefined list to specific sections. A section can be one or more persons or a conceptual identification of a work place. After a section is defined, it may be used to filter a selected DFR transaction.

How Do I Get Here?

· From the Section Maintenance window, choose DFR TTC Assignment. The Section TTC Assignment window opens.

This window displays the following information:

· TTC/SEQ

· English Description

To Assign TTCs to a Section

1. In the Section list, select the desired section.

2. Do one of the following:

· To assign one or more TTCs from a predefined list to the section, choose Search TTC. The Members window opens. Follow the steps in the topic for the new window.

· To assign all TTCs in a predefined list to the section, choose Add TTC List. The Predefined TTC-SEQ Lists window opens. Follow the steps in the topic for the new window.

· To enter a single TTC and a description, choose Input TTC. The Input TTC window opens.

To Delete TTCs from the Assigned TTCs List

1. Select one or more TTCs.

2. Choose Delete TTC. The TTCs are removed from the list.

To Exit this Window

· Choose Close. You return to the previous window.

Predefined TTC-SEQ Lists

xe "Predefined TTC-SEQ Lists"This window displays predefined TTC lists and their associated TTC/SEQs and allows you to assign a list to a user-defined section.

How Do I Get Here?

1. Begin on the Section TTC Assignment window.

2. Choose Add TTC List. The Predefined TTC-SEQ Lists window opens.

This window displays the following information:

· TTC List

· TTC-SEQ

· English Description of the TTC

To Assign a TTC List

1. In the TTC List, select a list. The TTCs associated with the list display.

2. Choose OK. The TTCs associated with the list are assigned and saved to the current section. You return to the Section TTC Assignment window. 

To Exit This Window

· Choose Cancel. You return to the previous window.

Input TTC

xe "Input TTC"This window allows you to type a TTC and a description that can be added to the section filter.

How Do I Get Here?

1. Begin on the Section TTC Assignment window.

2. Choose Input TTC. The Input TTC window opens.

To Add a TTC

1. In the TTC box, type the three-character TTC.

2. In the Description box, type the description.

3. Choose Save. You return to the Section TTC Assignment window, and the TTC and description display on the list.

To Exit This Window

· Choose Cancel. You return to the Section TTC Assignment window.

Load DFR

xe "Load DFR"This window allows the users browse for a load file then retrieve it to the window.  It builds records on the server's relational database. It is used to select and load a given cycle from tab delimited text format, which was downloaded via the main frame Oracle Load Ready File Format download.  An intuitive window that prompts for the downloaded mainframe file's location and name will guide users through the load process.  This process is available to all ELSIGs except Superviewer.

How Do I Get Here?

1. Begin on the Diary Feedback Report Summary window.

2. From the Tools menu, choose Load DFR.

3. The Load DFR window opens.

4. The user inputs the path where the file is stored by typing in the fully qualified file path name in the textbox or browsing for the file name.

It is used to select and load a given cycle from tab delimited text format, which was downloaded via the main frame Oracle Load Ready File Format download.

An intuitive window that prompts for the downloaded mainframe file's location and name will guide users through the load process.

Available to all ELSIGs except Superviewer.

Note: You cannot overlay the same cycle and RUC. If you attempt to load the same cycle and RUC, you will be warned to go back and delete the one on file, then do the load.

Purpose:

Provides a window that lets the users browse for a load file then retrieve it to the window.

Builds records on the server's relational database.

Load DFR entry box:

The user inputs the path where the file is stored by typing in the fully qualified file path name in the textbox or browsing for the file name.

OK button:

When clicked, the selected Load File will be added to the server database. A progress meter appears on the Load DFR window, displaying the loading file's progress. The execution will successfully terminate with a Finished window.

Cancel button:

Cancels the operation and closes the window.

Browse button:

Opens the select DFR Load File window.

Users will select the window's open command button after the desired file has been selected.

Successful loads terminate, displaying a "Finished" window with an OK button.

Delete DFR

xe "Delete DFR"How Do I Get Here?

From the Tools menu, choose Delete DFR.

Users may access this menu by using the following key sequence on the keyboard:

Alt-T, D.

The Delete DFR window opens.

To Delete A DFR Ruc Cycle.

Select the desired DFR Cycle.

Select OK.  

A warning window opens.  Select Yes.

A message informs you that the delete was successful.  Choose OK.

This utility lets all users, excluding Superviewers, delete selected DFR cycles from the server's database. The user will perform the below listed actions to delete a DFR cycle.

Note: Multiple selections cannot be performed.

DFR Cycle Box

Cycle:

Indicates Cycle number receiving focus.

Cycle Started Date:

Indicates the date that the cycle was initiated.

OK button:

When selected, deletes an entry from the Ruc cycle.

Cancel button

When selected, cancels current delete transaction with no action taken.

Export DFR Notes

Used to export a given cycle to tab a delimited text format, to be imported by a different machine.

How Do I Get Here?

From the Menu Bar:

Select Tools.
Select Export DFR Notesxe "Export DFR Notes".

You will then be in the Export DFR Notes window.

This utility lets the user export the notes of a selected DFR Cycle to any reasonable storage medium. These notes may be imported at a later time, on another machine, and at a different location. Should the size of the export exceed one floppy disk, if a floppy disk is being used, the user will be prompted to insert a disk. Anticipate using additional diskettes for DFRs that require in excess of 700 notes.

Allows a user to export DFR transactions by cycle, functional area, or work distribution.

Files will be compressed and then will show the *.DFR extension.

Available to all ELSIG's except Super Viewer.

DFR Cycle data box:
Displays a list of cycles to be exported.

Cycle column
Indicates the Cycle number receiving focus.

Cycle Started Date column
The date that processing began on a specific cycle.

OK button

When clicked, the Export DFR window opens. Users may define a location, name and file type for the export file. The default extension is *.DFR.  It is recommended that the default extension be used when exporting DFR Notes.

An Export Successful window appears to inform the user of successful execution.
Writes the selected cycle to tab delimited text format to be stored and imported to another machine.

Cancel button: Cancels the Export operation.

Import DFR Notes

xe "Import DFR Notes"Used to select an exported DFR file to be loaded into the database.

Used to import a given cycle from tab delimited text format, which was exported from the same or a different machine.

An intuitive window that prompts for the import file's location and name will guide users through the import process.

Available to Certifiers, Reviewers, Preparers, Viewers, ECO, and CO. This utility is not available to Superviewers.

Imported notes will be amended to the notes in the local database.

How Do I Get Here?

Start in the Import DFR Notes window.

From the Menu Bar
Select Tools
Select Import File Name box:

Type in the path and name of the file you want to import.

Users may browse for the import file, selecting those files with the *.DFR extension.

OK button:

Extracts the file shown in the Import File Name Edit box to the server's database. Users will be informed of a successful import.

Cancel button:
Terminates the operation, closes the window, and takes you back to the Diary Feedback Report Summary Window.

Browse button:

Opens the Select Import File window, which will bring up a directory for the user to look through until the correct file is found, highlighted, and then retrieved for selection to be imported.  

Archive DFR

xe "Archive DFR"This window allows any ELSIG, excluding Superviewers, to remove certified DFR cycles from the database to a discretionary storage medium like a diskette or a hard drive. 

How Do I Get Here?

12. Begin on the Diary Feedback Report Summary window.

13. From the Tools menu, choose Archive DFR. The Archive DFR window opens.

Note: If the DFR cycle is not certified, a message informs you the cycle must be certified before it can be archived.

This window displays the following information:

· Cycle List: Lists all available cycles with the current RUC.

· Trecon RUC: The Reporting Unit Code that maintains that DFR's cycle number.

· Cycle Number: Indicates the selected cycle number.

· Cycle Started Date: Indicates the date the cycle began.

· Cycle Status: The status of the cycle (always certified). 

To Archive a DFR Cycle

1. Select the cycle you want to archive.

2. Choose Archive. The Archive DFR window opens.

3. In the Save in list, select the directory where you want to save the archive file.

4. In the File Name box, type the name of the file with a .ARC extension.

5. In Save as Type, select Archive Files (*.ARC). 

6. Choose Save. A message informs you if the archiving was successful.

Note: If the storage medium is a diskette, a message will prompt you to put additional diskettes in the drive if the cycle exceeds the capacity of the disk. 

7. If the archive was successful, choose OK. You return to the Diary Feedback Report Summary window. All data related to the selected DFR has been removed from the database. To recover the information, see Recover Archived DFR. 

To Exit This Window

· Choose Close. You return to the Diary Feedback Report Summary window.

Recover Archived DFR

xe "Recover Archived DFR"How Do I Get Here?

1. From the Menu bar
2. Select Tools.

How Do I Recover An Archived DFR?

1. Select Recover Archived DFR.

2. Type the name of the file to be recovered in the Archive File Name edit box.

3. Select the Recover button.

You will see a progress window displaying the status of the recovery process.

Note: This recovered DFR cannot be re-archived. It must be deleted to remove it from the server's database.

You will then see a warning message if an attempt is made to archive a DFR with a "Closed" Cycle Status.

This window retrieves previously archived DFRs from authorized media and locations. Recovered DFRs are added to the server database with a Closed DFR status. 

Users may type the previously archived DFRs fully qualified directory name or they may browse for the archived file.

This utility is available to all users, excluding Superviewer.

Archive File Name data line.

The user may type a fully qualified file path name or may have a fully qualified file path name located by the 

Recover button.  Unarchive the selected file.

Cancel button.  Closes the active window.

Browse button.  This button opens Select Archived File window. Users choose the location and name of file to be recovered.

See Also:

Delete DFR 

Exception Report Selection

xe "Exception Report Selection"This window enables you to select the DFR cycle number in which the exception transactions were generated that you want to include on the Exception Report.  

If there are no exception transactions contained in any currently loaded DFR cycle, a message informs you there are no exception transactions to report.

How Do I Get Here?

2. Begin on the Diary Feedback Report Summary window.

3. From the Reports menu, choose Exception Report.  The Exception Report Selection window opens.

To View an Exception Report

· In the Select Cycle box, select the desired transaction cycle and then do one of the following:

· To display the report, choose OK.  The Exception Report window opens.

· To cancel the transaction, choose Cancel.  You return to the Diary Feedback Report Summary window.

To Exit This Window

· Choose Cancel.  You return to the Diary Feedback Report Summary window.

Marine Integrated Personnel System

About Marine Integrated Personnel System

xe "About Marine Integrated Personnel System"The Marine Integrated Personnel System (MIPS) allows you to view, manipulate, and print the data resident in the Commanders Unit Diary Database (CUDDB) for the Reporting Unit Code (RUC) and subordinate RUCs.  This data is used for many purposes considered vital to a particular user and/or task.

There is a separate RUC option on the menu bar to select the logged in RUC and its supported RUCs from the drop down list box.  You can view data on a selected RUC or all RUCs by selecting the CONAD.

Utilities
When you first log into the MIPS module, and the window is blank, the Utilities option in the Options Menu has a utility called User Field Update.  When selected you can add or change any of the weapons information needed at that time.

Report Selection Menu
The MIPS Reports selection is located in the Option Menu section of the MIPS window.
Note:
Ad Hoc reports are also available through COGNOS Impromptu®.

MIPS Reports
All reports contain the RUC, to which the information pertains, and is displayed in the Header of each report.

Following this section, each report is found in the order listed below, along with the description of its use.  

· Security Clearance / Access 

· Checklist 

· FitRep for OIC / NCOIC (Fitness Report for Officer in Charge/Non-Commissioned Officer in Charge)

· Higher Headquarters

· Personnel Information 

· Pay Inconsistencies and LES (Leave and Earning Statement)

· Personnel Management 

· Promotion 

· Reserve 

· Training Information

· Manpower

· RED (Record of Emergency Data/Family Readiness Roster)

· BIR/BTR (Basic Individual Record/Basic Training Record)

Modify In/Out
This option is available when in the MIPS Reports option.  It brings up a window that lets you to provide additional activity entries for External and/or Organizational Activities, and the Company/Battery they are applied to.BIR_BTR

MIPS View Members
The MIPS View Members selection is located in the MIPS Report Section of the Option Menu section of the MIPS window.  This option lets you view reports of members with information contained in the CUDDB Database. 

Personnel Status
This option is available when you are in the MIPS View Members options.  It contains the following options:

Create Unit Perstat
This report shows the personnel status, drawn from the wartime T/O (Table of Organization) to distinguish Navy and Marine Officers separately, and by rank.

Maintain Unit Field Statistics
This report shows the Cumulative and Current totals of Officers and Enlisted Marines while in action.

Manpower Report Utility 
After a Unit Perstat is created, the Projected Manpower Loss window is created to trend and monitor units from projections while a unit is in action.

Utilities
When you are in the MIPS View Members option, the Utilities option in the Options Menu has two options:

User Field Update

You can add or change any of the weapons information needed at that time.

Delete Members

You can delete a member presently in the database.

Note: Throughout each section, window numbers accompany window titles (e.g., User Field Maintenance (MI203)).  This was designed as an aid to capture the most accurate picture of problems, if encountered.  You should print the window as soon as a problem occurs by pressing the Ctrl+P keys.  This captured information should be referenced when discussing the problem with the local (Manpower Information Systems Support Office (MISSO).  If it is not possible to print the window, record the window number and provide a brief explanation of the error(s).

Personnel Tempo Computation

xe "Personnel Tempo Computation"Computation of Current Deployment ( 365 and 730 Day Inclusive Periods )

The Computation of Current Deployment reports list the total number of deployment days a member has on each of 30 days surrounding the effective date of computation.  

The user selects an SSN, inputs an Effective Date for Computation and selects either a 365 or 730 (default) day inclusive period for the report.

365 DAY COMPUTATION OF CURRENT DEPLOYMENT

EFFECTIVE DATE FOR COMPUTATION:  2000/03/20    COMPUTATION DATE DAYS 245





TOTAL





TOTAL
                   

DATE 
DAYS                        

DATE 

DAYS
DEPLOY DATE1:   2000/03/05
259         DEPLOY DATE16:  2000/03/21
245

DEPLOY DATE2:   2000/03/06
258         DEPLOY DATE17:  2000/03/22
245

DEPLOY DATE3:   2000/03/07
257         DEPLOY DATE18:  2000/03/23
245

DEPLOY DATE4:   2000/03/08
256         DEPLOY DATE19:  2000/03/24
245

DEPLOY DATE5:   2000/03/09
255         DEPLOY DATE20:  2000/03/25
245

DEPLOY DATE6:   2000/03/10
254         DEPLOY DATE21:  2000/03/26
245

DEPLOY DATE7:   2000/03/11
253         DEPLOY DATE22:  2000/03/27
245

DEPLOY DATE8:   2000/03/12
252         DEPLOY DATE23:  2000/03/28
245

DEPLOY DATE9:   2000/03/13
251         DEPLOY DATE24:  2000/03/29
245

DEPLOY DATE10:  2000/03/14
250         DEPLOY DATE25:  2000/03/30
245

DEPLOY DATE11:  2000/03/15
249         DEPLOY DATE26:  2000/03/31
245

DEPLOY DATE12:  2000/03/16
248         DEPLOY DATE27:  2000/04/01
245

DEPLOY DATE13:  2000/03/17
247         DEPLOY DATE28:  2000/04/02
245

DEPLOY DATE14:  2000/03/18
246         DEPLOY DATE29:  2000/04/03
245

DEPLOY DATE15:  2000/03/19
245         DEPLOY DATE30:  2000/04/04
245

PERIODS OF DEPLOYMENT (both first and last day are counted as deployed)

273. 20000320-20000915 = 180 days  (20000320 is the 'START' field and 20000915 is the 'ACTUAL DATE OF RETURN'.

274. 19991201-20000130 = 61 DAYS

275. 19990920-19991002 = 13 DAYS

276. 19990101-19990907 = 250 DAYS (The period from 19990101 thru 19990306 will not count towards the calculation of the 'TOTAL DAYS' field because these days were not within the current 365 day period.)  

Step 1

The earliest date on the report is 20000305.  This date is 15 days before the Effective Date of Computation entered.

Step 2

Calculate the 'TOTAL DAYS' for each of the thirty-one days, start with the earliest date (e.g. 'DEPLOY DATE01' 20000305), then establish a 365 day period prior to, and including THAT date ('DEPLOY DATE01' 19990307-20000305-extra day added for Leap Year).  

(example without leap year 1998-99: 19980306 – 19990305)

Step 3

If any deployment periods with a 'START DATE' and 'ACTUAL DATE OF RETURN' where only a portion of this deployment falls within the previous 365 day period, those days that do not fall within this period will need to be subtracted from this period of duty, and those days that do fall within this period need to be added. The days from 19990101 thru 19990306 on the first sequence of the remark will not count towards the calculation of the 'TOTAL DAYS' field because these days were not within the current 365 day period.  The days from 19990307 thru 19990907 will count (for a total of 185 days).  The period of 19990920-19991002 will count for a total of 13 days.

Step 4

Then calculate the days deployed from Pers Tempo Deployment remarks that fall within this 365 day period. The period of 19991201-20000130 will count for a total of 61 days. These three totals together (i.e. 185, 13 and 61 days) for a total of 259 days, and post these days to the 'TOTAL DAYS' field.

Step 5

Next, advance the 365 day period one day starting with DEPLOY DATE2 and perform the same calculation.

In this scenario, the member has four periods of Pers Tempo Deployment with the most current sequence indicating the member has a 'START' date but no 'ACTUAL DATE OF RETURN', which indicates the member expects to be deployed for 180 days.. 

Then to DEPLOY DATE3 and so on. 

As you can see, the 'TOTAL DAYS' for each of the previous days goes down until you reach 245 days.  On the 'EFFECTIVE DATE FOR COMPUTATION' field, this member has 245 days that count towards the $100.00 day per diem for Pers Tempo Deployment.  The 'TOTAL DAYS' for the Deploy Dates 16 thru 30 will remain at 245.  If you were to continue figuring each day up through the deployment period ending 20000915, the member's 'TOTAL DAYS' would reach '251' on 20000913 and '253' on 20000915 (the day the deployment ends).

730 DAY COMPUTATION OF CURRENT DEPLOYMENT

EFFECTIVE DATE FOR COMPUTATION: 2000/03/20 COMPUTATION DATE DAYS: 232



TOTAL


TOTAL


DATE
DAYS

DATE
DAYS

DEPLOY DATE 01
2000/03/05
246
DEPLOY DATE 16
2000/03/21
232

DEPLOY DATE 02
2000/03/06
245
DEPLOY DATE 17
2000/03/22
232

DEPLOY DATE 03
2000/03/07
244
DEPLOY DATE 18
2000/03/23
232

DEPLOY DATE 04
2000/03/08
243
DEPLOY DATE 19
2000/03/24
232

DEPLOY DATE 05
2000/03/09
242
DEPLOY DATE 20
2000/03/25
232

DEPLOY DATE 06
2000/03/10
241
DEPLOY DATE 21
2000/03/26
232

DEPLOY DATE 07
2000/03/11
240
DEPLOY DATE 22
2000/03/27
232

DEPLOY DATE 08
2000/03/12
239
DEPLOY DATE 23
2000/03/28
232

DEPLOY DATE 09
2000/03/13
238
DEPLOY DATE 24
2000/03/29
232

DEPLOY DATE 10
2000/03/14
237
DEPLOY DATE 25
2000/03/30
232

DEPLOY DATE 11
2000/03/15
236
DEPLOY DATE 26
2000/03/31
232

DEPLOY DATE 12
2000/03/16
235
DEPLOY DATE 27
2000/04/01
232

DEPLOY DATE 13
2000/03/17
234
DEPLOY DATE 28
2000/04/02
232

DEPLOY DATE 14
2000/03/18
233
DEPLOY DATE 29
2000/04/03
232

DEPLOY DATE 15
2000/03/19
232
DEPLOY DATE 30
2000/04/04
232

PERIODS OF DEPLOYMENT (both first and last day are counted as deployed)

18. 2000/03/20 – 2000/09/15, 180 deployed days.

19. 1999/12/01 – 2000/01/30, 61 deployed days.

20. 1998/01/01 – 1998/09/07, 250 deployed days.

Step 1 - Calculate the Computation Date Days.

21. Set a period of 730 days prior to and including the Effective Date of Computation, 1998/03/22 – 2000/03/20.  

22. Total the number of deployed days from each deployment that fall within the 730 day period; 1 + 61 + 170 = 232.  Notice that only 170 of the 250 days of the third deployment fall within the 730-day inclusive period.

Step 2 - Calculate the Total Days for each date within 15 days of the Effective Date of Computation.

23. Deploy Date 1: 2000/03/05 yields a 730 day period of 1998/03/07 – 2000/03/05.  The Total Days 0 + 61 + 185 equal 246.

24. Deploy Date 15: 2000/03/19 yields a 730 day period of 1998/03/21 – 2000/03/19.  The Total Days 0 + 61 + 171 equal 232.

Computation of Planned Deployment Report example:

This report displays the Gate Dates and the deployment on the first and last days of a proposed deployment.  Gate 182, 220 and 251 are calculated using the 365-day inclusive period.  Gate 401 uses the 730-day inclusive period.  The numbers of deployment days on the first and last days of the planned deployment are computed using each inclusive period.

The user enters one or more SSNs, the Planned Deployment Start Date and the Planned Deployment Stop Date.

Previous deployment records (Pers Tempo 112 Remarks)

1. 1998/02/15 – 1998/12/07, 296 deployment days

2. 1999/08/01 – 1999/08/30, 30 deployment days

3. 1999/06/01 – 1999/06/30, 30 deployment days

4. 1999/04/01 – 1999/04/30, 30 deployment days

5. 2000/01/01 – 2000/02/28, 59 deployment days

Planned deployment is 2000/03/20 – 2000/10/02, 197 deployment days.

Step 1 – Set the 365 and 730-day inclusive periods from the planned deployment start date.  1999/03/22 – 2000/03/20 and 1998/03/22 – 2000/03/20.

Step 2 – Compute the number of deployed days on the first day of the planned deployment by totaling the deployment days that fall within each inclusive period.  

(0 + 30 + 30 + 30 + 59 = 149) and (261 + 30 + 30 + 30 + 59 = 410).

Step 3 – Set the inclusive periods for the planned deployment end date as in step one, using 2000/10/02. 1999/10/04 – 2000/10/02 and 1998/10/04 – 2000/10/02.  Compute the number of deployed days on the last day of the planned deployment as in step two except add in the number of days from this planned deployment.  (0 + 0 + 0 + 0 + 59 + 197 = 256) and (65 + 30 + 30 + 30 + 59 + 197 = 411). 

Step 4 – Compute the dates for gates 182, 220 and 251.  If the 365 period number of deployed days is greater than or equal to 182, 220 or 251, the date(s) for the corresponding gate(s) is (are) equal to the planned deployment start date.  If the 730 first day deployed days number is greater than or equal to 430, the 401 gate date will be equal to the planned deployment start date.  For the remaining gates, use the computation from step two for each subsequent day within the planned deployment.   Report the date when 182, 220, 251 or 410 days are reached.

Note 1: Gates not reached within the planned deployment will be blank.

Note 2: If a gate date is less than the start date, the start date will be reported.

Note 3: Pers Tempo records with a return date less than the start date are considered swapped (bad) and not used in the deployment calculations.

Report Selection

The Report Selectionxe "Report Selection" window allows you to generate various reports for selected members, change the member list, and determine additional selection and sort criteria.

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the MIPS module icon.  The MIPS frame opens.

2. From the Options menu, choose MIPS Reports. The Report Selection window opens.

The Report Selection window consists of the following five areas:

· Window Title

· RUCs list

· Choose a Report treeview

· Customization Options

· OK Button

Window Title

The window title indicates that you are in the MIPS module and you are ready to make a Report Selection. The MIPS RUC number indicates the RUC currently logged into the system and the Report Selectionxe "Report Selection" RUC number indicates the RUC you chose to report on.

RUCs List

This list shows the RUCs that are currently available. The RUC selected will determine if the report is for active or reserve members.

Choose a Report Treeview

The treeview lists the reports from which you may choose. Most of the reports appear as icons representing major categories of reports. If a report category contains subcategories, a plus (+) sign shows to the left of the icon. Choosing the "+" sign will expand the category, displaying the subcategories, and the "+" sign changes to a "-" sign. To collapse the treeview, choose the minus sign. The subcategories collapse into the major category.

When you choose a report, the customization options for that report appear on the right side of the window.

Customization Options

This area allows you to choose whom you want to report on and, depending on the report you chose, contains several selection, reporting, and sort criteria.

OK Button

Creates the selected report.

To Generate a Report

1. From the Choose a Report treeview, choose a report. If any customization is available for the report, additional information will display in the Additional Selection/Sort Criteria group area.

2. In the RUCs list, choose the desired RUC.

3. In the Report On area, do one of the following:

· To report on all members of the selected RUC, choose All Personnel. All of the members from the RUC selected will be chosen. 

· To report on one or more members of a specific company, choose Company. 

· To report on one or more members of a specific platoon, choose Company/Platoon. 

4. From the Select area choose a Company from the list, if applicable. 

5. In the Select area choose a Platoon from the list, if applicable.

6. In the Additional Selection/Sort Criteria area, type or choose the requested selection, if applicable.  For details on completing the prompts for each report, see the applicable report topic.

7. Choose OK. The window displaying the generated report opens.

To Print the Report

· Do one of the following:

· On the toolbar, choose the icon with a printer displayed.  The report prints.

· From the File menu, choose Print.  The Print window opens choose OK.  The report prints. 

See Also:

Basic Individual Record/Basic Training Record

Checklists 

FitRep and OIC NCOIC 

Higher Headquarters TFS_Inbound_Roster 

Manpower 

Pay Inconsistencies and LES 

Personnel Information 

Personnel Management 

Promotion 

Record of Emergency Data/Family Readiness Roster 

Reserve 

Security Clearance /Access 

Training Information 

Search

This window allows you to select and searchxe "Search" for a member in descending and ascending order, using the member's SSN, name, rank, company, or platoon.

How Do I Get Here?

277. Do one of the following:

10. From the UD/MIPS - Navigator, choose the Intelligent Forms module icon.  The Intelligent Forms Selection window opens.  

11. Choose New.  The New Record window opens.

12. From the Forms list, choose the applicable option.  

OR

a) From the UD/MIPS - Navigator, choose the MIPS module icon.  The MIPS frame opens. 

Do one of the following:

· From the Options menu, choose MIPS View Members. The View Members window opens.  

· From the Options menu, choose MIPS Reports. The Report Selection window opens.

1)  Under Choose a Report, choose a Report option. The treeview expands and displays the available report icons.

2)  Choose the desired Report icon. The Additional Selection/Sort Criteria options display, if applicable.

OR

a) From the UD/MIPS - NavigatorUD_MIPS_Navigator, choose the ELSIG module icon.  The ELSIG frame opens.

b) Choose the Manage ELSIGS icon.  The Manage Electronic SignatureManage_Electronic_Signature window opens.

c) Choose New.  The Assign ELSIGAssign_ELSIG window opens.

OR

a) From the UD/MIPS - Navigator, choose the Student Management module icon. The Student Management frame or the Accessions window opens, depending on which ELSIG you are signed in under.  

b) From the Tools menu, choose Schools.  The Student Processes window opens.  

OR

a) From the UD/MIPS - Navigator, choose the Tickler File module icon. The Tickler Transaction List window opens.

b) Choose New.  The Tickler Transaction Detail window opens.

2. Choose Members. The Searchxe "Search" window opens.

Searchxe "Search" By
Select the searchxe "Search" type from the drop-down list.

· All
This is the default searchxe "Search" criteria. All records in the database will be listed.

· Company and Platoon
 Searches by company or platoon.

· Name
Searches by last name.

· Rank
Searches by rank.

· RUC
Searches by RUC.

· SSN
Searches by social security number.

Sort By
Select the column from the drop-down list the searchxe "Search" results are to be sorted by. 

Value.
User may type a value to searchxe "Search" for.

Locate
Enter the location to perform the searchxe "Search" on.

Select Grade
Available only for the DD 216 intelligent form. List displays E1s thru E4s who have a selected grade or an appropriate composite score.

Descending
Select the check box to list the searchxe "Search" results in descending order.

The default is ascending order if the Descending box is not checked.

Marines Only
Select the check box to searchxe "Search" for only Marine records.


The default is all records if the Marines Only box is not checked.

Button Selections

OK

Begins the searchxe "Search" when all selections have been made.



The searchxe "Search" results will be listed in the window.



Returns the selected member's to the previous window.

Cancel

Terminates the searchxe "Search" and returns to the previous window.

To Searchxe "Search" for A Member

Note: When typing information in the Value and Locate boxes, the searchxe "Search" list moves according to the alpha or numeric values you type.

Note: The searchxe "Search" list changes whenever the Sort by, Desc, or Marine options are changed.

278. In the Searchxe "Search" By list, choose a primary column. The Value box becomes available. 'ALL' is the default value.

279. In the Value box, type a known SSN, name, rank, company, or platoon.

· If the SSN you typed is not found, an error message will appear.

· If you are searching for other service personnel, type over the leading zero with the alpha character of the respective service, e.g., N for Navy. You are automatically taken to the first Army Record in SSN sequence or LAST NAME sequence.

280. In the Sort By list, select the order in which you want the results to be displayed. The Locate box becomes available. "SSN" is the default sort order.

281. If the Locate box is available, type a known SSN, name, rank, company, or platoon.

282. To view the searchxe "Search" list in descending order, select the Descending check box. The default order is ascending.

283. Do one of the following:

· To view only Marines in the searchxe "Search" list, select the Marines Only check box.

· To view both Marine and Navy membersxe "Members" in the searchxe "Search" list, clear the Marines Only check box.

284. If available, choose the Select Grade check box.

Note: This check box only displays for a DD216 form.

285. Choose OK.

To Exit This Window

· Choose Cancel. You return to the previous window or intelligent form, as applicable.

See Also:

Selected Members 

User Fields

This window allows you to record information about the unit members. Three fields are used to record information about each member's weapon. Twenty additional fields are available to record other essential information about the member that is not already found in the CUDDB. Assign User Field labels through the Common Utilities module prior to use. 

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the MIPS module icon.  The MIPS frame opens.

286. From the Options menu, choose Utilities, and then select User Field Update. The User Fields window opens.

Header

The User Fieldsxe "User Fields" Header displays the following information:

· Name

· SSN

· Grade

· Company

· Training Group

· Record Status

· Component code

· Reserve Record Status

· Reserve Component Code

· Platoon.

2. In the Weapon Type box, type the unit member's weapon type.

287. In the Weapon Serial Number box, type the serial number of the unit member's weapon.

288. In the Weapon Rack Number box, type the armory rack number where the unit member's weapon is stored.

289. In the User Field box, beginning with User Field 1, type the appropriate information for the unit member, up to 30 characters.

Caution:
Users are cautioned in using the User Fieldsxe "User Fields" if they have a single database consisting of more than one unit's records. For example: If a single database held the records for RUCs 30002 and 30010 (created by loading two separate TRECON files together) and the user wanted to update the database and had only a single TRECON for RUC 30002, all records for RUC 30010 would be lost. Theoretically, the user could use the User Fieldsxe "User Fields" but must update the database with a TRECON for both RUCs at the same time. Use of the User Fieldsxe "User Fields" in Databases created from a TRECON Tape is not recommended.

To Save a Member's Record

· Choose Save. The member's record is saved.

To Exit This Window

· Choose Cancel. You return to the previous window.

See Also:

User Field Labels 

View Members

This window allows you to build a member list for a specific RUC, to sort the records in one of several predetermined sort orders, and to browse through the member list one view at a time.

Note: The information available in the View Members window is ELSIG dependent.

How Do I Get Here?

1. Begin on the MIPS frame.

2. From the Options menu, choose MIPS View Members. The View Members window opens.

The View Members window consists of the following areas:

· Window Title

· Navigation Buttons

· Search Criteria

· Member Information Area

Window Title

The window title indicates that you are in the MIPS module and you are ready to View Members. The MIPS RUC number indicates the RUC currently logged into the system and the View Membersxe "View Members" RUC indicates the RUC whose members you can view.

Navigation Buttons

These buttons allow you to jump to the first member's record or last member's record in the member list and to browse forward and backward through the member list one record at a time. These buttons are on the tool bar.

Search Criteria

These options allow you the select the view you want, the sort order of the members you can view, the member's SSN, and the RUC whose members you want to view. 

Member Information Area

This area consists of a header that displays basic information about the member regardless of which view you choose and one or more tabs that display specific information about the member related to the specific view.

Header Area

Displays the following member information:

· Name

· Social Security Number

· Grade

· Company

· Training Group

· Record Status

· Component Code

· Reserve Record Status

· Reserve Component Code

· Platoon


View Area

Displays view-specific information on tabs labeled Page 1, Page 2, etc.

To View a Member's Record

1. From the RUCs list, choose the desired RUC.

2. From the View Reports list, choose the desired view. 

3. From the Order Options list, choose the desired sort order:

4. From the Search SSN list, type or choose a specific SSN in the member list you want to view.

5. To search for a member using additional criteria (SSN, Name, Rank, Company, or Platoon), choose Search. The Search window opens.

To Browse the Member List

· Do one of the following:

· To go directly to the first record in the ordered number list, chose the First icon. 

· To go directly to the last record in the ordered number list, chose the Last icon.

· To go to the next record in the member list, choose the Next icon.

· To go to the previous record in the member list, choose the Previous icon.

To Exit this Window

· From the File menu, choose Exit.  You return to the UD/MIPS - Navigator window.

See Also:

Service 

Pay/Dependent 

Personal

Reserve Data View 

Marksmanship 

User Fields

Training View 

Basic Individual Record 

Basic Training Record 

Record of Emergency Data

Individual Query 

Classification/Qualification

Reports

Basic Individual Record/Basic Training Record

xe "Basic Individual Record/Basic Training Record"This group of reports provides basic administrative and training information on one or more members in the RUC as well as an annual audit of member's records. For reports for specific members, you must create the member list each time you generate the report.

How Do I Get Here?

3. Begin on the Report Selection window.

4. Choose the BIR/BTR folder.

5. Do one of the following:

· Choose BIR (Basic Individual Record.)

· Choose BTR (Basic Training Record )
To Generate a Report for All Members

1. In the Select Option group, choose Select All. 

2. Choose OK. The MIPS – RUC BIR or MIPS- RUC BTR window opens.

To Generate a Report for Selected Members

1. In the Select Option group, choose Selected Members. Additional prompts become available.

2. Choose Members. The Search window opens. 

3. After you complete the steps for the Members window. You return to the Report Selection menu.

4. If you must remove members before generating the report, do one of the following:

· Choose Remove All.

· Select the unwanted members and choose Remove.

6. Choose OK. The MIPS – RUC BIR or MIPS- RUC BTR window opens.

To Generate an Annual Audit Report

1. In the Select Option group, choose Annual Audit. The Annual Audit Selection Criteria option displays.

2. In the Annual Audit Selection Criteria, Last Digit of SSN spin box, type or choose a number from 0 through 9. 

3. Choose OK. A list of SSNs appears where the last digit for the SSNs matches the number you selected from the previous step.

To Print a Audit Report

· Select File and then choose Print.

Basic Individual Record Report

xe "Basic Individual Record Report"This report provides administrative and training information on an active duty member as well as an annual audit of the member's records. All ELSIG authorities can print this report. 

How Do I Get Here?

7. From the UD/MIPS - Navigator, choose the MIPS module icon.  The MIPS frames opens.

8. From the Options menu, choose MIPS Reports.  The Report Selection window opens.

9. From the Choose a Report list, choose BIR/BTR.  The BIR/BTR folder opens.

To Generate a Report for All Members

10. In the Select Option group, choose Select All.

11. Choose OK.  The Basic Individual Record window opens.

To Generate a Report for Selected Members

12. In the Select Option group, choose Selected Members.

13. Choose Members.  The Search window opens.

14. After you complete the steps for the Members window, you return to the Report Selection menu.

15. If you must remove members before generating the report, do one of the following:

· Choose Remove All.

· Select the unwanted members and choose Remove.

16. Choose OK.  The Basic Individual Record window opens.

To Generate an Annual Audit Report

17. In the Select Option group, choose Annual Audit.  The Annual Audit Selection Criteria option displays.

18. In the Annual Audit Selection Criteria, Last Digit of SSN spin box, type or choose a number from zero through nine.

19. Choose OK.  A list of SSNs whose last digits match the number you selected from the previous step displays.

To Print A Report

· Select File and then choose Print.

It contains the following information:

Header Information

· Date

· Title (Basic Individual Record)

· Page

· Social Security Number

· Name (Last, First, Middle Initial)

· Grade

· Reporting Unit Code

· Company

· Platoon

· Anniversary Date

· Reserve Unit Join Date

Contract Information

· Expiration of Active Service

· End Obligated Service

· Reserve Expiration of Current Contract

· Active Reserve Career Status

· Date of Enlistment/Acceptance

· Armed Forces Active Duty Base Date 

· Pay Entry Base Date 

· Date of Original Entry

· Length of Current Enlistment Months

· Length of Current Enlistment Years

· Length Current Extension

· Number of Extensions of Current Enlistment

· Total Months Extension

· Effective Date of Current Extension

· Time Lost Current Enlistment

· Source of Entry

· Source of Initial Entry Military Service

· Component Code

· Strength Category

· Reserve Component Code

· Date Accepted 1st Commission

· Training Group

· Duty Status

· Duty Limit

· Start Mandatory Drill

· End Mandatory Drill 

· Mandatory Drill Participation Extension Month

· Reserve Montgomery GI Bill Start Date

· Reserve Montgomery GI Bill Stop Date

· Program Enlisted For

· Bonus PEF

· College PEF

· Active Duty Montgomery GI Bill Status Flag

· Active Duty Montgomery GI Bill Status Code

· Montgomery GI Bill-Selected Reserve Status

· Original Veterans Education Benefit Program Code

· Designated Military Pilot

Service Information

· Present Grade

· Date of Rank

· Select Grade 

· Select Grade Date

· Restricted Status Code

· Restricted Termination Date

· Program Element Number

· Responsibility Center Number

· Date Current Tour Began

· Present Unit Join Date

· Date Join Selective Marine Corps Reserve

· Geographical Location Code

· Geographical Location Date Current Tour Began

· Combat Service Code

· Last Combat Tour

· Table of Organization Number 

· Line Number

· Work Station

· Billet Description

· Military Occupational Specialty

· Billet Military Occupational Specialty

· Secondary Military Occupational Specialty

· Joint Military Occupational Specialty

· Joint Military Occupational Specialty Effective Date

· Present RUC and MCC

· Temporary RUC and MCC

· Additional Temporary RUC and MCC

· Fleet Assistance Program RUC and MCC

· Reserve RUC and MCC

· Former RUC and MCC

· Future RUC and MCC

· Mobilization RUC and MCC

· Deployment Status

· Anniversary Date

· Last Separation/Discharge Date

· Separation Code Reason 

· Last Physical Examination Date

· Last Physical Certification

· Overseas Control Date

· Officer Mandatory Removal Date

· Commanding Officer Date

· Individual Location Code

· Deploy Return Date

· Rotation Tour Date

MOS

· Additional Military Occupational Specialty

· Additional Military Occupational Specialty Assignment Date

Personal Information

· Date of Birth

· Citizenship

· Ethnic Code

· Race

· Race Aggregate Code

· Population Group

· Religion

· Home Phone

· Work Phone

· Street Address

· City Address

· State

· Zip-Code

· Address Validation Code

· Electronic Mail Effective Date

· Electronic Mail Address

· Home of Record

· Country of Origin

· Blood Type

· Sex

· DNA Date

· HIV III Tested Date

Civilian Education

· Year Left School

· Graduated

· Level of Education

· Education Certificate

· Major

Insignia Authority

· Wear Effective Date

· Insignia Authority Code

· Insignia Authority Description

Personal Awards

· Award Code

· Description

· Device Code

· From Date

· To Date

· Date Awarded

Service Awards

· Award Code

· Description

· Device Code

· From Date

· To Date

· Date Awarded

Unit Awards

· Award Code

· Description

· Device Code

· From Date

· To Date

· Date Awarded

Decorations Awards

· Award Code

· Description

· Device Code

· From Date

· To Date

· Date Awarded

· Good Conduct Medal Date

· Armed Forces Reserve Medal Date

· Selected Marine Corps Reserve Medal Date

· Duty Preference

Record Information

· Record Status

· Disputed Date

· Last Screening

· Screening Result

· Reserve Record Status

· Disputed Data

· Screening Reason

Dependents Information

· Marital Status

· Dependent Certification Code

· Dependent Geographical Location Code

· Service Spouse Social Security Number

· Service Spouse Code

· Total Number of Dependents

· Basic Allowance for Subsistence/Commuted Rations

· Date Dependent Location Began

· Custody Status Code

· Relationship Code

· Dependent First Name

· Dependent Middle Initial

· Dependent Last Name

· Dependent City Code

· Dependent Country Code

· Location Code

· Date Gained

· Date of Birth

BAH Eligibility Certification

· Member Signature

· Date

· Member ZIP Code

Reservists Certification

· Member Signature

· Date

· Auditor Signature

· Unit Diary Number

See Also:

Basic Individual Record/Basic Training Record 

Basic Training Record Report

xe "Basic Training Record Report"This report provides training information on a member who has been through Basic Training as well as an annual audit of the member's records. All ELSIG authorities can print this report. 

This report contains the following information:

Header Information

· Date

· Title (Basic Training Record)

· Page

· Social Security Number

· Name (Last, First, Middle Initial)

· Grade

· Reporting Unit Code

· Company

· Platoon

· Anniversary Date

· Reserve Unit Join Date

Unit Training

· Physical Fitness Test Date

· Physical Fitness Test Semi-Annual Code

· Physical Fitness Test Score

· Physical Fitness Test Class

Prior Physical Fitness Training 

· Prior Physical Fitness Test Date

· Prior Physical Fitness Test Semi-Annual Code

· Prior Physical Fitness Test Score

· Prior Physical Fitness Test Class

Basic Skills Training/Essential Skills Training

· Basic Skills Training/Essential Skills Training Date

· Basic Skills Training/Essential Skills Tasks Performed

· Basic Skills Training/Essential Skills Tasks Attempted 

· Basic Skills Training/Essential Skills Training Score

· Weight Control Status

· Weight Control Assign Quantity

· Military Appearance Status

· Military Appearance Assign Quantity

· HIV III Lecture Date

· Driver Improvement

· Drug Lecture Year:

· Leadership Training

· Leadership Training Date

· Security Lecture Date

· Water Survival Qualification Code and English Description

· Water Survival Requalification Date

· Gas Mask Size and Description

· Gas Mask Type and Description

· Gas Chamber Date

· Helmet Size

· Current Rifle Qualification Date

· Current Rifle Score

· Current Rifle Class

· Rifle Distinguished Date

· Rifle Proficiency Enhancement Training (PET) Date

· Rifle PET Exception Code

· Rifle PET Exception Date

· Number of Expert Rifle Qualifications

· Rifle Field Firing Date

· Individual Type Score (6-11)

· Current Pistol Qualification Date

· Current Pistol Score

· Current Pistol Class

· Pistol Distinguished Date

· Pistol Proficiency Enhancement Training (PET) Date

· Pistol PET Exception Code

· Pistol PET Exception Date

· Number of Expert Pistol Qualifications

· Incurred Obligated Service Code

· Incurred Obligated Service Date

Service Training

· Security Investigation Type

· Security Investigation Clearance

· Security Investigation Completion Date

· Security Investigation Adjudicated Date

· Agency Code

· Action Required

· Eligibility Code

· Place of Birth State

· Place of Birth County

· Intelligence Training Hours

· Level I Anti-Terrorism Training

· Anti-Terrorism Annual Date

· Anti-Terrorism Deployment Date

· Classified Non-Disclosure Agreement Information/Execute Date

· Weapons Ammunition Explosive Information Screened Date

Government Equipment Operator Licenses

· Effective Date

· Permit Number Identifier

· Expiration Date

· Type Code

· Restriction Code 1-5

Service Schools/Special Skills

· School/Special Skills Code

· School/Special Skills Code Description

· School/Special Skills Completion Date

Local School Complete

· Completion Date

· School Description

· School Location

Academic Test

· Completion Date

· Course Title

· Credit

· Grade

· Course Location

Off Duty Education

· Completion Date

· Course Title

· School and Location

· Credit

· Grade

Correspondence Courses

· Course Identification 

· Course Name

· Completion Date

· Status Code

· Score

Test Scores

· Class/Assign Test Type

· Date

· General Technical/General Clerical Technical Score

· General Technical Score

· Mechanical Maintenance Score

· Clerical Score

· Electronics Score

· Army Radio Code Score

· Army Radio Code Score Date

· Armed Forces Qualification Test Form Number

· Armed Forces Qualification Test Score

· Electronic/Data Processing Test Score

· Electronic/Data Processing Test Date

· Defense Language Aptitude Battery Score and Date

· Defense Language Aptitude Battery Date

· Foreign Language 1-4

· Listening Skill Level 1-4

· Reading Skill Level 1-4

· Speaking Skill Level 1-4

Martial Arts Training

· Martial Arts Belt Code

· Martial Arts Description

· Martial Arts Completion Date

· Martial Arts Re-Certification Date

See Also:

Basic Individual Record/Basic Training Record 

Checklists

The following checklistsxe "Checklists" are available.

· ACDU ID Card Application

· DEP Add-Loss

· From TAD/FAP 

· Home Awaiting PEB

· Check In/Out Sheet

· Appellate Leave

· Medical/Dental Letter

· TAD Procedures

· Admin Separations

· Retirement-Resignation

· Separations

· Transfer

· UA/Deserter

Selection Criteria

Select one or more from the SSN(s) to Choose From group window.

Move the desired SSN to the SSN(s) to Report group window by mouse, double-click or by clicking the direction (>) command button.  SSNs may be removed from this group window by highlighting it and clicking the direction (<) command button or double-clicking it.

An incremental search may be performed.  In use, as the user enters the desired SSN in the text box a search condition commences.  The condition becomes more specific as each SSN character is typed.  This is beneficial to the user when the list of SSNs greatly exceeds the list of SSNs in the SSN(s) to Choose From group window.

Additional Selection/Sort Criteria:

The following checklistsxe "Checklists" require additional information:

ACDU ID Card Application
Reason for Issuance of ID Card




Title




Signature Block




Rank

DEP Add-Loss


Checklist Completed By

From TAD/FAP


Checklist Completed By

Home Awaiting PEB

Checklist Completed By

Appellate Leave


Checklist Completed By

Medical/Dental Letter

Signature Block

TAD Procedures

Checklist Completed By

Admin Separations

Checklist Completed By

Retirement-Resignation

Checklist Completed By

Separations


Checklist Completed By

Transfer


Checklist Completed By

UA/Deserter


Checklist Completed By

Click OK.  Window opens.  Users may view and print the report.  When viewing the report navigation may be by keyboard, menu, or toolbar.  

Complete Personnel Training Report

xe "Complete Personnel Training Report"This report lists members who have completed some or all of various required subjects. Different training organizations use the information contained in this report to determine training schedules at the company, battalion, and division levels. Administrative organizations derive cutting scores to determine promotions based on information contained in this report.

Heading Information

· Report Date

· Report Title
(Complete Personnel Training)

· Page Number

· Reporting Unit Code

Report Information

· Last Name

· First and Middle Initials

· Social Security Number

· Rank

· Company/Platoon

· Current Rifle Qualification Date

· Current Rifle Qualification Score

· Current Pistol Qualification Date

· Current Pistol Qualification Score

· Basic Skills Training/Essential Subjects Test Year

· Basic Skills Training/Essential Subjects Test Tasks Performed

· Basic Skills Training/Essential Subjects Test Tasks Attempted

· Basic Skills Training/Essential Subjects Test Score

· Physical Fitness Test Date

· Physical Fitness Test Period

· Physical Fitness Test Score

· Sex

· Water Survival Qualification Class

· Weight Control Code Description

Footer Information

· Number of Records

See Also:

Training Information 

Comrats by Code/Last Name

xe "Comrats by Code/Last Name"This report contains codes that can be used to determine if members are receiving the proper entitlements. 

This report contains the following information:

Header Information

· Date

· Title (BAS by Code/Last Name)

· Page

· Reporting Unit Code

Report Information

· Last Name

· First Name

· Middle Initial

· Social Security Number

· Rank

· Company/Platoon

· Basic Allowance for Subsistence

· Basic Allowance for Housing

· Family Separation Allowance

· Marital Status

Footer Information

· Number of Records

See Also:

Personnel Information 
CPL Eligible Report

xe "CPL Eligible Report"This report lists members who are eligible to be promoted to Corporal. It includes a block to indicate whether or not the member has been recommended, a block for the signature of the commanding officer to approve recommendations, and blocks for the unit diary number and date of any members that were not recommended for promotion. All ELSIG authorities can print this report. 

This report contains the following information:

Header Information

· Date

· Title (Roster of Personnel for Promotion to Corporal)

· Page

· Reporting Unit Code

Report Information

· Last Name

· First Name

· Middle Initial

· Social Security Number

· Rank

· Company/Platoon

· Armed Forces Active Duty Base Date (Active Duty) or Pay Entry Base Date (Reserve)

· Date of Rank

· Composite Score

· Primary Military Occupational Specialty

· Restricted Status Code

· Restricted Termination Date

· Recommendation Block (indicates recommendation)

Footer Information

· Approval Statement

· Approval Signature Block

· Admin Center Instructions

· Unit Diary Number

· Unit Diary Date

See Also:

Promotion 

Fitness Reports

xe "Fitness Reports:Fitness Report Due List"xe "Fitness Reports:By Grade Report of Personnel"

xe "By Grade Report of Personnel"These reports provide information on those members who are being submitted for an annual fitness report or change of reporting senior fitness reportsxe "Fitness Reports". Both reports provide space for annotating the members record.

These reports contain the following information:

Heading Information

· Report Date

· Report Title
(Fitness Report Due List)

(By Grade Report of Personnel)

· Report Period

· Page Number

· Reporting Unit Code

Report Information

· Last Name

· First and Middle Initials

· Social Security Number

· Rank

· Company/Platoon

· Unit Joined Date

· Component Code (Fitness Report Due List)

· Date Of Rank

· Estimated Date of Departure

· End of Current Contract Date

· Reserve Component Code (Fitness Report Due List)

· Record Status (Fitness Report Due List)

· Reserve Record Status (Fitness Report Due List)

· Current Rifle Qualification Score

· Current Rifle Qualification Date

· Current Pistol Qualification Score

· Current Pistol Qualification Date

· Physical Fitness Test Score

· Physical Fitness Test Period

· Physical Fitness Test Date

· Primary Military Occupational Specialty

· Billet Military Occupational Specialty

· Table of Organization Number

· Line Number

Footer Information

· Number of Records

See Also:

FitRep and OIC/NCOIC 

FitRep and OIC/NCOIC

xe "FitRep for OIC NCOIC"This group of reports provides information on a member to their military leaders such as fitness rosters, individual member information for Marine leaders, requests for personnel action, and a recall roster.

How Do I Get Here?
290. Begin on the Report Selection window.

291. In the Choose a Report treeview, choose FitRep and OIC/NCOIC. The treeview expands and displays the available report icons.

292. Choose the desired report. The Additional Selection Sort Criteria options display, if applicable.

The FitRep and OIC/NCOIC group contains the following reports:

Annual Fitness Roster 

This report identifies personnel who are due an annual, promotion, transfer, or end of service fitness report.  This report does not include all of the occasions that may require a fitness report.  It is recommended that additions to a particular fitness report control log be annotated on the last page of the report.

A monthly report may be selected as desired, by typing in the beginning and the ending date(s) of the month (i.e., From: 1997/01/01 To: 1997/01/31). The dates that are entered will result in the report displaying all other personnel due an Annual Fitness Report who have an ECC, RTD, EDD, or DOR during the requested period and who would possibly require a fitness report.

It is recommended that this report be produced after receipt of the first TRECON that is received after the 5th of the month for which the report is to be produced.  If any option available on this menu is produced earlier than recommended, the report may not include the names of personnel whose promotion must be reported by HQMC (i.e., E6 and above or local unit promotions to the grade of sergeant).

Additional Selection/Sort Criteria

1. To choose the Month, click the text box's arrow to expose the static list of months. 

2. In the From Date box, type the date in YYYY/MM/DD format.

3. In the To Date box, type the date in YYYY/MM/DD format.

Note: EDDs, DORs, ECCs greater than the From Date and less than the To Date, inclusive, or present grade where the rank is according to the selected month will be generated as output to the fitness report.

This report contains this additional special processing criteria:

The only personnel due an Annual Fitness Report are those whose rank is in accordance with the month selected by the user.  The months and their respective grades are as follows:

January

· Active Duty 2nd LT (O1's)

· Reserve CAPT (O3's)

February

· Reserve WO/CWO/(W1,W2 ,W3 ,W4 and W5)

· Reserve 1st LT (O2's)

· Active Reserve WO/CWO/(W1,W2 ,W3 ,W4 and W5)

· Active Reserve 1st LT (O2's)

March

· Active Duty SGT (E5's)

April

· Active Duty WO/CWO/(W1, W2 ,W3 ,W4 and W5)

· Reserve 1st LT (O2's)

May

· Active Duty 1st LT (O2's)

· Active Duty LTCOL (O5's)

· Active Duty COL (O6's) 

June

· Active Duty BGEN (07's)

· Reserve SGT (E5's)

· Reserve SSGT (E6's)

· Reserve GYSGT (E7's)

· Reserve MSGT/1stSGT (E8's)

· Reserve MGYSGT/SGTMAJ (E9's)

· Reserve COL (06's)

· Reserve BGEN (07's)

· Active Reserve SGT (E5's)

· Active Reserve SSGT (E6's)

· Active Reserve GYSGT (E7's)

· Active Reserve MSGT/1stSGT (E8's)

· Active Reserve MGYSGT/SGTMAJ (E9's) 

July

· Active Duty 2ndLT (01's)

· Active Duty CAPT (03's)

· Active Duty MAJOR (04's)

· Active Reserve COL (06's) 

August – none

September

· Active Duty GYSGT (E7's)

· Active Duty MSGT/1stSGT (E8's)

· Active Duty MGYSGT/SGTMAJ (E9's)

· Active Reserve CAPT (03's)

· Active Reserve MAJOR (04's)

· Active Reserve LTCOL (05's) 

October - none

November 

· Active Duty 1stLT (02's)

· Reserve LTCOL (05's) 

December

· Active Duty SSGT (E6's)

· Reserve MAJOR (04's) 

Note: Reports on Active Duty 2nd and 1st Lieutenants are semiannual vice annual.

Fitness Report by Grade Only 

This option identifies personnel who may be due a fitness report.  The user will be prompted to specify for which grade the report is to be produced.

To Generate the Fitness Roster By Grade Only Report

· Choose a Pay Grade.  Click the text box's arrow to expose the list of grades.  Select a grade by mouse click.

Marine Leaders Notebook 

This option produces individual informational pages on members.  These pages, collectively, are designed for inclusion in a Marine Leader's Notebook.  Users will have the choice to produce a Marine Leader's Notebook for an individual Marine or for every member of a specific Company/Platoon.

Personnel Action Request

This option generates a Personnel Action Request (PAR).  The documents available for generation are actual letters to an individual Marine.  These letters are meant to assist members when seeking administrative assistance from the Consolidated Administrative Center.

To Generate A Personnel Action Request

· Expose the static list of PARs by clicking the text box's arrow.  

Recall Roster

This option produces a Recall Roster.  The accuracy of the report is dependent on the unit's voluntary reporting of local address information on the Unit Diary.  If a unit reports local address information in conjunction with Record of Emergency Data updates any changes noted on a Recall Roster would indicate a simultaneous requirement to update the Record of Emergency Data and/or VHA Affidavit.

From TAD Excess/FAP Checklist

xe "From TAD Excess/FAP Checklist"This two-page checklist is used to make sure that information is correct for members who have returned to their parent organizations after fleet assistance or temporary additional duty that has lasted longer than 30 days. It contains the following information:

Header Information

· Report Date

· Title (From TAD Excess/FAP Checklist)

· Page Number

· Reporting Unit Code

Report Information

· Rank

· Name (First, MI, Last, Cadency)

· Social Security Number

· Primary Military Occupational Specialty

· Component Code Description

Checklist Completed By

· Name (First and Middle Initials, Last Name)

· Checklist Reviewed By Signature Line

MMS Information for Review

· Good Conduct Medal Date

· Dependent Geographical Location Code

· Number of Dependents

· Rifle Qualification Date

· Rifle Qualification Score

· Physical Fitness Test Information

· Physical Fitness Test Date

· Physical Fitness Test Period

· Physical Fitness Test Score

· Basic Subjects Test Information

· Basic Subject Test Date

· Basic Subject Test Score

· Essential Subjects Test Information

· Essential Subject Test Date

· Essential Subject Test Score

· Pistol Information

· Pistol Information Date

· Pistol Information Score

· Education Bonus Points

· Recruiting Bonus Points

· Overseas Control Date

· Basic Allowance for Housing Flag

· Basic Allowance for Housing Type

· Basic Allowance for Quarters Flag

· Primary Military Occupational Specialty

· Selected Grade

· Pay Entry Base Date

· Armed Forces Active Duty Base Date

· Clothing Replacement Allowance Date

· Date of Rank

· Expiration of Current Contract Date

· Expiration of Active Service Date

· Time Lost

· Mid Month Normal Pay Amount

· End of Month Normal Pay Amount

· Enlistment Program

· Current Enlistment Date

· Extension Number

· Month Extended

· Duty Status Code

· Geographic Location Begin Date

· Family Separation Allowance Flag

· Proficiency Pay Flag

· Montgomery GI Bill Flag

· Veterans Education Assistance Program Flag

· Marital Status

· Duty Limit Code

· Pay Code

· Deployment Pay Amount

· Deployment Pay Effective Date

· Subsistence Code

Potential SRB Actions Required Are

Write a checkmark next to each completed item:

· Orders Endorsed?

· Service Record Book/Office Qualification Record Page 3 Completed?

· Family Separation Allowance Application Completed?

· Active Duty ID Card Issued?

· Dependents ID Card Application?

· Commuted Rations Applications Completed?

· Check-In Sheet Issued?

· Variable Housing Allowance Application Updated?

· Service Record Book Locator Card Contents Filed?

· Record of Emergency Data Reviewed/Updated/Signed?

· Record of Service Reviewed/Printed?

· Dental Plan Reviewed?

· Serviceman Group Life Insurance Reviewed/Updated?

· Service Record Book/Office Qualification Record Audited Completely?

· Dependents Add-Loss Checklist?

· Temporary Additional Duty Log Updated? Meal Card Log?

· Annual Leave and Earning Statement Audited

· Formal School Information Ran on Unit Diary Number

· Travel Liquidation

· Meal Card Reissued? Log Updated?

· Missing Leave and Earning Statement Obtained?

Potential Unit Diary Actions Required Are

Enter the Unit Diary Number and the Unit Diary Date for each of the following items:

· Good Conduct Medal Award Date

· Home Address

· Home Phone

· City Code

· Zip Code

· Marine Air/Ground Task Force Designator

· Work Phone

· Workstation/Center

· Billet Description

· Table of Organization/Line Number

· Date Dependent Location Began

· Pay Entry Base Date

· Extension of Enlistment

· Dependent Geographical Location Code

· Number of Dependents

· Disbursing Station Symbol Number

· Record of Emergency Data

· Overseas Control Date

· Rifle Qualification

· Pistol Qualification

· Physical Fitness Test Information

· Basic Skills Test/Essential Skills Test Information

· Education Bonus Points

· Recruiting Bonus Points

· Special Bonus Points

· Reenlistment Information

· Armed Forces Active Duty Base Date

· Promotion Information

· Dependent Dental Plan Information

· From Temporary Additional Duty/FAP

· Billet Military Occupational Specialty

· Platoon Code

· Basic Allowance for Housing Entitlement

· Family Separation Allowance Entitlement

· Primary and Additional Military Occupational Specialty Information

· Commuted Rations Applications Date

· History Statement

· Duty Status Code

· Diary Retrieval System Option 23 Viewed/Action Required

· Video Inquiry System D120/SRB Page 8A Verified

· Basic Individual Report/Basic Training Report Printed and Audited

· Print/Verify Record of Service

· Remarks

See Also:

Checklists 
Higher Headquarters

How Do I Get Here?

1. From the Navigator Bar, select the MIPS button.

2. Select the Options menu item.

3. Select MIPS Reports from the drop down list.

4. Select the Higher Headquarters option.

5. The Higher Headquarters window will open.

These reports are made available in databases created from either a Higher Headquartersxe "Higher Headquarters" TRECON or a database created by combining two or more RUCs.  Both database types contain records for personnel from two or more reporting units.

Deployment Status Report.

This report selects records if the Deployed Status Code is greater than 0.  Inbound personnel are not included, and only Marine records are considered.

Grade/MOS Report.

This report is identical to the MOS Totals Report on the Personnel Information Reports menu, except that it is designed to be run against a multiple RUC database. It is a MOS and grade spreadsheet.  Inbound personnel, other service personnel, and civilian records are not used in the creation of this report.

Inbound Report.

The Inbound Report was designed to provide Higher Headquartersxe "Higher Headquarters" with a means of identifying those personnel en route to a new command.  Upon processing of TTC 364 (TRANSFER), a member's record status becomes A, B, or 6, the PRES RUC field becomes blank, and what was formerly the FMCC now becomes the PRES MCC.  This report pulls only those records that have a blank PRES RUC.  This option will only work if the Higher Headquartersxe "Higher Headquarters" database was created by a TRECON that selected records based on a specific CMCC, MCC, or FMCC.  Only Marine records are considered.  This report may be produced for all personnel or for personnel with a specific PRES MCC.

Projected Loss.

This report selects records if the Record Status is equal to 4 or the Estimated Date of Detachment field is greater than 0.  Only Marine records are considered.  Inbound personnel are not considered.

Potential Inbounds.

This report will only work if the Higher Headquartersxe "Higher Headquarters" database was created by a TRECON that selected records with a specific CMCC, MCC, or FMCC.  The report identifies personnel who have been issued orders, but have not yet detached from their present command.  This report differs from the Inbound Report, which reflects records of personnel who have detached and are physically en- route.  The report will contain only Marine records and will be sorted to display information in a format identical to the Inbound Report.

Rotation Tour Dates.

This report selects records if the RTD field is greater than 0.  Only Marine records are considered.

Reserve Join Dates.

The date that a member joined the Reserves.

Selection Criteria.  

Choose one of the following:

All Personnel

Personnel with a Specific PRES RUC

Personnel with a Specific TEMP RUC

Personnel with a Specific ADDL TEMP RUC

Personnel with a Specific FAP RUC

Personnel with a Specific MAGTF Code

Additional Selection/Sort Criteria 

Where appropriate, complete the selection by entering the following information:

Enter CMCC
Enter RUC to Search On

Enter the MAGTF Designator you wish to Search On

Click OK.  The window opens.  Users may view and print the report.  When viewing the report navigation may be by keyboard, menu, or toolbar.  

LCPL Eligible Report

xe "LCPL Eligible Report"This report lists members who are eligible to be promoted to Lance Corporal. It includes a block to indicate whether or not the member has been recommended, a block for the signature of the commanding officer to approve recommendations, and blocks for the unit diary number and date of any members that were not recommended for promotion. All ELSIG authorities can print this report.

This report contains the following information:

Header Information

· Date

· Title (Roster of Personnel for Promotion to LCPL)

· Page

· Reporting Unit Code

Report Information

· Last Name

· First Name

· Middle Initial

· Social Security Number

· Rank

· Company/Platoon

· Date of Rank

· Armed Forces Active Duty Base Date

· Restricted Status Code

· Restricted Termination Date

· Recommendation Block (indicates recommendation)

Footer Information

· Approval Statement

· Approval Signature Block

· Admin Center Instructions

· Unit Diary Number

· Unit Diary Date

See Also:

Promotion 

Maintain Unit Field Statistics

This option is designed for use at both the reporting unit and higher headquarters.

Users must be in MIPS reports to open Options >>> Personnel Status >>> Maintain Unit Field Statisticsxe "Maintain Unit Field Statistics". The input window remains resident on a monitor to accommodate voice and courier confirmation of casualties.  Users will update the window by providing numeric totals in the following row/column categories:




CUMULATIVE
CURRENT

CATEGORY

OFFICER
ENLISTED
TOTALS
TOTALS

KIA


*

*

*

*

WIA


*

*

*

*

MIA


*

*

*

*

POW


*

*

*

*

DOW


*

*

*

*

NBD


*

*

*

*

NBI


*

*

*

*

ADMIN LOSSES


*

*

PERS GAINED



*

*

RETURNED TO DUTY




*

*

ENEMY CAPTURED




*

*

ENEMY EVACUATED




*

*

ENEMY HELD





*

*

Click Save.  The file created is drawn into the Manpower Report Utility Report.  Information used to update this window must be confirmed and forwarded to the Unit Diary, which is the only means of adjusting all other information that will appear on the completed Manpower Report Utility Report.

Manpower

xe "Manpower"Short MOS:

Click OK.  The Auth MOS will open.  Users will have the option to enter or update the database's MOS structure.  The unit's Table of Organization (T/O) is the source document for this window.

Click the Insert button to add one or more edit rows.  These rows contain the columns MOS and Auth MOS.  Fill each row using the T/O.  Caution.  The ENTER key terminates MOS inserts, use the TAB/SHIFT+TAB key to navigate multiple rows.  Additional rows will be inserted after last row.

Click OK.  The Confirmation window opens.  Click YES, NO, or CANCEL.

Command Buttons:

Clicking one of the following command buttons produces the corresponding action(s):

OK
Generates Short MOS report.  The Confirmation window opens.  Users will be informed of data modification and will be queried to save change.

Insert
Adds one or more rows for MOS/MOS AUTH input.

Delete
Removes one, selected row.

Save
Saves changes created by Insert and/or Delete.

SORTS Worksheet:

Click OK.  The Auth MOS window opens.  Users will have the option to enter or update the Table of Organization (T/O) MOS database structure.

Click Insert button.  This adds one or more empty rows with columns MOS and MOS AUTH.  Use the unit's Table of Organization to populate each row.  

CAUTION:  THE ENTER KEY ACCEPTS ENTERED DATA AND GENERATES A REPORT.

Click OK.  The Table of Organization window opens.  Complete by entering the following information utilizing the unit's WarTime Table of Organization.  Click the

T/O Number (5 characters)

Organization Name (12 characters)

Total Marine Officers (10 characters)

Total Marine NCO (10 characters)

Total Marine LCpl, PFC, Pvt (10 characters)

Total Navy Officers (10 characters)

Total Marine SNCO (10 characters)

Total Navy Enlisted (10 characters)

Today's Date.  System date.

Date 7 days future.  Calculated from system date.  Changeable.

Click OK button.  Self-explanatory.

Click OK button.  An on-window report opens.  This report may be printed or viewed.  Print by clicking the printer icon on the toolbar.  Perform on-window navigation by clicking on the direction arrows on the toolbar.  

Manpower Report Utility

This report is designed for the reporting unit.  Editing is limited to the date-time-group and remarks. 

Click Options >>> Personnel Status >>> Manpower Report Utilityxe "Manpower Report Utility".  The Manpower Report Utilityxe "Manpower Report Utility" window will open. Users will see information, on window, under the below listed columns:

RUC, Unit Name, and Date-Time-Group (DTG).  The DTG is an editable field.  Note that its default format is yymmddtimezone.
Short MOS

Non Effective

On Board

Staff - Auth, Have

Category - Off, Enl, Cumu

Remarks.  A maximum of three (3) lines, 93 character each, are available for user comments.

Click File >>> Print or click the Print icon.

Marine Leaders Notebook

xe "Marine Leaders Notebook"This report contains information for individual members and provides blank lines for annotating information for updating a member's record. Some of the information included is: name and address, military information, various test scores and dates, civilian education, personal information, and physical information.

This report contains the following information:

Heading Information

· Title (Marine Leaders Notebook)

· Report Date

· Page Number

Report Information

· Rank

· Member Name (First, MI, Last, Cadency)

· Social Security Number

· Primary Military Occupational Specialty (PMOS)

· Additional Military Occupational Specialty (1-2)

· Component Code Description

· Billet Description

· Company/Platoon

· Present Grade

· Date of Rank

· Selected Grade

· Date of Birth

· Date Joined Unit

· Overseas Contract Date

· 15th Normal Pay Amount

· 30th Normal Pay Amount

· End Active Service Date

· Future Monitored Command Code

· Estimated Date of Departure

· Pay Entry Base Date

· Expiration of Current Contract Date

· Reserve Unit Join Date

· Water Survival Qualifications

· Basic Skills Test Information

· Basic Skills Test Score

· Basic Skills Test Date

· Current Rifle Qualification Information

· Current Rifle Qualification Score

· Current Rifle Qualification Date

· Current Pistol Qualification Information

· Current Pistol Qualification Score

· Current Pistol Qualification Date

· Physical Fitness Test Information

· Physical Fitness Test Score

· Physical Fitness Test Date

· Physical Fitness Test Semiannual Period

· Good Conduct Medal Date

· Average Conduct

· Average Proficiency

· Occurrences of Weight Control

· Last Composite Score

Weapon Information

· Weapon Type

· Serial Number

· Rack Number

Civilian Education

· Year Left School

· Graduated Code

· Level of Education Code and Description

· Education Certificate Code and Description

· Major Subject Code and Description

Government Operators Permit Licenses

· Effective Date

· Permit Number Identifier

· Expiration Date

· Equipment Type Code

· Restriction Codes and Descriptions (1-5)

See Also:

FitRep and OIC/NCOIC 

Members with ComRats/BAH/Government Quarters

xe "Members with COMRATS/BAH/Government Quarters"This report lists members in receipt of Commuted Rations or Basic Allowance for Housing or assigned to Government Quarters. 

This report contains the following information:

Header Information

· Date

· Title (Members with COMRATS/BAH/Government Quarters)

· Page

· Reporting Unit Code

Report Information

· Last Name

· First Name

· Middle Initial

· Social Security Number

· Rank

· Company/Platoon

· Basic Allowance for Housing Code

· Quarters Flag

· Basic Allowance for Subsistence Code

· Marital Status

· Present Monitored Command Code

Footer Information

· Number of Records

See Also:

Pay Inconsistencies and LES 
Members with No ComRats

xe "Members with No COMRATS"This report lists members who are not in receipt of Commuted Rations.

This report contains the following information:

Header Information

· Date

· Title (Members with No COMRATS)

· Page

· Reporting Unit Code

Report Information

· Last Name

· First Name

· Middle Initial

· Social Security Number

· Rank

· Company/Platoon

· Basic Allowance for Subsistence Code

· Marital Status

· Present Monitored Command Code

· Quarters Code

Footer Information

· Number of Records

See Also:

Pay Inconsistencies and LES 
Monthly Management Report

This report displays calculated deployment gate dates for a period of time and allows you to determine if a member's deployment will pass Gate 401, Gate 251, Gate 220, or Gate 182 criteria, for the entered period. The displayed information is sorted by Gate (401 to 182) and Gate Date (ascending), and may be saved in a variety of formats for use outside of UD/MIPS.

This report uses the current month on your PC by default.

How Do I Get Here?

25. Begin in the Personnel Tempo folder.

26. Choose Monthly Management. The Monthly Management report window opens.

Report Heading

· Date

· PERSONNEL TEMPO MONTHLY MANAGEMENT REPORTxe "Monthly Management Report"
· Page

· RUC

· Report Start Date

· Report Stop Date

Column Headings

· SSN

· Last Name

· Initials

· Rank

· Estimated Return

· Gate 182

· Gate 220

· Gate 251

· Gate 401

Footer

· Number Of Records

See Also:

Personnel Management 

Report Selection 

Pay Inconsistencies and LES

xe "Pay Inconsistencies and LES"These reports show potential pay problems and indicate whether or not a member is receiving a particular pay entitlement. The units will see changes after reconciliation of the Unit Diary.

Units should view changes by generating the following reports once a month, minimum.

· Members with no ComRats 

· Members with ComRats/BAH/Govt Qtrs 
· Married Not Receiving FSA

· FSA Audit

· Annual LES Control Roster

· Married TAD Not Receiving FSA

· Proficiency Pay

· Commuted Rations and FSA

· Pay Status with Wrong Duty Status

· LES Batch Letter

To Generate an Annual LES Control Roster Report

1. Begin in the Additional Selection/Sort Criteria area.

2. In the Enter the last digit of the SSN to Audit box, type the last digit.

3. Choose OK. The Annual LES Control Roster window opens.

4. Select File and then choose Print.

To Generate a LES Batch Letter

1. Begin in the Additional Selection/Sort Criteria area.

2. In the Enter the last digit of the SSN to Audit box, type the last digit.

3. In the Enter your initials box, type your Initials.

4. In the Signature Block box, type the signer's name. 

5. Choose OK. The LES Batch Letter window opens.

6. Select File and then choose Print.

Personnel Information

This group of reports produces personnel informationxe "Personnel Information" pertaining to the member's military career.

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the MIPS module icon.  The MIPS frame opens.  

2. From the Options menu, choose MIPS Reports. The Report Selection window opens.

3. Under Choose a Report, choose Personnel Information.  The treeview expands and displays the available report icons.

4. Choose the desired report.  The Additional Selection/Sort Criteria options display, if applicable.

Selection Criteria 

Under Report On 


All Personnel
Choose Individual Sort (Last Name or SSN)

Choose Unit Sort (No Unit Sort, Company, or

Company/Platoon)
Company
Select Company Code

Choose Individual Sort (Last Name or SSN)

Choose Unit Sort (No Unit Sort or Company/Platoon)
Company/Platoon
Select Company Code

Select Platoon Number

Choose Individual Sort (Last Name or SSN)

Under Select

Company                                       Select Company Code

Platoon                                          Select Platoon Number

Under Unit Sort

No Unit Sort                                   Select No Unit Sort

Company                                        Select Company

Company/Platoon                          Select Company/Platoon

Additional Selection/Sort Criteria

These options are listed with report, when applicable.

EAS

This option produces Expiration of Active Service by either: name, primary MOS, or year/month.

Additional Sort Criteria

· By MOS

· By Name

· By EAS

· Enter From Date

· Enter To Date

ComRats by Code/Last Name  

This option produces reports by a specific ComRats Code.  The report will contain only those personnel who possess the requested ComRats code.  

Additional Sort Criteria

· Enter BAS Code

Med/Dental by Last Digits of SSN

This option produces Medical and Dental Reports.  Users may generate reports based on the last 2 or 4 digits of the last 4 digits of the social security number for proper filing/accountability of Medical and Dental Records. 

Additional Sort Criteria

Under Sort By

· Last 2

· Last 4

Education 

This option produces a report containing education levels for members in the unit. 

There are no Additional Selection/Sort Criteria for this report. 

MOS

This option produces MOS rosters and is sorted by last name, within 1st Add MOS; by last name within BMOS; by last name within 2nd Add MOS; by last name within PMOS; or totals.

Additional Selection/Sort Criteria

Under MOS Sort By

· PMOS

· BMOS

· 1st ADD MOS

· 2nd ADDL MOS

· Totals

Occupational

This option produces rosters similar to the MOS Roster.  It is sorted by last name within primary MOS, except it will only sort and display by occupational field (i.e., 0100, 0200, 0300, etc.).  

There are no Additional Selection/Sort Criteria for this report.

Career Planning by ECC

This option produces the standard Career Planning Report sorted by ECC, in descending order. 

There are no Additional Selection/Sort Criteria for this report.

Alpha Rosters

This option produces a standard Alpha Roster.  It can be sorted by last name, last name within CO/PLT, or by last name within rank.

Additional Selection/Sort Criteria

· Sort by Rank First

TFS Inbound Roster 

This option produces a listing of new recruits scheduled to arrive at the recruit depot. It can be sorted by last name.   A TFS Master Reconciliation needs to be done to enable this roster. 

Additional Selection/Sort Criteria

· From Date

· To Date

· Select or Enter a Monitored Command Code

Security Level

This option produces a report on members with various security levels.  It can be sorted by last name, SSN, company, platoon and company, or without a unit sort.

There are no Additional Selection/Sort Criteria for this report.

Time in Grade

This option produces a report showing time in grade for members. It can be sorted by Last Name, SSN, company, platoon and company, or without a unit sort.

Additional Selection/Sort Criteria

· Input Rank

· Input Date for Time In Grade

To Generate a Report

· Click OK.  The applicable report opens.

To Exit This Window

· From the File menu, choose Exit. You return to the UD/MIPS - Navigator window.

Personnel Management

xe "Personnel Management"This group of reports reflects management information on selected members.

Basic Individual Record/Basic Training Record 

These reports identify all personnel who have recently joined your unit. They are follow up reports to document actions that were to have occurred within 10 days of joining and actions that are to be accomplished within the first month of joining.

Additional Selection/Sort Criteria:

Basic Individual Record-Basic Training Record Report

293. Enter From Date in year/month/day format, i.e., 1997/01/01.

294. Enter To Date in year/month/day format, i.e., 1997/01/01.

Extension of Enlistment.

This option produces a by name report of personnel whose record reflects a status - WILL REENTER, COFGM, COFGL, COFGI or a retirement entry entered via Unit Diary - indicating an action that modifies their Expiration of Current Contract (ECC).  This report was designed to assist in monitoring personnel who have executed an Extension of Enlistment and the extension has not yet been effected.

Racial-Ethnic Report.

This report provides a population group breakdown of all personnel.

Foreign Language Menu.

This option produces three reports: Personnel with any foreign language, Personnel with a specific language, Personnel with a specific language and MOS.

Additional Selection/Sort Criteria:

Foreign Language

1. Choose a Language and MOS Criteria

2. Type a Language Code.  Click the text box's arrow to expose a list of language codes, then select one by mouse click.  This is activated when either Personnel with A Specific Language or Personnel with A Specific Language And MOS are selected.

3. Type MOS.  Click the text box's arrow to expose a list of MOSs, then select one. This is activated when Personnel with A Specific Language And MOS is selected.

GCM Report.

This is a report of all personnel who are due, or overdue, the Good Conduct Medal award.  The report will produce a list of all personnel who have a Good Conduct Medal Commencement Date three years or older.

· Type a Date in year/month/day format, i.e., 1997/01/01.

Personnel Loss Menu.

This option produces a Personnel Loss Report.

1. Type a Date in year/month/day format, i.e., 1997/01/01.

2. Loss Criteria.  Choose one of the following reports:  PCSO by EDD, PCSO by Pres Grad, PCSO by Last Name, PCSO by PMOS, SEPS-APPLV-HOME AWTG PEB

Specific MOS Report.

This option produces a basic Alpha Roster which is limited to personnel having a PMOS that falls between two variables entered in by the user, i.e., 0100 through 0193.

1. Type Starting MOS
2. Type Ending MOS
PRO-CON Report.

This report is produced on 1 July and 1 January of each year.  This option has the capability to produce a Pro/Con Control Log that identifies personnel who are due Semi-Annual Proficiency and Conduct Marks.  The date has no bearing on the sort pattern.

1. From Date.  Enter in the year/month/date format, i.e., 1996/08/01.

2. To Date.  Enter in the year/month/date format, i.e., 1997/01/31.

Religion.

This option produces an alpha roster limited to personnel with a specific religion code or an alpha roster for an entire unit that all Marines' religion codes.

· Type a Religion Code.  This text box is available when Specific Religion Code is selected.  When activated click the text box's arrow to expose a static list of religion codes.  Select a code from the drop down list box.

State Of Legal Residence.

This option produces a report of personnel from a specified state.

295. Choose a State or Code from the list.

296. Click OK.  The window opens.  Users may view and print the report.

Blood Type.

This option produces an alpha roster indicating each individuals Blood Type in natural English vice code.

Work Station/Line Number Report.

This option produces a Work Station/Line Number Report for an entire unit.  The Unit Diary reporting of the Work Station Code and the Line Number are optional. Therefore, the production of this report is dependent on local policy and procedure.

Personnel Tempo 

From this report category, you can compute deployment days and Gate Dates. The Personnel Tempo group contains the Personnel Tempo, Computation of Planned Deployment, Computation of Current Deployment, and the Monthly Management reports.

Monthly Management Report 

This report displays calculated deployment gate dates for a period of time and allows you to determine if a member's deployment will pass Gate 401, Gate 251, Gate 220, or Gate 182 criteria, in this order (highest to lowest) for the time period entered. The displayed information is sorted by Gate and Gate Date ascending, and may be saved in a variety of formats for use outside of UD/MIPS.

This report uses the current month on your PC by default.

To Generate a Monthly Management Report

1. Begin in the Select Option box.

2. Choose one of the following:

· To select all members, choose Select All.

· To select 1 or more members, choose Members.

3. Highlight the selected member or members in the Selected Members box.

4. Highlight the appropriate data in the Report Period group then choose OK.

5. First, a "Processing" progress meter appears and then the Monthly Management Report.

6. If a reporting period of more than one month is requested, an "excessive processing time" warning message is displayed.

7. If the Stop Date is less than the Start Date, a warning message will display stating that the date is invalid.

To Remove One or More Members

1. In the Selected Members box, highlight the members to be removed.

2. Choose OK. The selected members are removed.

To Remove All Members

· Choose Remove All. All members in the Selected Members box are removed.

Selection Criteria:

Select All
To select all members.

Selected Members
To select one or more members.

Personnel Tempo

From this report category, you can enter periods used in computing current and planned deployment dates as well as print associated reports for selected members in a specific RUC. By selecting an option and entering specific date information for the report selected, the user will receive a display of data for the SSNs selected.

How Do I Get Here?

1. Begin on the Report Selection window.

2. In the Choose a Report treeview, choose Personnel Management. The treeview expands and displays the available report icons.

3. Choose Personnel Tempo. The treeview expands and displays the available report icons.

4. Choose the desired report. The Additional Selection/Sort Criteria options display, if applicable.

Personnel Tempoxe "Personnel Tempo"
If you checked the Gate Dates box in the Additional Selection/Sort Criteria box of the Report Selection frame, the report is sorted by gate dates. If the Gate Dates box is not checked, the report will be sorted by SSN.

Computation of Current Deployment

This report computes the number of deployed days for 30 days surrounding the effective date.

This report displays deploy dates and the total days for each deploy date based on 15 days before and 15 days after an Effective Date of Computation has been input and may be sorted on the Current Deployment date.

This report is for a single member who has at least one 112 remark with a track type code's first byte equal to "D". The member may be deployed or not.

Additional Selection/Sort Criteria

1. In the Enter SSN box, type a known SSN.

2. Choose Members. From the displayed listing select a member. The SSN appears in the Enter SSN box.

3. Type a date in the Effective Date of Computation box.

4. Select one of the following Inclusive Period options
· 365 Day 

· 730 Day (default)

Computation of Planned Deployment

This report displays deployment information for all members selected, based on a Planned Deployment Start Date and a Planned Deployment Stop Date.

If a member is already deployed during the planned deployment date range, the word "DEPLOYED" is displayed in the Current Deployment column.

The members of the selected RUC are listed by SSN, rank, and last name. If there are no members highlighted, then all members in the Selected Members window are reported on.

Additional Selection/Sort Criteria

1. In the Planned Deployment Start Date box, type a date (yyyy/mm/dd).

2. In the Planned Deployment Stop Date box, type an ending date (yyyy/mm/dd).

Monthly Management 

This report displays calculated deployment gate dates for a period of time and allows you to determine if a member's deployment will pass Gate 401, Gate 251, Gate 220, or Gate 182 criteria, in this order (highest to lowest) for the period entered. The displayed information is sorted by Gate and Gate Date ascending, and may be saved in a variety of formats for use outside of UD/MIPS.

This report defaults to the current month on your PC.

See Also:

Personnel Tempoxe "Personnel Tempo" Computation 

Personnel with Composite Score

xe "Personnel with Composite Score"This report lists members with a composite score, which is used to determine if a member is eligible for promotion. The report reflects either active or reserve members depending on the reporting unit code (RUC) selected. All ELSIG authorities can print this report. 

This report contains the following information:

Header Information

· Report Date

· Title (Personnel with Composite Scores)

· Page

· Reporting Unit Code

Report Information

· Primary Military Occupational Specialty

· Last Name

· First and Middle Initials

· Social Security Number

· Rank

· Company/Platoon

· Composite Score

· Not Recommended for Promotion

· Restriction Status Code

· Restriction Termination Date

· Rifle Qualification Date

· Rifle Qualification Score

· Rifle Qualification Class

· Basic Skills Test Date

· Physical Fitness Test Date

· Physical Fitness Test Semiannual Code

· Physical Fitness Test Score

· Physical Fitness Test Class

· Proficiency Average

· Conduct Average

· Present RUC

· Duty Status Code

· Date of Rank

· Armed Forces Active Duty Base Date

· Special Duty Points

· Self Education Bonus Points

Footer Information

· Number of Records

See Also:

Promotion 
Personnel without Composite Score

xe "Personnel without Composite Score"This report lists members without a composite score and the related information used to determine if the member would otherwise be eligible for promotion. The report reflects either active or reserve members depending on the reporting unit code (RUC) selected. All ELSIG authorities can print this report. 

This report includes the following information:

Header Information

· Report Date

· Title (Personnel without Composite Scores)

· Page

· Reporting Unit Code

Report Information

· Primary Military Occupational Specialty

· Last Name

· First and Middle Initials

· Social Security Number

· Rank

· Company/Platoon

· Not Recommended for Promotion

· Restriction Status Code

· Restriction Termination Date

· Rifle Qualification Date

· Rifle Qualification Score

· Rifle Qualification Class

· Basic Skills Test Date

· Physical Fitness Test Date

· Physical Fitness Test Semiannual Code

· Physical Fitness Test Score

· Physical Fitness Test Class

· Proficiency Average

· Conduct Average

· Present RUC

· Duty Status Code

· Date of Rank

· Armed Forces Active Duty Base Date

· Special Duty Points

· Self Education Bonus Points

Footer Information

· Number of Records

See Also:

Promotion 
PFC Eligible Report

xe "PFC Eligible Report"This report lists members who are eligible to be promoted to Private First Class. It includes a block to indicate whether or not the member has been recommended, a block for the signature of the commanding officer to approve recommendations, and blocks for the unit diary number and date of any members that were not recommended for promotion. All ELSIG authorities can print this report. 

This report contains the following information:

Header Information

· Date

· Title (Roster of Personnel for Promotion to PFC)

· Page

· Reporting Unit Code

Report Information

· Last Name

· First Name

· Middle Initial

· Social Security Number

· Rank

· Company/Platoon

· Date of Rank

· Armed Forces Active Duty Base Date

· Restricted Status Code

· Restricted Termination Date

· Recommendation Block

Footer Information

· Approval Signature Block

· Approval Statement

· Admin Center Instructions

· Unit Diary Number

· Unit Diary Date

See Also:

Promotion 

Physical Fitness Reports

xe "Physical Fitness Reports"

xe "Physical Fitness Reports:Personnel Who Passed a PFT"

xe "Physical Fitness Reports:Personnel Who Failed or Were Not Required to Take a PFT"

xe "Physical Fitness Reports:Personnel Who Have Not Taken a PFT But Are Required To"These reports provide information on the member's Physical Fitness Test status. Each of the reports shows members in one of the three statuses.

All three of the reports contain the following information:

Heading Information

· Report Date

· Report Title
(Personnel Who Passed A PFT)

(Personnel Who Failed or Were Not Required to Take A PFT)

(Personnel Who Have Not Taken A PFT But Are Required To)

· Report Period

· Page Number

· Reporting Unit Code

Report Information

· Last Name

· First Name

· Middle Initial

· Social Security Number

· Rank

· Company/Platoon

· Physical Fitness Test Date

· Physical Fitness Test Period

· Physical Fitness Test Score

· Physical Fitness Test Class

· Temporary RUC

· Fleet Assistance Program RUC

· Temporary Additional Duty RUC

Footer Information

· Number of Records

See Also:

Training Information 

Promotion

This group of reports assists you in monitoring promotionxe "Promotion" eligibility and composite scores for the following:

· PFC Eligible

· LCpl Eligible

· Cpl Eligible

· Sgt Eligible

· SNCO Board

· Initial 6 Year Enlistment

· Promoted Meritoriously

· Composite Score

Additional Selection/Sort Criteria:

The user must stipulate a minimum date of rank. If a PFC is to be eligible for promotionxe "Promotion" to Lance Corporal on 1 June 1994, that Marine must possess a date of rank during October 1993. The user must enter a date of rank as the last day of October or 931101. Failure to use the last day of the month will cause a failure in identifying eligible personnel who entered active duty or was reduced to PFC during the period 2 October through 31 October. The only exception to this procedure is when executing Corporal and Sergeant Eligibility. Those options use the Date of Rank and Armed Forces Active Duty Base Date as stipulated in the ALMAR announcing the promotionxe "Promotion" period.

PFC Eligible 

· Type the minimum Date of Rank for promotionxe "Promotion".

LCpl Eligible 

· Type the minimum Date of Rank for promotionxe "Promotion".

Cpl Eligible 

1. Type the minimum Date of Rank for promotionxe "Promotion".

2. Do one of the following:

· If an Active Duty member, type the minimum AFADBD.

· If a Reservist, type the minimum PEDB.

Note: Ensure when entering the PEBD that you are using the MCBUL 1430 for Drilling Reserve (DR) and Active Reserve (AR) Promotionxe "Promotion" period announcement to effect promotionxe "Promotion" of the Marine in Question.

Sgt Eligible 

1. Type the minimum Date of Rank for promotionxe "Promotion".

2. Do one of the following:

· If an Active Duty member, type the minimum AFADBD.

· If a Reservist, type the minimum PEDB.

SNCO Board 

There are no Additional Selection/Sort Criteria for this report.

Initial 6 Year Enlistment

There are no Additional Selection/Sort Criteria for this report.

Promoted Meritoriously

297. Type the From Date.

298. Type the To Date.

Composite Score

1. Choose one of the following:

· Personnel with Composite Score 

· Personnel without Composite Score 

2. Type the minimum Date of Rank for promotionxe "Promotion".

3. Choose one of the following Grades:

· E3

· E4

4. Do one of the following:

· If an Active Duty member, type the minimum AFADBD.

· If a Reservist, type the minimum PEDB.

Note: Ensure when entering the PEBD that you are using the MCBUL 1430 for Drilling Reserve (DR) and Active Reserve (AR) Promotionxe "Promotion" period announcement to effect promotionxe "Promotion" of the Marine in Question.

Record of Emergency Data

xe "Record of Emergency Data/Family Readiness Roster"This group of reports provides a repository of emergency information on individual members and their family. You may search these reports by SSN, name, rank, company, and Platoon.

How Do I Get Here?

1. Begin on the Report Selection window.

2. From the Choose a Report treeview, choose RED. The treeview expands, displaying the available report icons.

3. Choose the desired report.

Record of Emergency Data

1. To create a REDSxe "REDS" report of members, select one of the following from the Select Option box:

· To report on all members, choose Select All.

· To report on one or more members, choose Selected Members.

2. If you want to sort the REDSxe "REDS" report by individual, select one of the following from the Individual Sort box.

· To sort by members last name, choose Last Name.

· To sort by members SSN, choose SSN.

3. If you want to sort the REDSxe "REDS" report by unit, select one of the following from the Unit Sort box.

· If you do not wish to sort by unit, choose No Unit Sort.

· To sort a unit by company, choose Company.

· To sort a unit by company and platoon, choose Company/Platoon.

4. Choose OK. The Record of Emergency Data Report opens.

Family Readiness Roster

There are no Additional Selection/Sort Criteria for this report.

Record of Emergency Data Report

xe "Record of Emergency Data Report"

xe "REDS"This report provides emergency information on a member as well as SGLI Election coverage information. 

It contains the following information:

Header Information

· Date

· Title (Record of Emergency Data)

· Page

Body Information

· Social Security Number

· Name (Last, First, Middle Initial)

· Reporting Unit Code

· Company

· Grade

· Record Status Code

· Component Code

· Platoon

· Training Group

· Reserve Record Status Code

· Reserve Component Code

Spouse

· Name

· Address

Children

· Nearest Relative

· Name

· Date of Birth

· Address

Guardian

· Nearest Relative

· Name

· Phone Number

· Relationship

· Address

Father/Mother

· Father's Name

· Father's Address

· Mother's Name

· Mother's Address

Death Gratuity Beneficiary(ies)

· Nearest Relative

· Name

· Relationship

· Percent of Distribution

· Address

Pay Arrears Beneficiary(ies)

· Nearest Relative

· Name

· Relationship

· Percent of Distribution

· Address

Do Not Notify Due to Ill Health

· Nearest Relative

· Name

· Relationship

· Address

Insurance Companies

· Nearest Relative

· Name

· Policy Number

Next of Kin

· Nearest Relative

· Telephone Number

· Relationship

Next of Kin Directions

· Directions to next of kin residence

MIA Notify 

· Name

· Relationship

· 1st Phone Number

· 2nd Phone Number

MIA Notify Directions

· Can be same as Next of Kin 

Bottom of Report

· Member Certification

· Witness Certification

· Reported on UD Number

· Date Certified

See Also:

Record of Emergency Data 

Record of Emergency View 

Reserve

This group of reports provides reservexe "Reserve" units with information about reservexe "Reserve" members. 

How Do I Get Here?

1. Begin on the Report Selection window.

2. Choose the Reserve folder.

3. Choose OK. The window for the selected report opens.

Alpha Roster

An alphabetical roster of reservexe "Reserve" members.

Additional Selection/Sort Criteria:

299. In the first group of the Additional Selection/Sort Criteria area, do one of the following:

· Choose All Members.

· Choose Component Code. The Component Code prompt opens.

· Choose TAD RUC. The TAD RUC prompt opens.

· Choose Training Group. The Training Group prompt opens.

· Choose Record Status. The Record Status prompt opens.

300. In the second group of the Additional Selection/Sort Criteria area, do one of the following:

· Choose All RUC Members.

· Choose MAGTF Designator. The MAGTF Designator prompt opens.

· Choose Monitored MCC. The Monitored MCC prompt opens.

· Choose Work Station. The Work Station prompt opens.

· Choose Platoon. The Company and Platoon prompts open.

301. Type the search criteria for the prompts.

Career Planning

This report lists reservexe "Reserve" members and their military occupational specialties.

1. To sort the report by ECC, select Sort by ECC.

2. In the Report On area, select All Personnel, Company, or Company/Platoon. If you select Company or Company/Platoon, the prompts will become active.

3. From the Company list, select the company code. 

4. From the Platoon list, select the platoon code.

Annual Audit Log

This report lists which reservists are due for an audit for a selected month.

Additional Selection/Sort Criteria:

· Select the month from the list in the Additional Selection/Sort Criteria area.

Mobilization Information

This report lists mobilization information on selected members.

Additional Selection/Sort Criteria:

1. In the first group of the Additional Selection/Sort Criteria area, do one of the following:

· Choose All Members.

· Choose Component Code. The Component Code prompt opens.

· Choose TAD RUC. The TAD RUC prompt opens.

· Choose Training Group. The Training Group prompt opens.

· Choose Record Status. The Record Status prompt opens.

2. In the second group of the Additional Selection/Sort Criteria area, do one of the following:

· Choose All RUC Members.

· Choose MAGTF Designator. The MAGTF Designator prompt opens.

· Choose Monitored MCC. The Monitored MCC prompt opens.

· Choose Work Station. The Work Station prompt opens.

· Choose Platoon. The Company and Platoon prompts open.

3. Type the search criteria for the prompts.

RGMIB UA Report 

This report lists the number of unexcused absences from drills over the preceding 12-month period for selected members.

There are no Additional Selection/Sort Criteria for this report.

Paid Drills

This report lists members who performed paid drills and how many.

Additional Selection/Sort Criteria:

1. In the first group of the Additional Selection/Sort Criteria area, do one of the following:

· Choose All Members.

· Choose Component Code. The Component Code prompt opens.

· Choose TAD RUC. The TAD RUC prompt opens.

· Choose Training Group. The Training Group prompt opens.

· Choose Record Status. The Record Status prompt opens.

2. In the second group of the Additional Selection/Sort Criteria area, do one of the following:

· Choose All RUC Members.

· Choose MAGTF Designator. The MAGTF Designator prompt opens.

· Choose Monitored MCC. The Monitored MCC prompt opens.

· Choose Work Station. The Work Station prompt opens.

· Choose Platoon. The Company and Platoon prompts open.

3. Type the search criteria for the prompts.

Reservexe "Reserve" Recall Roster

This report lists the addresses and phone numbers of reservists.

Additional Selection/Sort Criteria:

1. In the first group of the Additional Selection/Sort Criteria area, do one of the following:

· Choose All Members.

· Choose Component Code. The Component Code prompt opens.

· Choose TAD RUC. The TAD RUC prompt opens.

· Choose Training Group. The Training Group prompt opens.

· Choose Record Status. The Record Status prompt opens.

2. In the second group of the Additional Selection/Sort Criteria area, do one of the following:

· Choose All RUC Members.

· Choose MAGTF Designator. The MAGTF Designator prompt opens.

· Choose Monitored MCC. The Monitored MCC prompt opens.

· Choose Work Station. The Work Station prompt opens.

· Choose Platoon. The Company and Platoon prompts open.

3. Type the search criteria for the prompts.

Unit Muster Sheet 

This group of reports provides checklists to track a reservist's participation at IDT drills. 

Additional Selection/Sort Criteria:

1. Choose the type of unit muster sheet you want.

2. From the IDT Types list, select a type.

3. In the IDT Information group, type the training date in YYYY/MM/DD format. Type or choose the number of drills.

4. If you chose Individual Selection, do one of the following:

· Choose Select All.

· Choose Selected Members.

· Choose Members. See the Search topic for more detailed information.

5. If you chose TAD RUC, select the appropriate TAD RUC from the list.

6. If you chose Work Station, select the appropriate number from the list.

20. If you chose Training Group, select the appropriate training group from the list.

21. If you chose Platoon, select the appropriate company and platoon from the lists.

Note: Officer and Enlisted will only allow you to sort by Last Name in the Individual Sort. There are no sort options for Blank Muster Sheet.

To Exit This Window

· From the File menu, choose Exit. The UD/MIPS - Navigator window opens.

Rifle Range Reports

xe "Rifle Range Reports:Rifle Unqualified or Exempt Personnel"

xe "Rifle Range Reports:Required Personnel Who Have Not Rifle Fired"

xe "Rifle Range Reports"These reports provide information on members' rifle scores for the selected status.

The reports contain the following information:

Heading Information

· Report Date

· Report Title
(Required Personnel Who Have Not Rifle Fired)

(Rifle Qualified Personnel)

(Rifle Unqualified or Exempt Personnel)

· Fiscal Year

· Page Number

· Reporting Unit Code

Report Information

· Last Name

· First Name

· Middle Initial

· Social Security Number

· Rank

· Company/Platoon

· Current Rifle Qualification Date

· Current Rifle Qualification Score

· Current Rifle Qualification Class

· Armed Forces Active Duty Base Date (Not on Rifle Qualified Personnelxe "Rifle Range Reports:Rifle Qualified Personnel" Report)

· Date of Birth (Not on Rifle Qualified Personnelxe "Rifle Range Reports:Rifle Qualified Personnel" Report)

· Sex (Not on Rifle Qualified Personnelxe "Rifle Range Reports:Rifle Qualified Personnel" Report)

· Temporary RUC

· Fleet Assistance Program RUC

· Temporary Additional Duty RUC

Footer Information

· Number of Records

· Marksman (Rifle Qualified Personnel Report)

· Sharpshooter (Rifle Qualified Personnel Report)

· Expert (Rifle Qualified Personnel Report)

· Total Number of Records (Rifle Qualified Personnel Report)

See Also:

Training Information 

RMGIB UA Report

xe "RMGIB UA Report"This report lists all members with nine or more unexcused absences from drills during the last 12 months.

It contains the following information:

Header Information

· Date

· Title (RMGIB UA Report)

· Page

· RUC

Report Information

· Rank

· Last Name

· First Name

· Middle Initial

· Social Security Number

· Reserve Record Status

· Number of Unexcused Drills 12 Months

· RMGIB Code

· SGLI Code

See Also:

Reserve 

Security Clearance Access

xe "Security Clearance Access"Security

This option produces a report that lists personnel possessing security clearance/access.  Besides the standard identification of the member the report will list the member's security eligibility code, security level, security type, investigation completion date, security lecture year/month, and future Monitored Command Code (MCC).

Confidential

This option produces a report similar to the Security report, however it lists only those members in possession of a confidential clearance.

Secret

This option produces a report similar to the Security report, however it only lists those members in possession of a secret clearance.

Top Secret

This option produces a report similar to the Security report, however it only lists those members in possession of a top-secret clearance.

Specific

This option shows members with a specific Security Clearance input by the user.  It also gives the user the option to select only members with a specific Classified Information Non-Disclosure Agreement Date.

Action Pending

This option produces a list of personnel undergoing a security investigation and the investigation is incomplete (i.e. Request D Clearance).

Clearance with Future MCC

This option produces a list of personnel possessing a security access with a Future MCC.

Suspended/Revoked - Not Admin.

This option produces a report of all personnel who have had their clearance/access suspended or revoked by reason other than administrative.

Annual Security Brief Required.

This option produces a report of all personnel who have not attended an annual security brief.  When prompted to enter the date to report on, the user will type in an eight-digit date (i.e. 19940101).  The list will show all personnel who did not attend an annual security brief as specified by the calendar year.

Unit Security Level.  

This option produces a report of all personnel in possession of and not in possession of a clearance/access.  It shows the clearance/access type for each individual.

5-Year Update Needed.  

This option produces a report of all personnel possessing a secret clearance/access or higher that have an Investigation Completion Date which is 5 years or older.

Selection Criteria

Select one of the following under the Report On column.

Report On:

All Personnel
Choose Individual Sort (Last Name, SSN)



Choose Unit Sort (No Unit Sort, Company, Company/Platoon)
Company
Select Company Code

Choose Individual Sort (Last Name, SSN)

Choose Unit Sort (No Unit Sort, Company/Platoon)

Company/Platoon
Select Company Code


Select Platoon Number


Choose Individual Sort (Last Name, SSN)

Additional Selection/Sort Criteria.

The following security reports require additional information:

Specific – Select a specific Security Level Code and check the checkbox if only members with a specific Classified Information Non-Disclosure Agreement Date should be retrieved for the report.  If the checkbox is checked, the date field must be filled in.

Annual Security Brief Required - Enter Date to Report On

5 Year Update Needed - Enter Fiscal Year to Report On

Click OK.  Window opens.  Users may view and print the report.  When viewing the report navigation may be by keyboard, menu, or toolbar.  

SGT Eligible Report

xe "SGT Eligible Report"This report lists members who are eligible to be promoted to Sergeant. It includes a block to indicate whether or not the member has been recommended, a block for the signature of the commanding officer to approve recommendations, and blocks for the unit diary number and date of any members that were not recommended for promotion. All ELSIG authorities can print this report. 

This report contains the following information:

Header Information

· Date

· Title (Roster of Personnel for Promotion to Sergeant)

· Page

· Reporting Unit Code

Report Information

· Last Name

· First Name

· Middle Initial

· Social Security Number

· Rank

· Company/Platoon

· Armed Forces Active Duty Base Date (Active Duty) or Pay Entry Base Date (Reserve)

· Date of Rank

· Composite Score

· Primary Military Occupational Specialty

· Restriction Status Code

· Restriction Termination Date

· Recommendation Block (indicates recommendation)

Footer Information

· Approval Statement

· Approval Signature Block

· Admin Center Instructions

· Unit Diary Number

· Unit Diary Date

See Also:

Promotion 

SNCO Board Report

xe "SNCO Board Report"This report provides information to determine the eligibility for promotion of staff non-commissioned officers with grades of E6 through E9.

This report contains the following information:

Header Information

· Date

· Title (SNCO Board)

· Page

Report Information

· Last Name

· First Name

· Middle Initials

· Social Security Number

· Present Grade

· Company/Platoon

· Monitored Command Code

· Reporting Unit Code

· Select Grade Date

· Select Grade

· Board Number

· Seniority Number

To Sort the Report Columns

· From the Tools menu, choose Sort. The Multiple Column Sort window opens.

To Exit This Window

· From the File menu, choose Close. You return to the Report Selection window and the Promotions folder.

See Also:

Multiple Column Sort 

Promotion 
Training Information

This option provides training statistics to the unit's S-3/Training, Company/Platoon, and other sections that use training informationxe "Training Information".

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the MIPS icon.  The MIPS window opens.

2. From the toolbar, choose Options.  A submenu displays.

3. From the submenu, choose MIPS Reports.  The Report Selection window opens.

The following reports are available through this window:

· BST/EST

This option produces a report of personnel who have taken the Basic Skills Training or Essential Skills Training for the calendar year entered.

· Complete

This option produces a report of members who have completed some or all of various required subjects in each of the basic skills.

· Physical Fitness

This option produces various reports of personnel who have taken a PFT and passed, failed or were not required to take a PFT, or personnel who have taken a PFT but are required to take one for the calendar year and period entered.  The report generated depends on the selection made in the Additional Selection/Sort Criteria box.  The user will be prompted to enter the year and period.

· Weight-Mil Appearance

This option produces a report of members who have been on Weight Control and Military Appearance.

· Pistol

This option produces a report of Officers and SNCOs who have qualified for the fiscal year entered.  The user will be prompted to enter the fiscal year.

· Rifle Range

This option produces various reports of personnel who have qualified for the fiscal year entered, personnel who are required but have not rifle fired, or personnel who are unqualified or exempt.  The report generated depends on the selection made in the Additional Selection/Sort Criteria box.  The user will be prompted for the fiscal year.

· Statistics

This option produces a report providing statistics on personnel training accomplished and the rationale behind how the statistics are accumulated.  Statistics may be provided numerically or with percentages.

· Water Survival

This option accesses a list that allows the user to select from a series of reports identifying personnel within various levels of qualification.

Choosing A Report

22. In the Choose a Report treeview, choose Training Information.  The Treeview expands and lists the available reports.

2. Under Training Informationxe "Training Information", choose the desired report icon.  The Selection Criteria options for that report display to the right of the treeview.  Depending on which option you choose in the Report On box, different groups of personnel can be accessed for the report.

Completing Selection Criteria

Available options for sorting the report may be limited by the Selection Criteria previously chosen for the report.

23. In the Report On box, choose one the following:

· If you want to report on all members of a particular RUC, choose All Personnel.

· If you want to report on all members of a particular company, choose Company.

· If you want to report on all members of a particular company and platoon, choose Company/Platoon.

302. In the Individual Sort box, choose one of the following:

· If you want to sort the report by the members' last names, choose Last Name.

· If you want to sort the report by members' social security numbers, choose SSN.

303. In the Unit Sort box, choose one of the following:

· If you do not want to sort the report, choose No Unit Sort.

· If you want to sort by companies, choose Company.

· If you want to sort by both companies and platoons, choose Company/Platoon.

Completing Additional Selection/Sort Criteria

24. For instructions on completing the applicable Additional Selection/Sort Criteria, choose one of the following links:

BST/EST  

Physical Fitness 

Weight-Mil Appearance 

Pistol 

Rifle Range 

Statistics 

Water Survival 

BST/EST
1. In the Status box, do one of the following:

· For a report on members who have taken the PFT, choose Taken.

· For a report on members who were not required to take the PFT, choose Not Required.

· For a report on members who have not taken the PFT, choose Not Taken.

304. In the Enter Calendar Year box, type the year the test was taken, in YYYY format.

Physical Fitness
2. In the Status box, do one of the following:

· For a report on members who passed the PFT, choose Passed.

· For a report on members who failed, were not required to take the PFT, or were excluded due to age or medical, and/or took a partial PFT, choose Fail/RNT, Age, Med, Partial.
· For a report on members who have not taken the PFT, choose Not Taken.

· For a report on members whose PFT is not required because the member is in a combat situation, choose Not Required - Combat.

3. In the Enter the Year box, type the year the PFT was conducted, in YYYY format.

4. In the Enter the Period box, do one of the following:

· For a report of members who took the PFT during the first six months of the year, type a 1.

· For a report of members who took the PFT the last six months of the year, type a 2.

Weight-Mil Appearance

· In the Report box, do one of the following:

· For a report on members who have been placed on military appearance, choose Military Appearance.

· For a report on members who have been placed on weight control, choose Weight Control.

Pistol

5. In the Status box, do one of the following:

· If the Officers and SNCOs qualified for pistol training, choose Qualified.

· If the Officers and SNCOs were unqualified or exempt from pistol training, choose Unqualified/Exempt.

· If the Officers and SNCOs have not taken pistol training, choose Not Fired.

6. In the Enter Fiscal Year box, type the year the pistol training was taken, in YYYY format.

Rifle Range

7. In the Status box, do one of the following:

· For a report of members who qualified in rifle range training, choose Qualified.

· For a report of members who did not qualify or were exempt from rifle range training, choose Unqualified/Exempt.

· For a report of members who have not participated in rifle range training, choose Not Fired.

8. In the Enter Fiscal Year box, type the year the rifle range was conducted, in YYYY format.

Statistics

25. In the Enter BST Score on which to break box, type the Basic Skills Test score.

26. In the Enter Age for Drive Improvement box, type the age.

27. In the Display Format box, choose one of the following:

· If you want to display the data in whole number format, choose Numbers.

· If you want to display the data in percentage format, choose Percentages.

Water Survival

· In the Select Qualifications list box, select the applicable swim qualification code.

To Exit This Window

· From the File menu, choose Exit.  You return to the UD/MIPS – Navigator window.

Unit Muster Sheet

xe "Unit Muster Sheet"This group of reports provides checklists to track a reservist's participation at IDT drills.

This report contains the following information:

Header Information

· Date

· Title (Unit Muster Sheet)

· Page

· Reporting Unit Code

· Unit

· Type of Inactive Duty Training (IDT)

· Certified Correct (Reserve Unit Commander Signature)

· Inactive Duty Training Dates

· Number of IDTs

Report Information

· Last Name

· First and Middle Initial

· Rank

· Record Status

· Strength Category

· Social Security Number

· Times

· Total IDTs

· Comments

Footer Information

· Signature of Mustering Personnel

· Totals

· Date

· Time

See Also:

Reserve 
Unit Perstat

Users must be in MIPS reports to open Options >>> Personnel Status >>> Create Unit Perstatxe "Unit Perstat".  The Auth MOS window will open.  Two column headings and four command buttons are displayed.  The column headings are MOS and Auth MOS, below are the described command buttons function:

Insert.  Users will transcribe information from their table of organization creating rows as needed.  A scroll bar appears when the number of rows exceeds the displayed window size.

Delete.  Removes one row.

Save.  The Table of Organization window will open.  Enter information for the below listed field titles utilizing the unit's Wartime Table of Organization:

Organization Name (12 characters)

Total Marine Officers (10 characters)

Total Marine NCO (10 characters)

Total Marine LCpl, PFC, Pvt (10 characters)

Total Navy Officers (10 characters)

Total Marine SNCO (10 characters)

Total Navy Enlisted (10 characters)

Click the Save button >>> Close.  Self-explanatory.

Views

Basic Individual Record View

xe "Basic Individual Record View"This window contains several tabs (Pages) that provide administrative and training information on an active duty or reserve member as well as an annual audit of the member's records.

How Do I Get Here?

27. From the UD/MIPS - Navigator, choose the MIPS module icon.  The MIPS frame opens.  

28. From the Options menu, choose MIPS View Members.  The View Members window opens.

29. From the View Reports list, choose Basic Individual Record.  Page tabs display.

Tab Summary

· Do any of the following:

· To view Contract information, choose the Page 1 tab.

· To view Service information, choose the Page 2 tab.

· To view Service and Personal information, choose the Page 3 tab. 

· To view Insignia Authority information, choose the Page 4 tab. 

· To view Record information, choose the Page 5 tab.

· To view Dependents information, choose the Page 6 tab.

· To view Personal/Service Awards information, choose the Page 7 tab.

· To view Unit Awards/Decorations information, choose the Page 8 tab.

Page 1—Contract Information

Contract Information

· End of Active Service Date

· Reserve Expiration of Current Contract Date

· Active Reserve Career Status Code

· Date of Enlistment/Acceptance

· Armed Forces Active Duty Base Date

· Pay Entry Base Date

· Date of Original Entry

· Length of Current Enlistment Months

· Length of Current Enlistment Years

· Length of Current Extension

· Number of Extensions of Current Enlistment

· Total Months Extension

· Effective Date of Current Extension

· Time Lost Current Enlistment

· Designated Military Pilot

· Source of Entry

· Source of Initial Entry of Military Service

· End of Obligated Service

· Strength Category Code

· Date Accepted 1st Commission

· Duty Status

· Duty Limit

· Start Mandatory Drill Date

· End Mandatory Drill Date

· Mandatory Drill Participation Extension Month

· Program Enlisted For

· Bonus Program Enlisted For

· College Program Enlisted For

· Active Duty Montgomery GI Bill Status Flag

· Active Duty Montgomery GI Bill Status Code

· Montgomery GI Bill Selected Reserve Status

· Original Veterans Education Benefit Program Code

Page 2—Service Information

Service Information

· Date of Rank

· Select Grade

· Select Grade Date

· Restricted Status Code

· Restricted Termination Date

· Date Current Tour Began

· Present Unit Join Date

· Date Join Selected Marine Corps Reserve

· Geographical Location Code

· Geographical Location Date Current Tour Began

· Combat Service Code

· Last Combat Tour Date

· Table of Organization Number 

· Line Number

· Work Station

· Billet Description

· Present RUC and MCC

· Temporary RUC and MCC

· Additional Temporary RUC and MCC

· Fleet Assistance Program RUC and MCC

· Reserve RUC and MCC

· Former RUC and MCC

· Future RUC and MCC

· Mobilization RUC and MCC

· Deployment Status

· Anniversary Date

· Last Separation/Discharge Date

· Separation Code Reason 

· Last Physical Examination Date

· Last Physical Certification Date

· Overseas Control Date

· Officer Mandatory Removal Date

· Commanding Officer Date

· Individual Location Code

· Deploy Return Date

· Rotation Tour Date

· Reserve Unit Join Date

Page 3—Service Information-Personal Information

Service Information

· Military Occupational Specialty

· Billet Military Occupational Specialty 

· Secondary  Military Occupational Specialty

· Joint Military Occupational Specialty

· Joint Military Occupational Specialty Effective Date

Personal Information

· Date of Birth

· Sex

· Citizenship

· Ethnic Code

· Race

· Race Aggregate Code

· Religion

· Blood Type

· DNA Date

· HIV III Tested Date

· Home Phone

· Work Phone

· Electronic Mail Effective Date

· Electronic Mail Address

· Street Address

· City Address

· State

· Zip-Code

· Country of Origin

· Address Validation Code

· Home of Record

Additional MOS

· Assignment Date

· Additional Military Occupational Specialty

Civilian Education

· Year Left School

· Graduated

· Level of Education

· Education Certificate

· Major Subject

Page 4—Insignia Authority

Insignia Authority 

· Wear Effective Date

· Insignia Authority Code

· Insignia Authority Description

Page 5—Record Information

· Good Conduct Medal Date

· Armed Forces Reserve Medal Date

· Selected Marine Corps Reserve Medal Date

· Duty Preference

Record Information

· Disputed Date

· Last Screening Date

· Screening Result

· Disputed Data

· Screening Reason

Page 6—Dependents Information

Dependents Information

· Marital Status

· Dependent Certification Code

· Dependent Geographical Location Code

· Service Spouse Social Security Number

· Service Spouse Code

· Service Spouse Effective Date

· Total Number of Dependents

· Basic Allowance for Subsistence/Commuted Rations

· Date Dependent Location Began Date

· Custody Status Code

· Special Power of Attorney

· Expiration Date of Special Power of Attorney

Dependents

· Relationship Code

· Dependent First Name

· Dependent Middle Initial

· Dependent Last Name

· Dependent City Code

· Dependent County Code

· Dependent Location Code

· Date Gained

· Date of Birth

Page 7—Personal/Service Awards Information

Personal Awards Information

· Award Code

· Device Code

· From Date

· To Date

· Date Awarded

· Description

Service Awards Information

· Award Code

· Device Code

· From Date

· To Date

· Date Awarded

· Description

Page 8—Unit Awards/Decorations Information

Unit Awards Information

· Award Code

· Device Code

· From Date

· To Date

· Date Awarded

· Description

Decorations Information

· Award Code

· Device Code

· From Date

· To Date

· Date Awarded

· Description

To Exit This Window

· From the File menu, choose Exit.  You return to the UD/MIPS - Navigator window.

Basic Training Record View

xe "Basic Training Record View"This report provides training information on a member who has been through Basic Training.

How Do I Get Here?

1. Begin on the View Members window.  

2. From the View Reports list, choose Basic Training Record.  The page tabs display.

Tab Summary

· Do one of the following:

· To view Unit Training information, choose the Page 1 tab.

· To view Weapons Training information, choose the Page 2 tab.

· To view Security Investigation information, choose the Page 3 tab.

· To view Test Scores information, choose the Page 4 tab.

· To view Local School information, choose the Page 5 tab.

· To view Off Duty Education Course information, choose the Page 6 tab.

· To view Martial Arts Training information, choose the Page 7 tab.

Page 1 – Unit Training

Unit Training

· Physical Fitness Test Date

· Physical Fitness Test Semi-Annual Code

· Physical Fitness Test Score

· Physical Fitness Test Class

· Prior Physical Fitness Test Date

· Prior Physical Fitness Test Semi-Annual Code

· Prior Physical Fitness Test Score

· Prior Physical Fitness Test Class

· Basic Skills Training/Essential Skills Training Date

· Basic Skills Training/Essential Skills Training Performed

· Basic Skills Training/Essential Skills Training Attempted

· Basic Skills Training/Essential Skills Training Score

· HIV III Lecture Date

· Driver Improvement

· Drug Lecture Year

· Leadership Training Code

· Leadership Training Date

· Security Lecture Date

· Water Survival Qualification Code and Description

· Water Survival Requalification Date

· Gas Mask Size and Description

· Gas Mask Type and Description

· Gas Chamber Date

· Helmet Size and Description

· Weight Control Status

· Weight Control Assignment Quantity

· Military Appearance Status

· Military Appearance Assignment Quantity

Incurred Obligated Service

· Incurred Obligated Service Code

· Incurred Obligated Service Date

Page 2 –Weapons Training

Unit Training

· Current Rifle Qualification Date

· Current Rifle Score

· Current Rifle Class

· Rifle Distinguished Date

· Rifle Proficiency Enhancement Training (PET) Date

· Rifle PET Exception Code

· Rifle PET Exception Date

· Number of Expert Rifle Qualifications

· Current Pistol Qualification Date

· Current Pistol Score

· Current Pistol Class

· Pistol Distinguished Date

· Pistol Proficiency Enhancement Training (PET) Date

· Pistol PET Exception Code

· Pistol PET Exception Date

· Number of Expert Pistol Qualifications

Rifle Field Firing Date

· Rifle Field Firing Date

· Rifle Field Firing Individual Type Score 6

· Rifle Field Firing Individual Type Score 7

· Rifle Field Firing Individual Type Score 8

· Rifle Field Firing Individual Type Score 9

· Rifle Field Firing Individual Type Score 10

· Rifle Field Firing Individual Type Score 11

Anti-Terrorism Training 

· Anti-Terrorism Training Annual Date

· Anti-Terrorism Training Deploy Date

Weapons Ammo Explosive 

· Screened Date

Page 3 –Security Investigation

Security Investigation 

· Security Investigation Type

· Security Clearance

· Security Investigation Agency Code

· Action Required

· Completion Date

· Eligibility Code

· Current Award Date

· Place Of Birth

· County

Intelligence Training Hours

· Level I Anti-Terrorism Training Annual Date

· Level I Anti-Terrorism Training Deploy Date

Service Schools/Special Skills

· Service School Code

· Service School Description

· Service School Date

Classified Non-Disclosure Agreement

· Executed Date

Page 4—Test Scores

· Class/Assign Test Type

· Date

· General Technical/General Classification Test

Scores

· General Technical Score

· Math Score

· Clerical Score

· Electronics Score

Army Radio Code

· Army Radio Code Score

· Army Radio Code Date

Electronic Data Processing Test

· Electronic Data Processing Test Score

· Electronic Data Processing Test Date

Defense Language Aptitude Battery

· Defense Language Aptitude Battery Score

· Defense Language Aptitude Battery Date

Armed Forces Qualification Test 

· Armed Forces Qualification Test Form Number

· Armed Forces Qualification Test Score

· Foreign Language 1-4

· Listening Skill Level 1-4

· Reading Skill Level 1-4

· Speaking Skill Level 1-4

Page 5—Local School

Local School

· Complete Description

· Complete Location

· Complete Date

Academic Test

· Course Title Name

· Location

· Credit Quantity 

·  Grade code 

· Completion Date

Page 6—Off Duty Education Course

Off Duty Education Course

· Complete Date

· Course Title

· Location

· Credit Quantity

· Grade Code

Correspondence Course

· Effective Date

· Course Identifier

· Course Name

· Status Code

· Score Quantity

Page 7—Martial Arts Information

Martial Arts Training

· Martial Arts Belt Code

· Martial Arts Description

· Martial Arts Completion Date

· Martial Arts Re-Certification Date

To Exit This Window

· From the File menu, choose Exit.  You return to the UD/MIPS - Navigator window.

Marksmanship View

xe "Marksmanship View"This report provides information on member's pistol and rifle qualifications status.

How Do I Get Here?

30. Begin on the View Members window.

31. From the View Reports list, choose Marksmanship. The page tab displays.

Page 1 - Pistol and Rifle Qualification

Pistol Qualification

· Current Pistol Qualification Date

· Current Pistol Qualification Score

· Current Pistol Qualification Class

· Current Pistol Qualification Individual Type Score (1-2)

· Prior Pistol Qualification Date

· Prior Pistol Qualification Score

· Prior Pistol Qualification Class

· Prior Pistol Qualification Individual Type Score (1-2)

· Pistol Distinguished Date

· Pistol Proficiency Enhancement Training (PET) Date

· Pistol PET Exception Code

· Pistol PET Exception Date

· Number of Expert Pistol Qualifications

Rifle Qualification

· Current Rifle Qualification Date

· Current Rifle Qualification Score

· Current Rifle Qualification Class

· Current Rifle Qualification Individual Type Score (1-4)

· Prior Rifle Qualification Date

· Prior Rifle Qualification Score

· Prior Rifle Qualification Class

· Prior Rifle Qualification Individual Type Score (1-4)

· Rifle Distinguished Date

· Rifle Proficiency Enhancement Training (PET) Date

· Rifle PET Exception Code

· Rifle PET Exception Date

· Number of Expert Rifle Qualifications

Rifle Field Firing

· Rifle Field Firing Date

· Rifle Field Firing Weapons Code

· Rifle Field Firing Individual Type Score 6

· Rifle Field Firing Mastery Level

· Rifle Field Firing Individual Type Score 7

· Rifle Field Firing Mastery Level

· Rifle Field Firing Individual Type Score 8

· Rifle Field Firing Mastery Level

· Rifle Field Firing Individual Type Score 9

· Rifle Field Firing Mastery Level

· Rifle Field Firing Individual Type Score 10

· Rifle Field Firing Mastery Level

· Rifle Field Firing Individual Type Score 11

· Rifle Field Firing Mastery Level

To Exit This Window

· From the File menu, choose Exit. The UD/MIPS – Navigator window opens.

Pay/Dependent View

xe "Pay/Dependent View"This series of pages indicates how the member is paid and includes information about the member's dependents.

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the MIPS module icon.  The MIPS frame opens.  

2. From the Options menu, choose MIPS View Members. The View Members window opens.

To View the Service Records

1. In the View Reports list, choose Pay/Dependent.  The Pay/Dependent page tabs display.

2. Do one of the following:

· To view Pay Information and Remark Flags, choose the Page 1 tab. 

· To view Dependents, choose the Page 2 tab. 

Page 1—Pay Information and Remark Flags

This page contains the following information:

Pay group

· Reserve Pay Status

· Pay Status

· Special Pay Code

· Proficiency Pay

· Hostile Fire Pay Code

· Quarters Code

· Sea Foreign Duty Code

· Hardship Duty Pay Code

· Career Status Bonus Election Code

· Basic Allowance for Subsistence Code

· State of Legal Tax Residence

· Diving Duty Termination Date

· Clothing Replacement Allowance Date

· First Normal Pay Day Amount

· Second Normal Pay Day Amount

· Request Split Pay Amount

· Request Split Pay Effective Date

· Prime Payment Option Election Code

· Incentive Pay First Duty

· Incentive Pay Second Duty

· Hardship Duty Pay Location

· Career Status Bonus Election Date

· Electronic Funds Transfer Indicator

Remark Flags group

· Family Separation Allowance

· Overseas Housing Allowance

· Cost of Living Allowance

· Cost of Living Allowance Barracks Without Dependents

· Career Sea Duty

· Proficiency Pay

· Lost Time

· Basic Allowance for Housing Credit

· Montgomery GI Bill

· Veterans Education Assistance Program

· Active TSP

· Reserve TSP

Page 2—Dependents

Dependents

· Marital Status

· Number of Dependents

· Geographical Location Begin Date

· Geographical Location Code

· City/County Location Code

· State/Country Location Code

· Custody Status Code

· Dependent Certification Code

Service Spouse

· Code

· Social Security Number

· Effective Date

To Exit This Window

· From the File menu, choose Exit. The UD/MIPS - Navigator window opens.

See Also:

View Members 
Personal View

xe "Personal View"This view contains personal information on an active duty or reserve member.

How Do I Get Here?

28. From the UD/MIPS - Navigator, choose the MIPS module icon.  The MIPS frame opens.

29. From the Options menu, choose MIPS View Members.  The View Members window opens.

30. From the View Reports list, choose Personal.  The Personal report folder opens.

Tab Summary

· Do any of the following:

· To view Personal information, choose the Page 1 tab.

· To view Military information, choose the Page 2 tab.

· To view Address information, choose the Page 3 tab.

· To view Enlistment information, choose the Page 4 tab.

· To view MGIB information, choose the Page 5 tab.

Page 1 - Personal Information

· General Classification Test

· Sex

· Race Code

· Race Code Description

· Race Aggregate Code 

· Ethnic

· Religion

Civilian Education

· Year Left School

· Year Graduated

· Level of Education

· Education Certificate

· Major Subject

· Blood Type

· DNA Test Date

· Helmet Size

· Gas Mask Size

· Gas Mask Type

· Date Of Birth

· Good Conduct Medal Date

· Armed Forces Reserve Medal Date

· Selected Marine Corps Reserve Medal Date

· Date Initial Entry Reserves

Page 2 - Military Information

Military Appearance/Weight Control

· Military Appearance Flag

· Military Appearance Assignment Quantity

· Weight Control Flag

· Weight Control Assignment Quantity

Security Clearance

· Investigation Agency Code

· Investigation Code

· Eligibility Level

· Action Request Code

· Clearance Held

· Current Award Date

· Completion Date

Classified Non-Disclosure Agreement

· Executed Date

Citizenship

· Citizenship Code

· Country Origin Geographic

Birthplace

· Birthplace County

· Birthplace State

Page 3 – Address Information

Address

· Street

· City

· State

· Zip Code

· Valid Address Date 

· Status

· Valid Address Code

Phone

· Home Phone Number

· Work Phone Number

Home of Record

· City Code

· County Code

· State and Country Code

Individual Location

· City Code

· County Code

· State and Country Code

Expanded Name

· Last Name

· First Name

· Middle Name

· Cadency Code

Page 4 – Enlistment Information

Screening

· Screening Reason

· Screening Result

· Screening Date

Marine Corps College Fund

· Maximum Amount Code

· Maximum Amount

· Election Effective Date

Enlistment

· Reason Transfer From Selected Marine Corps Reserve

· Contract Agreement

· Program Enlisted For Date

· Reenlistment Indicator

· Source Initial Entry

· Last Physical Date

· Mandatory Removal Date

· Date of Rank 1st Commission

· Date 1st Commission

· Prior Date Enlisted/Acceptance

· Date Accession

· Date From Active Duty

· Training Completion Date

· Physical Risk

· Date Physical Certified

· Prisoner Of War Code

· Years Service

Page 5 – MGIB Information

Active Duty Montgomery GI Bill

· Active Duty Montgomery GI Bill Status Code

· Montgomery GI Bill Start Date

· Montgomery GI Bill Stop Date

Reserve Montgomery GI Bill

· Reserve GI Bill Code

· Reenlistment Extension Flag

· Reserve Start Date

· Reserve Termination Date

Reserve Montgomery Selected Reserve Kicker Incentive

· Begin Date

· Eligibility Effective Date

· Control Number

· Basis Code

· Eligibility Code

· Incentive Code

To Exit This Window

· From the File menu, choose Exit.  The UD/MIPS – Navigator window opens.

Record of Emergency Data View

xe "Record of Emergency Data View"

xe "REDS"This view contains several tabs (Pages) that provide emergency information on an active duty or reserve member.

How Do I Get Here?

32. Begin on the View Members window.

33. From the View Reports list, choose Record of Emergency Data.  Page tabs display.

Tab Summary

· Do any of the following:

· To view Dependent information, choose the Page 1 tab.

· To view Guardian information, choose the Page 2 tab.

· To view Death Gratuity Beneficiary(ies) information, choose the Page 3 tab.

· To view Do Not Notify Due to Ill Health information, choose the Page 4 tab. 

· To view Next of Kin information, choose the Page 5 tab.

· To view MIA information, choose the Page 6  tab.

Page 1—Dependent

Spouse

· Name

· Address

Children

· Name

· Address

Page 2—Guardian

Guardians

· Name

· Address

· Phone Number

· Relationship

Father

· Name

· Address

Mother

· Name

· Address

Page 3—Death Gratuity Beneficiary(ies)

Death Gratuity Beneficiary(ies)

· Name

· Address

Pay Arrears

· Name

· Address

Page 4—Do Not Notify Due To Ill Health

Do Not Notify Due to Ill Health

· Name

· Address

Insurance Companies

· Name

· Policy Number

Page 5—Next of Kin/SGLI Member Election

Next of Kin

· Phone Number

· Relationship

· Directions to residence

SGLI Member Election

· SGLI Member Election

· SGLI Spouse Election

· Beneficiary

· Pay Designation

· Date of Coverage

Page 6—MIA

MIA

· MIA Name

· Relationship

· MIA 1st Phone Number

· MIA 2nd Phone Number

· MIA Notify Directions

To Exit This Window

· From the File menu, choose Exit.  The UD/MIPS – Navigator window opens.

See Also:

Record of Emergency Data 

Record of Emergency Data Report 

Reserve Data View

xe "Reserve Data View"This window contains several tabs (Pages) that provide information on the member's career and points they have accumulated throughout their career.

How Do I Get Here?

34. Begin on the View Members window.  From the View Reports list, choose Reserve Data.

35. Do one of the following:

· To view Reserve Data information, choose the Page 1 tab.

· To view Drill/Retirement Points information, choose the Page 2 tab.

Page 1-Reserve Data

· Present Grade

· Effective Date of Rank

· Reserve Unit Joined Date

· Joined Selected Marine Corps Reserve Date

· Joined Unit Date

· Current Activity Duty Began Date

· Date of Enlistment/Acceptance

· Unexcused 12 Month Quantity 

· Montgomery Reserve GI Bill Flag

· Prior Anniversary Retirement Point Correction Flag

· Regular Drill Authorize Fiscal Year

· Mandatory Drill Participation Start Date

· Mandatory Drill Participation Stop Date

· Mandatory Drill Participation Extension Month

· Mandatory Removal Date

· Anniversary Date

· Total Career Retirement Points

· Total Quality Service

· Total Satisfactory Years

· Twenty Year Flag

· Twenty Year Flag Effective Date

· Career Reserve Credit Report Certification Date

Page 2-Drill/Retirement Points

IDT Attend Points

· For Anniversary Year, Anniversary Prior Year, Fiscal Year, and Fiscal Prior Year:

· Paid Equivalent Instruction or Duty

· Regulation Anniversary Year

· Readiness Management Period

· Additional Flight Training Period (AFTP)

· Additional Training Period

· Reserve Reporting Unit Code

· Fiscal Year Retirement Compute Date

· Authorized Drill

· Total Retirement Points Anniversary Year

· Excess AFTP Prior Fiscal Year Quantity

· Excess Discrepancy Report Prior Fiscal Year Quantity

· Career Reserve Credit Report Date

· Excess AFTP Current Fiscal Year Quantity

· Excess Discrepancy Report Current Fiscal Year Quantity

· Membership Points Earned Current Month

· Total Career Retirement Points

· Anniversary Change Flag

· Accumulated End Of Month Active Duty Days

· Total Satisfactory Years

· Anniversary Date

· For Other Current Anniversary and Other Prior Anniversary:

· Mobilization Training Unit

· Associate

· Appropriate

· Non-Paid Equivalent Instruction or Duty

· Correspondence

· Other

To Exit This Window

· From the File menu, choose Exit.  You return to the UD/MIPS - Navigator window.

Service View

xe "Service View"This window contains several tabs (Pages) that provide information on the member's service record to include promotion dates, location, service dates, and other information.

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the MIPS module icon.  The MIPS frame opens.  

2. From the Options menu, choose MIPS View Members. The View Members window opens.

3. From the View Reports list, choose Service. The page tabs display.

4. Do one of the following:

· To view Service/Promotion information, choose the Page 1 tab.

· To view Current Location information, choose the Page 2 tab.

· To view Flight Duty and Mobilization information, choose the Page 3 tab. 

· To view Personnel Tempo information, choose the Page 4 tab. 

· To view SNCO Selection Board information, choose the Page 5 tab.

Page 1—Service/Promotion

· Current Active Duty Begin Date

· Armed Forces Active Duty Begin Date

· Enlistment Acceptance Date

· Pay Entry Base Date

· Expiration of Active Service

· Expiration of Obligated Service

· Active Duty Expiration of Current Contract

· Expiration of Current Contract Flag

· Reserve Expiration of Current Contract

· Active Reserve Career Status

· Extension Number

· Extension Months

· Length of Current Enlistment Months

· Length of Current Enlistment Years

· Current Days Lost

· Mandatory Start Drill Date

· Mandatory Stop Drill Date

· Reserve Unit Join Date

· Date of Rank

· Date of Rank Effective Date

· Grade Select

· Grade Select Date

· Participation Date

· Restricted Status Code

· Restricted Termination Date

· Composite Score Date

· Composite Score

· Strength Category 

· Duty Status

· Duty Limit

· Reenlistment Extension Flag

· Reenlistment Indicator

· Recommended for Promotion

· Separation Document Code

· Separation Document Type

Page 2—Current Location

Monitored Command Code

· Present Monitored Command Code

· Command Monitored Command Code

· Future Monitored Command Code

· Reserve Monitored Command Code

· Marine Air Ground Task Force Designator

· Combat Service Code

· Complete Last Tour Date

Reporting Unit Code

· Present Reporting Unit Code

· Present Unit Platoon Code

· Present Unit Company Code

· Fleet Assistance Program Reporting Unit Code

· Fleet Assistance Program Platoon Code

· Fleet Assistance Program Company Code

· Temporary Active Duty Reporting Unit Code

· Temporary Active Duty Platoon Code

· Temporary Active Duty Company Code

· Additional Temporary Active Duty Reporting Unit Code

· Additional Temporary Active Duty Platoon Code

· Additional Temporary Active Duty Company Code

· Former Reporting Unit Code

· Future Reporting Unit Code

· Reserve Reporting Unit Code

· Reserve Unit Platoon Code

· Reserve Unit Company Code

· Work Station

· Table of Manpower Requirement Line-Table of Organization Number

· Geographical Location Begin Date

· Rotation Tour Date

· Overseas Control Date

· Average Service Proficiency and Conduct

· Average Grade Proficiency and Conduct

· Average Enlist Proficiency and Conduct

Deployment

· Deployment Status

· Deployment Return Date

· 365 Deployment Total Days Quantity

· 730 Deployment Total Days Quantity

· First Deployment Total Days Waiver Quantity

· Second Deployment Total Days Waiver Quantity

· First Six Month Quantity

· Second Six Month Quantity

· Third Six Month Quantity

· Fourth Six Month Quantity

· Present Unit Join Date

· Present Tour Control Factor

· Temporary Additional Duty Excess Flag

· Joined Selective Marine Corps Reserve

Lump Sum Leave

· Total Days Lump Sum Leave

· Active Date

· Military Occupational Specialty

· Billet Military Occupational Specialty

· Billet Description

· Supplemental Military Occupational Specialty

Page 3—Flight Duty and Mobilization

Mobilization

· Mobilization Monitored Command Code

· Mobilization Status Code

· Mobilization Delay Effective Date

Aviation

· Officer Service Date

· Aviation Service Date

· Gate 1 Pass/Fail Code

· Gate 1 Pass/Fail Code Effective Date

· Gate 2 Pass/Fail Code

· Gate 2 Pass/Fail Code Effective Date

Orders Info Area

· Estimated Date of Arrival

· Estimated Date of Detachment

· Future Monitored Command Code

· Present Tour Control Date

· Date Current Tour Began

Operation Fly Time

· Operation Fly Time Base Date

· Operation Fly Time Start Date

· Operation Fly Time Stop Date

· Accumulated Time

· Completion Date

· Designated Military Pilot

Program Enlisted For Codes

· Skills Program Enlisted For

· Bonus Program Enlisted For

· College Program Enlisted For

Incurred Obligated Service

· Incurred Obligated Service Code

· Incurred Obligated Service Date

Page 4—Personnel Tempo

Personnel Tempo Open Remark

· Reporting Unit Code

· Start Date

· Estimated Date of Return+

· Branch of Service

· Track Type

· Number of Days Deployed

· Gate One Date (182 Days)

· Gate Two Date (220 Days)

· Gate Three Date (251 Days)

· Gate Four Date (401 Days)

· Accumulated Deployed Time Credit

Personnel Tempo Closed Remarks

· Reporting Unit Code

· Start Date

· Last Actual Credit Date

· Branch of Service

· Track Type

· Number of Days Deployed

· Gate One Date (182 Days)

· Gate Two Date (220 Days)

· Gate Three Date (251 Days)

· Gate Four Date (401 Days)

· Accumulated Deployed Time Credit

Page 5—SNCO Selection Board

· Select Grade

· Select Grade Date

· Seniority Number

· Selection Board Number

To Exit This Window

· From the File menu, choose Exit. You return to the UD/MIPS - Navigator window.

Training View

xe "Training View"This report provides information on a member's training, scores, completion dates, and any additional MOSs.

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the MIPS module icon.  The MIPS frame opens.  

2. From the Options menu, choose MIPS View Members.  The View Members window opens.

3. From the View Reports list, choose Training.  The Training report folder opens.

Tab Summary

· Do one of the following:

· To view Training Summary information, choose the Page 1 tab.

· To view Government Equipment Operator Licenses information, choose the Page 2 tab.

· To view Cohesion Information, choose the Page 3 tab.

Page 1 – Training Summary

Basic Skills Test/Essential Subjects Test

· Date Test Taken

· Number of Tasks Attempted

· Number of Tasks Performed

· Final Test Score

Physical Fitness Test

· Physical Fitness Test Date

· Physical Fitness Semi-Annual Code

· Physical Fitness Score

· Physical Fitness Class

· Prior Physical Fitness Test Date

· Prior Physical Fitness Semi-Annual Code

· Prior Physical Fitness Score

· Prior Physical Fitness Class

· Gas Chamber Training Date

· Drug Lecture Date

· HIV Lecture Date

· HIV Test Date

· Security Lecture Date

· Special Duty Bonus Points

· Special Duty Bonus Date

· Command Recruiter Bonus Points

· Pistol Qualification Date

· Current Pistol Qualification Score

· Current Pistol Qualification Class

· Prior Pistol Qualification Score

· Prior Pistol Qualification Class

· Rifle Qualification Date

· Current Rifle Qualification Score

· Current Rifle Qualification Class

· Prior Rifle Qualification Score

· Prior Rifle Qualification Class

Water Survival

· Qualification Code and Description

· Requalification Date

Leadership Training

· Leadership Level

· Training Date

· Hours Intelligence Training

· Driver Improvement School Code and Description

· Self Education Bonus Points

Additional Military Occupational Specialty (ADMOS)

· ADMOS (1-12) Assignment Date

· ADMOS (1-12) Assignment

Page 2 – Government Equipment Operator Licenses

· Effective Date

· Permit Number Identifier

· Expiration Date

· Equipment Type Code

· Restriction Code (1-5)

Page 3 – Cohesion Information

· Cohesion Project Training Completion Date

· Cohesion Number

· Cohesion Intended MOS

· Cohesion Future Monitored Command Code

Incurred Obligated Service

· Incurred Obligated Service Code

· Incurred Obligated Service Date

To Exit This Window

· From the File menu, choose Exit.  You return to the UD/MIPS – Navigator window.

Individual Query View

xe "Individual Query View"This view contains one tab (Page) that provides current information on an active duty or reserve member.

How Do I Get Here?

31. From the UD/MIPS - Navigator, choose the MIPS module icon.  The MIPS frame opens.

32. From the Options menu, choose MIPS View Members.  The View Members window opens.

33. From the View Reports list, choose Individual Query.  The Individual Query folder opens.

Tab Summary

· Do the following:

· To view Individual Query information, choose the Page 1 tab.

Page 1 – Individual Query Option

· Current Location

· Service Branch

· Service Component

· Project Loss Date

· Security Clearance

· Occupational Skills

· Language Skills

· Sex

· Race

· Race Aggregate Code

· Blood Type

· Duty Status


To Exit this Window

· From the File menu, choose Exit.  You return to the UD/MIPS - Navigator window.

Intelligent Forms

About Intelligent Forms

xe "About Intelligent Forms"Intelligent Forms processing makes possible the automation of the workflow process for administrators utilizing the Commanders Unit Diary Database (CUDDB) resident within UD/MIPS.  You can create forms available on a pre-defined list and add TTCs to a selected diary, or the Tickler File, if applicable.

Search Features

The following options are available to you for searching:

· ALL

· Form Name

· Last Name

· RUC

· SSN (Social Security Number)

The Export and Import options in the Tools menu of Common Utilities allows the forms data to be exported and imported by All Forms/Personnel, Individual SSN, or individual form.

Features

Intelligent Forms processing provides you with these abilities:

· Input search criteria to open a form.

· Edit existing forms.

· Save forms.

· Print forms.

· Retrieve reports based on the processed date. This indicates the type and number of forms produced.

See also:

Intelligent Forms Selection 

Export 

Import 

Intelligent Forms Selection

xe "Intelligent Forms Selection" This window allows you to see all of the form records in the database as well as to filter the data by form name, last name, and social security number. You can create a new record, change an existing record, and delete or print a record. 

A form management feature allows you to retrieve reports, which shows how many forms of each type were prepared.  The reports are generated for a specific date range.

How Do I Get Here?

305. Begin on the UD/MIPS - Navigator.

306. Choose Intelligent Forms. The Intelligent Forms Selection window opens.

To Find an Intelligent Form

307. In the Select Search Criteria list, choose the column you want to search on.

308. In the value list to the right of the Select Search Criteria list, choose the value you want displayed in the Intelligent Forms Selection list.

· The label of the list to the right of the Select Search Criteria list changes to reflect the selection you made in the Select Search Criteria list.

To Create a New Form

309. Choose New. The New Record window opens.

310. After completing the steps in the New Record topic, choose OK.  The New Form window displays the selected form with some entries auto-populated. See the topic for the applicable form for more information on how to complete the form. 

After completing the steps in the New Form window, you return to the Intelligent Forms window.  If you attempt to create a new form and the form already exists, a message informs you that a duplicate form was found.

To Edit a Form

311. In the Intelligent Forms Selection list, select the form you want to change.

312. Choose Edit. The edit window for the selected form opens. See the topic for the applicable form for more information on how to complete the form.

To Print Forms

313. In the Intelligent Forms Selection list, select one or more forms to print.

314. From the File menu, choose Print. The selected form prints.

To Delete A Form

315. In the Intelligent Forms Selection list, select one or more forms to delete.

316. Choose Delete. 

317. Choose OK to confirm deletion. You return to the Intelligent Forms Selection window.

To Exit This Window

· Choose Close. You return to the Intelligent Forms frame.

See also:

Intelligent Forms Print Options 

DD Form 216 

DD Form 1561 

NAVMC 10592 

NAVMC 10922 

NAVMC 3 


NAVMC 11116 

NAVMC 71 

NAVMC 11200 

NAVMC 10522 

SGLV 8286 

New Record

xe "New Record"This window allows you to search for a specific form and SSN or create a form for the member.  

How Do I Get Here?

318. Begin on the Intelligent Forms Selection window.

319. Choose New. The New Record window opens.

To Create A New Form

320. In the Forms list, select the form you want to create.

321. Do one of the following:

· If you know the member's SSN, in the SSN box, type the SSN.

· If you don't know the member's SSN or want to create a DD 216 for more than one member, choose Members. The Search window opens.

322. After completing the steps in the Search topic, the SSN(s) you selected display in the SSN list.

323. Choose OK.  The New Form window opens with some of the information auto-populated.

To Exit This Window

· Choose Cancel. You return to the previous window.

Report Date

xe "Report Date"This window allows you to enter the beginning and ending date range for the Forms Monthly Statistics Report.

How Do I Get Here?

324. Begin on the Intelligent Forms frame.

325. From the Reports menu, choose Report By Process Dates. The Report Date window opens.

To Create A Report

173. In the Enter report begin date box, type the beginning date in YYYY/MM/DD format.

174. In the Enter report end date box, type the ending date in YYYY/MM/DD format.

175. Choose OK. The Forms Monthly Statistics Report opens.

To Exit This Window

· Choose Cancel. You return to the Intelligent Forms Selection window.

See also:

Intelligent Forms Selection 

Forms Monthly Statistics Report

xe "Forms Monthly Statistics Report"This report lists all intelligent forms in the database that match the date range you entered in the Report Date window.

How Do I Get Here?

326. Begin on the Report Date window.

327. Choose OK. The Forms Monthly Statistics Report opens.

The following information is available on this report:

Form Name

Displays the intelligent form name.

Date (YYYY/MM/DD)
Displays the date the form was created.

Hour (HH/MM/SS)
Displays the time of day the form was created using the 24-hour clock.

Total


Displays the subtotal of the number of forms by form name.

Grand Total

Displays the grand total of all forms listed on the report.

If the Report Is Empty

328. If no forms exist between the selected dates, a message informs you that the report is empty.

329. Choose OK. The Forms Monthly Statistics Report opens displaying only the heading and column labels.

330. Choose Close. You return to the Intelligent Forms Selection window.

To Print the Report

· Choose Print.

To Exit This Window

· Choose Close.

Intelligent Forms Print Options

This window allows you to print the data only when you're using preprinted form stock or to print certain pages when you're printing a multipage form. When you select more than one type of form to print, this window displays once for each form type. Any options you select will apply to all forms of that type.

How Do I Get Here?

158. Begin on the New Form window.

159. Choose Print. The Intelligent Forms Print Optionsxe "Intelligent Forms Print Options" window opens.

To Print the DD Form 216DD_Form_216_MC_ENLISTED_E2_E5_PROMOTION_WARRANT Form

331. If you want to print the background and the data, choose Print Data With DD Form 216 Background.

332. If you are using a preprinted form, choose Print Data Only.

333. Choose OK. You return to the New Form window.

To Print the NAVMC 3NAVMC_3_Leave_Authorization_Form Form

334. If you want to print the front of the original copy, choose Original Copy Front.

335. If you want to print the back of the original copy, choose Original Copy Back.

336. If you want to print the front of the Mail Orderly copy, choose Mail Orderly Copy Front.

337. If you want to print the back of the Mail Orderly copy, choose Mail Orderly Copy Back.

338. If you want to print the front of the CO's copy, choose CO's Copy Front.

339. If you want to print the back of the CO's copy, choose CO's Copy back.

340. Choose OK.

To Print the SGLV 8286SGLV_8286_SGLI_ELECTION_AND_CERTIFICATE Form

341. If you want to print the clerk's  directions for completing the form, choose Directions to Personnel Clerks.

342. If you want to print only the SGLV 8286, choose Servicemember's Group Life Insurance Election and Certificate.

343. If you want to print the servicemember's directions for completing the form, choose Directions to Servicemember.

344. If you want to print the VA benefits information page, choose What You Should Know About VA Benefits.

345. Choose OK.

Forms

DD Form 216 MC: ENLISTED E2 – E5 PROMOTION WARRANT

xe "DD Form 216 MC  ENLISTED E2 – E5 PROMOTION WARRANT"This warrant is presented to a member who is being promoted to the rank of E2, E3, E4, or E5.

The E2-E5 Promotion Warrant window, allows you to input required information as applicable to produce a DD Form 216 MC.

You can generate the following TTCs for this form from the information you input:

· TTC 335-000
Proficiency and Conduct Marks

· TTC 052-003
Promotion (Enlisted) Meritorious

How Do I Get Here?

346. Begin on the Intelligent Forms Selection window.

347. Choose DD Form 216. The DD Form 216 MC Promotion Warrant window opens.

Note: The DD Form 216 is the only Intelligent Form on which you can do a multiple member edit or delete. (See the Intelligent Forms Selection topic for details.)

Marine Information
The first part of the window is for entering Marine Information.

Social Security Number (SSN
Is automatically displayed from the CUDDB (Commander's Unit Diary Database). Display only.

First Name
Is automatically displayed from the CUDDB.

Middle Name
Is automatically displayed from the CUDDB.

Last Name
Is automatically displayed from the CUDDB.

Cadency
Is automatically displayed from the CUDDB.

Unit Name
Is automatically displayed from the CUDDB. If the Unit Name is different from the one appearing, choose the down arrow and select the correct Unit Name from the list.

Unit Address
Is automatically displayed from the CUDDB.

Reserve
Select this check box if the member is a Reservist.

Promotion Data
The next part of the window is for entering Promotion Data.

Rank
Is automatically displayed from the CUDDB with the next rank higher than the member's present rank. 

Date Of Rank
Is automatically displayed from the CUDDB.

Presented Date
Is automatically displayed from the CUDDB with the selected grade date.  You may type a different date, as applicable. 

Effective Date
Is automatically displayed from the CUDDB with the selected grade date.  You may type a different date, as applicable. 

Authority
Choose the down arrow and select the correct Authority from the list. You may type or edit data as necessary.

Note: If selecting "MCBUL 1430 of" authority from the list, you must type the input date in parentheses.

Note: If the Add to Diary or Add to Tickler button is selected, the authority will be preceded with the text "AUTH:" in the History statement.

Commanding Officer
This part of the window is for entering the authorizing Commanding Officer information.

Commander's Name
Automatically displayed with the name of the Commanding Officer of the member's present RUC. You may select or type the commanding officer's name.

Commander's Rank
Automatically displayed to coincide with Commanding Officer's Name. You may select or type the commanding officer's rank from the list.

Branch of Service
Automatically displayed to coincide with Commanding Officer's Name. You may select or type the commanding officer's branch of service from the list.

Billet Description
Automatically displayed to coincide with Commanding Officer's Name. You may select or type the commanding officer's billet description.  

PRO/CON Information
This part of the window is for entering the member's Proficiency and Conduct Marks.


Proficiency Mark
Member's proficiency rating.


Conduct Mark
Member's conduct rating.

DD Form 1561: STATEMENT TO SUBSTANTIATE PAYMENT OF FAMILY SEPARATION ALLOWANCE

xe "DD Form 1561  STATEMENT TO SUBSTANTIATE PAYMENT OF FAMILY SEPARATION ALLOWANCE"DATA REQUIRED BY THE PRIVACY ACT STATEMENT

AUTHORITY:
Title 37, U.S. Code, Section 427.

PRINCIPAL PURPOSE:
To evaluate member's application for Family Separation Allowances.
ROUTINE USES:

cl) Serves as substantiating document for FSA payments.

cm) Provides an audit trail for validating propriety of payments and to assist in collection erroneous payments.

cn) Provides a record in service member's personal financial record.

co) Provides information for preparation of required input to the automated pay system, which maintains pay, accounts for Army members.

DISCLOSURE:
Disclosure of your social security number and other personal information is voluntary.  However, if requested information is not provided, member may not be considered for FSA.

The Statement To Substantiate Payment of Family Separation Allowance window, presented to the user, enables the user to input required information as applicable to produce a DD Form 1561.

Last Name
Will be automatically populated from the CUDDB.

First Name
Will be automatically populated from the CUDDB.

Middle Name
Will be automatically populated from the CUDDB.

Cadency
Will be automatically populated from the CUDDB.

Social Security Number
Will be automatically populated from the CUDDB (display only).

Grade
Will be automatically populated from the CUDDB.

Organization/Activity
Will be automatically populated from the CUDDB.

Permanent Duty Station of Member
Will be automatically populated from the CUDDB.

Part I – To Be Completed By The Member (Check applicable block(s))

Type I
Check/Select FSA-1.

Type II
Check/Select FSA-R or FSA-T or FSA-S.  If claiming FSA Type II for Parent(s), I Certify that:  I maintain a residence(s) for my dependent(s) and have assumed the liability and responsibilities thereof, at the address(es) shown above, where I will likely reside during period of leave or other times as my duty assignment might permit.

Dependents
Address(es) of Dependent(s).  Applicable to all types of Allowances.  To see other dependents press the page down or page up keys.

Address of dependent(street, city, state, zip code)
Applicable to all types of Allowances.

I Certify To The Following Facts (As Applicable)
Check/Select only one below:

I am not divorced or legally separated from my spouse.

My dependent child (children)are not in the legal custody of another person.

My dependent is not a member of the military service on active duty.

My sole dependent is not in an institution for a known period of over 1 year or a period expected to exceed 1 year.

Temporary Duty Station __
Enter temporary duty station.

Inclusive Dates (From/To) (YYYYMMDD)
Will be automatically populated from the CUDDB.

Part II – To Be Completed By Certifying Officer (Check applicable block(s))

Type I – FSA – 1 The above member reported to __
Check/Select Type I – FSA – 1.  Enter the duty station of the member.

On (Date) (YYYYMMDD)
Enter date the member reported to duty station.

Type II – FSA –R    Type II – FSA –T

The above member departed (was detached) from ___ 
Select Type II – FSA – R or Type II – FSA – T.  Enter members last permanent duty station.

On (YYYYMMDD)
Enter date the member was detached.

Was on leave en route (YYYYMMDD)


Enter the inclusive date(s) chargeable as leave.

Proceed time (YYYYMMDD)
Enter the inclusive proceed date.

And he reported to __ 
Enter permanent duty station.

On (YYYYMMDD)
Enter date member reported to permanent duty station.

Note:  Transportation of his dependents is not authorized at government expense to this station or to a place near this station.

Type II – FSA – T
Check Type II – FSA - T.

Note:  The above member has been ordered to and has performed temporary duty at the location(s) shown below for a continuous period of more than 30 days.

Location __
Enter Location of temporary duty.

Inclusive Dates of TDY/T From/To (YYYYMMDD)
Enter inclusive dates of TDY/T (From/To)

NO. Days __
Enter no. days TDY/T

Type II – FSA – S
Check Type II – FSA – S.  Check member on duty or member did not depart.

Name of Ship __
Enter name of ship.  Note: I don't know if not known.

Location of Home Port __
Enter the name of the home port.

Travel performed under authority of __
Check Travel performed under authority of.  Enter authority under which travel is performed.

Dated (YYYYMMDD)
Enter date of travel.

Member claiming Type II FSA, is receiving basic allowance for quarters as a member with dependents.
Check member claiming Type II FSA if member is receiving basic quarter(s) allowance with dependent(s).

Certifying Officer Signing Date (YYYYMMDD)
Will be automatically populated with the system date.

NAVMC 3: LEAVE AUTHORIZATION FORM

xe "NAVMC 3  LEAVE AUTHORIZATION FORM"This window allows you to input data for generating official leave authorization. The leave form is restricted to Active duty only.

How Do I Get Here?

160. Begin on the Intelligent Forms Selection window.

161. Choose NAVMC 3 Leave Authorization. The NAVMC 3 Leave Authorization form opens with some entries already populated.

To
Authorizing Official
Type or select an Authorizing Official from the list. 

Commanding Officer is the default value.

Leave Request



From
SSN
Automatically displayed from the CUDDB.


Last Name
Automatically displayed from the CUDDB.


Cadency
Automatically displayed from the CUDDB.


First Name
Automatically displayed from the CUDDB.


Middle Name
Automatically displayed from the CUDDB.


Grade
Automatically displayed from the CUDDB and is editable.


MOS
Automatically displayed from the CUDDB.


Branch of Service
Automatically displayed from the CUDDB.

Organization
Unit Name
Automatically displayed from the CUDDB.


Address Line 1
Type the unit's street address.


Address Line 2
Type the unit's city, state, and zip code.


Duty Telephone Number
Automatically displayed from the CUDDB.

Leave Request Information
Date Requesting Leave
Automatically populated with the system date.


Date and Time Leave Effective
Type the date in YYYY/MM/DD format and the time in HHMM format the leave will be effective.


Date and Time Leave Expires
Type the date in YYYY/MM/DD format and the time in HHMM format the leave will expire. 


Number of Days Requested and Inclusive Dates
Auto-populated from the results of: 

· Dates and Times Leave Effective Expires in the Leave Requested Information group.

(Display only)


Type of Leave Requested
Select leave type from the list. Annual Leave is the default value.


Days Taken this Fiscal Year
Type the number of days leave the member has taken during the current fiscal year. 0 is the default value.


Leave Balance
Automatically displayed from the CUDDB.


ECC (Expiration of Current Contract)
Automatically displayed from the CUDDB in YYYY/MM/DD format.

Address and Phone Number While On Leave
Address Line 1
Type the member's primary street address while on leave, if applicable.


Address Line 2
Type the member's primary city, state, and zip code while on leave, if applicable.


Primary Phone
Type the member's primary leave telephone number, if applicable. 


Secondary Phone
Type the member's alternate leave telephone number, if applicable . 

Approval of Immediate Supervisor/Company Commander

First Approval - All fields can be auto-populated from the Members search option.


Last Name
Type the approver's last name.


First Name
Type the approver's first name.


Middle Initial
Type the approver's middle initial.


Grade
Type or select the approver's grade.

Second Approval - All fields can be auto-populated from the Members search option.


Last Name
Type the approver's last name.


First Name
Type the approver's first name.


Middle Initial
Type the approver's middle initial.


Grade
Type or select the approver's grade.

Signature of Officer Authorized to Grant Leave - All fields can be auto-populated from the Members search option.


Last Name
Type the Granting Officers last name.


First Name
Type the Granting Officers first name.


Middle Initial
Type the Granting Officers middle initial.


Grade
Type or select the Granting Officers grade.


Branch of Service



Title
Type or select from the list.

MCTFS Reporting Information

Departure Information and Signature of Duty Officer/NCO -- All signature fields can be auto-populated from the Members search option.


Hour and Date of Departure
The time in HHMM format and date in YYYY/MM/DD format of the member's departure on leave.


Last Name
Type the Duty Officer/NCO's last name.


First Name
Type the Duty Officer/NCO's first name.


Middle Initial
Type the Duty Officer/NCO's middle initial.


Grade
The grade may be changed by selecting a grade from the drop down list.

Return Information and Signature of Duty Officer/NCO -- All signature fields can be auto-populated from the Members search option.


Hour and Date of Return
The time in HHMM format and date in YYYY/MM/DD format of the member's return from leave.


Last Name
Type the Duty Officer/NCO's last name.


First Name
Type the Duty Officer/NCO's first name.


Middle Initial
Type the Duty Officer/NCO's middle initial.


Grade
The grade may be changed by selecting a grade from the drop down list.

Extension Information and Signature of Granting Officer -- All signature fields can be auto-populated from the Members search option.


Number of Days Granted for Extension

New Leave Expiration Time and Date
Type up to two digits for the days the member's leave has been extended.

Type the time in HHMM format and date in YYYY/MM/DD format of the member's revised expected return from leave. 


Date Granted
Type the date in YYYY/MM/DD format.


Unit Name
The Unit Name that you typed in Leave Request, Organization at the top of the form displays in this block. 

You may select from other units in the drop down list.


Last Name
Type the Granting Officer's last name.


First Name
Type the Granting Officer's first name.


Middle Initial
Type the Granting Officer's middle initial.


Grade
User may select a different grade from the drop down list.

Hospitalization
Hospital Name 
Type up to 45 characters for the name of the hospital.


Address Line 1
Street address for the hospital.


Address Line 2
Type the hospital's City, State, and Zip Code.


Tricare Contact Number
Select the Tricare Contact phone number for the region.


Remarks and Diagnosis
Type up to 150 characters for pertinent remarks and diagnosis.


Time and Date Admitted
Type the time in HHMM format and date in YYYY/MM/DD format.


Time and Date Released
Type the time in HHMM format and date in YYYY/MM/DD format.

Unit Diary Computation – Inclusive Dates
Number of Days Charged as Leave
Auto-populated from the departure and return information in MCTFS Reporting Information.


From
The date the member's leave begins in YYYY/MM/DD format. Auto-populated from the departure and return information in MCTFS Reporting Information.


Thru
The date the member's leave begins in YYYY/MM/DD format. Auto-populated from the departure and return information in MCTFS Reporting Information.


Unit Diary Number
Auto-populated from the Add to Diary process.

Type the Unit Diary Number.


Unit Diary Number Date
Auto-populated from the Add to Diary process.

Type the date in YYYY/MM/DD format.

New Form

This window allows you to create an intelligent form on the database. You can also add transactions created through the form to the Tickler file, the Diary Transaction Pool, a new diary or an available open Unit Diary.

You can create a new intelligent form for members who are not on the CUDDB. When a member's record is on the CUDDB, some fields on the form are auto-populated.

How Do I Get Here?

348. From the UD/MIPS Navigator window, choose the Intelligent Forms Selection module icon. The Intelligent Forms Selection window opens.

349. Choose New. The New Record window opens.

350. Select the form and the member for whom the form is intended.

351. Choose OK. The New Form window opens with the selected form partially completed.

To Create a New Intelligent Form

352. Input all fields, as applicable. See the appropriate form topic for more detail on filling out each specific form.

353. Choose Save. A message informs you that the form has been saved.

Note: If you attempt to create or edit a new formxe "New Form" and the form already exists, a message informs you that a duplicate form was found.

354. Choose OK. You return to the New Form window.

Note: If you try to advance from the last record, a message informs you that you are on the last record.

To Add a New DD 216 MC Enlisted Promotion Warrant

355. Choose New. The New Record window opens.

356. Under Form, select DD216MC Enlisted Promotion Warrant. 

357. Choose Members. The Search window opens.

358. Select members of the same desired rank (PVT-E2 through CPL-E4).

359. Choose OK. The New Form window opens with the selected forms partially completed.

360. To navigate, do one of the following:

· To move to the next record, choose the right arrow (>) icon.

· To return to the previous record, select the left arrow (<) icon.

Note: If you try to go beyond the first or last record, a message informs you that you are on the first or last record.

To Add the Form to the Tickler File

· After you save the form, choose Add to Tickler. The Add Tickler window opens.

To Add the Form to A Diary

· After you save the form, choose Add to Diary. The Select Diary window opens. 

To Print the Form

361. Choose Print. The form prints.

362. If the Intelligent Forms Print Options window opens, complete the steps in the Intelligent Forms Print Options  topic.

To Exit This Window

· Choose Close. You return to the Intelligent Forms Selection window.

NAVMC 71: CERTIFICATE OF GOOD CONDUCT

xe "NAVMC 71  CERTIFICATE OF GOOD CONDUCT"This certificate is awarded to a member who conducted him or herself in a creditable manner.

The Certificate of Good Conduct window, allows you to input required information as applicable to produce a NAVMC 71 form.

You can generate the following TTCs for this form from the information you input:

· TTC 140-000
Awards

· TTC 140-001
Good Conduct Medal

How Do I Get Here?

363. Begin in the Intelligent Forms Selection window.

364. Choose NAVMC 71. The Certificate of Good Conduct window opens.

Marine Information
The first part of the window is for entering Marine Information.

Grade
Is automatically displayed from the CUDDB (Commander's Unit Diary Database).

First Name
Is automatically displayed from the CUDDB.

Middle Name
Is automatically displayed from the CUDDB.

Last Name
Is automatically displayed from the CUDDB.

Cadency
Is automatically displayed from the CUDDB.

Social Security Number (SSN)
Is automatically displayed from the CUDDB (display only)

Unit Name
Is automatically displayed from the CUDDB.  This option is a drop down list box.  If the Unit Name is different from the one appearing, select the down arrow and select the correct Unit Name from the drop down list options.

Unit Address
Is automatically displayed from the CUDBB.

Medal and Date
The next part of the window is for entering the type of medal and the active as of date.

Medal


Select the occurrence of the award from the drop down list.  The choices are First through Eleventh Award. First Award is the default value.

Device
Select a device from the list. 0-None is the default.

From Date
The beginning date of the award period.

To Date
The ending date of the award period. Auto-calculated from the From Date (3 Years minus 1 day).

Award Date 
Is automatically displayed with the system date in YYYY/MM/DD format.

Commanding Officer
The last part of the window is for entering the authorizing Commanding Officer information.

Commander's Name (FI, MI, Last Name)
Type the Commanding Officer's name or choose from the drop down list.

Commander's Rank
Type or select the Commanding Officer's rank from the drop down list.

Branch of Service
Type or Select the branch of Service.

Title
Type the Commanding Officer's title. 'Commanding' is the default value.

NAVMC 10522: COMMUTED RATIONS ACTION

xe "NAVMC 10522  COMMUTED RATIONS ACTION"The purpose of this form is for the member to request authorization to be subsisted separately and receive a commuted ration allowance instead of being subsisted in the dining facility.  This form also documents the approval or disapproval and the termination of authority to receive commuted rations.

The member will be REQUIRED TO PAY for all meals eaten in a dining facility while in receive of commuted ration and WILL NOT BE ENTITLED TO THE ALLOWANCE until the effective hour and date of approval in Section II.

The member will immediately notify the commanding officer of any change in the reason given as a basis for requesting these commuted rations.

Should the member be discharged while this authorization is in effect, such authorization remains in full force and effect, provided the member reenlists at the same station within 24 hours of such discharge.

The Commuted Rations Action window, presented to the user, enables the to input required information as applicable to produce a NAVMC 10522 form.

Date (YYYYMMDD)
Will be automatically populated with the system date.

Section I – Application of Member

Present Grade Code
Will be automatically populated from the CUDDB.

Last Name 
Will be automatically populated from the CUDDB.

First Name
Will be automatically populated from the CUDDB.

Middle Name
Will be automatically populated from the CUDDB.

Cadency
Will be automatically populated from the CUDDB.

Social Security Number
Will be automatically populated from the CUDDB (display only).

Branch of Service
Enter 'USMC' (default) or 'USMCR'.

Unit Name
Will be automatically populated from the CUDDB.

Unit Address (Street, City, State, Zip Code)
Will be automatically populated from the CUDDB.

To:  Commanding Officer (Last, First, MI, Grade)
Enter the unit's commanding officer's last name, first name, and middle initial in the respective fields. 

Select the commanding officer's grade from the drop down list.

Commanding Officer Unit and Unit Address
Enter the commanding officer's unit name and address. Will be automatically populated from the CUDDB.

Reasons:


I am married and reside with my family 
Will be 'X'd if the member's marital status is 'M'.

Note: This field will be blanked out if the alternate reason field is completed.

I am not married but reside with my (Relationship) 
Will be 'X'd if the member's marital status is other than 'M'.  

Note: This field will be blanked out if the alternate reason field is completed.

Other
Enter a reason for this request if the first two reasons do not apply.

Note: If this field is completed, the first two reason options will be blanked out.

Relationship
Enter the relationship of the person the member resides with if the member's marital status is other than 'M'.  

Enter 'SELF' if the member resides alone.

Note: This field will be blanked out if the alternate reason field is completed.

Address (Street, City, State, and Zip Code)
Will be automatically populated from the CUDDB with the spouse's address if the member's marital status is 'M'.

Will be automatically populated from the CUDDB with the member's address if the member's marital status is other than 'M'.

Note: This field will be blanked out if the alternate reason field is completed.

Section II – Approval or Disapproval

Date (YYYY/MM/DD)
Will be automatically populated with the system date.

Approved Effective From (YYYY/MM/DD HH:MM:SS)
Select only one choice in Section II.

Enter the starting effective hour and date for which the request is approved.

Approved Effective To (YYYY/MM/DD HH:MM:SS)
Enter the ending effective hour and date for which the request is approved.

Disapproved for following reason:
Select only one choice in Section II.

Enter the reason the commanding officer disapproved this request.

Section III – Termination of Authority to Receive Commuted Rations

Date (YYYY/MM/DD)
Will be automatically populated with the system date.

The authorization previously granted to you to receive commuted rations is hereby terminated to take effect for the following reason:
Enter the reason the commanding officer terminated this request.

Termination Hour and Date (YYYY/MM/DD HH:MM:SS)
Enter the hour and date the request is terminated by the commanding officer.

NAVMC 10592: SELECTED MARINE CORPS RESERVE CERTIFICATE

xe "NAVMC 10592  SELECTED MARINE CORPS RESERVE CERTIFICATE"This certificate is awarded to a member who attended the necessary drills and annual training duty with the Selected Marine Corps Reserve (SMCR) and conducted him or herself in a creditable manner.

The Selected Marine Corps Reserve Certificate window allows you to input required information as applicable to produce a NAVMC 10592 form.

You can generate the following TTCs for this form from the information you input:

· TTC 140-000
Awards

· TTC 140-003
Selected Marine Corps Reserve Medal

How Do I Get Here?

365. Begin on the Intelligent Forms Selection window.

366. Select the Form Name from the Select Search Criteria list. The Select A Form list box is activated.

367. In the Select A Form list box, choose the Selected Marine Corps Reserve Certificate. The form appears with some of the information auto-populated.

Marine Information  The first part of the window is for entering Marine Information.

· Grade   Is automatically displayed from the CUDDB (Commander's Unit Diary Database) and is editable.

· First Name   Is automatically displayed from the CUDDB.

· Middle Name   Is automatically displayed from the CUDDB.

· Last Name   Is automatically displayed from the CUDDB.

· Cadency   Is automatically displayed from the CUDDB.

· Social Security Number (SSN)   Is automatically displayed from the CUDDB.

· Unit Name   Is automatically displayed from the CUDDB.

This option is a drop down list box. If the Unit Name is different from the one appearing, select the down arrow and select the correct Unit Name from the drop down list options.

· Medal and Date  The next part of the window is for entering the type of medal and the active date.

· Medal   Select the occurrence of the award from the list. The choices are First through Eleventh Award. First Award is the default value.

· Device Choose a device from the list. 0-None is the default.

· From Date The beginning date of the award period.

· To Date The ending date of the award period. Auto-calculated from the From Date (3 Years minus 1 day).

· Award Date  Is automatically displayed with the system date in YYYY/MM/DD format.

· Date From  Type the SMCR Medal Date.
· Commanding Officer   The authorizing Commanding Officer's information.

· Commander's Name   Type or choose the commanding officer's name from the list. The Commander's Rank list is populated, if available.

· Commander's Rank   Type or select the commanding officer's rank from the list.

· Branch of Service    Type or select the branch of service.

· Title    Type the commanding officers title. 'Commanding' is the default.

NAVMC 10922 (REV. 5-95): DEPENDENCY APPLICATION (1751)

xe "NAVMC 10922 (REV. 5-95)  DEPENDENCY APPLICATION (1751)"(Supersedes all previous editions that are obsolete and will not be used)

SN: 0109-LF-064-6300
INSTRUCTIONS

WHERE ADDITIONAL SPACE IS NECESSARY TO COMPLETE ITEMS.  USE SEPARATE SHEET.

The Dependency Application (1751) window, presented to the user, enables the user to input required information as applicable to produce a NAVMC 10922 (Rev. 5-95) form.

Date of Application (YYYY/MM/DD)
Will be automatically populated with the system date.

Change In Dependents (Check One)
Check either Start, Loss, Gain options.

Section 1 Identification

Last Name 
Will be automatically populated from the CUDDB.

First Name
Will be automatically populated from the CUDDB.

Middle Name
Will be automatically populated from the CUDDB.

Cadency
Will be automatically populated from the CUDDB.

SSN
Will be automatically populated from the CUDDB (display only).

Grade
Will be automatically populated from the CUDDB.

Type of Service
Select/Check either USMC or USMCR.

Organization and Station Preparing Application

(Unit Name and Address)
Enter the name of the organization and station preparing this application.

Unit RUC
Enter the Unit RUC.  Will be automatically be populated from the CUDDB.

Date of Current Entitlement/Appointment or Date Reporting for Active Duty (whichever is Later) 
Enter the date of current entitlement/appointment or date reporting for active duty.

ECC (YYYY/MM/DD)
Enter the ECC date.  Will automatically be populated from the CUDDB.

Future Address and ETA if Transfer is Anticipated Within 60 Days (YYYY/MM/DD)
Enter address and ETA if within 60 days.

Date of Last Discharge or Date of Last release to Inactive Duty (YYYY/MM/DD)
Enter date of last discharge or date of last release to inactive duty.

Section 2 Dependent Information

Name of Dependent (Include full given name Last, First, MI) __
Select the dependents name from the drop-down list.

Complete Address (Include Zip Code) __
Will be automatically populated from the CUDDB.

The user may enter complete address (include zip code)

Relationship:  If child, indicate step, adopted, ward or born out of wedlock.
Will be automatically populated from the CUDDB.

The user may enter a relationship. If child, indicate step, adopted, ward or born out of wedlock.

Date of Birth (YYYY/MM/DD)
Will be automatically populated from the CUDDB.

The user may enter the date of birth of the child.

Date Allowance Claimed From (If previously approved, give date of approval). (YYYY/MM/DD)
Enter date allowance claimed from. If previously approved, give date of approval.

Section 3 Custodian Information

Furnish the following information concerning custodian of any dependent named above

DEP NO __          Full Name of Custodian __
Enter the dependent number (1 ….. (n)) and full name of the custodian (First, Last)

Relationship to Dependent __
Enter relationship to dependent.

Address and Zip Code
Enter relationship address and zip code.

Section 4 Marital Service Member, Spouse and Information Regarding Support/Paternity

INFORMATION CONCERNING PRESENT MARRIAGE

Date (YYYY/MM/DD)

Place(Country and State) __

Full Given Name of Spouse __
Enter the date of present marriage, place of marriage (country and state), and full given name of spouse.

Have You Been Previously Married?
Select yes or no.

Has Present Spouse Been Previously Married?
Select yes or no

If Either Answer Above is 'Yes'.  Give Information Requested Below.

Former Marriage of (Check One)

Name of Spouse In The Dissolved Marriage Date of the Dissolution (YYYY/MM/DD)

Place of Dissolution (Country and State)

Reason (Check One)
Check former marriage (yourself, spouse, or none)

Enter name of spouse in the dissolved marriage.

Enter the date the marriage was dissoluted.

Enter the place (country and state) of the dissolution.

Select the reason for the dissolution (death, annulment, divorce, or none)

Is there a court order or written agreement in effect relative to support/maintenance/paternity?
Select yes or no.

If yes, state date and place (county and state) where such order/agreement was issued and attach a copy.

Date (YYYY/MM/DD)

Country __

State __
Enter the court date, county, and state.

Section 5 Natural Parent of Child in Armed Forces

Has natural parent other than claimant of child(ren) listed ever bee a member of any U.S. Armed Force?
Enter yes or no.

If yes, list all available identifying information

Full Name of Natural Parent __

SSN __

Grade __

Type of Service __

Branch of Service __
Enter full name of natural parent to include:  social security number, grade (select), type of service, and branch of service.

Inclusive Dates of Active Service (From/To)

(YYYY/MM/DD)
Enter dates of natural parents active service

Full Name of Child(ren))

Child __
Enter full name of the child and/or children.

Section 6 Spouse in Armed Forces

Has your spouse ever been a member of an U.S. Armed Force?
Enter yes or no.

If yes, complete the blocks below.

SSN __

Grade __

Type of Service __

Branch of Service __

Inclusive Dates of Active Service (From/To)

(YYYY/MM/DD)
Enter the spouses social security number, grade (select), type of service, branch of service and inclusive dates of

BAQ
Enter BAQ with dependents or without dependents.

Section 7 Certification

Social Security Number __
Enter social security number.

Grade __
Select grade.

Subscribed and sworn before this date (YYYY/MM/DD)
Enter date certification was subscribed and sworn.

Title of Attesting Officer __
Enter title of the attesting officer.

DOCUMENT VIEWED
Check if document viewed.

Section 8 Approving Authority

For Use by Command Approving Authority
Check one of the following:

Approved as Claimed

Approved for Dependent Numbers

Forwarded to CMC(CODE MHP-20) for Approval for dependent numbers

Approved for child born out of wedlock for DEERS eligibility per MCO P551211.  Check one:

Child resides in members household.

Court Order

Type Name and Grade of Commanding Officer (Last, First, MI and Grade) ___
Enter the name and grade of the commanding officer.

Unit Designation __
Enter the unit designation.

For use by NIT Diary Clerk

Reported on Unit Diary

No. __

Dated (YYYY/MM/DD)

RUC __
Enter the unit diary number, the date, and RUC name.

ENTRIES REPORTED
Enter the entries reported.

NAVMC 11116: MISCELLANEOUS MILITARY PAY ORDER/SPECIAL PAYMENT AUTHORIZATION

xe "NAVMC 11116  MISCELLANEOUS MILITARY PAY ORDER/SPECIAL PAYMENT AUTHORIZATION"This authorization form is processed to handle miscellaneous military pay order(s) or special payment(s) authorizations to personnel. 

The Miscellaneous Military Pay Order/Special Payment Authorization window, presented to the user, enables the user to input required information as applicable to produce a NAVMC 11116 form.

Individual Information


Date (YYYY/MM/DD)
Will be automatically populated with the system date.

RUC
Will be automatically populated from the CUDDB.

SSN
Will be automatically populated from the CUDDB (display only).

ECC
Will be automatically populated from the CUDDB.

Last Name 
Will be automatically populated from the CUDDB.

First Name
Will be automatically populated from the CUDDB.

Middle Name
Will be automatically populated from the CUDDB.

Cadency
Will be automatically populated from the CUDDB.

To Disbursing Officer
Choose only one instruction for the disbursing officer, the authorization or the direction.

You are authorized to 
Choose only one type of authorization

Debit


Credit


Adjust the individual's military pay account for transaction indicated


You are directed to make the following special payment based on the transactions indicated.


Payments (Requires Commanding Officer's Signature)

Type
Choose one of the types indicated.

Pay day adjustment




Special payment


Purpose
Choose one purpose.

Severe hardship


Events aged 60 days and more


Member's JUMP/MMS record not in central site. Accession message attached.


Typed Name(Last, First, MI) of Commanding Officer
Type or choose the commanding officer's last name, first name, and middle initial from the list.

Grade of Commanding Officer
Type or choose the commanding officer's grade from the list.

Date (YYYY/MM/DD)
Will be automatically populated with the system date.

Adjustments
Choose one method of adjustment.

Advance Pay
Choose this adjustment when an advance is made against only the member's basic pay.

Pay ___ month's advance pay incident to PCS orders
Type the number of month's of advance pay to pay the member.

Repayment ___ months
Type the number of month's over which the member must repay the advance.

Advance Pay and Allowances
Choose this adjustment when an advance is made against the member's basic pay and allowances and the member will be in a remote location.

Pay ___ month's advance pay and allowances for assignment to a remote location deployed aboard ship for more than 30 days.
Type the number of month's of advance pay and allowances to pay the member.

Note: Pursuant to DODPM, Par 40102

Advance Housing Allowances


Pay ___ month's advance housing allowance to be repaid in monthly payments of ___.
Type the number of month's of advance housing allowance to pay the member.

Type the monthly amount to be withheld from the member's pay to repay the advance.

Effective date (YYYY/MM/DD)
Type the date the repayment is to start.

Unit Diary


NO.
Type the unit diary number that reflects the adjustment to the member's pay.

Dated


Type the date of the unit diary that reflects the adjustment to the member's pay.

Reported
Type the date the adjustment was reported.

Effective Date
Type the effective date of the unit diary that reflects the adjustment to the member's pay.

Other
No other information is required.

Certifying Officer Name (Last, First, MI)
Type the certifying officer's last name, first name, and middle initial.

Certifying Officer Grade
Choose the certifying officer's grade from the list.

Certifying Officer Title
Type the certifying officer's title.

Date (YYYY/MM/DD)
Will be automatically populated with the system date.

NAVMC 11200 (Rev 6-94): RESERVE MISCELLANEOUS MILITARY PAY ORDER

xe "NAVMC 11200 (Rev 6-94)  RESERVE MISCELLANEOUS MILITARY PAY ORDER"SN: 0109-LF-065-8600

This pay order form is processed to handle the reserve miscellaneous military pay order(s) for personnel.

The Reserve Miscellaneous Military Pay Order window allows you to input required information as applicable to produce a NAVMC 11200 (Rev 6-94) form.

This report is broken up into ten areas.

· Individual Information

· Foreign Language Proficiency Pay

· Selected Reserve Educational Assistance

· Career Sea Pay

· Family type Quarters Assigned to Active Duty Spouse

· Cost-of-Living Allowance (Barrack COLA)

· Officer Field Rations

· Individual Ready Reserve Reenlistment Bonus (IRREB)

· Officer Field Rations

· Other/Remarks

Individual Information
The first part of the report window covers an individual's information and what you are authorized to cover, which follows.  Once you select the individual to generate a report for, their information appears in the window.
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The following steps show you how to fill out this part of the window.

1.
If the Unit Name differs from the one showing
The select the down arrow in the Unit field and select the correct name.

2.
Type the Unit Address information in the address fields.

3.
Type the Zip Code of the Unit Address.

4.
The system date is displayed.


If you need a different date
Then type in the Date in YYYY/MM/DD format.

5.
Type the Military Pay Order number.

6.
The individuals Social Security Number, First Name, Middle Name, Last Name, Cadency, and Expiration of Current Contract displays in the comparable field.  Edit them if needed. Social Security Number is display only.



7.
Select the appropriate option (Debit, Credit, Close, and Adjust) in the You Are Authorized To field.

Foreign Language Proficiency Pay
The next part of the window is the Foreign Language Proficiency Pay area.
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The following steps show you how to fill out this part of the window.

1.
Select the box under the Item column if the individual is receiving Foreign Language Proficiency Pay. 

2.
Type the Language(s) as applicable. 

3.
Type the starting and stopping Date(s) of Entitlement in YYYY/MM/DD format.

4.
Type the Proficiency Level achieved. 

5.
Type the Date of Last Test in YYYY/MM/DD format.

Selected Reserve Educational Assistance
The next part of the window is the Selected Reserve Educational area.
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The following steps show you how to fill out this part of the window.

1.
Select the box under the Item column if the individual is receiving Selected Reserve Educational Assistance. 

2.
Select Initial or Installment for the Type of Payment.

3.
Type the number of MOS (Months).

4.
Type the Bonus number.

5.
Type the Reason for Reimbursement/Payment.

6.
Type the Amount of Reimbursement/Payment.

Career Sea Pay
The next part of the window is the Career Sea Pay area.
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The following steps show you how to fill out this part of the window.

1.
Select the box under the Item column if the individual is receiving Career Sea Pay. 

2.
Type the Name of the Vessel.

3.
Type of number of Yrs (Years), MOS (Months) and Days of Cumulative Years Sea Service.

4.
Type the As of Date from which the payment starts.

5.
Type the Dates of Embarkation (up to 3 entries) in From YYYY/MM/DD To YYYY/MM/DD format.

Family Type Quarters Assigned to Active Duty Spouse
The next part of the window is the type of quarters that is assigned to an Active Duty spouse. 
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The following steps show you how to fill out this part of the window.

1.
Select the box under the Item column if the individual is receiving Family Type Quarters Assigned to Active Duty Spouse. 

2.
Select Adequate or Inadequate for the type of quarters. 

3.
Select Army or Air Force type of quarters.

4.
Type the Date(s) of Duty From dates in From YYYY/MM/DD To YYYY/MM/DD format.

5.
Type the Fair Rental Value for (Inadequate Quarters).

Cost-of-Living Allowance (Barrack COLA)
The next part of the window is the cost-of-living allowance for Barracks. 
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The following steps show you how to fill out this part of the window.

1.
Select the box under the Item column if the individual is receiving a Cost-of-Living Allowance for Barracks.

2.
Type the Duty Location.

3.
Type the Date(s) of Entitlement From dates in From YYYY/MM/DD To YYYY/MM/DD format.

Officer Field Rations
The next part of the window is Officer Field Rations.
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The following steps show you how to fill out this part of the window.

1.
Select the box under the Item column if the individual is receiving payment for Officer Field Rations.

2.
Type the Date(s) of Field Duty From in From YYYY/MM/DD To YYYY/MM/DD format.

Individual Ready Reserve Reenlistment Bonus 

(IRREB)
The next part of the window is the Individual Ready Reserve Reenlistment Bonus (IRREB). 
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The following steps show you how to fill out this part of the window.

1.
Select the box under the Item column if the individual is receiving an IRREB.

2.
Select Initial, Anniversary, or Recoupment for Type of Payment.

3.
Type the number of MOS (Months).

4.
Type the Bonus number.

Other/ Remarks


The next part of the window contains blank fields to type in any other type of payment/reimbursement, and remarks.
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The following steps show you how to fill out this part of the window.

1.
Select the box under the Item column if the individual is receiving payment for other payment/reimbursements not on this report window.

2.
Type the applicable information in the Other and Remarks fields.

Certifying Officer
This part of the window holds the information for the Certifying Officer authorizing payment/reimbursement.
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The steps below show how to fill out this part of the window.

1.
Type the Certifying Officer name (Last, First, MI).

2.
Select the down arrow on the Certifying Officer Grade to display a drop down list to select from. 

The options are: 

WO, CWO2, CW03, CW04, CW05, 2NDLT, 1STLT, CAPT, MAJ, LTCOL, COL, BGEN, LTGEN, and GEN.

3.
Type in the Certifying Officer Title.

4.
The system date is displayed.


If the date signed by the Certifying Officer is different from the System Date
Then type the new date in YYYY/MM/DD format.

SGLV 8286: SGLI ELECTION AND CERTIFICATE

xe "SGLV 8286 SGLI ELECTION AND CERTIFICATE"

xe "SGLV SGLI ELECTION AND CERTIFICATE"This form is used to update beneficiary information for the Servicemembers' Group Life Insurance Election and Certificate. It can also be used to lower the amount of SGLI coverage or to decline it.

The New Form window, allows you to input required information as applicable to produce a SGLV 8286 form.

How Do I Get Here?

162. Begin on the Intelligent Forms Selection window.

163. Choose SGLV 8286: Servicemember's Group Life Insurance Election and Certificate. The SGLV 8286 form opens with some entries already populated.

Member Information
This part of the window is for entering or editing member information.

Social Security Number
Is automatically displayed from the CUDDB (display only)

First Name
Is automatically displayed from the CUDDB.

Middle Name
Is automatically displayed from the CUDDB.

Last Name
Is automatically displayed from the CUDDB.

Grade
Is automatically displayed from the CUDDB.

Service
Is automatically displayed from the CUDDB. United States Marine Corps is the default value.

Unit Name
Is automatically displayed from the CUDDB.

Unit Address
Is automatically displayed from the CUDDB.

Use This Form To
The first part of the window contains three check boxes to indicate how the form will be used. Select the appropriate options.

Name, Change or Update Your Beneficiary
Select this option to update beneficiary information.

Reduce the Amount of Insurance Coverage
Select this option to reduce the amount of insurance coverage. Use the drop down menu to determine the new amount.

Decline Insurance Coverage
Select this option to decline SGLI coverage.

Witnessed and Received By
This part of the window is for identifying the individual who witnessed and received the form and when. Choose Members to select the witness. The Search window opens.

First Name
Is automatically displayed from the CUDDB.

Middle Initial
Is automatically displayed from the CUDDB.

Last Name
Is automatically displayed from the CUDDB.

Grade
Is automatically displayed from the CUDDB.

Organization
Is automatically displayed from the CUDDB.

Date Received
The system date is the default value.

Beneficiary(ies) and Payment Options
This portion of the window is for entering information about beneficiaries and payment options.

Principal Beneficiary (1-2)
This portion of the window is for identifying principal beneficiaries.

Complete Name (First, Middle, and Last Name)
Type the First Name, Middle Name, and Last Name of the beneficiary.

Address Line 1
Type the beneficiary's street address.

Address Line 2
Type the recipient's city, state, and zip.

SSN
Type the beneficiary's Social Security number.

Relationship
Type the relationship of the beneficiary to the member.

Share to Beneficiary
Type the share of the benefits.

Payment Option
Select a payment option from the drop down list.

Contingent Beneficiary (1-3)
This portion of the window is for identifying contingent beneficiaries.

Complete Name (First, Middle, and Last Name)
Type the First Name, Middle Name, and Last Name of the beneficiary.

Address Line 1
Type the beneficiary's street address.

Address Line 2
Type the recipient's city, state, and zip.

SSN
Type the beneficiary's Social Security number.

Relationship
Type the relationship of the beneficiary to the member.

Share to Beneficiary
Type the share of the benefits.

Payment Option
Select a payment option from the drop down list.

Student Management

About Student Management

xe "About Student Management"The following highlights the two main areas of the Student Management module's significant capabilities and features that have been created for the automated TTC process:

Accessions 
Allows the Marine Corps Recruit Depot (MCRD) to verify newly arrived recruits with information from the Marine Corps Recruiting Information Support System-Recruiting Station (MCRISS-RS) data.  As directed by current FY shipping schedules, appropriate company and platoon numbers per respective battalions are initially added or deleted through this window. 

After importing the MCRISS-RS data, recruits can be verified, added, deleted, and changed. Companies and platoons can be formed, and rosters and reports for training platoons and companies can be generated. Class ID and Fiscal Year (CID-FY) data can be assigned and accession diaries can be created.  Blank service record books for pages three and eleven can be printed for each recruit that is on the accession diary.

Student Processes 
Allows the unit to perform volume updates for transfers, school joins, individual discharges, start school, and school complete.  It also allows situational reporting on drops, deserters, and schools.  

Searches can be done on school specifics and the option to print student batch and individual orders is available. 

See Also:

Accessions 

Student Processes 

Accessions

Accession Data

xe "Recruit Accessions" This window allows you to view, edit, or delete any information on the recruit's or officer candidate's record after the platoon assignment is completed. 

Recruit/Officer

After the recruit's or officer's information has been checked for accuracy and verified, it is then ready to be added to a diary and the SSN, name and cadency code are protected. Based on the member's criteria and whether the record was created in Receiving Barracks or Inbound, or imported from a MCRISS record, certain fields will be available for input. Required fields have bold labels. This window is available to Recruit Depots and Inbound Officer's, and is RUC-specific for access. Only the Preparer has access to change this information, and changes must be made before the diary is built.

How Do I Get Here?

176. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

2. From the Tools menu, choose Accessions. The Accessions window opens

3. On the Accessions window, select the appropriate platoon code listed under the company and battalion in the treeview option, and then choose the desired Record.  The Accession Data window displays. Only records that have been assigned to a company and platoon should be accessed.

To Enter/Change the Accession Dataxe "Accession Data"
1. Under Accession Data
a) In the Social Security Number box, type the member's nine-digit Social Security Number.

b) In the Platoon box, type the four-digit platoon number the member is assigned to.

c) In the Company box, type the one-digit company code the member is assigned to.

d) In the Last Name box, type the member's last name (up to 26 characters).

Note: If the MCRISS Trecon reflects the cadence in the Last Name box, you must delete it and move it to the Cadency Code box.

e) In the Cadency Code box, select the members' cadency code. 

f) In the First Name box, type the member's first name (up to 18 characters).

g) In the Middle Name box, type the member's middle name (up to 19 characters).

2. Under Enlistment Data
a) In the Comp Code box, select the applicable component code number. 

b) In the Ship Date box, type the member's ship date in YYYY/MM/DD format. Unless the member had prior service, this date is the same as AFADBD, CADBD, DCTB, and PEBD.

c) In the DOEAF box, type the date the member entered the armed forces in YYYY/MM/DD format.

d) In the DOE box, type the date the member enlisted in YYYY/MM/DD format.

e) In the TOE box, select the one-digit number of years for which the member has enlisted. 

f) In the DCTB box, type the date the member's current tour began in YYYYMMDD format.

g) In the ACT NAV SERV box, type the member's active service date in YYYY/MM/DD format.

h) In the Effective Date of Rank, type the date of the member's rank in YYYY/MM/DD format.

i) In the Officer Service Base Date box, type the date of the members service base date in YYYY/MM/DD.

j) In the Date Accept 1st Commission box, type the date the member accepted first commission in YYYY/MM/DD format.

k) In the Date of Rank 1st Commission box, type the date of the member's first accepted first commission in YYYY/MM/DD format.

l) In the Grade Appointed box, type the grade that the member has been appointed.

m) In the Contract Legal Agreement box, select the box if the member is under a legal contract agreement.

n) In the PEBD box, type the member's pay entry base date in YYYY/MM/DD format.

o) In the AFADB Date box, type the date the member started active duty in YYYY/MM/DD format. 

p) If available, in the EAS box, type the date the member's active service expires in YYYY/MM/DD format.

q) In the ECC box, type the date the member's current contract expires in YYYY/MM/DD format.

r) In the Rank box, do one of the following:  

· If the member is a Private under 4 months, choose E0.

· If the member is a Private over 4 months, choose E1.

s) In the DOR box, type the date the member's rank was established in YYYY/MM/DD format.

t) In the Duty Limit box, select the applicable duty limit letter code and description.

u) In the Primary MOS box, select the applicable primary military occupational specialty code and description. The default value is 9971-Basic Marine with Enlistment Guara if the component code is not equal to 11.

v) In the Current Active Duty Base Date box, type the base date the member's current active duty began in YYYY/MM/DD format. 

w) In the Future Trng MCC box, select the applicable code and description of the member's future training monitored command code.

x) In the Future Trng MCC EDA box, type the date the member is estimated to arrive at the future training MCC in YYYY/MM/DD format.

y) In the College Ret Date box, type the date the member returned to college in YYYY/MM/DD format.  Applicable to split incremental reservists (IIAD/92 day) only.

z) In the Source of Entry box, type for active duty members, the four-character source of entry code.  For the Reserve source of entry code, type blank, blank, 7F.

aa) In the EFT IND box, select the applicable electronic file transfer indicator bank code. The default value is an applicable MCRD banking institute.

ab) In the Enlst Ref Number box, type the member's two-character enlisted reference number.

ac) In the Duty Pref box, select the applicable duty preference code.

3. This information is for Inbound officer's only and can only be accessed using RUC 30382.

a) In the Rank Effective Date box, select the member's effective date of rank in YYYY/MM/DD format.

b) In the Active Naval Service Date box, type the member 's active service date in YYYY/MM/DD format.

c) In the Contract Legal Agreement box, select the box if the member is under a legal contract agreement.

4. Under Recruiting Information
a) In the District Code box, type the two-digit district code of the district where the member joined the armed forces.

b) In the RS MCC box, type the member's three-character recruiting station monitored command code. 

c) In the Sub Station box, type the two-character substation number. 

5. Under Reserve Information
a) In the IMOS box, type the five-character alphanumeric code for the member's intended military occupational specialty.

b) In the Reserve MCC box, select the applicable reserve monitored command code.

c) In the Res Rep Unit Code box, select the applicable reserve reporting unit code.

d) In the Res Comp Code box, select the applicable reserve component code.

e) In the Projected Trng Complete Date box, type project training completion date in YYYYMMDD format.

6. Under Program Enlisted For Data
a) In the Code box, select the applicable code and description of the program for which the member enlisted. The default value is 00 if the component code is not equal to 11.

b) In the Bonus box, select the applicable code and description of the bonus for which the member enlisted.

c) In the College box, select the applicable code and description of the college for which the member enlisted.

Note: If the Program Enlisted For Code is blank, either the Bonus or College PEF will appear on the Depot orders.

7. Under Personal Data
a) In the Sex box, select the applicable sex code.

b) In the Race box, select the applicable race code.

c) In the Citizenship box, select the applicable citizenship code.

d) In the Marital Status box, select the applicable marital status code.

e) In the Tax State box, select the applicable state tax code and description.

f) In the Num of Depn, type the member's number of dependents (up to two digits).

g) In the Religion Code box, select the applicable religion code.

h) In the Ethnic Code box, select the applicable ethnic code.

i) In the Citizen Orig Geo Loc box, type the two-character geographic location code of the region to which the member has citizenship. 

j) In the Height box, type the member's height in inches.

k) In the Indiv Weight Qnty box, type the member's weight in pounds.

l) In the Hair Color box, select the color of the member's hair.

m) In the Eye Color box, select the color of the member's eyes.

n) In the Birth Date box, type the member's birth date in YYYY/MM/DD format. 

o) In the Birth State box, select the code and description of the member's birth state.

p) In the Birth County box, type the three-digit number of the county in which the member was born.

q) In the L/R Handed box, select right or left.

r) In the Valid Driv License box, select the box if the member has a valid driver's license.

s) In the Civilian Conviction box, select the number that corresponds with the number of convictions the member has had.

t) In the Security Eligibility box, select the member's level of security.

u) In the Gas Mask Size box, select the appropriate gas mask size. The default value is C-medium.

v) In the Gas Mask Type box, select the appropriate gas mask type. The default value is N-XM40.

w) In the Helmet Size box, select the appropriate helmet size. The default value is C-medium.

8. Under Visual Acuity
a) In the Rt Uncorrected box, type the two-digit number of the uncorrected visual acuity in the member's right eye.

b) In the Rt Corrected box, type the two-digit number of the corrected visual acuity in the member's right eye.

c) In the Left Uncorrected box, type the two-digit number of the uncorrected visual acuity in the member's left eye.

d) In the Left Corrected box, type the two-digit number of the corrected visual acuity in the member's left eye.

e) In the Vis Acuity Code box, select the code and description that corresponds with the member's visual acuity rating.

9. Under Home of Record
a) In the State box, select the applicable code and description of the state in which the member resides.

b) In the County Code box, type the three-digit number of the county in which the member resides.

c) In the City Code box, type the four-digit number of the city in which the member resides.

d) In the Phone box, type the member's ten-digit telephone number.

10. Under Address
a) In the Street Text box, type the member's street address (up to 38 characters).

b) In the City Text box, type the city in which the member resides (up to 29 characters).

c) In the City Code box, type the four-digit city code of the city in which the member resides.

d) In the County Code box, type the three-digit code of the county in which the member resides.

e) In the State box, select the state code and description of the state in which the member resides.

f) In the Zip Code box, type the member's five-digit or nine-digit zip code.

11. Under Education
a) In the Civ Ed Level Code box, select the code and description that corresponds to the members level of education.

b) In the Educational Subj box, select the applicable code and description of the major study area performed by the member.

c) In the Civ Educ Cert box, select the applicable code and description of the highest education certificate the member has received.

d) In the High Math box, select the applicable code and description of the highest math course the member has completed.

e) In the DLAB Score box, type the member's three-digit number DLAB score.

f) In the Army Radio Code box, type the member's three-digit number Army radio code. 

g) In the MEPS AFQT Score box, type the member's two-digit number MEPS AFQT score.  

h) In the MEPS ASVAB Test Id box, type the member's three-character MEPS ASVAB test Id number.

i) In the DLAB Date box, type the member's DLAB date in YYYY/MM/DD format.

j) In the Army Radio Code Date box, type the date the member's Army radio code was effective, in YYYY/MM/DD format.

k) In the MEPS Mon Cmd Code box, type the member's three-character MEPS Mon Command code.

l) In the MEPS ASVAB Test Date box, type the date the member took the MEPS ASVAB test date in YYYY/MM/DD format.

m) In the EDPT Score box, type the member's three-digit number EDPT score.

n) In the EDPT Date box, type the date the member took the EDPT in YYYY/MM/DD format.

12. Under High School
a) If the member graduated from a high school, select the Graduated box.

b) In the Years Attended box, select the applicable number of years the member attended high school.

c) In the Year Last Attended box, type the four-digit number of the last year the member attended high school in YYYY format.

13. Under College
a) If the member graduated from a college, select the Graduated box. 

b) In the Years Attended box, select the applicable number of years the member attended college.

c) In the Last Attnd Date box, type the date the member last attended the college in YYYY/MM/DD format.

d) In the Major Subject box, select the applicable code and description of the member's major subject at the college.

14. Under Trade/Business
a) If the member graduated from a trade or business school, select the Graduated box.

b) In the Years Attended box, select the applicable number of years the member attended the school.

c) In the Last Attnd Date box, type the date the member last attended the school in YYYY/MM/DD format.

d) In the Major Subject box, select the applicable code and description of the member's major subject at the school.

15. Under MEPS Composite
a) In the GT box, type the three-digit number score the member received on the GT.

b) In the EL box, type the three-digit number score the member received on the EL.

c) In the MM box, type the three-digit number score the member received on the MM.

16. Under Foreign Language box,

a) In the First box, select the code and description of the member's first foreign language.

b) In the Second box, select the code and description of the member's second foreign language.

c) In the Third box, select the code and description of the member's third foreign language.

d) In the Fourth box, select the code and description of the member's fourth foreign language.

17. Under Military Class Identification (CID) 
All data in this section is automatically populated after the class convene date is selected in the To Assign Class Convene date process.  If any data is incorrect, you must return to the Accessions topic, To Assign Class Convene section and change the class convene date at the company level for the entire company.

a) In the Sponsor Code box, the one-character letter that specifies which organization is sponsoring the class displays.

b) In the Base Location Code box, the two-digit number that designates the base's location displays.

c) In the School Code box, the three-character school code displays.

d) In the School House Code box, the one character school house code displays.

e) In the Fiscal Year box, the fiscal year in YYYY format displays.

f) In the CID Text box, the CID text (up to 10 characters) displays.

g) In the Report Date box, the date the member reported in YYYY/MM/DD format displays.

h) In the Convene Date box, the date the member will start school in YYYY/MM/DD format displays.

i) In the Graduation Date box, the date the member will graduate in YYYY/MM/DD format displays.

To Save Unverified Data

You may save changes at any time during input without verifying the data.  However, the record is not available to add to the unit diary for certification until the Data Verification check box is selected and the data has been verified.

1. Choose OK.  A message prompts you to verify that you want to save your changes.

2. Do one of the following:  

· If you want to save your changes, choose Yes.  

· If the member is a recruitxe "Accession:Recruit", your changes are updated and you return to the Receiving Barracks window.

· If the member is an officer candidate, you changes are updated and you return to the Officer Accession window.

· If you do not want to save your changes, choose No.  

· If the member is a recruitxe "Accession:Recruit", your changes are not updated and you return to the Receiving Barracks window.

· If the member is an officer candidate, you changes are not updated and you return to the Officer Accession window. 
· If you want to cancel the save process you made and make other changes, choose Cancel.  You return to the Accession Data window.

To Verify Accession Dataxe "Accession Data"
1. When all mandatory fields have been entered, select the Data Verified check box and then choose OK.  If any mandatory accession dataxe "Accession Data" fields are not complete, a message informs you which field is not complete or has an invalid data type and the cursor returns to the applicable data field for correction.

2. When the data is verified, a message prompts you to save the changes.  Do one of the following:

· If you want to save your changes, choose Yes. You return to the Receiving Barracks window and the record is available to add to the diary.

· If you do not want to save your changes, choose No.  You return to Receiving Barracks window and the record is available to add to the diary.  

· If you want to cancel the save process you made and make other changes, choose Cancel.  You return to the Accession Data window to make changes.

3. Your return to the Accessions window.

To Exit This Window

· Choose Cancel. You return to the Accessions window.

See Also:

About Student Management 

Accessions 

Create Recruit 

Add to Diary

Assign Class Convene Date

This window allows you to assign a Company to a class by assigning a specific Class Convene Date for recruits and officers. Only the Certifier ELSIG and above has access this window.

How Do I Get Here?

1. From the UDMIPS - Navigator, choose Student Management.  The Student Management window opens.

2. From the treeview, under the company level choose the company to which you want to assign a class convene datexe "Assign A Class Convene Date".  A shortcut menu displays.

3. From the shortcut menu, choose Assign Class Convene Date.  The Assign Class Convene Date window opens.

To Assign A Class Convene Datexe "Assign A Class Convene Date"
1. From the School Convene Date list, select a class convene date.

Note: It is important to verify that the correct convene and graduation dates are reflected for each specific company.  If a date is not correct, contact MMEA-11 and BNA sponsor at TECOM.

2. Choose OK.  

· If you are assigning recruits, you return to the Accession window.

· If you are assigning officers, you return to the Officer Accession window.

To Exit This Window

· To close without saving changes, choose Cancel.  You return to the previous window.

Add Recruiting Station Members

xe "Add Recruit"

xe "Add Recruiting Station Members"This window allows you to move the records from the MCRISS data to the Receiving Barracks folder. Members reflected on the MCRISS dataset are either within 15 days of their Projected Active Duty Date (PADD) or have shipped that day. The MCRISS dataset includes members assigned to a depot and members who have not been assigned to a specific depot because their future training monitored command codes are missing or incorrect. Only a Preparer ELSIG can access this window.

Columns or Column headings can be sorted by selecting any column or column heading and dragging it to the desired spot.

How Do I Get Here?

1. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

2. From the Tools menu, choose Accessions.  The Accessions window opens.

3. Begin on the Accessions window.

4. From the Tools menu, choose Add Recruits. The Add Recruiting Station Members window opens.

This window contains the following:

· SSN

· Name

· Ship Date

· Sex

· City, State

To Add A Recruit

1. In the Filter By box, choose one of the options for the criteria that you want to search by.

2. In the Value box, type the value that you want to search for.  Records meeting the criteria display.

3. Select one or more records.  

4. Choose OK.  A message informs you that all selected SSNs have been moved to the Receiving Barracks folder.

5. Choose OK.  You return to the Accessions window.

To Exit This Window

· Choose Cancel.  You return to the Accessions window.

Add Officer Candidates

xe "Add Officers Canididates"This window allows you to manually add Officers from MCRISS data to the Accessions screen.  Members reflected on the MCRISS dataset.  Only a Preparer ELSIG can access this window.

Columns or Column headings can be sorted by selecting any column heading and dragging it to the desired spot.

How Do I Get Here?

177. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

178. From the Tools menu, choose Accessions.  The Accessions window opens.

179. Begin on the Accessions window.

180. From the Tools menu, choose Add Officers.  The Add Officer Candidates window opens.

This window contains the following:

· SSN

· Name

· Ship Date

· Sex

· City and State

To Add A Officer

181. In the Filter By box, choose one of the options for the criteria that you want to search by.

182. In the Value box, type the value that you want to search for.  Records meeting the criteria display.

183. Select one or more records.

184. Choose OK.  A message informs you that all selected SSNs have been moved to the Receiving Barracks folder.

185. Choose OK.  You return to the Accessions window.

To Exit This Window

· Choose Cancel.  You return to the Accessions window.

Create Recruit

xe "Create Recruit"This window allows a preparer to add a new recruit who does not appear on the roster from the Recruiting Station, to the Receiving Barracks. The UD/MIPS database is checked for a duplicate SSN before a new record can be created.

How Do I Get Here?

1. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

2. From the Tools menu, do one of the following:

· Choose Create Recruit.  The Create Recruit window opens.

· Choose Accessions.  The Accessions window opens. From the Tools menu, choose Create Recruit.  The Create Recruit window opens.

To Add a Record

186. In the Social Security Number box, following the default zero (0), type the recruit's 9-digit SSN without any dashes.

187. In the Last Name box, type the recruit's last name.

188. In the Cadency list, select the member's cadency, if applicable.

189. In the First Name box, type the recruit's first name.

190. In the Middle Name box, type the recruit's middle name

191. In the Gender list, select the gender.

192. In the Component Code list, select the component code.

193. Choose OK. You return to the Accessions window and the recruit displays in the Receiving Barracks folder pending assignment and accession processing.

To Exit This Window

· Choose Cancel. You return to the Accessions window.

Create Officer Candidates

xe "Create Officer Candidates"This window allows you to add a new Officer who is a recruit for Officer school.  The UD/MIPS database is checked for duplicate SSNs before a new record can be created. Only a Preparer ELSIG can add a recruit.

How Do I Get Here?

194. From the UD/MIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

195. From the Tools menu, choose Create Officer.  The Create Officer Candidates window opens.

To Add a Record

196. In the Social Security Number box, following the default zero (0), type the officer's 9-digit SSN without any dashes.

197. In the Last Name box, type the officer's last name.

198. In the Cadency list, select the officer's cadency, if applicable.

199. In the First Name box, type the officer's first name.

200. In the Middle Name box, type the officer's middle name.

201. Choose OK.  You return to the Officer Accession window and the officer displays in the Inbound folder pending assignment and accession processing.

To Exit This Window

· Choose Cancel.  You return to the Officer Accession window.

Accessions

xe "Recruit Accessions"This window allows you to access recruits or officers.  Depending on whether you are accessing a recruit or officer, some fields or options will be different; these differences will be mentioned where applicable.  Only a Preparer ELSIG can add recruits or officers.

Recruits

If you are accessing recruits, it allows you to assign recruits to platoons, add and delete companies and platoons, and assign classes.

Officers

If you are accessing officers, it allows you to assign officers who are inbound to platoons, add and delete companies and assign a class convene date.  Officer Accessionsxe "Accessions" are only visible if the user is signed in as RUC 30382.

Note: When logging in:


Depotxe "Accession:Depot" RUCs default to the Accessions screen.

School RUCs default to the Schools screen. 

All other RUCs default to the Student Management screen.

How Do I Get Here?

1. From the UD/MIPS - Navigator  window, choose the Student Management icon. The Student Management window opens.

2. From the Tools menu, choose Accessions. The Accessionsxe "Accessions" window opens.

· If you are accessing a recruitxe "Accession:Recruit", the Accessionsxe "Accessions" window opens.

· If you are accessing an officer, the Officer Accessionxe "Accessions" window opens.

This window displays the following information:

Status

There are six main accession categories:

· Marine Corps Recruitxe "Accession:Recruit" Depotxe "Accession:Depot" (MCRD) (Recruit only)

· MCRISS Officer Data (Officers only)

· Receiving Barracks (Recruit only)

· Inbound (Officers only)

· Rejected

· Assigned Platoon

Preview Pane View

The preview pane on the right side of the window contains information about recruitxe "Accession:Recruit" or officer accessionsxe "Accessions". 

Column Headings

You can rearrange the column headings by selecting headings and dragging them into the preferred order. In addition, you can rearrange the columns by selecting the desired columns and dragging them into the preferred order. The default order is as follows:

· Social Security Number

· Name

· Component Code

· Status

· Class Convene Date

· Company 

· Platoon

· Ship Date

· Sex

· City 

· State

Bottom of the Window

· MCRISS Extract date 

Marine Corps Recruitxe "Accession:Recruit" (MCRD)/MCRISS Officer Data 

This view displays all recruits located MCRD or officers located at Quantico regardless of their status.  This view is populated with members added from the MCRISS extract and members created from this window.  The MCRISS data from recruiting service reflects recruits that are scheduled to or have shipped or are scheduled to arrive at MCRD within a 15-day window. The MCRISS dataset includes members assigned to a depotxe "Accession:Depot" and members who have not been assigned to a specific depotxe "Accession:Depot" because their future training monitored command codes are missing or incorrect. By using either the Create Officer process under Accessions or Initial Depotxe "Accession:Depot" Join TTCs process under Student Processes, you can join shipped or reported recruits or officers who don't appear in the MCRISS Trecon.

Receiving Barracks/Inbound

This view displays all recruits or Inbound officers currently being processed.  When members are added from the MCRISS extract, they are placed in this folder by default.  All members in this folder also display in the MCRD or Inbound folder. A member will no longer appear here once assigned a platoon.

Rejected

This view displays all recruits or officers who have been removed from a diary and returned for further action and the company and platoon information is removed.   All members in this folder also display in the MCRD or Inbound folder.  Recruits or Officers must have another platoon before they can be accessed.

Assigned Platoon

This view displays all recruits or officers who have been assigned to a battalion, company and platoon in this folder.  All members in this folder also display in the MCRD or Inbound folder.

Battalion

There are four system-supplied battalion folders that can not be deleted.  This view displays all recruits or officers assigned to the selected battalion regardless of which company or platoon they are assigned.  Fourth Battalion is applicable only to MCRD, Parris Island.

Company

This view displays all recruits or officers assigned to a company regardless of which platoon they are assigned.  All members in this folder also display in the applicable battalion folder.

Platoon

This view displays all recruits or officers assigned to the selected platoon.  All members in this folder also display in the MCRD, company, and battalion folders.

To Add Recruiting Station Members 

1. Begin on the Student Management frame.

2. From the Tools menu choose Add Recruits.  The Add Recruiting Station Members window opens. 

To Create A Recruitxe "Accession:Recruit"
1. Begin on the Student Management frame.

2. From the Tools menu choose Create Recruit.  The Create Recruit window opens.  The created record will be moved to the Receiving Barracks folder.

To Delete A Recruitxe "Accession:Recruit"
1. In the Status treeview, select the member you want to delete from any folder.  A shortcut menu displays.  

2. Choose the Delete option.  A message prompts you to verify that you want to delete the member.  Choose Yes.  The member is deleted from All folders.

To Add A Company 

1. In the Status treeview, select the battalion to which you want to add the new company.  A shortcut menu displays.

2. From the shortcut menu, choose Add Company.  A company folder and edit box display below the selected battalion.  

3. In the edit box, type a one-letter company designator.  This should agree with companies assigned on the current FY shipping schedules.

4. Press the Enter key.  The new company is added to the Status treeview.

To Delete A Company
1. In the Status treeview, select the Company you want to delete.  A shortcut menu displays.

2. From the shortcut menu, choose Delete Company.  The company is removed from the Status treeview.  Records for any company recruits return to the Receiving Barracks folder.

To Add A Platoon

1. In the Status treeview, select the Company to which you want to add a platoon.  A shortcut menu displays.

2. From the shortcut menu, choose Add Platoon.  A platoon folder and edit box display below the selected company.

3. In the edit box, type the four-character alphanumeric platoon designator.  Codes input should agree with platoons assigned on the current FY shipping schedules.

4. Press the Enter key.  The new platoon is added to the Status treeview.

To Assign Class Convene Date (Certifier Only)

1. In the Status treeview, select the Company to which you want to add a class convene date.  A shortcut menu displays.

2. From the shortcut menu, choose Assign Class Convene Date.  The Assign Class Convene Date window opens. 

3. After completing the steps in the Assign Class Convene Date topic, the class convene date displays in the Class Convene column.  

Note: It is important to verify that the correct convene and graduation dates are reflected for each specific company.  If either of the dates are not correct, contact MMEA-11 and the BNA sponsor at TECOM.

To Delete A Platoon

1. In the Status treeview, select the Platoon you want to delete.  A shortcut menu displays.

2. From the shortcut menu, choose Delete Platoon. The platoon is removed from the Status treeview.  Records for any platoon recruits return to the Receiving Barracks folder.

To Assign a Recruitxe "Accession:Recruit" to a Platoon

202. In the Status treeview do the following:

203. Select the destination platoon.

204. Choose the originating folder.

Note: This is usually the Receiving Barracks folder, but you can move recruits between platoons, companies and battalions.

3. Select one or more records.  Drag and drop the selected records on top of the applicable platoon.  On the treeview the numbers in the parentheses, next to the Platoon number, inform you of how many members are assigned to the platoon.

Note: Moving a recruitxe "Accession:Recruit" who has been verified to another platoon will remove the verification and the status will revert to assign platoon.

To Add an Officer

205. Begin on the Student Management frame.  

206. From the Tools menu, choose Add Officers.  The Add Officer Candidates window opens.

To Create an Officer

207. Begin on the Student Management frame.

208. From the Tools menu, choose Create Officer.  The Create Officer Candidates window opens.

To Add a Transaction to a Diary

· From the Tools menu, choose Add To Diary.  The Add To Diary window opens.

To Export Receiving Barracks Data 

· From the File menu choose Export.  The Export window opens. 

To Import Receiving Barracks Data 

· From the File menu choose Import.  The Import window opens. 

To Exit This Window

· Choose Close.  You return to the Student Managementxe "Accession:Student Management" frame.

See Also:

About Student Management 

Accession Data 

Receiving Barracks Roster 

Create Recruit 

Receiving Barracks 

xe "Receiving Barracks"This window allows you to initialize a students accession record and assign a platoon code. In addition, you may import and reconcile at any time, print or view student records by males only, females only or all personnel, and input a new recruit record if no SSN is on file.

How Do I Get Here?

209. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

2. From the Tools menu, choose Accessions. The Accessions window opens.

3. In the Accessions, within Status tree view, choose Receiving Barracks. The Receiving Barracks window opens.  When a folder is selected in the treeview the list box on the right populates with all applicable members.

Accession Reports

This window enables you to view and print the Validation Audit Report, Platoon Alpha Roster, Receiving Barracks Roster, Chronological Record (Page 3), and Administrative Remarks (Page 11) reports.  The Page 3 report can be printed as a blank form or with the recruit data.

How Do I Get Here?

1. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

2. From the Tools menu, choose Accessions.  The Accessions window opens.

3. From the Reports menu, choose the applicable report.  The Accession Reportsxe "Accession Reports" Selection Criteria window opens.

4. Enter the appropriate criteria.

5. Choose OK.  The applicable report opens.

To Print a Report

· Choose Print. The report prints.

To Exit This Window

· Choose Close. You return to the Accessions window.

See Also:

Administrative Remarks (Page 11) 

Chronological Record (Page 3) 

Platoon Roster 

Receiving Barracks Roster Reports 

Validation Audit Report 

Receiving Barracks Roster

This window allows you to filter the Receiving Barracks Rosterxe "Receiving Barracks Roster" Report by gender.

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

2. From the Tools menu, choose Accessions.  The Accessions window opens.

3. From the Reports menu, choose Rcv Barracks Roster. The Receiving Barracks Roster window opens.

To Generate This Report

1. Under Gender, select whether you want to report on male, female, or all recruits.

2. Choose OK. The Accession Reports window opens and displays the Receiving Barracks Rosterxe "Receiving Barracks Roster" Report.

To Exit This Window

· Choose Cancel. You return to the previous window.

Add To Diary

This window allows accession transactions to be added to a unit diary for processing from the Student Management module.

After you have added a record to an available diary, you must manage those changes in the Unit Diaries module.  This includes rejecting a transaction from a diary.

How Do I Get Here?

1. Begin on the Accessions window.

2. From the Tools menu, choose Add To Diary.  The Add To Diary window opens.

To Add to Diaryxe "Add To Diary"
210. In the Record(s) list, select one or more records you want to add to a diary.

Note: If the record you want to add to the diary is not available, return to the Accession Data topic and complete the To Verify Accession Data section.

2. Choose OK.  The Unit Diary Management window opens. 

To Exit This Window

· Choose Cancel. You return to the Accessions window.

See Also:

About The Unit Diary 

Reject An Accession Diary Transaction 

Platoon Alpha Roster Selection Criteria

xe "Platoon Alpha Roster Selection Criteria"

xe "Alpha Roster"This window allows you to generate a report of all members assigned to the receiving barracks and reports by the companies and platoons they are assigned to. 

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the Student Management icon.  From the Tools menu, choose Accessions.  The Accessions window opens

2. On the Accessions window, choose the appropriate Status tree-view option then select the desired Record.  The Accession Data window displays.

3. Begin in the Accessions window.

4. From the Reports menu, choose Platoon Alpha Roster. The Platoon Alpha Roster window opens.

To Generate a Platoon Roster

1. Under Selection Criteria, do one of the following:

· To report on all personnel, select All Personnel.

· To report on a single company, select Company.

· To report on a single platoon, select Company/Platoon.

2. If you chose to generate a report by company, under Select, in the Company list, select the company.

3. If you chose to generate a report by company and platoon, under Select, do the following:

· In the Company list, select the company.

· In the Platoon list, select the platoon.

4. Choose OK. The Accession Reports window opens and displays the Platoon Roster report.

To Exit This Window

· Choose Close. You return to the Accessions window.

SRB (Page 11) Selection Criteria

xe "SRB (Page 11) Selection Criteria"This window allows you to select a recruit's Service Record Book (SRB) and enter remarks not otherwise covered in other pages of the member's SRB.  

How Do I Get Here?

1. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

2. From the Tools menu, choose Accessions.  The Accessions window opens.

3. From the Reports menu, choose SRB p11. The SRB (Page 11) Selection Criteria window opens.

To Generate a Report

1. Under Selection Criteria, do one of the following:

· To report on all personnel, select All Personnel.

· To report on a single company, select Company.

· To report on a single platoon, select Company/Platoon.

· To report on a individual, select Individual.

2. If you chose to generate a report by company, under Select, in the Company list, select the company.

3. If you chose to generate a report by company and platoon, under Select, do the following:

· In the Company list, select the company.

· In the Platoon list, select the platoon.

4. If you chose to generate a report by individual, under Select, in the SSN box, enter the individual's social security number.

5. Choose OK. The Accession Reports window opens and displays the Administrative Remarks (1070) (Page 11) report.

To Exit This Window

· Choose Close. You return to the Accessions window.

SRB Recruit (Page 3) Selection Criteria

xe "SRB Recruit (Page 3) Selection Criteria"This window allows you to select the recruit's Service Record Book (SRB) is displaying a chronological record of the duties the member has performed throughout the member's Marine Corps career. 

How Do I Get Here?

1. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

2. From the Tools menu, choose Accessions.  The Accessions window opens.

3. From the Reports menu, choose SRB p3 (Blank) or SRB p3 (Recruit). The SRB p3 (Blank) Selection Criteria or SRB p3 (Recruit) Selection Criteria window opens.

To Generate a Report

1. Under Selection Criteria, do one of the following:

· To report on all personnel, select All Personnel.

· To report on a single company, select Company.

· To report on a single platoon, select Company/Platoon.

· To report on a individual, select Individual.

2. If you chose to generate a report by company, under Select, in the Company list, select the company.

3. If you chose to generate a report by company and platoon, under Select, do the following:

· In the Company list, select the company.

· In the Platoon list, select the platoon.

4. If you chose to generate a report by individual, under Select, in the SSN box, enter the individual's social security number.

5. Choose OK. The Accession Reports window opens and displays the Chronological Record (Page 3) report.

To Exit This Window

· Choose Close. You return to the Accessions window.

Validation Audit Report

This report displays members in the Receiving Barracks in alphabetical order by last name that are ready to be validated without having to go through every record.

Roster Heading

· Title (Validation Audit Report)

· Date

· Company/Platoon

· Page X of Y

Column Headings

· Last Name

· First Name

· Middle Initial

· Social Security Number

· Component Code

· Rank

· Date of Rank

· Date of Birth

· Term of Enlistment

· Program Enlisted For

· Bonus Program Enlisted For

· College Program Enlisted For

· Source of Entry

· Pay Entry Base Date

· Active Duty Base Date

· Intended Military Occupation Specialty

· Reserve Monitored Command Code

· Reserve Reporting Unit Code

· Project Training Complete Date

· College Return Date

· Status

Footer

· Total Members in this Platoon 

See Also:

Accession Reports 

Validation Audit Reportxe "Validation Audit Report" Selection Criteria 
Validation Audit Report Selection Criteria

xe "Validation Audit Report Selection Criteria"This window allows you to select all members before certification to the Unit Diary and reports by the companies and platoons they are assigned to. 

How Do I Get Here?

1. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

2. From the Tools menu, choose Accessions.  The Accessions window opens.

3. Begin in the Accessions window.

4. From the Reports menu, choose Validation Audit Report. The Validation Audit Report window opens.

To Generate a Report

211. Under Selection Criteria, do one of the following:

· To report on all personnel, select All Personnel.

· To report on a single company, select Company.

· To report on a single platoon, select Company/Platoon.

2. If you chose to generate a report by company, under Select, in the Company list, select the company.

3. If you chose to generate a report by company and platoon, under Select, do the following:

· In the Company list, select the company.

· In the Platoon list, select the platoon.

4. Choose OK. The Accession Reports window opens and displays the Validation Audit Report.

To Exit This Window

· Choose Close. You return to the Accessions window.

Joins

xe "Joins"This window enables you to process information for members joining to attend training or school at Entry Level Schools (ELS) or Marine Combat Training (MCT). 

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

2. From the Student Processes.  Under Choose a Process, select Joins.

3. Do one of the following:

· If you want to process students for ELS, choose ELS Join. The ELS Join window opens.

· If you want to process students for MTC, choose MCT Join. The MCT Join window opens.

To Generate an ELS Join Diary

1. In the Date of Action box, type the date in YYYYMMDD format. 

2. In the Monitored Command Code list, select the code

3. In the School Code box, type the three-character code.

4. In the Company Code box, type the one-character company code.

5. In the Platoon Number box, type the four-character alphanumeric platoon.  For RUCs 33353 and 31407 this field is automatically populated, and can be overtyped.

6. In the Billet MOS box, type the four-character billet military occupational specialty code.

7. In the Selected Members area, select one or more members.

8. Choose OK. The new diary is generated.

To Generate an MCT Join Diary

1. In the Date of Action box, type the date in YYYYMMDD format. 

2. In the Monitored Command Code list, select the code

3. In the Company Code box, type the one-character company code.

4. In the Platoon Number box, type the four-character alphanumeric platoon.  This field is automatically populated depending on the company code input, and can be overtyped.

5. In the School Code box, type the three-character code.

6. In the Selected Members area, select one or more members.

7. Choose OK. The new diary is generated.

To Exit This Window

· Choose Close. You return to the Student Management frame.

Reports

Platoon Roster

xe "Platoon Roster"This report displays members in the Receiving Barracks in alphabetical order by last name. Depending on which companies or platoons have been selected, a different page prints for each platoon.

Roster Heading

· Title (Platoon Roster)

· Date

· Company/Platoon

· Page X of Y

Column Headings

· Social Security Number

· Last Name

· First Name

· Middle Initial

· Component Code

· Status

Footer

· Platoon Total

See Also:

Accession Reports 

Platoon Roster 

Administrative Remarks (1070) (Page 11)

xe "Administrative Remarks (1070) (Page 11)"This page of the recruit's Service Record Book (SRB) is for entering remarks not otherwise covered in other pages of the member's SRB.  Administrative Remarks pages are populated with name and social security number.  You can reprint this record as long as the member is on the receiving barracks roster.

How Do I Get Here?

212. From the UD/MIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

213. From the Tools menu, choose Accessions.  The Accessions window opens.

214. Select one or more members in the desired platoon or platoons.

215. Under Reports menu, select SRB p11. The Accessions Reports window opens and displays the Administrative Remarks report.

Heading

· Title (Administrative Remarks)

Date Blocks

· Date 1: Signed upon initial entry into recruit training.

· Date 2: Signed by the member after six months active duty or upon re-enlistment.

Columns

· Remark Entries

Member Identification

· Last Name and Cadency

· First Name

· Middle Initial

· Social Security Number

Footer

· Form Number

· Version

· Stock Number

Page Sequence

· Page 11xe "Page 11" Sequence Number

To Print a Report

· Choose Print. The report prints.

To Exit This Window

· Choose Close. You return to the Accessions window.

Chronological Record (Page 3)

xe "Chronological Record (Page 3)"This page of the recruit's Service Record Book (SRB) is displaying a chronological record of the duties the member has performed throughout the member's Marine Corps career. Chronological Record can be printed by name, platoon, or company (SRB p3 (Recruit)). You can reprint this record as long as the member is on the receiving barracks roster. The Page 3xe "Page 3" report can also be printed as a blank form (SRB p3 (Blank)).

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

2. From the Tools menu, choose Accessions.  The Accessions window opens.

3. Select one or more members in the desired platoon or platoons.

4. From the Reports menu, select SRB p3. The Accessions Reports window opens and displays the Chronological Record report.

Heading

· Title (Chronological Record)

Columns

· Unit/Organization

· Platoon

· Unit Address

· Primary Duty

· Primary Military Occupational Specialty (PMOS) 

· Remarks

· Ship Date   

Member Identification

· Last Name and Cadency

· First Name

· Middle Initial

· Social Security Number

Footer

· Form Number

· Version

· Stock Number

To Print a Report

· Choose Print. The report prints.

To Exit This Window

· Choose Close. You return to the Accessions window.

TFS Inbound Roster

xe "TFS Inbound Roster"This report is used for permanent duty station and school assignments. Items appearing on the list are selected by Monitored Command Code, and an optional date range.

Header Information

· Title (TFS Inbound Roster)

· Date

· Monitored Command Code

· Page X of Y

· From Date

· To Date

Report Information

· Last Name

· First Name

· Middle Initial

· Social Security Number

· Intermediate Monitored Command Code

· Intermediate Monitored Command Code Estimated Date of Arrival

· Future Training Monitored Command Code

· Future Training Monitored Command Code Estimated Date of Arrival

· Future Monitored Command Code

· Present Monitored Command Code

· Estimated Date of Arrival

Bottom of Report

·  Total Number of Records

To Print the Roster

· In the File menu, choose Print.

To Exit This Window

· In the File menu, choose Close. You return to the Report Selection window.

Receiving Barracks Roster Report

xe "Receiving Barracks Roster Report"This report lists incoming recruits and can be filtered by any column heading. The report also identifies the company, platoon, and status that each individual recruit is in.  This report allows you to verify the member's name, SSN, and accession process status and whether all recruits have been assigned to platoons.  

Report Heading

· Title (Receiving Barracks Members)

· Date

· Reporting Unit Code

· Page X of Y

Column Headings

· Social Security Number

· Name (last, first, middle initial)

· Sex

· Company

· Platoon

· Status

Footer

· Number of Records

Receiving Barracks

Reported to MCRD, add recruit completed, not yet assigned to a company platoon.

Assigned Platoon

Reported to MCRD, add recruit completed, assigned to company platoon, not accessed.

Diary

Assigned a recruit on an uncertified accession unit diary.

Courier

Assigned recruit on a certified unit diary.

Rejected

Recruit removed from an uncertified accession unit diary, company platoon no longer assigned.

Note: Rejected recruits require special attention and should be handled as soon as possible, reassigned to a platoon, and accessed.

See Also:

Accession Reports 

Receiving Barracks Roster 

Student Processes

Student Processes

This window enables you to process volume updates for regular joins, starts and completions for schools, initial depot joins, and orders for individual students or groups of students.

How Do I Get Here?

1. From the UD/MIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

2. From the Tools menu, choose Schools. The Student Processes window opens.

The Student Processesxe "Student Processes" window consists of these five sections:

· Window Title

· Treeview

· Input area

· Selected Members

· Command buttons

Window Title

The window title indicates that you are in the Student Management module and which RUC you logged in with.

Treeview

The treeview lists the volume processes you may choose from. The available options depend on your ELSIG level. 

Student Process icons appear as schoolhouses and note pads in the treeview. 

The icons indicate the level of the categories:

· A red schoolhouse indicates the main category. 

· A white notepad and pencil indicates what type of volume processing can be performed. Choosing one of these icons allows you to enter information.

Input Area

When a processing category is chosen, the available input fields display to the right of the treeview. Some fields may be required and some may not.

Note: For details on completing the prompts for each process, see the applicable process topic.

Selected Members

This area allows you to select members for processing by member, by organization (RUC, company, or platoon), by class, or from TFS Inbound. It allows you to remove members from the search results. The Selected Members section is not available in the Initial Depot Join TTC's process.

Command Buttons

The following two buttons appear in the upper right-hand corner of each of the volume process windows:

· OK

· Close

Each volume process topic explains the specific actions that occur when you choose one of these buttons relevant to the category. 

To Exit This Window

· Choose Close. You return to the Student Management frame.

See Also:

Adding a Volume Transaction 

Initial Depot Join TTC's 

Print Orders 

Joins 

Schools Complete 

Selected Members 

Start Schools 

Transfer 

Selected Members

This section of the Student Processes window allows you to select members for processing by member, by organization (RUC, company, or platoon), by class, or from TFS inbound. It allows you to remove members from the search results. This section is not available if you selected the Initial Depot Join TTC's option. 

This section displays the following information:

· Social Security Number

· Name

· Grade

· Company

· Platoon

To Search for Specific Members

· Choose Members. The Search window opens.  After completing the steps in the Search topic, the members you selected display in the list.

To Search for Members by Organization

· Choose Organization. The Select Organization window opens.  After completing the steps in the Select Organization topic, the members you selected display in the list.

To Search for Members by Class

· Choose Class. The Class Selection window opens.  After completing the steps in the Class Selection topic, the members you selected display in the list.

To Search for Members Who Are Inbound to a Unit

· Choose Inbound. The TFS Inbound Selection Criteria window opens.  After completing the steps in the TFS Inbound Selection Criteria topic, the members you selected display in the list.

To Remove Members from the List

· Do one of the following:

· To remove selected membersxe "Selected Members" from the list, select one or more members, then choose Remove. The selected membersxe "Selected Members" are removed from the list.

· To remove all members, choose Remove All. All of the members are removed from the list.

Start School

xe "Start School"This window allows you to process information on members beginning to attend schools.

How Do I Get Here?

3. From the UD/MIPS- Navigator window, choose the Student Management icon.  The Student Management window opens.

4. Under Tools, select Schools. The Student Processes window opens. 

5. Under Choose a Process, select Start Schools.

6. Choose Start School. The Start School window opens.

To Generate a Diary

Note: Class Number, Class Fiscal Year and Class Location box are disabled until information is entered into School Code box.

7. In the Date of Action box, date is automatically populated with current date.  You can overtype this date but it cannot be future dated.  Type the date in YYYYMMDD format. 

8. In the Company Code box, type the one-character company code.

9. In the Platoon Number box, type the four-character alphanumeric number.

10. In the School Code box, type the three-character code or from the radio button list select the applicable School Code.

11. In the Class Number box, type the 7-character alphanumeric number id or from the radio button list select the applicable Class Number. 

12. In the Class Fiscal Year box, the Class Fiscal Year is automatically entered when the Class Number is selected from the radio button list. Or type the 4-digit Class Fiscal Year.

13. In the Class Location box, the Class Location code is automatically entered when the Class Number is selected from the radio button list. Or type the 3-character alphanumeric Class Location code.

14. In the Selected Members area, select one or more members.

15. Choose OK. The new diary is generated.

To Exit This Window

· Choose Close. You return to the Student Management frame.

School Complete

xe "School Complete"This window allows you to process information on members who have completed a school's training.

How Do I Get Here?

16. Begin in the UD/MIPS- Navigator, choose the Student Management icon.  The Student Management window opens.

17. Under Tools, select Schools. The Student Processes window opens. 

18. Under Choose a Process, select Schools Complete.

19. Choose School Complete. The School Complete window opens.

To Process Member Information

Note: Class Number, Class Fiscal Year and Class Location box are disabled until information is entered into School Code box.

20. In the Date of Action box, date is automatically populated with current date.  You can overtype this date but cannot be future dated.  Type the date in YYYYMMDD format. 

21. In the School Code box, type the three-character code or from the radio button list select the applicable school code that you want.

22. In the Class Number box, type the 7-character alphanumeric number id or from the radio button list select the applicable Class Number. 

23. In the Class Fiscal Year box, the Class Fiscal Year is automatically entered when the Class Number is selected from the radio button list. Or type the 4-digit Class Fiscal Year.

24. In the Class Location box, the Class Location code is automatically entered when the Class Number is selected from the radio button list. Or type the 3-character alphanumeric Class Location code.

25. In the Selected Members area, select one or more members.

26. Choose OK. The new diary is generated.

To Exit This Window

· Choose Close. You return to the Accessions window.

Initial Depot Join TTCs

xe "Initial Depot Join TTCs"This process allows you to write volume transactions to a diary on initial depot joins for prior service or CAT P Reservist members who already have MCTFS records.   

How Do I Get Here?

27. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

28. Begin in the Student Processes window.

29. Under Choose a Process, select Initial Depot Join TTCs. 

30. Choose Initial Depot Join TTC 022-XXX. The Initial Depot Join TTCs information displays, if available.

Note: 'TTC 022-XXX' informs you that the processing is being done in TTC 022, but does not designate a specific sequence. 

To Process Member Information

31. In the Choose an Initial Join TTC list, select a TTC or a TTC and SEQ.   (022.047 is most common for CAT P)

32. In the SSN box, type the member's Social Security Number.

33. In the Last Name box, type the member's last name.

34. In the Initials box, type the member's initials.

35. In the Date Of Action box, type the date in YYYYMMDD format. The system date is the default value.

36. In the MCC list, select the monitored command code.

37. In the School Code box, type the three-character code, 808 for male, 809 for female.

38. In the EFT Select list, select the code. The default values are "F" for MCRD PI, or "M" for MCRD SD.

39. In the Effective Date box, type the date in YYYYMMDD format.

40. In the Billet MOS box, type the four-character billet military occupational specialty code.

41. In the Company Code box, type the one-character company code.

42. In the Platoon Number box, type the four-character alphanumeric number.

43. In the Intended MOS box, type the five-character alphanumeric code for the member's intended military occupational specialty.

Note: Character 5 of the IMOS should be an A or B.

44. In the Proj Trng Complete Date box, type project training completion date in YYYYMMDD format.

45. In the Marital Status Code list, select the applicable marital status code.

46. In the Address Validation Flag list, select the appropriate flag.

47. In the Mail Condition list, select the handling information.

48. In the Street Address list, type the member's address.

49. In the City box, type the name of the member's city.

50. In the State list, select the member's state.

51. In the Zip Code box, type the member's five-digit or nine-digit zip code.

52. In the Home Telephone Number box, type the 10-digit phone number.

53. Choose OK. The new diary is generated.

To Exit This Window

· Choose Close. You return to the Accessions window.

Print Orders

This window allows you to print ordersxe "Print Orders" of transfers for members who have completed Basic Training, Marine Combat Training or School of Infantry training.  Only the depot has access to the Depot Transfer and only the MCT has access to the MCT Transfer.

How Do I Get Here?

54. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens. 

55. From Tools, choose Schools. The Student Processes window opens.

56. Under Choose a Process, select Print Orders.

57. Do one of the following:

· If you want to generate transfer orders for depot transfers, choose Depot. The Depot window opens.

· If you want to generate transfer orders for MCT transfers, choose MCT. The MCT window opens.

This window displays the following information:

· Graduation Date

· Delay Days

· Proceed Days

· Travel Days

· Report Date

· No Unit Sort

· Company

· Company/Platoon

· Last Name

· SSN

· Certifying Officer

· Title ID

· Number of Copies

Depot

These transfer orders are issued to recruits who have completed recruit training.

MCT

These transfer orders are sent to members who have completed Marine Combat Training or School of Infantry training.

To Generate Orders

58. In the Graduation Date list, select an authorized graduation date.

59. In the Delay Days box, type the number of authorized days of leave.  For depot orders, the default value is 10.

60. If available, in the Proceed Days box, select the number of authorized days of proceed time.

61. In the Travel Days box, select the number of authorized travel days. For depot orders, the default value is 1.

62. The Report Date box is automatically populated with the graduation date plus delay, proceed, and travel days. 

63. To print ordersxe "Print Orders" by unit, in the Print Order, Unit Sort box, select one of the following:

· If you do not want the printed orders sorted by unit, select No Unit Sort.

· If you want to sort the printed orders by company, select Company.

· If you want to sort the printed orders by platoon within company order, select Company/Platoon.

64. To print ordersxe "Print Orders" by individual member, in the Print Order, Individual Sort box, select one of the following:

· If you want to sort the printed orders by last name, select Last Name.

· If you want to sort the printed orders by social security number, select SSN.

Note: The default for Print Orders is No Unit Sort by Last Name.

65. In the Certifying Officer box, type the name of the officer that will certify the orders.

66. In the Title ID list, select the certifying officer's title.

67. In the Copies box, select the number of copies of orders you want to print.

68. In the Selected Members area, select one or more members.

69. Choose OK. The orders are generated.

To Exit This Window

· Choose Close. You return to the Student Management frame.

See Also:

Recruit Transfer Orders 

IIADT Orders 

Release From IIADT Orders 

Completion of Marine Combat Training Orders 

Reserve Marine Combat Training Orders 

Transfer

This window allows Depots, MCTs and entry level schools to initiate transfers. Both individual and volume transfers are allowed.

How Do I get Here?

216. From the UD/MIPS - Navigator window, choose the Student Management icon. The Student Management window opens.

217. From the Tools menu, choose Schools. The Student Processes window opens.

218. Under Choose a Process, select Transfer. The Transfer window opens.

To Initiate a Transferxe "Transfer"
219. In the Choose TTC Entry list, select the applicable Type Transaction Code (TTC) for the transferxe "Transfer".

220. In the Date of Action box, type the date in YYYYMMDD format. The default value is the current date.

221. In the Monitored Command Code list, select the member's new Monitored Command Code (MCC).

222. In the Estimated Date of Arrival box, type the date of arrival in YYYYMMDD format.

223. In the Selected Members area, select one or more members.

224. Choose OK. The Select Diary window opens. Follow the instructions in the Select Diary topic. When you have placed the transactions in the Transaction Pool or a Unit Diary, a message informs you that the transferxe "Transfer" has been processed. 

225. Choose OK. You return to the Transfer window.

To Exit This Window

· Choose Close. You return to the Student Management frame.

Select Organization

xe "Select Organization"This window allows you to select members for student processing based on the RUC, company code, or platoon they are assigned to.

How Do I Get Here?

70. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens. 

71. Begin in the Student Processes window.

72. Under Selected Members, choose Organization. The Select Organization window opens.

To Select a RUC, Company, or Platoon

73. In the RUC/Company/Platoon list, select the RUC, company, or platoon you want.

74. Choose OK. You return to the Student Processes window.

To Exit This Window

· Choose Cancel. You return to the Student Processes window.

Class Selection

xe "Class Selection"This window allows you to select members for student processing based on the school code and graduation date.

How Do I Get Here?

75. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

76. Begin in the Student Processes window under Selected Members.

77. Choose Class. The Class Selection window opens.

To Select Members 

78. In the School Code list, select the member's school code that you want to view.

79. In the Graduation Date list, select the member's graduation date.

80. Choose OK.  You return to the Student Processes window, and the members display in the Selected Members area.

To Exit This Window

· Choose Cancel. You return to the Student Processes window.

TFS Inbound Selection Criteria

xe "TFS Inbound Selection Criteria"This window allows you to select members scheduled to arrive at the school within a range of dates.

How Do I Get Here?

81. From the UDMIPS - Navigator, choose the Student Management icon.  The Student Management window opens.

82. Begin in the Student Processes window. 

83. Under Selected Members, choose Inbound. The TFS Inbound Selection Criteria window opens.

To Select Members

84. In the From Date box, type the beginning date of the range in YYYYMMDD format.

85. In the To box, type the ending date of the range in YYYYMMDD format.

86. In the Monitored Command Code box, select the monitored command code and description.

87. Choose OK. You return to the Student Processes window and the members display in the Selected Members area.

To Exit This Window

· Choose Cancel. You return to the Student Processes window.

Orders Forms

IIADT Orders

xe "IIADT Orders"These ordersxe "Orders" allow you to transfer the selected Marine Corps Reserve recruit from the depot upon completion of boot camp to MCT or SOI.  Proceed days are not included in these ordersxe "Orders", delay days defaults to ten and travel days defaults to one day.

See Also:

Depot

MCT

Print Orders 

Recruit Transfer Orders

xe "Recruit Transfer Orders"These ordersxe "Orders" allow you to transfer the active duty recruit from the depot upon completion of boot camp to MCT or SOI.

See also:

Depot

MCT

Print Orders 

Release From IIADT Orders

xe "Release From IIADT Orders"These ordersxe "Orders" allow you to release the ninety-two day reserve recruit from active duty upon the completion of boot camp and transfer the recruit back to the reserve unit.

See Also:

Depot

MCT

Print Orders 

Completion of Marine Combat Training Orders

xe "Completion of Marine Combat Training Orders"These ordersxe "Orders" allow you to transfer the regular active duty personnel that have completed Marine Combat Training to further schooling or back to their unit.

See Also:

Depot

MCT

Print Orders 

Reserve Marine Combat Training Orders

xe "Reserve Marine Combat Training Orders"These ordersxe "Orders" allow you to transfer the reserve personnel that have completed Marine Combat Training to further schooling or back to their Reserve unit.

See Also:

Depot

MCT

Print Orders 
Impromptu

Impromptu

(If Cognos Reference Books are provided in the Cognos installation process, they will be available in the Cognos directory on the install destination drive.  Ex:  <drive:>\UDMIPS\COGNOS.  These books provide more detailed information on using Impromptuxe "Impromptu".)

The report generator lets the user create reports with the use of templates or from scratch.  There are six templates included in this version ready for use: Cross Tab, Form Letter, Cross Tab with Group, List with Headings, Mailing Labels, and List.

For simple reports, users will at most provide the data item(s), create expressions, and filter the data.  Impromptu's on-line help system can assist in this endeavor.  Complex reports require dedicated, hands-on experience by the user.

To get users started, procedures for a few sample reports are provided.  Users are encouraged to experiment with these samples.

CREATE A LIST REPORT

Log in.  Users must be logged-in to use Impromptuxe "Impromptu". User activity will be dictated by the user's ELSIG.

From the Navigator Bar:
Select the Impromptuxe "Impromptu" button.

The Select RUC window opens if you are a CONAD.

(If you are not a CONAD you will go directly into Impromptu)

Select the RUC you want.

Select the OK button.
Click File >>> New.

Select List Report from the palette.
Click OK.  The Data-Tab Query window opens.  Ensure the Data tab is selected and the CUDDB folder shows in the Catalog group window.

Double-Click the CUDDB folder.  The folder's data items are exposed for selection.  Select SSN, Name, User Company, and User Platoon by mouse.  Double-click each data item or highlight each, then click the Add command button, or drag each data item to the Query Data box.  A data item may be removed by highlighting it and clicking the Remove command button.

Scroll the CUDDB folder.  In some cases, it may be advantageous to key the first character for data items not visible on the window.  For example, user on Data Item Company Code, pressing "P" on the keyboard will jump to the first data item beginning with "P".

Double-Click on the MCTFS folder.  Scroll to, select, and add Expiration of Active Service, Present Grade Code, and Primary MOS.

Order the data items in the Query Data box.  Select a data item by mouse click.  Hold click until a slashed circle appears.  Still holding the mouse, drag the circle to a desired placement.  Release the mouse button.  For example, click and hold on Platoon Number.  When the slashed circle appears drag the mouse pointer so that it stops under Company Code.  This sample was ordered to read: Expiration of Active Service, Present Grade Code, Name, SSN, Primary MOS, Company Code, and Platoon Number.

Sort

Click Sort tab.
Highlight Expiration of Active Service.

Click the Ascending button.  A small triangle will appear left of the selected data item.
Group

Click Group tab >>> Highlight Company Code >>> Click Group button >>> Click OK.  

The report appears with data under the selected columns.  Data formats may be manipulated to appear as desired by:

Select any field, by left mouse click, in the Expiration of Active Service column.

Right mouse click on selection to open pop up menu.

Select the Format menu item.

Enter the desired data format in the Normal edit box.  For example, enter YYYYMMDD for DOD formats.

Click OK.  Again, Impromptu's on-line help provides detailed assistance in data formatting.

Format column/cell by clicking right mouse button to open pop up menu and selecting a menu item, i.e. format.

Click File >>> Save.  Provide a unique filename, e.g. AROSTER.  An .IMR extension will be provided, for example AROSTER.IMR.

CREATE A CROSS-TAB REPORT

· Log in >>> Click on Impromptu >>> Click File >>> New >>> Select Cross Tab Report >>> Click OK.  

· The Data-Tab Query window opens.  Ensure the Data tab is selected and the CUDDB folder shows in the Catalog group window.

· Double-Click the CUDDB folder.  The folder's data items are exposed for selection.

· Select MCTFS folder, then Platoon Number.

· Click the Add button >>> Select Primary MOS >>> click the Add button.

· Select Primary MOS >>> click the Summary button.  The Smart Summary of Primary MOS opens.

· Click the Count icon >>> Click OK >>> Click OK.

· Format column/cell by clicking right mouse button to open pop up menu and selecting a menu item, (Example:  format)

· Click File >>> Save.  Provide a unique filename, (Example:  AROSTER)  AN .IMR extension will be provided, for example AROSTER.IMR.

CREATE A GROUP CROSS-TAB REPORT

· Log in >>> Click on Impromptu >>> Click File >>> New >>> Select Group Cross-Tab Report >>> Click OK.  

· The Data-Tab Query window opens.  Ensure the Data tab is selected and the CUDDB folder shows in the Catalog group window.

· Open CUDDB folder to add User Company (for Grouped Item).

· Open MCTFS folder to add Strength Category Description (for Row Item).

· Open CUDDB folder to add User Platoon (for Column Item).

· Open Filters folder to add Number of Members (for Cell Details).  Click OK.

· Format column/cell by clicking right mouse button to open pop up menu and selecting a menu item, i.e. format.

· Click File >>> Save.  Provide a unique filename, e.g. AROSTER.  An .IMR extension will be provided, for example AROSTER.IMR.

CREATE MAILING LABELS

Log in >>> Click File >>> Open >>> Select MAIL_RPT.IMR >>> Click OK.  
The reporting of local address information is voluntary, however, to generate this report this information must be resident in the CUDDB.

CREATE SRB/OQR LABELS

Log in >>> Click File >>> Open >>> Select SRB_OQR2.IMR >>> Click OK.

This option produces standard labels for SRB/OQR covers for one social security number.

Creating Impromptu UD/MIPS Report(s)

xe "Creating Impromptu UD/MIPS Report(s)"This chapter explains how to create an Impromptu Report containing Record of Emergency Data that has multiple rows and other manpower data.

From the UD/MIPS navigation toolbar, click Impromptu.

· Click the FILE button and then click NEW.

· Double-click on BLANK REPORT.
· When the Query  window is displayed, click OK.

· Click on the FORM FRAME icon and drag it to the blank page.

· Click and drag a large FORM FRAME area (about ¾ of the window) with the left mouse button.

· Click  INSERT and then click DATA.

· Click inside the FORM FRAME.

· When the Query window is displayed, double-click, the CUDDB folder, and click the Name and SSN.

· Right-click the mouse anywhere inside the FORM FRAME.
· Click PROPERTIES.  Click the LAYOUT tab.  Select SINGLE ROW OF DATA.  Click OK.

· Click the QUERY icon.  Click the FILTER tab.  Select the check box ELIMINATE DUPLICATE ROWS.  Click OK.

· Click on the LIST FRAME icon and drag it on the blank page.

· Click and drag a rectangle (about 1/3 the size of the FORM FRAME) with the left mouse button.

· Click inside the rectangle.  Click REPORT.  Click CHANGE TO SUB REPORT.
· On the DATA tab double-click the needed fields out of either RED INSURANCE or REDS PERSON Including SSN.

For REDS PERSON do the following: 

· Click the FILTER tab.  Use any of the predefined filter(s) in the REDS PERSON folder for the member type you want, SPOUSE.  The SSN of the SUB QUERY must equal the SSN of the MAIN QUERY.  The filter should appear as:  SPOUSE and SSN = MAIN.QUERY.SSN.

For REDS INSURANCE do the following:  
· Click the FILTER tab.  Set the filter to SSN in the SUB QUERY.  The SSN must equal the SSN of the MAIN QUERY.  The filter should appear as: SSN = MAIN.QUERY.SSN.

· Size the form frame and rectangle appropriately. 

Catalog

UD/MIPS Catalog Folders

xe "UD/MIPS Catalog Folders"(Listed alphabetically by Folder Name within each Folder)

Folder Name


Folder Name



Folder Name

CUDDB


Additional Mos


Anti Terrorism Trng R137


Awards  R143


Classification/Qualification



Academic Test Info R148



Civilian Educ Info R147



Local School Complete R145



Mci Course Info R120



Off Duty Education R121


Classified Info Nda R139


Current Trng Location R157


Dependent Information R150


Draw Case Information


Electronic Mail R991 


Entitlements Information


Filters


Foreign Language R118


Future Trng Location R156


Govt Equip Opr License R141


Impromptu User


Insignia Auth Wear R140


Last Processing Cycle

             Mand Drill Partic Ext Mo

             Martial Arts R146

                     Ssn

                     Sequence Number

                     Kill Date

                     Martial Arts Belt Code

                     Martial Arts Completion Date

                     Martial Arts Recert Date

                     B 146 Document Type Code

                     B 146 Document Number Id

                     B 146 Document Year Date

                     B 146 Document Rpt Unit Code

                     B 146 Document Dpi Code

                     B 146 Document Type Trans Cd

                     Remark B Date Rmk 146

                     E 146 Document Type Code

                     E 146 Document Number Id

                     E 146 Document Year Date

                     E 146 Document Rpt Unit Code

                     E 146 Document Dpi Code

                     E 146 Document Type Trans Cd

                     Remark E Date Rmk 146


Mctfs


Member Command Information


Member Service


Officer Personal Information


Pers Tempo Track R112


Person Identification R159


Personal Class R154


Personal Test Information


Personal Vision R152


Personnel Information


Record of Emergency Data



Red Insurance



Red Mia Notify



Reds Person


Recruit Distribution R158


Recruit Identification R153


Remark Flags


Reserve Entry Level R155


Reserve Information


School Special Skill R136


Self Professed Language Codes


Separation Information


Soc Sec Admin Information


Training Information


Trecon Fields


Unit Cohesion Tracking Information


User Fields


Wpn Ammo Explsv Scrn R138

Receiving Barracks


Lk Eye Color


Lk Hair Color


Lk High Math 71 20 45


Lk Receive Status


Lk Vision 71 20 65

TFS Master Verification

Unit Address Record

Look-up Code Tables


Lk Address Mailing Condition


Lk Address Validation 71 70 20


Lk Authorizing Official


Lk Awards 70


Lk Bah 71 30 30


Lk Bah 71 90 10


Lk Bas 71 70 60


Lk Blood Type


Lk Career Status Bonus Instlmt


Lk CID Class


Lk Citizenship 71 20 10


Lk Civilian Education Certific


Lk Civilian Educ Maj Sub 07


Lk Civilian Education Level 71


Lk Component Code


Lk Contract Legal Agreement


Lk Crisis 43


Lk Custody Status 71 30 40


Lk Dependents 21


Lk Deployment Status 71 10 40


Lk Driver Imp School 71 40 20


Lk Dssn 13


Lk Duty Limit 71 10 10


Lk Duty Status 71 10 20


Lk Ecc Flag


Lk Entry Source 71 10 30


Lk Ethnic Group 71 20 20


Lk Eye Color


Lk Family Sgli Premium 60


Lk Flpp Category


Lk Flpp Pay Level


Lk Foreign Language 03


Lk Ftp Event Level


Lk Ftp Result


Lk Gas Mask Size 71 70 70


Lk Gas Mask Type 71 70 90


Lk Geo Location Codes 08


Lk Geol 40 30


Lk Geol Restr 40 20


Lk Grade


Lk Grade Full Rank 72


Lk Hair Color


Lk Hardship Duty Loc 55


Lk Hardship Duty Pay 55


Lk Helmet Size 71 70 80


Lk High Math 71 20 45


Lk Insignia 40 10


Lk Jmmstabs County Codes 08


Lk Jmmstabs Location Codes 08


Lk Juris


Lk Leave Requested Type


Lk Marital Status 71 30 10


Lk Martial Arts 71 40 40


Lk Mci Course 33


Lk Mgib Election


Lk Mgib Eligibility 71 60 10


Lk Mgib Sr Kick Incent Elig 47


Lk Mgib Sr Kick Incentive


Lk Mgib Sr Kick Incnt Basis


Lk Military Appearance


Lk Military Service School 02 


Lk Mobilization Status 71 20 9


Lk Off Candt Src Cd 71 60 60 


Lk Pay 42


Lk Physical Risk Codes


Lk Population Group 


Lk Prime Pay Status Code 


Lk Privatized Housing 54


Lk Program Enlisted For 06


Lk Race 71 20 80

             Lk Race Aggregate Code 71 20 85


Lk Receive Status


Lk Record Status 71 70 30


Lk Red Relation


Lk Reenlistment Recommendation 36


Lk Religion 71 20 60


Lk Reserve Rec Status 71 80 40


Lk Retirement


Lk Ruc Mcc 01


Lk Scolcd Incpl 71 40 30


Lk Screening Reason 71 70 40


Lk Screening Result 71 70 50


Lk Security Act Req 71 50 10


Lk Security Eligibility Level


Lk Security Investigation Agen


Lk Security Investigation Type


Lk Separation 05


Lk Service Spouse 71 30 20


Lk Sgli Beneficiary


Lk Sgli Pay Designation


Lk Sgli Rate 68


LK Sglv 8286


Lk Special Rank Code 71 10 70


Lk State


Lk Strength Category 71 10 60


Lk Strength Category 71 10 60


Lk Trecon Type


Lk Vision 71 20 65


Lk Water Survival 71 40 10


Lk Weight Control

UD/MIPS Catalog Predefined Filters

xe "UD/MIPS Catalog Predefined Filters"(Listed alphabetically by Filter Name within each folder)

Filter Name
Folder Name

E5 and below
Filters

Enlisted Only
Filters

Female
Filters

Male
Filters

NCO
Filters

NON-NCO
Filters

Officers Only
Filters

Staff NCO
Filters



Child
Reds Person

Death Beneficiary
Reds Person

Father
Reds Person

Guardian
Reds Person

Mother
Reds Person

Next of Kin
Reds Person

Not Notify
Reds Person

Pay Arrears
Reds Person

Spouse
Reds Person

UD/MIPS Catalog Columns

xe "UD/MIPS Catalog Columns"(Listed alphabetically by Column Name)

Column Name
Folder Name

Able Ach Orientation Score
PERSONAL_TEST_INFORMATION

Able Adjustment Score
PERSONAL_TEST_INFORMATION

Able Dependability Score
PERSONAL_TEST_INFORMATION

Able Faking Score
PERSONAL_TEST_INFORMATION

Academic Test Completion Dt
ACADEMIC_TEST_INFO_R148

Academic Test Course Title Nm
ACADEMIC_TEST_INFO_R148

Academic Test Credit Qy
ACADEMIC_TEST_INFO_R148

Academic Test Grade Code
ACADEMIC_TEST_INFO_R148

Academic Test Location Tx
ACADEMIC_TEST_INFO_R148

Accession Date
MEMBER_SERVICE

Accum Eomod Active Duty Dys
RESERVE_INFORMATION

Accumulated Time Lost
MEMBER_SERVICE

Active Duty Flag
MCTFS

Active Duty Flag
TFS_MASTER_VERIFICATION

Active Duty From Date
RESERVE_INFORMATION

Active Duty Mgib Status Code
ENTITLEMENTS_INFORMATION

Active Naval Service Date
MEMBER_SERVICE

Active Res Career Status Cd
MCTFS

Active Service Length
MEMBER_SERVICE

Activity Number Cd
LK_PAY_42

Activity Sub Account Number Cd
LK_PAY_42

Actual Train Completion Date
TRAINING_INFORMATION

Adaptability Test Date
PERSONAL_TEST_INFORMATION

Adaptability Test Form Number
PERSONAL_TEST_INFORMATION

Additional Mos Code
ADDITIONAL_MOS

Additional Mos Seq
ADDITIONAL_MOS

Additional Temporary Mcc
MCTFS

Addl Tad Company Code
MCTFS

Addl Tad Platoon Code
MCTFS

Addl Temp Reporting Unit Code
MCTFS

Addl Temp Reporting Unit Code
TFS_MASTER_VERIFICATION

Addl Temp Reporting Unit Name
MCTFS

Addr1 Dssn Address 1stline
LK_DSSN_13

Addr2 Dssn Address 2ndline
LK_DSSN_13

Address Mailing Condition
MCTFS

Address Mailing Condition Description
LK_ADDRESS_MAILING_CONDITION

Address Status Flag
MCTFS

Address Validation Code
MCTFS

Address Validation Date
MCTFS

Address Validation Description
LK_ADDRESS_VALIDATION_71_70_20

Addressline1
REDS_PERSON

Addressline2
REDS_PERSON

Advance Geo Loc Arrival Dt
MEMBER_COMMAND_INFORMATION

Advance Geographic Loc Code
MEMBER_COMMAND_INFORMATION

Advance Monitor Cmd Arrival Dt
MEMBER_COMMAND_INFORMATION

Advance Monitored Command Code
MEMBER_COMMAND_INFORMATION

Advance Security Deposit Flag
REMARK_FLAGS

Advancement Grade Code
SEPARATION_INFORMATION

Advancement Grade Code Description
SEPARATION_INFORMATION

Advancement Grade Eff Date
SEPARATION_INFORMATION

Aero Med Eval Msg Auth Code
TRAINING_INFORMATION

Aero Med Eval Msg Exp Date
TRAINING_INFORMATION

Aeronautical Design Category
TRAINING_INFORMATION

Aeronautical Waiver Code
TRAINING_INFORMATION

Aeronautical Waiver Year Date
TRAINING_INFORMATION

Afqt Form Number
PERSONAL_TEST_INFORMATION

Afqt Score
PERSONAL_TEST_INFORMATION

Age 24 Quantity
LK_FAMILY_SGLI_PREMIUM_60

Age 29 Quantity
LK_FAMILY_SGLI_PREMIUM_60

Age 34 Quantity 
LK_FAMILY_SGLI_PREMIUM_60

Age 39 Quantity
LK_FAMILY_SGLI_PREMIUM_60

Age 44 Quantity
LK_FAMILY_SGLI_PREMIUM_60

Age 49 Quantity
LK_FAMILY_SGLI_PREMIUM_60

Age 54 Quantity
LK_FAMILY_SGLI_PREMIUM_60

Age 59 Quantity
LK_FAMILY_SGLI_PREMIUM_60

Age 64 Quantity
LK_FAMILY_SGLI_PREMIUM_60

Age 69 Quantity
LK_FAMILY_SGLI_PREMIUM_60

Age 74 Quantity
LK_FAMILY_SGLI_PREMIUM_60

Age 99 Quantity
LK_FAMILY_SGLI_PREMIUM_60

Alpha Country Cd
LK_HARDSHIP_DUTY_PAY_55

Anniversary Date
RESERVE_INFORMATION

Anniversary Date Change Flag
RESERVE_INFORMATION

Anti Terrorism Annual Dt
ANTI_TERRORISM_TRNG_R137

Anti Terrorism Deploy Dt
ANTI_TERRORISM_TRNG_R137

Application Ret Separation Dt
SEPARATION_INFORMATION

Armed Forces Ac Du Base Date
RECEIVING_BARRACKS

Armed Forces Act Du Base Date
MCTFS

Armed Forces Orig Entry Date
PERSONNEL_INFORMATION

Armed Forces Res Medal Date
MCTFS

Armed Services Applicant Total
PERSONAL_TEST_INFORMATION

Army Radio Code Test Date
PERSONAL_TEST_INFORMATION

Army Radio Code Test Score
PERSONAL_TEST_INFORMATION

Army Radio Test Score Code
RECEIVING_BARRACKS

Army Radio Test Score Date
RECEIVING_BARRACKS

Assignment  Unit Code
LK_RUC_MCC_01

Asvab Comp Clerical Qy
PERSONAL_TEST_INFORMATION

Asvab Comp Electronics Qy
PERSONAL_TEST_INFORMATION

Asvab Comp General Tech Qy
PERSONAL_TEST_INFORMATION

Asvab Comp Mech Maint Qy
PERSONAL_TEST_INFORMATION

Asvab Test Date
PERSONAL_TEST_INFORMATION

Asvab Ver Number Id
PERSONAL_TEST_INFORMATION

Aviation Service Entry Date
OFFICER_PERSONAL_INFORMATION

Award Device Type Code
AWARDS_R143

Award Effective Date
AWARDS_R143

Award From Date
AWARDS_R143

Award Precedence ID
LK_AWARDS_ 70

Award Remark Code
AWARDS_R143

Award Remark Code Description
LK_AWARDS_ 70

Award Table Code
AWARDS_R143

Award To Date
AWARDS_R143

B 146 Document Dpi Code
MARTIAL_ARTS_R146

B 146 Document Number Id
MARTIAL_ARTS_R146

B 146 Document Rpt Unit Code
MARTIAL_ARTS_R146

B 146 Document Type Code 
MARTIAL_ARTS_R146

B 146 Document Type Trans Cd
MARTIAL_ARTS_R146

B 146 Document Year Date
MARTIAL_ARTS_R146

B 150 Document Dpi Code
DEPENDENT_INFORMATION_R150

B 150 Document Number Id
DEPENDENT_INFORMATION_R150

B 150 Document Rpt Unit Code
DEPENDENT_INFORMATION_R150

B 150 Document Type Code
DEPENDENT_INFORMATION_R150

B 150 Document Type Trans Cd
DEPENDENT_INFORMATION_R150

B 150 Document Year Date
DEPENDENT_INFORMATION_R150

B 152 Document Dpi Code
PERSONAL_VISION_R152

B 152 Document Number Id
PERSONAL_VISION_R152

B 152 Document Rpt Unit Code
PERSONAL_VISION_R152

B 152 Document Type Code
PERSONAL_VISION_R152

B 152 Document Type Trans Cd
PERSONAL_VISION_R152

B 152 Document Year Date
PERSONAL_VISION_R152

B 153 Document Dpi Code
RECRUIT_IDENTIFICATION_R153

B 153 Document Number Id
RECRUIT_IDENTIFICATION_R153

B 153 Document Rpt Unit Code
RECRUIT_IDENTIFICATION_R153

B 153 Document Type Code
RECRUIT_IDENTIFICATION_R153

B 153 Document Type Trans Cd
RECRUIT_IDENTIFICATION_R153

B 153 Document Year Date
RECRUIT_IDENTIFICATION_R153

B 154 Document Dpi Code
PERSONAL_CLASS_R154

B 154 Document Number Id
PERSONAL_CLASS_R154

B 154 Document Rpt Unit Code
PERSONAL_CLASS_R154

B 154 Document Type Code
PERSONAL_CLASS_R154

B 154 Document Type Trans Cd
PERSONAL_CLASS_R154

B 154 Document Year Date
PERSONAL_CLASS_R154

B 155 Document Dpi Code
RESERVE_ENTRY_LEVEL_R155

B 155 Document Number Id
RESERVE_ENTRY_LEVEL_R155

B 155 Document Rpt Unit Code
RESERVE_ENTRY_LEVEL_R155

B 155 Document Type Code
RESERVE_ENTRY_LEVEL_R155

B 155 Document Type Trans Cd
RESERVE_ENTRY_LEVEL_R155

B 155 Document Year Date
RESERVE_ENTRY_LEVEL_R155

B 156 Document Dpi Code
FUTURE_TRNG_LOCATION_R156

B 156 Document Number Id
FUTURE_TRNG_LOCATION_R156

B 156 Document Rpt Unit Code
FUTURE_TRNG_LOCATION_R156

B 156 Document Type Code
FUTURE_TRNG_LOCATION_R156

B 156 Document Type Trans Cd
FUTURE_TRNG_LOCATION_R156

B 156 Document Year Date
FUTURE_TRNG_LOCATION_R156

B 157 Document Dpi Code
CURRENT_TRNG_LOCATION_R157

B 157 Document Number Id
CURRENT_TRNG_LOCATION_R157

B 157 Document Rpt Unit Code
CURRENT_TRNG_LOCATION_R157

B 157 Document Type Code
CURRENT_TRNG_LOCATION_R157

B 157 Document Type Trans Cd
CURRENT_TRNG_LOCATION_R157

B 157 Document Year Date
CURRENT_TRNG_LOCATION_R157

B 158 Document Dpi Code
RECRUIT_DISTRIBUTION_R158

B 158 Document Number Id
RECRUIT_DISTRIBUTION_R158

B 158 Document Rpt Unit Code
RECRUIT_DISTRIBUTION_R158

B 158 Document Type Code
RECRUIT_DISTRIBUTION_R158

B 158 Document Type Trans Cd
RECRUIT_DISTRIBUTION_R158

B 158 Document Year Date
RECRUIT_DISTRIBUTION_R158

B 159 Document Dpi Code
PERSON_IDENTIFICATION_R159

B 159 Document Number Id
PERSON_IDENTIFICATION_R159

B 159 Document Rpt Unit Code
PERSON_IDENTIFICATION_R159

B 159 Document Type Code
PERSON_IDENTIFICATION_R159

B 159 Document Type Trans Cd
PERSON_IDENTIFICATION_R159

B 159 Document Year Date
PERSON_IDENTIFICATION_R159

Bah Flag Code
REMARK_FLAGS

Bah Quarters Code
MCTFS

Bah Quarters Code Description
LK_BAQ_71_30_30

Bankruptcy File Date
PERSONNEL_INFORMATION

Bankruptcy Flag Code
PERSONNEL_INFORMATION

Bas Code
MCTFS

Bas Code Description
LK_BAS_71_70_60

Billet Description
MCTFS

Billet Mos
MCTFS

Billet Mos Remark Flag
REMARK_FLAGS

Birth County Cd
RECEIVING_BARRACKS

Birth Date
RECEIVING_BARRACKS

Birth State Code
RECEIVING_BARRACKS

Blood Type
MCTFS

Blood Type Description
LK_BLOOD_TYPE

Bonus Program Enl For Cd
MCTFS

Bonus Program Enl For Code
PERSONNEL_INFORMATION

Bst Est Final Score Qy
MCTFS

Bst Est Task Attempted Cd
MCTFS

Bst Est Task Performed Cd
MCTFS

Bst Est Year Date
MCTFS

Cadency Name
RECEIVING_BARRACKS

Career Inactive Duty Pts Eqvil
RESERVE_INFORMATION

Career Sea Duty Audit Rpt Flag
REMARK_FLAGS

Career Sea Duty Flag
REMARK_FLAGS

Career Sea Duty History Flag
REMARK_FLAGS

Career Status Bonus Elect Cd
MEMBER_SERVICE

Career Status Bonus Elect Dt
MEMBER_SERVICE

Career Status Flag
MEMBER_SERVICE

Carried Forward Leave Qy
ENTITLEMENTS_INFORMATION

Category Code
LK_PAY_42

Change Date
LK_DSSN_13

CID Base Location Code
LK_CID_CLASS

CID Base Location Code
RECEIVING_BARRACKS

CID Convene Date
LK_CID_CLASS

CID Description Text
LK_CID_CLASS 

CID Fiscal Year Date
LK_CID_CLASS

CID Fiscal Year Date
RECEIVING_BARRACKS

CID Graduation Date
LK_CID_CLASS

CID Military School Code
LK_CID_CLASS 

CID Military School Code
RECEIVING_BARRACKS

CID Mos Code
LK_CID_CLASS

CID Report Date
LK_CID_CLASS

CID School House Code
LK_CID_CLASS

CID School House Code
RECEIVING_BARRACKS

CID Sponsor Code
LK_CID_CLASS

CID Sponsor Code
RECEIVING_BARRACKS

CID Text
LK_CID_CLASS

CID Text
RECEIVING_BARRACKS

Citizen Cntry Orig Geo Code
MCTFS

Citizen Orig Geo Loc Code
RECEIVING_BARRACKS

Citizenship Code
MCTFS

Citizenship Code
RECEIVING_BARRACKS

Citizenship Code Description
LK_CITIZENSHIP_71_20_10

City Address
MCTFS

Civilian Conviction Code
PERSONAL_CLASS_R154

Civilian Conviction Code
RECEIVING_BARRACKS

Civilian Educ Certificate Cd
CIVILIAN_EDUC_INFO_R147

Civilian Educ Certificate Description
LK_CIVILIAN_ED_CERT71_20_40

Civilian Educ Graduation Cd
CIVILIAN_EDUC_INFO_R147

Civilian Educ Left School Dt
CIVILIAN_EDUC_INFO_R147

Civilian Educ Level Code
CIVILIAN_EDUC_INFO_R147

Civilian Educ Level Code Description
LK_CIVILIAN_ED_LEVEL_71_20_30

Civilian Educ Major Subject Cd
CIVILIAN_EDUC_INFO_R147

Civilian Educ Major Subject Description
LK_CIVILIAN_EDUC_MAJ_SUB_07

Civilian Education Certificate
RECEIVING_BARRACKS

Civilian Education Years Compl
RECEIVING_BARRACKS

Class Complete Date
CURRENT_TRNG_LOCATION_R157

Class Convene Date
CURRENT_TRNG_LOCATION_R157

Class Fiscal Year Date
CURRENT_TRNG_LOCATION_R157

Class Location Code
CURRENT_TRNG_LOCATION_R157

Class Number Identifier
CURRENT_TRNG_LOCATION_R157

Class Number Identifier
RECEIVING_BARRACKS

Class School Code
CURRENT_TRNG_LOCATION_R157

Classified Info Nda Execute Dt
CLASSIFIED_INFO_NDA_R139

Clothing Replacement Allow Dt
ENTITLEMENTS_INFORMATION

Cohesion Future Mc Code
TRAINING_INFORMATION

Cohesion Future Mc Code
UNIT_COHESION_TRACKING_INFORMATION

Cohesion Intended Mos Code
TRAINING_INFORMATION

Cohesion Intended Mos Code
UNIT_COHESION_TRACKING_INFORMATION

Cohesion Number Id
TRAINING_INFORMATION

Cohesion Number Id
UNIT_COHESION_TRACKING_INFORMATION

Cohesion Proj Train Compl Dt
TRAINING_INFORMATION

Cohesion Proj Train Compl Dt
UNIT_COHESION_TRACKING_INFORMATION

Col Grad Code
RECEIVING_BARRACKS

Col Last Attend Dt
RECEIVING_BARRACKS

Col Major Subject Code
RECEIVING_BARRACKS

Col Yrs Attend Qy
RECEIVING_BARRACKS

Cola Barracks No Dependents Flag
REMARK_FLAGS

College Fund Election Eff Dt
ENTITLEMENTS_INFORMATION

College Fund PEF Code
PERSONNEL_INFORMATION

College Fund Prog Enl For Cd
MCTFS

College Ret Date
RECEIVING_BARRACKS

College Return Date
RESERVE_ENTRY_LEVEL_R155

Combat Casualty Status Code
PERSONNEL_INFORMATION

Combat Last Tour Date
MCTFS

Combat Related Disability
SEPARATION_INFORMATION

Combat Service Code 1
MCTFS

Combat Service Code 1 Description
LK_COMBAT_SERVICE_71_10_50

Combat Service Code 2
MCTFS

Combat Service Code 2 Description
LK_COMBAT_SERVICE_71_10_50

Combat Service Code 3
MCTFS

Combat Service Code 3 Description
LK_COMBAT_SERVICE_71_10_50

Combat Service Code 4
MCTFS

Combat Service Code 4 Description
LK_COMBAT_SERVICE_71_10_50

Combat Service Code 5
MCTFS

Combat Service Code 5 Description
LK_COMBAT_SERVICE_71_10_50

Command Dp Installation
MEMBER_COMMAND_INFORMATION

Command Monitored Command Code
MCTFS

Command Monitored Command Name
MCTFS

Command Recruiter Bonus Points
MCTFS

Command Reporting Unit Code
MCTFS

Command Reporting Unit Code
TFS_MASTER_VERIFICATION

Commanding Officer Date
OFFICER_PERSONAL_INFORMATION

Commanding Officer Flag
OFFICER_PERSONAL_INFORMATION

Commission Service Total
OFFICER_PERSONAL_INFORMATION

Company
TRECON_FIELDS

Company Code
RECEIVING_BARRACKS

Component Code
MCTFS

Component Code
RECEIVING_BARRACKS

Component Code
TFS_MASTER_VERIFICATION

Composite Score
PERSONNEL_INFORMATION

Composite Score Computation Dt
PERSONNEL_INFORMATION

Conduct Average Enlistment
PERSONNEL_INFORMATION

Conduct Average Grade
PERSONNEL_INFORMATION

Conduct Average Service
PERSONNEL_INFORMATION

Construct Service
SEPARATION_INFORMATION

Contract Legal Agreement
RESERVE_INFORMATION

Correspondence Course Eff Date
MCI_COURSE_INFO_R120

Correspondence Course Name
MCI_COURSE_INFO_R120

Correspondence Crs Identifier
MCI_COURSE_INFO_R120

Correspondence Crs Identifier Description
LK_MCI_COURSE_33

Correspondence Crs Score Qy
MCI_COURSE_INFO_R120

Correspondence Crs Status Code
MCI_COURSE_INFO_R120

Cost Of Living Allowance Flag
REMARK_FLAGS

County Code
LK_JMMSTABS_COUNTY_CODES_08

County Description
LK_JMMSTABS_COUNTY_CODES_08

Crcr Certification Date
RESERVE_INFORMATION

Crisis Code Description
LK_CRISIS_43

Cruise Service Total
SEPARATION_INFORMATION

Curr Enl Mo
MCTFS

Current Account Standing Amt
ENTITLEMENTS_INFORMATION

Current Account Standing Date
ENTITLEMENTS_INFORMATION

Current Active Duty Began Date
MCTFS

Current City Code
RECEIVING_BARRACKS

Current City Text
RECEIVING_BARRACKS

Current Contract Days Lost
MEMBER_SERVICE

Current County Code
RECEIVING_BARRACKS

Current Days Leave Qy
ENTITLEMENTS_INFORMATION

Current Enlist Length Mth Qy
MCTFS

Current Enlistment Length
MCTFS

Current Extension Length
MEMBER_SERVICE

Current Extension Number
MEMBER_SERVICE

Current Net Rspa As Of Amount
ENTITLEMENTS_INFORMATION

Current Net Rspa As Of Date
ENTITLEMENTS_INFORMATION

Current Pistol Qual Class Cd
MCTFS

Current Pistol Qual Dt
MCTFS

Current Pistol Qual Its1 Cd
TRAINING_INFORMATION

Current Pistol Qual Its2 Cd
TRAINING_INFORMATION

Current Pistol Qual Score Cd
MCTFS

Current Rifle Qual Class Cd
MCTFS

Current Rifle Qual Dt
MCTFS

Current Rifle Qual Its1 Cd
TRAINING_INFORMATION

Current Rifle Qual Its2 Cd
TRAINING_INFORMATION

Current Rifle Qual Its3 Cd
TRAINING_INFORMATION

Current Rifle Qual Its4 Cd
TRAINING_INFORMATION

Current Rifle Qual Score Cd
MCTFS

Current Source Of Entry
MEMBER_SERVICE

Current Source Of Entry Description
LK_ENTRY_SOURCE_71_10_30

Current State Code
RECEIVING_BARRACKS

Current Street Text
RECEIVING_BARRACKS

Current Tour Began Date
RECEIVING_BARRACKS

Current Tour Begin Date
MCTFS

Current Zip Code
RECEIVING_BARRACKS

Custody Status Code
MCTFS

Date Accepted First Commission
OFFICER_PERSONAL_INFORMATION

Date Completed Qualify Service
RESERVE_INFORMATION

Date Enlistment Or Acceptance
MEMBER_SERVICE

Date Initial Entry Reserve
RESERVE_INFORMATION

Date Joined Smcr
RESERVE_INFORMATION

Date Of Birth
MCTFS

Date Of Birth
TFS_MASTER_VERIFICATION

Date Of Last Physical
MCTFS

Date Of Physical Certification
RESERVE_INFORMATION

Date Of Rank First Commission
MCTFS

Date Rank Ldo 1st Commission
OFFICER_PERSONAL_INFORMATION

Date Ret Elig Requirements Met
SEPARATION_INFORMATION

Debt Reason Code
ENTITLEMENTS_INFORMATION

Def Lang Apt Bat Score Code
RECEIVING_BARRACKS

Default Flag Code
LK_FAMILY_SGLI_PREMIUM_60

Defense Debt Manage Sys Flag
SEPARATION_INFORMATION

Defense Lang Apt Bat Date
RECEIVING_BARRACKS

Defense Lang Apt Battery Date
PERSONAL_TEST_INFORMATION

Defense Lang Apt Battery Score
PERSONAL_TEST_INFORMATION

Delayed Checkage Flag
LK_PAY_42

Delflg Delete Flag
LK_PAY_42

Delflg Delete Flag
LK_PRIVATIZED_HOUSING_54

Dental Insurance Flag
REMARK_FLAGS

Deox Acid Test Date
PERSONNEL_INFORMATION

Dependent 1 Birth Date
RECEIVING_BARRACKS

Dependent 1 First Name
RECEIVING_BARRACKS

Dependent 1 Last Name
RECEIVING_BARRACKS

Dependent 1 Middle Name
RECEIVING_BARRACKS

Dependent 1 Relationship Cd
RECEIVING_BARRACKS

Dependent 1 Suffix Cd
RECEIVING_BARRACKS

Dependent 2 Birth Date
RECEIVING_BARRACKS

Dependent 2 First Name
RECEIVING_BARRACKS

Dependent 2 Last Name
RECEIVING_BARRACKS

Dependent 2 Middle Name
RECEIVING_BARRACKS

Dependent 2 Relationship Cd
RECEIVING_BARRACKS

Dependent 2 Suffix Cd
RECEIVING_BARRACKS

Dependent 3 Birth Date
RECEIVING_BARRACKS

Dependent 3 First Name
RECEIVING_BARRACKS

Dependent 3 Last Name
RECEIVING_BARRACKS

Dependent 3 Middle Name
RECEIVING_BARRACKS

Dependent 3 Relationship Cd
RECEIVING_BARRACKS

Dependent 3 Suffix Cd
RECEIVING_BARRACKS

Dependent Certification Code
MCTFS

Dependent Qy
RECEIVING_BARRACKS

Dependents Geo Location Code
MCTFS

Dependents Location Begin Date
MCTFS

Deployed Calculation Date
ENTITLEMENTS_INFORMATION

Deployed Per Diem Credit Flag
REMARK_FLAGS

Deployment Return Date
MCTFS

Deployment Status Code
MCTFS

Depn 1 City Code
RECEIVING_BARRACKS

Depn 1 County Code
RECEIVING_BARRACKS

Depn 1 Gain Date
RECEIVING_BARRACKS

Depn 1 State Code
RECEIVING_BARRACKS

Depn 2 City Code
RECEIVING_BARRACKS

Depn 2 County Code
RECEIVING_BARRACKS

Depn 2 Gain Date
RECEIVING_BARRACKS

Depn 2 State Code
RECEIVING_BARRACKS

Depn 3 City Code
RECEIVING_BARRACKS

Depn 3 County Code
RECEIVING_BARRACKS

Depn 3 Gain Date
RECEIVING_BARRACKS

Depn 3 State Code
RECEIVING_BARRACKS

Depn Info Birth Date
DEPENDENT_INFORMATION_R150

Depn Info City Code
DEPENDENT_INFORMATION_R150

Depn Info County Code
DEPENDENT_INFORMATION_R150

Depn Info First Name
DEPENDENT_INFORMATION_R150

Depn Info Gain Date
DEPENDENT_INFORMATION_R150

Depn Info Last Name
DEPENDENT_INFORMATION_R150

Depn Info Location Code
DEPENDENT_INFORMATION_R150

Depn Info Mid Initial Id
DEPENDENT_INFORMATION_R150

Depn Info Relationship Code
DEPENDENT_INFORMATION_R150

Depn Loc Begin Dt
RECEIVING_BARRACKS

Detached Last Command Date
MEMBER_SERVICE

Disability Retained Date
SEPARATION_INFORMATION

Discharge Flag
SEPARATION_INFORMATION

Disputed Data Date
RESERVE_INFORMATION

Disputed Data Flag
RESERVE_INFORMATION

District Code
RECEIVING_BARRACKS

District Code
RESERVE_INFORMATION

Diving Duty Terminate Date
ENTITLEMENTS_INFORMATION

Docity Dssn City and State
LK_DSSN_13

Dod Code
LK_MOS_04

Dod Train Category Pay Group
RESERVE_INFORMATION

Dodpi Dssn Data Processing Ins
LK_DSSN_13

Doeaf
RECEIVING_BARRACKS

Dojuris Dssn Juristriction
LK_DSSN_13

Dozip Dssn Zip Code
LK_DSSN_13

Draw Case Seq
DRAW_CASE_INFORMATION

Draw Case Signal Code
DRAW_CASE_INFORMATION

Draw Case Term Date
DRAW_CASE_INFORMATION

Drill Aft Annv Prior Year
RESERVE_INFORMATION

Drill Aft Fiscal Prior Year
RESERVE_INFORMATION

Drill Aftp Annv Yr
RESERVE_INFORMATION

Drill Aftp Fiscal Year
RESERVE_INFORMATION

Drill Atp Anniv Year
RESERVE_INFORMATION

Drill Atp Annv Prior Year
RESERVE_INFORMATION

Drill Atp Fiscal Prior Year
RESERVE_INFORMATION

Drill Atp Fiscal Year
RESERVE_INFORMATION

Drill Eiod Annv Prior Year
RESERVE_INFORMATION

Drill Eiod Annv Yr
RESERVE_INFORMATION

Drill Eiod Fiscal Prior Year
RESERVE_INFORMATION

Drill Fiscal Year Eiod
RESERVE_INFORMATION

Drill Reg Annv Prior Year
RESERVE_INFORMATION

Drill Reg Annv Yr
RESERVE_INFORMATION

Drill Reg Fiscal Prior Year
RESERVE_INFORMATION

Drill Reg Fiscal Year
RESERVE_INFORMATION

Drill Rmp Anniv Year
RESERVE_INFORMATION

Drill Rmp Annv Prior Year
RESERVE_INFORMATION

Drill Rmp Fiscal Prior Year
RESERVE_INFORMATION

Drill Rmp Fiscal Year
RESERVE_INFORMATION

Driver Improvement School
MCTFS

Driver Improvement School Description
LK_DRIVER_IMP_SCHOOL_71_40_20

Drop Discharge Unit Date
SEPARATION_INFORMATION

Drug Lecture Training Date
MCTFS

Dssn Disb Station Symbol Nbr
LK_DSSN_13

Duty Limit Code
RECEIVING_BARRACKS

Duty Limit Status Code
MCTFS

Duty Limit Status From Date
MEMBER_COMMAND_INFORMATION

Duty Preference Code
RECEIVING_BARRACKS

Duty Preference First Choice
PERSONNEL_INFORMATION

Duty Preference Second Choice
PERSONNEL_INFORMATION

Duty Preference Third Choice
PERSONNEL_INFORMATION

Duty Status Code
MCTFS

E 138 Document Type Code
WPN_AMMO_EXPLSV_SCRN_R138

E 146 Document Dpi Code
MARTIAL_ARTS_R146

E 146 Document Number Id
MARTIAL_ARTS_R146

E 146 Document Rpt Unit Code
MARTIAL_ARTS_R146

E 146 Document Type Code
MARTIAL_ARTS_R146

E 146 Document Type Trans Cd
MARTIAL_ARTS_R146

E 146 Document Year Date
MARTIAL_ARTS_R146

E 150 Document Dpi Code
DEPENDENT_INFORMATION_R150

E 150 Document Number Id
DEPENDENT_INFORMATION_R150

E 150 Document Rpt Unit Code
DEPENDENT_INFORMATION_R150

E 150 Document Type Code
DEPENDENT_INFORMATION_R150

E 150 Document Type Trans Cd
DEPENDENT_INFORMATION_R150

E 150 Document Year Date
DEPENDENT_INFORMATION_R150

E 152 Document Dpi Code
PERSONAL_VISION_R152

E 152 Document Number Id
PERSONAL_VISION_R152

E 152 Document Rpt Unit Code
PERSONAL_VISION_R152

E 152 Document Type Code
PERSONAL_VISION_R152

E 152 Document Type Trans Cd
PERSONAL_VISION_R152

E 152 Document Year Date
PERSONAL_VISION_R152

E 153 Document Dpi Code
RECRUIT_IDENTIFICATION_R153

E 153 Document Number Id
RECRUIT_IDENTIFICATION_R153

E 153 Document Rpt Unit Code
RECRUIT_IDENTIFICATION_R153

E 153 Document Type Code
RECRUIT_IDENTIFICATION_R153

E 153 Document Type Trans Cd
RECRUIT_IDENTIFICATION_R153

E 153 Document Year Date
RECRUIT_IDENTIFICATION_R153

E 154 Document Dpi Code
PERSONAL_CLASS_R154

E 154 Document Number Id
PERSONAL_CLASS_R154

E 154 Document Rpt Unit Code
PERSONAL_CLASS_R154

E 154 Document Type Code
PERSONAL_CLASS_R154

E 154 Document Type Trans Cd
PERSONAL_CLASS_R154

E 154 Document Year Date
PERSONAL_CLASS_R154

E 155 Document Dpi Code
RESERVE_ENTRY_LEVEL_R155

E 155 Document Number Id
RESERVE_ENTRY_LEVEL_R155

E 155 Document Rpt Unit Code
RESERVE_ENTRY_LEVEL_R155

E 155 Document Type Code
RESERVE_ENTRY_LEVEL_R155

E 155 Document Type Trans Cd
RESERVE_ENTRY_LEVEL_R155

E 155 Document Year Date
RESERVE_ENTRY_LEVEL_R155

E 156 Document Dpi Code
FUTURE_TRNG_LOCATION_R156

E 156 Document Number Id
FUTURE_TRNG_LOCATION_R156

E 156 Document Rpt Unit Code
FUTURE_TRNG_LOCATION_R156

E 156 Document Type Code
FUTURE_TRNG_LOCATION_R156

E 156 Document Type Trans Cd
FUTURE_TRNG_LOCATION_R156

E 156 Document Year Date
FUTURE_TRNG_LOCATION_R156

E 157 Document Dpi Code
CURRENT_TRNG_LOCATION_R157

E 157 Document Number Id
CURRENT_TRNG_LOCATION_R157

E 157 Document Rpt Unit Code
CURRENT_TRNG_LOCATION_R157

E 157 Document Type Code
CURRENT_TRNG_LOCATION_R157

E 157 Document Type Trans Cd
CURRENT_TRNG_LOCATION_R157

E 157 Document Year Date
CURRENT_TRNG_LOCATION_R157

E 158 Document Dpi Code
RECRUIT_DISTRIBUTION_R158

E 158 Document Number Id
RECRUIT_DISTRIBUTION_R158

E 158 Document Rpt Unit Code
RECRUIT_DISTRIBUTION_R158

E 158 Document Type Code
RECRUIT_DISTRIBUTION_R158

E 158 Document Type Trans Cd
RECRUIT_DISTRIBUTION_R158

E 158 Document Year Date
RECRUIT_DISTRIBUTION_R158

E 159 Document Dpi Code
PERSON_IDENTIFICATION_R159

E 159 Document Number Id
PERSON_IDENTIFICATION_R159

E 159 Document Rpt Unit Code
PERSON_IDENTIFICATION_R159

E 159 Document Type Code
PERSON_IDENTIFICATION_R159

E 159 Document Type Trans Cd
PERSON_IDENTIFICATION_R159

E 159 Document Year Date
PERSON_IDENTIFICATION_R159

Ecc Eas Flag
MEMBER_SERVICE

Educational Subject Cd
RECEIVING_BARRACKS

Eft Ind Code
RECEIVING_BARRACKS

Eft Select Indicator Cd
ENTITLEMENTS_INFORMATION

Elec Data Proc Test Date
PERSONAL_TEST_INFORMATION

Elec Data Proc Test Date
RECEIVING_BARRACKS

Elec Data Proc Test Score Cd
RECEIVING_BARRACKS

Electronic Dp Test Score
PERSONAL_TEST_INFORMATION

Electronic Mail Address Text
ELECTRONIC_MAIL_R991

Electronic Mail Effective Date
ELECTRONIC_MAIL_R991

Enlistment Bonus Flag
REMARK_FLAGS

Enlistment Or Acceptance Date
RECEIVING_BARRACKS

Enlistment Referral Quantity
PERSONAL_CLASS_R154

Enlistment Referral Quantity
RECEIVING_BARRACKS

Estimated Arrival Date
MCTFS

Estimated Arrival Date
TFS_MASTER_VERIFICATION

Estimated Departure Date
MCTFS

Ethnic Code
RECEIVING_BARRACKS

Ethnic Group
MCTFS

Ethnic Group Description
LK_ETHNIC_GROUP_71_20_20

Ex Prisoner Of War Code
PERSONNEL_INFORMATION

Excess Aftp Curr Fiscal Yr Qy
RESERVE_INFORMATION

Excess Aftp Prior Fiscal Yr Qy
RESERVE_INFORMATION

Excess Atp Curr Fiscal Yr Qy
RESERVE_INFORMATION

Excess Atp Prior Fiscal Yr Qy
RESERVE_INFORMATION

Excess Drill Curr Fiscal Yr Qy
RESERVE_INFORMATION

Excess Drill Pr Fiscal Yr Qy
RESERVE_INFORMATION

Excess Rmp Curr Fiscal Yr Qy
RESERVE_INFORMATION

Excess Rmp Prior Fiscal Yr Qy
RESERVE_INFORMATION

Expiration Obligated Service
MCTFS

Expiration Obligated Service
RECEIVING_BARRACKS

Expiration Of Active Service
MCTFS

Expiration Of Active Service
RECEIVING_BARRACKS

Expiration Of Current Contract
MCTFS

Expiration Of Current Contract
RECEIVING_BARRACKS

Extension Enlist Effect Date
MEMBER_SERVICE

Eye Color Card Code
LK_EYE_COLOR

Eye Color Code
LK_EYE_COLOR

Eye Color Code
RECEIVING_BARRACKS

Family Separation Allow Flag
REMARK_FLAGS

Family SGLI Code
LK_FAMILY_SGLI_PREMIUM_60

Family SGLI Coverage Amount
LK_FAMILY_SGLI_PREMIUM_60

Fap Company Code
MCTFS

Fap Monitored Command Code
MEMBER_COMMAND_INFORMATION

Fap Platoon Code
MCTFS

Fap Reporting Unit Code
MCTFS

Fap Reporting Unit Code
TFS_MASTER_VERIFICATION

Fap Reporting Unit Name
MCTFS

Field Data
USER_FIELDS

Field Data Type
USER_FIELDS

Field Length
USER_FIELDS

First Depl Ttl Day Waiver Qy
ENTITLEMENTS_INFORMATION

First Deployed Total Day Qy
ENTITLEMENTS_INFORMATION

First Extension Length
MEMBER_SERVICE

First Name
MCTFS

First Name
RECEIVING_BARRACKS

First Name
TFS_MASTER_VERIFICATION

First Normal Pay Day Amount
ENTITLEMENTS_INFORMATION

First Prior Initial
SOC_SEC_ADMIN_INFORMATION

First Six Month Deployed Qy
ENTITLEMENTS_INFORMATION

Fiscal Year Retire Compute Dt
RESERVE_INFORMATION

Fleet Marine Corps Res Date
SEPARATION_INFORMATION

Foreign Lang 1 Code
RECEIVING_BARRACKS

Foreign Lang 2 Code
RECEIVING_BARRACKS

Foreign Lang 3 Code
RECEIVING_BARRACKS

Foreign Lang 4 Code
RECEIVING_BARRACKS

Foreign Lang Category Code
FOREIGN_LANGUAGE_R118

Foreign Lang Pro Pay Level Cd
FOREIGN_LANGUAGE_R118

Foreign Language Code
FOREIGN_LANGUAGE_R118

Foreign Language Code Description
LK_FOREIGN_LANGUAGE_03

Foreign Language Pro Pay Flag
REMARK_FLAGS

Foreign Language Source Code
FOREIGN_LANGUAGE_R118

Former Geo Loc Tour Began Dt
MEMBER_COMMAND_INFORMATION

Former Geographical Location
MEMBER_COMMAND_INFORMATION

Former Monitored Command Code
MEMBER_COMMAND_INFORMATION

Former Percent Disab Eff Date
SEPARATION_INFORMATION

Former Percent Disability
SEPARATION_INFORMATION

Former Reporting Unit Code
MEMBER_COMMAND_INFORMATION

Former Reporting Unit Name
MEMBER_COMMAND_INFORMATION

Former Sat Dp Installation
MEMBER_COMMAND_INFORMATION

Former Vet Admin Code Eff Date
SEPARATION_INFORMATION

Former Veterans Admin Code 1
SEPARATION_INFORMATION

Former Veterans Admin Code 2
SEPARATION_INFORMATION

Former Veterans Admin Code 3
SEPARATION_INFORMATION

Fourth Six Month Deployed Qy
ENTITLEMENTS_INFORMATION

Future Monitored Command Code
MCTFS

Future Monitored Command Code
TFS_MASTER_VERIFICATION

Future Reporting Unit Code
MCTFS

Future Reporting Unit Code
TFS_MASTER_VERIFICATION

Future Sat Dp Installation
MEMBER_COMMAND_INFORMATION

Future Tour Control Factor
MEMBER_COMMAND_INFORMATION

Future Training Mcc Date
RECEIVING_BARRACKS

Future Training Monitor Cmd Cd
RECEIVING_BARRACKS

Future Trng Loc Arrival Date
FUTURE_TRNG_LOCATION_R156

Future Trng Loc Arrival Date
TFS_MASTER_VERIFICATION

Future Trng Loc Mntrd Cmd Cd
FUTURE_TRNG_LOCATION_R156

Future Trng Loc Mntrd Cmd Cd
TFS_MASTER_VERIFICATION

Gas Chamber Training Date
MCTFS

Gas Mask Size
MCTFS

Gas Mask Size
RECEIVING_BARRACKS

Gas Mask Type
MCTFS

Gas Mask Type
RECEIVING_BARRACKS

Gct Arithmetic Composition
PERSONAL_TEST_INFORMATION

Gct Arithmetic Reasoning
PERSONAL_TEST_INFORMATION

Gct Pattern Analysis
PERSONAL_TEST_INFORMATION

Gct Reading Vocabulary
PERSONAL_TEST_INFORMATION

Gct Test Total
PERSONAL_TEST_INFORMATION

Gct Total
PERSONAL_TEST_INFORMATION

Geneva Convention Category CD
LK_GRADE

Geographic Location Began Dt
PERSONNEL_INFORMATION

Geographical Location Code
PERSONNEL_INFORMATION

Geol Effective Date
GOVT_EQUIP_OPR_LICENSE_R141

Geol Expiration Date
GOVT_EQUIP_OPR_LICENSE_R141

Geol Permit Number Identifier
GOVT_EQUIP_OPR_LICENSE_R141

Geol Renewal Expiration Dt
GOVT_EQUIP_OPR_LICENSE_R141

Geol Renewal Issuance Dt
GOVT_EQUIP_OPR_LICENSE_R141

Geol Restriction1 Code
GOVT_EQUIP_OPR_LICENSE_R141

Geol Restriction1 Code Description
LK_GEOL_RESTR_40_20

Geol Restriction2 Code
GOVT_EQUIP_OPR_LICENSE_R141

Geol Restriction2 Code Description
LK_GEOL_RESTR_40_20

Geol Restriction3 Code
GOVT_EQUIP_OPR_LICENSE_R141

Geol Restriction3 Code Description
LK_GEOL_RESTR_40_20

Geol Restriction4 Code
GOVT_EQUIP_OPR_LICENSE_R141

Geol Restriction4 Code Description
LK_GEOL_RESTR_40_20

Geol Restriction5 Code
GOVT_EQUIP_OPR_LICENSE_R141

Geol Restriction5 Code Description
LK_GEOL_RESTR_40_20

Geol Type Code
GOVT_EQUIP_OPR_LICENSE_R141

Geol Type Code Description
LK_GEOL_40_30

Good Conduct Medal Date
MCTFS

Grade Officer Enlstd Sort Key CD
LK_GRADE

Grade Select Officer Enlisted
PERSONNEL_INFORMATION

Grade Select Pay Scale
PERSONNEL_INFORMATION

Grade Select Special Code
PERSONNEL_INFORMATION

Grade Selected For Status
PERSONNEL_INFORMATION

Gt Gct Test Type Flag
PERSONAL_TEST_INFORMATION

Hair Color Card Code
LK_HAIR_COLOR

Hair Color Code
LK_HAIR_COLOR

Hair Color Code
RECEIVING_BARRACKS

Hardship Duty City Id
ENTITLEMENTS_INFORMATION

Hardship Duty Code
ENTITLEMENTS_INFORMATION

Hardship Duty Country Cd
ENTITLEMENTS_INFORMATION

Hardship Duty Country Id
ENTITLEMENTS_INFORMATION

Hardship Duty Pay Flag Code
REMARK_FLAGS

Hardship Duty Type Code
ENTITLEMENTS_INFORMATION

Hdp City Desc Tx
LK_HARDSHIP_DUTY_PAY_55

Hdp Country Desc Tx
LK_HARDSHIP_DUTY_PAY_55

Hdp Eighth Am
LK_HARDSHIP_DUTY_PAY_55

Hdp Eighth Eff Dt
LK_HARDSHIP_DUTY_PAY_55

Hdp Fifth Am
LK_HARDSHIP_DUTY_PAY_55

Hdp Fifth Eff Dt
LK_HARDSHIP_DUTY_PAY_55

Hdp First Am
LK_HARDSHIP_DUTY_PAY_55

Hdp First Eff Dt
LK_HARDSHIP_DUTY_PAY_55

Hdp Fourth Am
LK_HARDSHIP_DUTY_PAY_55

Hdp Fourth Eff Dt
LK_HARDSHIP_DUTY_PAY_55

Hdp New Am
LK_HARDSHIP_DUTY_PAY_55

Hdp New Eff Dt
LK_HARDSHIP_DUTY_PAY_55

Hdp Second Am
LK_HARDSHIP_DUTY_PAY_55

Hdp Second Eff Dt
LK_HARDSHIP_DUTY_PAY_55

Hdp Seventh Am
LK_HARDSHIP_DUTY_PAY_55

Hdp Seventh Eff Dt
LK_HARDSHIP_DUTY_PAY_55

Hdp Sixth Am
LK_HARDSHIP_DUTY_PAY_55

Hdp Sixth Eff Dt
LK_HARDSHIP_DUTY_PAY_55

Hdp Third Am
LK_HARDSHIP_DUTY_PAY_55

Hdp Third Eff Dt
LK_HARDSHIP_DUTY_PAY_55

Height Dimension
RECEIVING_BARRACKS

Helmet Size
MCTFS

Helmet Size
RECEIVING_BARRACKS

Helmet Size Description
LK_HELMET_SIZE_71_70_80

Heroism Pay Flag
REMARK_FLAGS

High Math Achievement Code
PERSONAL_CLASS_R154

High Math Cd
RECEIVING_BARRACKS

High School Last Attended Date
RECEIVING_BARRACKS

Highest Grade Held
SEPARATION_INFORMATION

Highest Grade Held Description
SEPARATION_INFORMATION

Highest Rank Limit
LK_MOS_04

Hiv Iii Education Lecture
MCTFS

Hiv Iii Tested
MCTFS

Home Of Record City Code
MCTFS

Home Of Record City Code
RECEIVING_BARRACKS

Home Of Record County
MCTFS

Home Of Record County Code
RECEIVING_BARRACKS

Home Of Record State Code
RECEIVING_BARRACKS

Home Of Record State Country
MCTFS

Home Of Record Zip Code
RECEIVING_BARRACKS

Home Telephone Number
MCTFS

Home Telephone Number Id
RECEIVING_BARRACKS

Hostile Fire Pay Code
ENTITLEMENTS_INFORMATION

Hostile Fire Pay Flag
REMARK_FLAGS

Hours Intelligence Training
MCTFS

Hqmc Ruc Originating Orders
MEMBER_COMMAND_INFORMATION

Hs Grad Code
RECEIVING_BARRACKS

Hs Yrs Attend Qy
RECEIVING_BARRACKS

Inactive Status List From Date
RESERVE_INFORMATION

Inactive Status List To Date
RESERVE_INFORMATION

Inadequate Quarters Flag
REMARK_FLAGS

Incentive Expiration Date
SEPARATION_INFORMATION

Incentive Pay First Duty
ENTITLEMENTS_INFORMATION

Incentive Pay Second Duty
ENTITLEMENTS_INFORMATION

Incurred Obligated Service Code
OFFICER_PERSONAL_INFORMATION

Incurred Obligated Service Date
OFFICER_PERSONAL_INFORMATION

Individual Loc City Code
MCTFS

Individual Loc County Code
MCTFS

Individual Location Code
MCTFS

Individual Weight Quantity
RECEIVING_BARRACKS

Initial Active Duty Date
RESERVE_INFORMATION

Initials
MCTFS

Initials
TFS_MASTER_VERIFICATION

Insignia Auth Wear Code
INSIGNIA_AUTH_WEAR_R140

Insignia Auth Wear Code Description
LK_INSIGNIA_40_10

Insignia Auth Wear Eff Dt
INSIGNIA_AUTH_WEAR_R140

Insp Inst Ruc Closest Gnd Smcr
RESERVE_INFORMATION

Inspect Inst Ground Identifier
RESERVE_INFORMATION

Insurance Information
RED_INSURANCE

Insurance Seq
RED_INSURANCE

Intended Mos
RECEIVING_BARRACKS

Intended Mos
TRAINING_INFORMATION

Intended Transfer Date
MEMBER_COMMAND_INFORMATION

Inter Sat Dp Installation
MEMBER_COMMAND_INFORMATION

Interim Housing Allowance Flag
REMARK_FLAGS

Interm Monitor Cmd Arrival Dt
MEMBER_COMMAND_INFORMATION

Interm Monitor Cmd Arrival Dt
TFS_MASTER_VERIFICATION

Intermediate Monitor Cmd Code
MEMBER_COMMAND_INFORMATION

Intermediate Monitor Cmd Code
TFS_MASTER_VERIFICATION

Involuntary Extension Flag
MEMBER_SERVICE

Joint Mil Occ Spec Eff Date
OFFICER_PERSONAL_INFORMATION

Joint Mos
OFFICER_PERSONAL_INFORMATION

Last Monitor Cmd Detach Date
MEMBER_COMMAND_INFORMATION

Last Monitored Command Code
MEMBER_COMMAND_INFORMATION

Last Name
MCTFS

Last Name
RECEIVING_BARRACKS

Last Name
TFS_MASTER_VERIFICATION

Last Prior Initial
SOC_SEC_ADMIN_INFORMATION

Last Touched Record Date
LAST_PROCESSING_CYCLE

Last Transfer Action Date
MEMBER_COMMAND_INFORMATION

Last Transfer Report Unit Code
MEMBER_COMMAND_INFORMATION

Last Transfer Type Trans Code
MEMBER_COMMAND_INFORMATION

Last Transfer Unit Diary Date
MEMBER_COMMAND_INFORMATION

Last Transfer Unit Diary Id
MEMBER_COMMAND_INFORMATION

Last Ttc Touched
LAST_PROCESSING_CYCLE

Last Ttc Ud Nr
LAST_PROCESSING_CYCLE

Last Type Trans Action Date
LAST_PROCESSING_CYCLE

Last Type Trans Unit Diary Dt
LAST_PROCESSING_CYCLE

Leadership Training Level Code
TRAINING_INFORMATION

Leadership Training Level Date
MCTFS

Legal Order Former Spouse Flag
PERSONNEL_INFORMATION

Les Extract Flag A
ENTITLEMENTS_INFORMATION

Les Extract Flag M
ENTITLEMENTS_INFORMATION

Les Extract Flag Y
ENTITLEMENTS_INFORMATION

Lineal Control Nbr War Officer
OFFICER_PERSONAL_INFORMATION

Lineal Control Number
OFFICER_PERSONAL_INFORMATION

Lineal Footnote Codes
OFFICER_PERSONAL_INFORMATION

Lineal Precedence Year Date
OFFICER_PERSONAL_INFORMATION

Local School Complete Descr Tx
LOCAL_SCHOOL_COMPLETE_R145

Local School Complete Dt
LOCAL_SCHOOL_COMPLETE_R145

Local School Complete Loc Tx
LOCAL_SCHOOL_COMPLETE_R145

Location Code
LK_JMMSTABS_COUNTY_CODES_08

Location Code
LK_JMMSTABS_LOCATION_CODES_08

Location Description
LK_JMMSTABS_LOCATION_CODES_08

Lowest Rank Limit
LK_MOS_04

Lump Sum Leave Last Elect Date
ENTITLEMENTS_INFORMATION

Lump Sum Leave Total Paid Qy
ENTITLEMENTS_INFORMATION

Magtf Designator
MCTFS

Mand Drill Partic Ext Mth Qy    
RESERVE_INFORMATION

Mand Drill Partic Start Date
RESERVE_INFORMATION

Mand Drill Partic Stop Date
RESERVE_INFORMATION

Mandatory Removal Date
OFFICER_PERSONAL_INFORMATION

Mandatory Ret Separation Date
SEPARATION_INFORMATION

Marital Status Code
MCTFS

Marital Status Code
RECEIVING_BARRACKS

Martd Identifier
RESERVE_INFORMATION

Martd Number        
RESERVE_INFORMATION

Martial Arts Belt Code
MARTIAL_ARTS_R146

Martial Arts Completion Code
MARTIAL_ARTS_R146

Martial Arts Recert Date
MARTIAL_ARTS_R146

Mccf Maximum Amount
ENTITLEMENTS_INFORMATION

Mccf Maximum Amount Code
ENTITLEMENTS_INFORMATION

Member Points Earned Curr Mo
RESERVE_INFORMATION

Mental Incompetency Flag
PERSONNEL_INFORMATION

Meps Afqt Score Code
RECEIVING_BARRACKS

Meps Asvab Comp Cl Score Qy
RECEIVING_BARRACKS

Meps Asvab Comp El Score Qy
RECEIVING_BARRACKS

Meps Asvab Comp Gt Score Qy
RECEIVING_BARRACKS

Meps Asvab Comp Mm Score Qy
RECEIVING_BARRACKS

Meps Asvab Test Date
RECEIVING_BARRACKS

Meps Asvab Test Identifier
RECEIVING_BARRACKS

Meps Monitored Command Code
RECEIVING_BARRACKS

Mgib Sr Kick Incent Basis Cd
RESERVE_INFORMATION

Mgib Sr Kick Incent Begin Dt
RESERVE_INFORMATION

Mgib Sr Kick Incent Bnt Cd
RESERVE_INFORMATION

Mgib Sr Kick Incent Bonus Qy
RESERVE_INFORMATION

Mgib Sr Kick Incent Cd
RESERVE_INFORMATION

Mgib Sr Kick Incent Elig Cd
RESERVE_INFORMATION

Mgib Sr Kick Incent Yr Dt
RESERVE_INFORMATION

Mgib Sr Kick Incnt Elig Eff Dt
RESERVE_INFORMATION

Mia Notify  Fir Phone Prefix Id
RED_MIA_NOTIFY

Mia Notify Addl Dir Tx
RED_MIA_NOTIFY

Mia Notify Addr Direction1 Tx
RED_MIA_NOTIFY

Mia Notify Addr Direction2 Tx
RED_MIA_NOTIFY

Mia Notify Addr Direction3 Tx
RED_MIA_NOTIFY

Mia Notify Addr Direction4 Tx
RED_MIA_NOTIFY

Mia Notify Fir Phone Suffix Id
RED_MIA_NOTIFY

Mia Notify First Name
RED_MIA_NOTIFY

Mia Notify First Phone Area Cd
RED_MIA_NOTIFY

Mia Notify Last Name
RED_MIA_NOTIFY

Mia Notify Mid Initial Id
RED_MIA_NOTIFY

Mia Notify Relationship Cd
RED_MIA_NOTIFY

Mia Notify Sec Phone Area Cd
RED_MIA_NOTIFY

Mia Notify Sec Phone Prefix Id
RED_MIA_NOTIFY

Mia Notify Sec Phone Suffix Id
RED_MIA_NOTIFY

Mid Initials
MCTFS

Mid Initials
TFS_MASTER_VERIFICATION

Middle Name
RECEIVING_BARRACKS

Middle Prior Initial
MCTFS

Military Appearance Assign Qy
MCTFS

Military Appearance Status Cd
MCTFS

Mob Future Mcc Eda
RESERVE_INFORMATION

Mob Satellite Dp Installation
RESERVE_INFORMATION

Mob Special Assign Date From
RESERVE_INFORMATION

Mob Special Assign Date To
RESERVE_INFORMATION

Mob Special Assign Line Number
RESERVE_INFORMATION

Mob Special Mcc
RESERVE_INFORMATION

Mob Special Table Organization
RESERVE_INFORMATION

Mobilization Monitored Cmd Cd
MEMBER_COMMAND_INFORMATION

Mobilization Sia Mcc
RESERVE_INFORMATION

Mobilization Station Mcc Eda
RESERVE_INFORMATION

Mobilization Status
MCTFS

Mobilization Status Description
LK_MOB_STATUS_71_20_90

Mobilization Status Eff Date
MCTFS

Montgomery Gi Bill Flag 
REMARK_FLAGS

Montgomery Gi Bill Start Date 
ENTITLEMENTS_INFORMATION

Montgomery Gi Bill Stop Date
ENTITLEMENTS_INFORMATION

Montgomery Res Gi Bill Flg
REMARK_FLAGS

Mos Additional Assignment Date
ADDITIONAL_MOS

Mos Sex Indicator
LK_MOS_04

Nbr Expert Pistol Qualified Qy
TRAINING_INFORMATION

Nbr Expert Rifle Qualified Qy
TRAINING_INFORMATION

New 24 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

New 29 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

New 34 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

New 39 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

New 44 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

New 49 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

New 54 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

New 59 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

New 64 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

New 69 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

New 74 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

New 99 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

New Premium Effective Date
LK_FAMILY_SGLI_PREMIUM_60

New Reason For Transfer Code
MEMBER_COMMAND_INFORMATION

Nok Directions1
RED_RECORD

Nok Directions2
RED_RECORD

Nok Directions3
RED_RECORD

Nok Directions4
RED_RECORD

Nok Directions5
RED_RECORD

Not Recommended For Promotion
PERSONNEL_INFORMATION

Number Of Dependents
MCTFS

Numeric City Cd
LK_HARDSHIP_DUTY_PAY_55

Numeric Country Cd
LK_HARDSHIP_DUTY_PAY_55

Off Duty Educ Crs Compl Date
OFF_DUTY_EDUCATION_R121

Off Duty Educ Crs Credit Qy
OFF_DUTY_EDUCATION_R121

Off Duty Educ Crs Grade Code
OFF_DUTY_EDUCATION_R121

Off Duty Educ Crs Location Tx
OFF_DUTY_EDUCATION_R121

Off Duty Educ Crs Title Name
OFF_DUTY_EDUCATION_R121

Officer Active Duty Base Date
OFFICER_PERSONAL_INFORMATION

Officer Candidate Cd
OFFICER_PERSONAL_INFORMATION

Officer Candidate Cd Description
LK_OFF_CANDT_SRC_CD_71_60_60

Officer Candidate Eff Dt
OFFICER_PERSONAL_INFORMATION

Officer Enlisted Flag
LK_PAY_42

Officer Service From Date
OFFICER_PERSONAL_INFORMATION

Officer Service To Date
OFFICER_PERSONAL_INFORMATION

Old 24 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

Old 29 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

Old 34 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

Old 39 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

Old 44 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

Old 49 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

Old 54 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

Old 59 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

Old 64 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

Old 69 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

Old 74 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

Old 99 Premium Amount
LK_FAMILY_SGLI_PREMIUM_60

Old Premium Effective Date
LK_FAMILY_SGLI_PREMIUM_60

Old Reason For Transfer Code
MEMBER_COMMAND_INFORMATION

Oper Fly Gate First Year Dt
OFFICER_PERSONAL_INFORMATION

Oper Fly Gate Second Year Dt
OFFICER_PERSONAL_INFORMATION

Operation Fly Computation Date
OFFICER_PERSONAL_INFORMATION

Operation Fly Gate1
MCTFS

Operation Fly Time Start Date
OFFICER_PERSONAL_INFORMATION

Operation Fly Time Stop Date
OFFICER_PERSONAL_INFORMATION

Operational Fly Gate2
OFFICER_PERSONAL_INFORMATION

Operational Fly Time Base Date
OFFICER_PERSONAL_INFORMATION

Operational Flying Time Total
OFFICER_PERSONAL_INFORMATION

Orders Transaction Date
MEMBER_COMMAND_INFORMATION

Orig Vet Educ Benefit Pgm Cd
ENTITLEMENTS_INFORMATION

Other Appropriate Prior Year
RESERVE_INFORMATION

Other Associate Prior Year
RESERVE_INFORMATION

Other Ein Prior Year
RESERVE_INFORMATION

Other Mtu Prior Year
RESERVE_INFORMATION

Other Prior Annv Corresp Pts
RESERVE_INFORMATION

Other Prior Year
RESERVE_INFORMATION

Other Pts Approp Curr Annv Yr
RESERVE_INFORMATION

Other Pts Assoc Curr Annv Yr
RESERVE_INFORMATION

Other Pts Corresp Curr Annv Yr
RESERVE_INFORMATION

Other Pts Earned Curr Annv Yr
RESERVE_INFORMATION

Other Pts Ein Curr Annv Yr
RESERVE_INFORMATION

Other Pts Mtu Curr Annv Yr
RESERVE_INFORMATION

Out Balance Cat Months Qy
ENTITLEMENTS_INFORMATION

Out Balance Months Qy
ENTITLEMENTS_INFORMATION

Overseas Control Date
MCTFS

Overseas Extension Pay Flag
REMARK_FLAGS

Overseas Housing Allowance Flg
REMARK_FLAGS

Parent Sat Dp Installation
MEMBER_COMMAND_INFORMATION

Pay Delete Suspense Code
SEPARATION_INFORMATION

Pay Delete Suspense Eff Date
SEPARATION_INFORMATION

Pay Entry Base Date
MCTFS

Pay Entry Base Date
RECEIVING_BARRACKS

Pay Flag
LK_DSSN_13

Pay Group Code
ENTITLEMENTS_INFORMATION

Percent Disability
SEPARATION_INFORMATION

Percent Disability Eff Date
SEPARATION_INFORMATION

Perm Change Of Station Code
MEMBER_COMMAND_INFORMATION

Permanent Grade
PERSONNEL_INFORMATION

Permanent Grade Description
LK_GRADE

Permanent Rank Date
PERSONNEL_INFORMATION

Pers Tempo Track Act Rtrn Dt
PERS_TEMPO_TRACK_R112

Pers Tempo Track Adt Credit Cd
PERS_TEMPO_TRACK_R112

Pers Tempo Track Branch Srv Cd
PERS_TEMPO_TRACK_R112

Pers Tempo Track Estm Rtrn Dt
PERS_TEMPO_TRACK_R112

Pers Tempo Track Gate Four Dt
PERS_TEMPO_TRACK_R112

Pers Tempo Track Gate One Dt
PERS_TEMPO_TRACK_R112

Pers Tempo Track Gate Three Dt
PERS_TEMPO_TRACK_R112

Pers Tempo Track Gate Two Dt
PERS_TEMPO_TRACK_R112

Pers Tempo Track Nbr Day Qy
PERS_TEMPO_TRACK_R112

Pers Tempo Track Rpt Unit Cd
PERS_TEMPO_TRACK_R112

Pers Tempo Track Start Date
PERS_TEMPO_TRACK_R112

Pers Tempo Track Type Cd
PERS_TEMPO_TRACK_R112

Pers Vis Acuity Code
PERSONAL_VISION_R152

Pers Vis Left Eye Corr Qy
PERSONAL_VISION_R152

Pers Vis Left Eye Uncorr Qy
PERSONAL_VISION_R152

Pers Vis Right Eye Corr Qy
PERSONAL_VISION_R152

Pers Vis Right Eye Uncorr Qy
PERSONAL_VISION_R152

Person Cadency Code
PERSON_EXPANDED_NAME_R151

Person Eye Color Text
PERSON_IDENTIFICATION_R159

Person First Name
PERSON_EXPANDED_NAME_R151

Person Hair Color Text
PERSON_IDENTIFICATION_R159

Person Hand Preference Code
PERSON_IDENTIFICATION_R159

Person Hand Preference Code
RECEIVING_BARRACKS

Person Height Quantity
PERSON_IDENTIFICATION_R159

Person Last Name
PERSON_EXPANDED_NAME_R151

Person Middle Name
PERSON_EXPANDED_NAME_R151

Person Name
REDS_PERSON

Person Seq
REDS_PERSON

Person Type Code
REDS_PERSON

Person Type Description
LK_RED_PERSON_TYPE

Person Weight
PERSON_IDENTIFICATION_R159

Phone
REDS_PERSON

Physical Fitness Class Cd
MCTFS

Physical Fitness Score Qy
MCTFS

Physical Fitness Semi Ann Code
MCTFS

Physical Fitness Test Dt
MCTFS

Physical Risk Code
RESERVE_INFORMATION

Pilot Designation Effect Date
OFFICER_PERSONAL_INFORMATION

Pistol Distinguished Date
TRAINING_INFORMATION

Pistol Exception Code
TRAINING_INFORMATION

Pistol Exception Date
TRAINING_INFORMATION

Pistol Exception Pet Date
TRAINING_INFORMATION

Place Of Birth
MCTFS

Place Of Birth County
MCTFS

Planned Character Of Service
SEPARATION_INFORMATION

Planned Detachment Date
SEPARATION_INFORMATION

Planned Reenl Ext Retire Date
MEMBER_SERVICE

Planned Reenl Ext Retire Flag
MEMBER_SERVICE

Planned Sep Program Designator
SEPARATION_INFORMATION

Platoon
TRECON_FIELDS

Platoon Number
RECEIVING_BARRACKS

Population Group Code
TRECON_FIELDS

Population Group Code Description
LK_POPULATION_GROUP

Pres Grade Special Rank Code
PERSONNEL_INFORMATION

Present Grade Code
MCTFS

Present Grade Code
RECEIVING_BARRACKS

Present Grade Code
TFS_MASTER_VERIFICATION

Present Grade Code Description
LK_GRADE

Present Grade Effective Date
MCTFS

Present Grade Rank Date
RECEIVING_BARRACKS

Present Monitored Command Code
MCTFS

Present Monitored Command Code
RECEIVING_BARRACKS

Present Monitored Command Code
TFS_MASTER_VERIFICATION

Present Rank Date
MCTFS

Present Reporting Unit Code
MCTFS

Present Reporting Unit Code
TFS_MASTER_VERIFICATION

Present Reporting Unit Name
MCTFS

Present Sat Dp Installation
MEMBER_COMMAND_INFORMATION

Present Tour Control Factor
MEMBER_COMMAND_INFORMATION

Present Unit Company Code
MCTFS

Present Unit Joined Date
MCTFS

Present Unit Platoon Code
MCTFS

Primary Mos Assignment Dt
MCTFS

Primary Mos Code
MCTFS

Primary Mos Code
RECEIVING_BARRACKS

Primary Retire Sep Law Cd
SEPARATION_INFORMATION

Prime Disb Office Dssn Code
MEMBER_COMMAND_INFORMATION

Prime Disb Office Dssn Code Description
LK_DSSN_13

Prime Pay Opt Elect From Date
ENTITLEMENTS_INFORMATION

Prime Pay Status Code
ENTITLEMENTS_INFORMATION

Prime Pay Status Code Description
LK_PRIME_PAY_STATUS_CODE

Prime Pay Status From Date
ENTITLEMENTS_INFORMATION

Prime Pay Status From Hour Tm
ENTITLEMENTS_INFORMATION

Prime Poe Check Cash Code
ENTITLEMENTS_INFORMATION

Prime Poe Code
ENTITLEMENTS_INFORMATION

Prior Account Standing Amt
ENTITLEMENTS_INFORMATION

Prior Account Standing Date
ENTITLEMENTS_INFORMATION

Prior Anniv Retmnt Pt Corr Flg
RESERVE_INFORMATION

Prior Contract Expiration Date
RESERVE_INFORMATION

Prior Enl Acceptance Date
MEMBER_SERVICE

Prior Phys Fitness Class Cd
TRAINING_INFORMATION

Prior Phys Fitness Score Qy
TRAINING_INFORMATION

Prior Phys Fitness Semi Ann Cd
TRAINING_INFORMATION

Prior Phys Fitness Test Dt
TRAINING_INFORMATION

Prior Pistol Qual Class Cd
TRAINING_INFORMATION

Prior Pistol Qual Dt
TRAINING_INFORMATION

Prior Pistol Qual Its1 Cd
TRAINING_INFORMATION

Prior Pistol Qual Its2 Cd
TRAINING_INFORMATION

Prior Pistol Qual Score Cd
TRAINING_INFORMATION

Prior Rifle Qual Class Cd
TRAINING_INFORMATION

Prior Rifle Qual Dt
TRAINING_INFORMATION

Prior Rifle Qual Its1 Cd
TRAINING_INFORMATION

Prior Rifle Qual Its2 Cd
TRAINING_INFORMATION

Prior Rifle Qual Its3 Cd
TRAINING_INFORMATION

Prior Rifle Qual Its4 Cd
TRAINING_INFORMATION

Prior Rifle Qual Score Cd
TRAINING_INFORMATION

Prior Service Code
RECEIVING_BARRACKS

Prior Service Entry Date
RECEIVING_BARRACKS

Prior Ssn
SOC_SEC_ADMIN_INFORMATION

Privatized Hsg Account Nbr Id
LK_PRIVATIZED_HOUSING_54

Privatized Hsg Account Type Cd
LK_PRIVATIZED_HOUSING_54

Privatized Hsg City Tx
LK_PRIVATIZED_HOUSING_54

Privatized Hsg Company Name
LK_PRIVATIZED_HOUSING_54

Privatized Hsg Rtn Id
LK_PRIVATIZED_HOUSING_54

Privatized Hsg State Cd
LK_PRIVATIZED_HOUSING_54

Privatized Hsg Street Addr Tx
LK_PRIVATIZED_HOUSING_54

Privatized Hsg Unit City Tx
LK_PRIVATIZED_HOUSING_54

Privatized Hsg Unit Code
LK_PRIVATIZED_HOUSING_54

Privatized Hsg Unit State Cd
LK_PRIVATIZED_HOUSING_54

Privatized Hsg Zip Code
LK_PRIVATIZED_HOUSING_54

Proficiency Average Enlistment
PERSONNEL_INFORMATION

Proficiency Average Grade
PERSONNEL_INFORMATION

Proficiency Average Service
PERSONNEL_INFORMATION

Proficiency Pay Code
MCTFS

Proficiency Pay Flag
REMARK_FLAGS

Program Element Number
MEMBER_COMMAND_INFORMATION

Program Enlisted For
MCTFS

Program Enlisted For Bonus Cd
RECEIVING_BARRACKS

Program Enlisted For Code
RECEIVING_BARRACKS

Program Enlisted For Colleg Cd
RECEIVING_BARRACKS

Program Enlisted For Type Cd
LK_PROGRAM_ENLISTED_FOR_06

Projected Active Duty Date
RECEIVING_BARRACKS

Projected Train Complete Date
MCTFS

Projected Train Complete Date
RECEIVING_BARRACKS

Prom Restricted Status Cd
PERSONNEL_INFORMATION

Prom Restricted Term Dt
PERSONNEL_INFORMATION

Qa Report Date
SEPARATION_INFORMATION

Quarters Credit Flag Code
REMARK_FLAGS

Quota Mil Occupation Spec Cd
RECRUIT_DISTRIBUTION_R158

Quota Serial Number Id
RECEIVING_BARRACKS

Race
MCTFS

Race Aggregate Code
MCTFS

Race Aggregate Code
RECEIVING_BARRACKS

Race Code
RECEIVING_BARRACKS

Rd 1mos
RECEIVING_BARRACKS

Reason Transferred From Smcr
RESERVE_INFORMATION

Rec Length
LAST_PROCESSING_CYCLE

Rec Station Code
RECEIVING_BARRACKS

Receive Status Code
RECEIVING_BARRACKS

Record Identifier
LK_RUC_MCC_01

Record Status Code
MCTFS

Record Status Code
TFS_MASTER_VERIFICATION

Recruit Dist Class Fisc Yr Dt
RECRUIT_DISTRIBUTION_R158

Recruit Dist Class Location Cd
RECRUIT_DISTRIBUTION_R158

Recruit Dist Class Number Id
RECRUIT_DISTRIBUTION_R158

Recruit Dist Class School Cd
RECRUIT_DISTRIBUTION_R158

Recruit Enlistment Reserve Mcc
RECEIVING_BARRACKS

Recruit Security Eligible Cd
PERSONAL_CLASS_R154

Recruit Security Eligiblty Cd
RECEIVING_BARRACKS

Recruit Station Mntrd Cmd Cd
RECRUIT_IDENTIFICATION_R153

Recruit Substation Code
RECRUIT_IDENTIFICATION_R153

Recruiter Assist Days Auth Qy
RECRUIT_DISTRIBUTION_R158

Recruiting Sub Station Code
RECEIVING_BARRACKS

Reenlist Recommendation Code
MEMBER_SERVICE

Reenlistment Bonus Type
MEMBER_SERVICE

Reenlistment Recommendation Description
LK_REENLISTMENT_RECOMMEND_36

Reg Drill Authorized Fiscal Yr
RESERVE_INFORMATION

Regular Reenlist Bonus Flag
REMARK_FLAGS

Relationship
REDS_PERSON

Religion
MCTFS

Religion Code
RECEIVING_BARRACKS

Religion Description
LK_RELIGION_71_20_60

Remark B Date Rmk 146
MARTIAL_ARTS_R146

Remark B Date Rmk 150
DEPENDENT_INFORMATION_R150

Remark B Date Rmk 152
PERSONAL_VISION_R152

Remark B Date Rmk 153
RECRUIT_IDENTIFICATION_R153

Remark B Date Rmk 154
PERSONAL_CLASS_R154

Remark B Date Rmk 155
RESERVE_ENTRY_LEVEL_R155

Remark B Date Rmk 156
FUTURE_TRNG_LOCATION_R156

Remark B Date Rmk 157
CURRENT_TRNG_LOCATION_R157

Remark B Date Rmk 158
RECRUIT_DISTRIBUTION_R158

Remark B Date Rmk 159
PERSON_IDENTIFICATION_R159

Remark B Date Rmk 947
ENTITLEMENTS_INFORMATION

Remark E Date Rmk 146
MARTIAL_ARTS_R146

Remark E Date Rmk 150
DEPENDENT_INFORMATION_R150

Remark E Date Rmk 152
PERSONAL_VISION_R152

Remark E Date Rmk 153
RECRUIT_IDENTIFICATION_R153

Remark E Date Rmk 154
PERSONAL_CLASS_R154

Remark E Date Rmk 155
RESERVE_ENTRY_LEVEL_R155

Remark E Date Rmk 156
FUTURE_TRNG_LOCATION_R156

Remark E Date Rmk 157
CURRENT_TRNG_LOCATION_R157

Remark E Date Rmk 158
RECRUIT_DISTRIBUTION_R158

Remark E Date Rmk 159
PERSON_IDENTIFICATION_R159

Remark E Date Rmk 947
ENTITLEMENTS_INFORMATION

Remark Kill Date Rmk 118
FOREIGN_LANGUAGE_R118

Remark Kill Date Rmk 120
MCI_COURSE_INFO_R120

Remark Kill Date Rmk 121
OFF_DUTY_EDUCATION_R121

Remark Kill Date Rmk 136
SCHOOL_SPECIAL_SKILL_R136

Remark Kill Date Rmk 137
ANTI_TERRORISM_TRNG_R137

Remark Kill Date Rmk 138
WPN_AMMO_EXPLSV_SCRN_R138

Remark Kill Date Rmk 139
CLASSIFIED_INFO_NDA_R139

Remark Kill Date Rmk 140
INSIGNIA_AUTH_WEAR_R140

Remark Kill Date Rmk 141
GOVT_EQUIP_OPR_LICENSE_R141

Remark Kill Date Rmk 143
AWARDS_R143

Remark Kill Date Rmk 145
LOCAL_SCHOOL_COMPLETE_R145

Remark Kill Date Rmk 146
MARTIAL_ARTS_R146

Remark Kill Date Rmk 147
CIVILIAN_EDUC_INFO_R147

Remark Kill Date Rmk 148
ACADEMIC_TEST_INFO_R148

Remark Kill Date Rmk 150
DEPENDENT_INFORMATION_R150

Remark Kill Date Rmk 152
PERSONAL_VISION_R152

Remark Kill Date Rmk 153
RECRUIT_IDENTIFICATION_R153

Remark Kill Date Rmk 154
PERSONAL_CLASS_R154

Remark Kill Date Rmk 155
RESERVE_ENTRY_LEVEL_R155

Remark Kill Date Rmk 156
FUTURE_TRNG_LOCATION_R156

Remark Kill Date Rmk 157
CURRENT_TRNG_LOCATION_R157

Remark Kill Date Rmk 158
RECRUIT_DISTRIBUTION_R158

Remark Kill Date Rmk 159
PERSON_IDENTIFICATION_R159

Remark Sequence Number Rmk 120
MCI_COURSE_INFO_R120

Remark Sequence Number Rmk 121
OFF_DUTY_EDUCATION_R121

Remark Sequence Number Rmk 136
SCHOOL_SPECIAL_SKILL_R136

Remark Sequence Number Rmk 137
ANTI_TERRORISM_TRNG_R137

Remark Sequence Number Rmk 138
WPN_AMMO_EXPLSV_SCRN_R138

Remark Sequence Number Rmk 139
CLASSIFIED_INFO_NDA_R139

Remark Sequence Number Rmk 140
INSIGNIA_AUTH_WEAR_R140

Remark Sequence Number Rmk 141
GOVT_EQUIP_OPR_LICENSE_R141

Remark Sequence Number Rmk 143
AWARDS_R143

Remark Sequence Number Rmk 144
ADDITIONAL_MOS

Remark Sequence Number Rmk 145
LOCAL_SCHOOL_COMPLETE_R145

Remark Sequence Number Rmk 146
MARTIAL_ARTS_R146

Remark Sequence Number Rmk 147
CIVILIAN_EDUC_INFO_R147

Remark Sequence Number Rmk 148
ACADEMIC_TEST_INFO_R148

Remark Sequence Number Rmk 150
DEPENDENT_INFORMATION_R150

Remark Sequence Number Rmk 152
PERSONAL_VISION_R152

Remark Sequence Number Rmk 153
RECRUIT_IDENTIFICATION_R153

Remark Sequence Number Rmk 154
PERSONAL_CLASS_R154

Remark Sequence Number Rmk 155
RESERVE_ENTRY_LEVEL_R155

Remark Sequence Number Rmk 156
FUTURE_TRNG_LOCATION_R156

Remark Sequence Number Rmk 157
CURRENT_TRNG_LOCATION_R157

Remark Sequence Number Rmk 158
RECRUIT_DISTRIBUTION_R158

Remark Sequence Number Rmk 159
PERSON_IDENTIFICATION_R159

Reporting Unit Code
LK_RUC_MCC_01

Request Split Pay Amount
ENTITLEMENTS_INFORMATION

Request Split Pay Eff Date
ENTITLEMENTS_INFORMATION

Res Absence Fr Idt Rmk Flag
RESERVE_INFORMATION

Res Mgib Reenl Ext Flag
RESERVE_INFORMATION

Res Mgib Reserve Gi Bill Cd
RESERVE_INFORMATION

Res Mgib Start Date
RESERVE_INFORMATION

Res Mgib Term Date
RESERVE_INFORMATION

Res Pay Status Code
RESERVE_INFORMATION

Res Special Sep Install Date
RESERVE_INFORMATION

Res Special Sep Install Number
RESERVE_INFORMATION

Reserve Active Duty Flag
MCTFS

Reserve Bonus Control Number
RECEIVING_BARRACKS

Reserve Component Code
MCTFS

Reserve Component Code
RECEIVING_BARRACKS

Reserve Component Code
TFS_MASTER_VERIFICATION

Reserve Drill Account Flag
REMARK_FLAGS

Reserve Entitlement Flag
REMARK_FLAGS

Reserve Exp Current Contract
MCTFS

Reserve Exp Current Contract
RECEIVING_BARRACKS

Reserve Monitored Command Code
RESERVE_INFORMATION

Reserve Monitored Command Code
TFS_MASTER_VERIFICATION

Reserve Pay Change Flag
RESERVE_INFORMATION

Reserve Pay Extract Flag
RESERVE_INFORMATION

Reserve Pay Hold Flag
RESERVE_INFORMATION

Reserve Record Status Code
LAST_PROCESSING_CYCLE

Reserve Reporting Unit Code
MEMBER_COMMAND_INFORMATION

Reserve Reporting Unit Code
RECEIVING_BARRACKS

Reserve Reporting Unit Name
MEMBER_COMMAND_INFORMATION

Reserve Retire Credit Flag
RESERVE_INFORMATION

Reserve Retirement Flag
RESERVE_INFORMATION

Reserve Token Payment Flag
REMARK_FLAGS

Reserve Tsp Election Flag Code
REMARK_FLAGS

Reserve Tsp Payment Flag Code
REMARK_FLAGS

Reserve Unit Company Code
MEMBER_COMMAND_INFORMATION

Reserve Unit Join Date
RESERVE_INFORMATION

Reserve Unit Platoon Code
MEMBER_COMMAND_INFORMATION

Responsibility Center Number
MEMBER_COMMAND_INFORMATION

Retired Category Code
SEPARATION_INFORMATION

Retired Functional Acct Nbr
SEPARATION_INFORMATION

Retired Pay Grade Code
SEPARATION_INFORMATION

Retired Pay Grade Code Description
LK_GRADE

Retired Pay Grade Eff Date
SEPARATION_INFORMATION

Retirement Date
SEPARATION_INFORMATION

Retirement Separation Auth
SEPARATION_INFORMATION

Rifle Distinguished Date
TRAINING_INFORMATION

Rifle Exception Code
TRAINING_INFORMATION

Rifle Exception Date
TRAINING_INFORMATION

Rifle Exception Pet Date
TRAINING_INFORMATION

Rifle Field Fire Its10 Scr Cd
TRAINING_INFORMATION

Rifle Field Fire Its11 Scr Cd
TRAINING_INFORMATION

Rifle Field Fire Its6 Score Cd
TRAINING_INFORMATION

Rifle Field Fire Its7 Score Cd
TRAINING_INFORMATION

Rifle Field Fire Its8 Score Cd
TRAINING_INFORMATION

Rifle Field Fire Its9 Score Cd
TRAINING_INFORMATION

Rifle Field Firing Qual Dt
TRAINING_INFORMATION

Rifle Field Firing Weapon Cd
TRAINING_INFORMATION

Rifle Fld Fire Its10 Mst Lv Cd
TRAINING_INFORMATION

Rifle Fld Fire Its11 Mst Lv Cd
TRAINING_INFORMATION

Rifle Fld Fire Its6 Mstr Lv Cd
TRAINING_INFORMATION

Rifle Fld Fire Its7 Mstr Lv Cd
TRAINING_INFORMATION

Rifle Fld Fire Its8 Mstr Lv Cd
TRAINING_INFORMATION

Rifle Fld Fire Its9 Mstr Lv Cd
TRAINING_INFORMATION

Rotation Tour Date
MCTFS

School Convene Date
RECEIVING_BARRACKS

School Special Skill Code
SCHOOL_SPECIAL_SKILL_R136

School Special Skill Code Description
SCHOOL_SPECIAL_SKILL_R136

School Special Skill Status Cd
SCHOOL_SPECIAL_SKILL_R136

School Special Skill Status Cd Description
SCHOOL_SPECIAL_SKILL_R136

School Special Skill Year Dt
SCHOOL_SPECIAL_SKILL_R136

Screening Date
RESERVE_INFORMATION

Screening Reason
RESERVE_INFORMATION

Screening Reason Description
LK_SCREENING_REASON_71_70_40

Screening Result
RESERVE_INFORMATION

Screening Result Description
LK_SCREENING_RESULT_71_70_50

Second Depl Ttl Day Waiver Qy
ENTITLEMENTS_INFORMATION

Second Deployed Total Day Qy
ENTITLEMENTS_INFORMATION

Second Normal Pay Day Amount
ENTITLEMENTS_INFORMATION

Second Six Month Deployed Qy
ENTITLEMENTS_INFORMATION

Second Tad Sat Dp Installation
MEMBER_COMMAND_INFORMATION

Secondary Retire Sep Law Cd
SEPARATION_INFORMATION

Security Action Request Code
MCTFS

Security Clear Curr Awd Date
PERSONNEL_INFORMATION

Security Clearance Held
PERSONNEL_INFORMATION

Security Eligibility Code
PERSONNEL_INFORMATION

Security Invest Agency Code
PERSONNEL_INFORMATION

Security Invest Complete Date
PERSONNEL_INFORMATION

Security Lecture Training Dt
MCTFS

Security Type Invest Code
PERSONNEL_INFORMATION

Selected Grade Date
PERSONNEL_INFORMATION

Selective Reenlistment Bonus Z
MEMBER_SERVICE

Self Education Bonus Points
TRAINING_INFORMATION

Self Professed Language Code
SELF_PROFESSED_LANGUAGE_CODES

Self Professed Language Seq
SELF_PROFESSED_LANGUAGE_CODES

Selres Transition Program Code
RESERVE_INFORMATION

Separation Code
SEPARATION_INFORMATION

Separation Code Description
LK_SEPARATION_05

Separation Document Type
SEPARATION_INFORMATION

Separation Incentive Code
SEPARATION_INFORMATION

Separation Report Flag
SEPARATION_INFORMATION

Separation Reporting Unit Code
SEPARATION_INFORMATION

Separation Reporting Unit Name
SEPARATION_INFORMATION

Serv Grp Life Insurance Code
PERSONNEL_INFORMATION

Service Academy Months Attend
OFFICER_PERSONAL_INFORMATION

Service Medical Rec Book Flag
RESERVE_INFORMATION

Service Spouse Code
MCTFS

Service Spouse Effective Date
MCTFS

Service Spouse Ssn
MCTFS

Sex
MCTFS

Sex
RECEIVING_BARRACKS

Sex
TFS_MASTER_VERIFICATION

Sgli Beneficiary Code
RED_RECORD

Sgli Code
LK_SGLI_RATE_68

Sgli Coverage
LK_SGLI_RATE_68

Sgli Full New Ed
LK_SGLI_RATE_68

Sgli Full New Rate
LK_SGLI_RATE_68

Sgli Full Old Ed
LK_SGLI_RATE_68

Sgli Full Old Rate
LK_SGLI_RATE_68

Sgli Partial New Ed
LK_SGLI_RATE_68

Sgli Partial New Rate
LK_SGLI_RATE_68

Sgli Partial Old Ed
LK_SGLI_RATE_68

Sgli Partial Old Rate
LK_SGLI_RATE_68

Sgli Pay Designation Code
RED_RECORD

Sgli Pay Designation Description
LK_SGLI_PAY_DESIGNATION

Sgli Pay Election Code
RED_RECORD

Ship Date
RECEIVING_BARRACKS

Skill Level Listening Code
FOREIGN_LANGUAGE_R118

Skill Level Reading Code
FOREIGN_LANGUAGE_R118

Skill Level Speaking Code
FOREIGN_LANGUAGE_R118

Smcr Medal Date
MCTFS

Soc Sec Admin Validation Dt
SOC_SEC_ADMIN_INFORMATION

Social Security Number
RECEIVING_BARRACKS

Source Initial Entry Mil Ser
MEMBER_SERVICE

Source Of Entry Code
RECEIVING_BARRACKS

Source Of Input Code
RECEIVING_BARRACKS

Special Duty Bonus Date
PERSONNEL_INFORMATION

Special Duty Bonus Points Qy
PERSONNEL_INFORMATION

Special Pay Code
ENTITLEMENTS_INFORMATION

Special Power Attorney Exp Dt
MCTFS

Split Pay Chek Start Date
ENTITLEMENTS_INFORMATION

Spouse SGLI Election Code
RED_RECORD

Ssa Validation Birth Date
SOC_SEC_ADMIN_INFORMATION

Ssa Validation Flag
SOC_SEC_ADMIN_INFORMATION

Ssa Validation Name
SOC_SEC_ADMIN_INFORMATION

Ssn
CURRENT_TRNG_LOCATION_R157

Ssn
DRAW_CASE_INFORMATION

Ssn
ELECTRONIC_MAIL_R991

Ssn
FUTURE_TRNG_LOCATION_R156

Ssn
MARTIAL_ARTS_R146

Ssn
PERSON_IDENTIFICATION_R159

Ssn
PERSONAL_CLASS_R154

Ssn
PERSONAL_VISION_R152

Ssn
RECRUIT_DISTRIBUTION_R158

Ssn
RECRUIT_IDENTIFICATION_R153

Ssn
RED_INSURANCE

Ssn
RED_MIA_NOTIFY

Ssn
REDS_PERSON

Ssn
RESERVE_ENTRY_LEVEL_R155

Ssn
TFS_MASTER_VERIFICATION

Ssn
TRECON_FIELDS

Ssn
USER_FIELDS

Ssn Change Date
SOC_SEC_ADMIN_INFORMATION

Staff Selection Board Id
PERSONNEL_INFORMATION

Staff Selection Seniority Id
PERSONNEL_INFORMATION

State Abbreviation
MCTFS

State Flag
LK_JMMSTABS_LOCATION_CODES_08

State Long Name
LK_STATE

State Of Legal Tax Residence
MCTFS

Station Init Assign Mcc Eda
RESERVE_INFORMATION

Street Address
MCTFS

Strength Cat Effective Date
MEMBER_COMMAND_INFORMATION

Strength Category Code
MCTFS

Supplementary Mos Code
MCTFS

Survivor Benefit Plan Amt Redu
RESERVE_INFORMATION

Survivor Benefit Plan Eff Date
RESERVE_INFORMATION

Survivor Benefit Plan Level
RESERVE_INFORMATION

Survivor Benefit Plan Option
RESERVE_INFORMATION

Survivor Benefit Plan Type
RESERVE_INFORMATION

Tabfrdtd Table From Date
LK_DSSN_13

Tabfrdtd Table From Date
LK_PROGRAM_ENLISTED_FOR_06

Table Of Organization Number
MCTFS

Table Status Flag
LK_PAY_42

Table Tax Code1
LK_PAY_42

Table Tax Code2
LK_PAY_42

Table Tax Code3
LK_PAY_42

Table Tax Code4
LK_PAY_42

Table Tax Code5
LK_PAY_42

Table Tax Code6
LK_PAY_42

Table06 Pgrmenl Code 06
LK_PROGRAM_ENLISTED_FOR_06

Tad Company Code
MCTFS

Tad Platoon Code
MCTFS

Tad Satellite Dp Installation
MEMBER_COMMAND_INFORMATION

Tax Marital Status Code
RECEIVING_BARRACKS

Tax Plan
RECEIVING_BARRACKS

Tax State
RECEIVING_BARRACKS

Temporary Add Duty Excess Flag
MEMBER_COMMAND_INFORMATION

Temporary Mcc
MEMBER_COMMAND_INFORMATION

Temporary Reporting Unit Code
MCTFS

Temporary Reporting Unit Code
TFS_MASTER_VERIFICATION

Temporary Reporting Unit Name
MCTFS

Term Of Enlistment Qy
RECEIVING_BARRACKS

Tertiary Retire Sep Law Cd
SEPARATION_INFORMATION

Third Six Month Deployed Qy
ENTITLEMENTS_INFORMATION

Time Lost Flag
REMARK_FLAGS

Tmr T O Line Number
MCTFS

Todtd06 To Date 06
LK_PROGRAM_ENLISTED_FOR_06

Todtd13 To Date 13
LK_DSSN_13

Total Active Constructive Svc
SEPARATION_INFORMATION

Total Active Military Service
SEPARATION_INFORMATION

Total Career Inactive Duty Pts
SEPARATION_INFORMATION

Total Career Retirement Points
RESERVE_INFORMATION

Total Career Service Pay
SEPARATION_INFORMATION

Total Constructive Service
SEPARATION_INFORMATION

Total Inactive Service
SEPARATION_INFORMATION

Total Length All Extensions
MCTFS

Total Military Service
SEPARATION_INFORMATION

Total Multiplier Service
SEPARATION_INFORMATION

Total Number Of Extensions
MEMBER_SERVICE

Total Qualifying Service
SEPARATION_INFORMATION

Total Retire Pts For Annv Yr
RESERVE_INFORMATION

Total Satisfactory Year
RESERVE_INFORMATION

Touch Rec Cycle Nr
LAST_PROCESSING_CYCLE

Touch Record Flag
LAST_PROCESSING_CYCLE

Train School Obligation Date
TRAINING_INFORMATION

Train School Obligation Status
TRAINING_INFORMATION

Training Category Pay Group
MCTFS

Training Geographical Location
TRAINING_INFORMATION

Trd Bus Grad Code
RECEIVING_BARRACKS

Trd Bus Last Attend Dt
RECEIVING_BARRACKS

Trd Bus Major Subject Code
RECEIVING_BARRACKS

Trd Bus Yrs Attend Qy
RECEIVING_BARRACKS

Trecon Ruc
TRECON_FIELDS

Trecon Ruc
USER_FIELDS

Tsp Election Flag Code
REMARK_FLAGS

Tsp Loan Flag Code
REMARK_FLAGS

Tsp Payment Flag Code
REMARK_FLAGS

Twenty Year Letter Eff Date
RESERVE_INFORMATION

Twenty Year Letter Flag
RESERVE_INFORMATION

Type Current Duty
MEMBER_COMMAND_INFORMATION

Unexcused Twelve Mth Cntr Qy
RESERVE_INFORMATION

Unit Command Identifier
LK_RUC_MCC_01

User Field Number
USER_FIELDS

User Field Title
USER_FIELD_LABELS

User Id
IMPROMPTU_USER

User Ruc
IMPROMPTU_USER

Va Certification Date
RED_RECORD

Valid Civ Drivers License Code
PERSONAL_CLASS_R154

Valid Drivers License Code
RECEIVING_BARRACKS

Variable Reenlist Bonus Flag
REMARK_FLAGS

Veteran Educate Assist Flag
REMARK_FLAGS

Veterans Admin Code 1
SEPARATION_INFORMATION

Veterans Admin Code 2
SEPARATION_INFORMATION

Veterans Admin Code 3
SEPARATION_INFORMATION

Veterans Admin Code Eff Date
SEPARATION_INFORMATION

Visual Acuity Test Lc Qy
RECEIVING_BARRACKS

Visual Acuity Test Lu Qy
RECEIVING_BARRACKS

Visual Acuity Test Rc Qy
RECEIVING_BARRACKS

Visual Acuity Test Ru Qy
RECEIVING_BARRACKS

Visual Color Code
RECEIVING_BARRACKS

Waiver Benefits Pension Code
ENTITLEMENTS_INFORMATION

Waiver Benefits Pension Date
ENTITLEMENTS_INFORMATION

Water Survival Code
MCTFS

Water Survival Requal Date
MCTFS

Weapon Rack Number
TRECON_FIELDS

Weapon Serial Number
TRECON_FIELDS

Weapon Type
TRECON_FIELDS

Weight Control Assignment Qy
MCTFS

Weight Control Status Code
MCTFS

Work Station
MCTFS

Work Telephone Number
MCTFS

Wpn Ammo Explsv Screen Dt
WPN_AMMO_EXPLSV_SCRN_R138

Years Of Service
MEMBER_SERVICE

Zip Code
MCTFS

Narrative List of Changes

What's New

xe "What's New"

xe "Narrative List of Changes 2003.2"SR2003.2

Production Trouble Reports (PTRs)

The following items were accomplished under 317-03-IAT

Updated the ECCO Accession Religion, Present Rank, Primary MOS, Reserve RUC, Major Subject and Country Code combo boxes to be more uniform by indenting the drop down entries and removing the blank lines from the bottom of each listing.

The following items were accomplished under 318-03-IAT

Updated the ECCO Accession Term of Enlistment combo box to add the options for one and two year contracts.

The following items were accomplished under 323-03-IAT

Updated the UDMIPS Help Manual and UDMIPS Installation instructions to change the naming conventions.

The following items were accomplished under 329-03-IAT

Updated the logic in the RUC Server process to prevent any modifications of start and stop times once the RUC Server process has started.

The following items were accomplished under 341-03-IAT

Updated the logic in the Student Management module, Depot Orders to ensure members with PEF codes of UH, UV, UW or Y3 receive Infantry Training Battalion (ITB) orders to School of Infantry (SOI) East if the PRES-RUC is 32092, and SOI West if the PRES-RUC is 34022.

The following items were accomplished under 611-03-SMB

Updated the SR2003.2 UDMIPS Production tables by deleting TTC 016, sequences 000 and 001 to be inline with MCTFS SR2003.2 production tables.

System Change Requests (SCRs)

The following functionality was added with this release:

KC024-03: SYSTEM CHANGE REQUEST TO ADD W-2 PRINT INFORMATION FOR MYPAY USERS

This SCR modified MyPay to add functionality to allow a Marine to designate the delivery method of their W-2s.  An edit to prevent the input of TTC 386 sequences 005 and 006 from December 1st through January 31st of any year was added to establish a non-election period for the hardcopy printing of W-2 forms.  

Unit Diary Module

 TTC 386 005_STRT HARDCOPY W2 PRINT

Short Name: STRT W2 HARDCOP

Long Name: Start Hardcopy Print of W-2

New Prompt:


Prompt #1 Date of Action

· Transaction is reportable by both Active and Reserve units

· Allow normal transactions only

· Allow individual transactions only

TTC 386 006_STOP HARDCOPY W2 PRINT

Short Name: STOP W2 HARDCOP

Long Name: Stop Hardcopy Print of W-2

New Prompt:


Prompt #1 Date of Action

· Transaction is reportable by both Active and Reserve units

· Allow normal transactions only

· Allow individual transactions only

MT441U: UNIT DIARY MARINE INFORMATION PERSONNEL SYSTEM

This SCR modified the index rebuild and statistics gathering procedures so that they are called from regular and full TRECONS, TFS Master, Tables and MCRISS reconciliation.  It also ensures that indexes are rebuilt only when it is determined that a performance benefit would be drawn from it, and statistics are replaced when they are outdated.

MT444U: UD/MIPS ENHANCEMENT TO LINK TICKLER FILE WITH UNIT DIARY MODULE AND INTELLIGENT FORMS

This SCR modified UD/MIPS to establish a link between the Tickler File Module, the Intelligent Forms Module, and the Unit Diary Module.  When the transaction data for a service member is contained in more than one module, and the data is updated from one module, then the data is updated in all three modules to reflect the changes.

Unit Diary Module

Modified the Unit Diary module to allow transaction changes made in the UDMIPS module to reflect in the Intelligent Forms module if the same transaction resides in the Intelligent Forms module.

Tickler Module

1. Modified the Tickler module to allow transaction changes made in the Tickler module to reflect in the Intelligent Forms module if the same transaction resides in the Tickler module.

2. Modified the Tickler module to display a duplicate entry found message if the user attempts to create a new form for a member if that form already exists.

Intelligent Forms Module

b) Modified the Intelligent Forms module to allow transaction changes made in the Tickler or Unit Diary modules to reflect in the Intelligent Forms module if the same transaction resides in the Intelligent Forms module 

c) Modified the Tickler module to display a duplicate entry found message if the user attempts to create a new form for a member if that form already exists.

MT453US: MOVE MAINFRAME ARMS OFFICER INTO UD/MIPS

This SCR modified the UD/MIPS Student Management module to add current ARMS functions and processes for Officer Accessions, using the MCRISS Officer Data.  This process is available to only Reporting Unit Code (RUC) 30382

Student Management

1. A new menu for officers only was added to the Tools menu and is visible to RUC 30382 only.  It has the following options:

· Accessions

· Add Officers

· Create Officer

2. The following functionality was added to the Student Management Module:

· Allow users to import records from the MCRISS Officer file 

· Allow the user to create new records manually and input all data if they are not on the MCRISS Officer file 

· The new Officer Accession window allows the user to double click on a member in the list view to display all available MCRISS information for the member

3. A new treeview for Officer Accessions was added and consists of: 

· MCRISS Officer Data

· Inbound

· Rejected

· Assigned Platoon

4. The new Officer Accession treeview allows the user to:

· Drag and Drop members into platoons

· Add Company Code

· Add Platoon

· Assign Class Convene Date

5. The Officers Accession list view displays the following columns:

· SSN

· Name

· Component Code

· Status

· Class Convene Date

· Company

· Platoon 

· Sex

· City 

· State

MT458: RACE/ETHNIC GROUP CHANGE

This SCR modified the current MCTFS Race Codes to reflect the Department of Defense (DOD) standard Race Codes, changed the Ethnic Codes and Race and Ethnic English descriptions, added a new data element Race Aggregate Code to tables and reports and changed the Ethnic Group codes tables. The Race Aggregate Code was added to the MCTFS table.

d) The following changes were made to the Ethnic Group codes:

· Ethnic English Description

e) The following changes were made to the Race code:

· Race Code English Description

· Race Aggregate Code

Unit Diary Module

TTC 163 002 ___________RACE AGGREGATE CODE _|

Short Name: RACE AGG CODE

Long Name: Race Aggregate Code

New Prompts:


Prompt #1 Date of Action


Prompt #2 Code

· TTC sequence is a Group D transaction

· Reportable by Headquarters, Regular and Reserve RUCs

· No DEL AS ERR or DEL/ADD capability

· TTC can be input by Individual, Group, Volume, or Situational transaction types

· Event reporting is not authorized for this TTC sequence

f) UDMIPS/Retiree Accession:

New Label added:



Race Aggregate

New Data Element added:


Race Aggregate Code

g) UDMIPS/HAMS Accession Enlisted and HAMS Accession Officers Input Screen:

New Label added:



Race Aggregate 

New Data Element added:


Race Aggregate Code 




h) UDMIPS/ECCO Reserve Accession:

New Label added:



Race Aggregate

New Data Element added:


Race Aggregate Code

MIPS Module

i) UDMIPS/View Members/Individual Query Page 1:

New Label added:


            Race Agg Code

New Data Element added:                            Race Aggregate Code





                         Race Aggregate Code English Description

English Description expanded for this label:  Race

Expanded to:


            40 bytes

j) UDMIPS/View Members/Personal Page 1:

New Label added:



Race Agg Code

New Data Element added:


Race Aggregate Code







Race Aggregate Code English Description

English Description expanded for this label:
Race

Expanded to:



40 bytes

English Description expanded for this label:
Ethnic

Expanded to:



22 bytes





k) UDMIPS/View Reports/Basic Individual Record:

New Label added:



Race Agg Code

New Data Element added


Race Aggregate Code







Race Aggregate Code English Description

English Description expanded for this label:
Race

Expanded to:



40 bytes

English Description expanded for this label:
Ethnic Code

Expanded to:



22 bytes

l) UDMIPS/ Basic Individual Record Report:

New Label added:



Race Agg Code

New Data Element added:


Race Aggregate Code







Race Aggregate Code English Description

English Description expanded for this label:
Race

Expanded to:



40 bytes

English Description expanded for this label:
Ethnic Code

Expanded to:



22 bytes

English Description expanded for this label:   Population Group

Expanded to:



 40 bytes

Student Management Module

m) Depot/Accession Data:

New Label added:



Race Agg Code

New Data Element added:


Race Aggregate Code







Race Aggregate Code English Description

English Description expanded for this label:
Race

Expanded to:



40 bytes

English Description expanded for this label:
Ethnic Code


Expanded to:



22 bytes

Impromptu Module

n) Modified the Impromptu module to add a new look up table LK_RACE_AGG_CD_71_20_85 to the Lookup Code Tables folder.

o) Modified the Impromptu module to add a new column to the CUDDB/Receiving Barracks folder:

· Race Aggregate Code

MT482: CHANGE TO COMPOSITE SCORE ROUTINE

This SCR modified the Composite Score routine by increasing the maximum Self Education points to 100 and applying the Marine Corps Institute (MCI) scores achieved by PVTs and PFCs to the LCPLs composite score.  The SELF_EDUCATION_BONUS_POINTS data element and the Education Bonus Points fields were expanded to 3-byte numeric fields in one MIPS view and nine MIPS reports, the UD/MIPS Training Information table, and the Impromptu CUDDB Catalog Training Information folder.  It expanded TTC 287 002, prompt 5, Off Duty Education Bonus to a 3-byte alphanumeric. 

p) The following changes were made to the Ethnic Group codes:

Codes


Description

       Changed:
  7


ESKIMO
to
ALASKA NATIVE



  Z


UNKNOWN
to
DECLINED TO RESPOND

       Deleted:
  8



  X

       Added:
  P


EUROPEAN/ANGLO

q) The following changes were made to the Race codes:

Codes


Description

       Changes:
  7


ESKIIMO
to
ALASKA NATIVE

           

 Z


UNKNOWN
to
DECLINED TO RESPOND

        Deleted:
  8



  X

        Added:
  P


EUROPEAN/ANGLO






Unit Diary Module

 TTC 287 002 ___ REQ RECOMPUTE COMP SCORE ___ ___ ___ ___ ___ PROM QTR ___|

Short Name: COMPOSITE SCORE

Long Name: Req Recompute Composite Score

Changed Prompt:




From
To

Prompt 5
ODEDB

Off Duty Education Bonus
xx
xxx

Deleted:

 TTC 288 000 ___ Delete CPL COMPOSITE SCORE|

Deleted:

 TTC 288 001 ___ DELETE LCPL COMPOSITE SCORE|

MIPS Module

r) Expanded the Self Education Bonus Score Points field to a 3-byte numeric in the following views and reports:

Views:

· View Members Training Information, Page 1

Promotion Reports:

· Reserve Personnel with Composite Scores 

· Reserve Personnel without Composite Scores 

· Reserve Headquarters Personnel with Composite Scores 

· Reserve Headquarters Personnel without Composite Scores 

· Personnel with Composite Scores 

· Personnel without Composite Scores 

· Reserve VI Personnel with Composite Scores 

s) Expanded the Education Bonus Points field to a 3-byte numeric in the following reports:

· From TAD Excess/FAP Checklist for Selected Members report

· From TAD Excess/FAP Checklist for Select All report

Impromptu Module

Expanded the SELF_EDUCATION_BONUS_POINTS data element to a 3-byte numeric in the UDMIPS CUDDB Catalog Training Information folder.

TSO033-03M: UPGRADE TO ORACLE 9i ENTERPRISE EDITION

Modified the installation process to accommodate Oracle 9i and consolidated the Install/Uninstall topics in the help file and the readme.doc files so they could include Enterprise, Client, and Personal installations. Updated the Hardware Requirements topic.

The following naming convention changes were made in the Install/Uninstall application:

· UD/MIPS Server is now called UD/MIPS Enterprise

· UD/MIPS Client is now called UD/MIPS Client

· UD/MIPS Standalone is now called UD/MIPS Personal

TSO139-03M: ADD NEW TTC PROMPT WORD TYPES TO UDMIPS

This SCR modified the Unit Diary module word types to provide greater flexibility for user input. The new word types are numeric and accept user input without forcing input of extra zeroes. The new word types add functionality to handle decimal values in numeric fields and require only one prompt.

 Unit Diary Module

 TTC 757 000_VETERANS ADMINISTRATION CODE___/___/___| EFF___|

Short Name: VETERANS ADM CD

Long Name: Veterans Admin Code

Changed Prompt:




From

To

Prompt 4
CODE 3
Veterans Admin Code

C

Z0

TTC 778 000_TDRL TO PDRL___DSBL___VA___/___/___ INDEX___EFF___|

Short Name: TDRL TO PDRL

Long Name: Status Change
fr TDRL to PDRL

Changed Prompt:




From

To

Prompt 6
VA CODE 3
Veterans Administration

C

Z0

Glossary

Glossary

xe "Glossary"Archive 

The process of saving of saving a copy of files for future retrieval.

Backup 

A UD/MIPS function that copies files from the hard disk to another location for safekeeping or other purposes.

Combination Box

Dialogs box component that combines the capabilities of both text and list boxes.  With text boxes users enter information into the text field, with list boxes users select from a list of choices (value set).

Command Line 

The on-window area where cryptic commands are typed, usually at the DOS prompt.

Command Button 

A rectangular button that carries out the action described by the text on the button.  The most common buttons include OK, Cancel, and Close.

Control Menu 

A menu that allows the user to resize, close, or switch windows.  Access is gained by mouse click or keyboarding ALT+SPACE.

Check Box 

A dialog box component that acts like a switch - it represents an option that can be turned on or off.  Where multiple options exists, multiple options may be turned off.  Grayed or dimmed options are not available for selection.

Courier

A means to transfer completed unit diaries to Marine Corps mainframe computers.  The media used to store the courier may be a hard disk or diskette(s).

Command Reporting Unit Code (CRUC)

The CRUC is the unit, generally the RUC of the senior command with an MCC, which has authority to issue permanent change of station orders.  Refer to the MCTFSPRIM.

Data Set

A distinct name identified by a string of characters that is utilized by the mainframe to hold related files, such as TRECON or Courier.

Dialog Box:

A temporary window that appears to request information or provide information.

Drop – Down Combination Box

A special type of combination box that reveals a list of choices (value set) when it's associated arrow is clicked.

Drop – Down List Box:

A special type of list box that reveals a list of choices (value set) when it's associated arrow is clicked.

ELSIG

ELSIG is an acronym for Electronic Signature.  Specific users are authorized specific access to the UD/MIPS application by their ELSIG.  ELSIGs assist in system security.

Hard Disk:

The Hard Disk is a secondary storage unit.  The fixed disk used for storing data files.

Higher Headquarters (HHQ)

Any headquarters senior to the reporting unit in the chain of command, to include all command elements of a MAGTF.  This term does not apply to HQMC.  Source, MCTFSPRIM.

Icon

An icon is a representation of a task, a command, or an application whereby the user clicks to activate an intended or expected response.  A thumbnail size picture usually represents the task, command, application, etc.

Keyword:

For UD/MIPS purposes, any word contained in a Unit Diary-English statement.

Monitored Command Code (MCC):

A three-digit alpha-numeric code assigned for identification and control purposes to a command, unit, activity, or an individual billet to which assignment of personnel is controlled by the CMC (MM).  Source, MCTFSPRIM.

Network Support:

A feature designed to make easier the use of UD/MIPS on a network.  Users can:

· Connect to network drives,

· Add/Delete connections to network printers,

· Recognize both local and network printers,

· Display the contents and status of network printer queues, and

· Select network features.

Users can back up from or restore to a network drive that is physically attached to a network server rather than the user's computer.

Program Manager

Automatically starts when Windows is loaded and remains active the entire time while working in Windows.  Closing this program closes Windows.  The organizational tool places applications into groups.  Then displays those groups as windows or group icons.
Progression Bar:

A window function that displays the CUDDB's changing state, i.e., point to point data movement during reconciliation.  This function appears in those functions that move large volumes of data and/or require a substantial amount of time.  The window displays a task completion percentage as the data moves from point to point.

Reporting Unit (RU):

The Reporting Unit is the basic unit of the manpower reporting process.  Source, MCTFSPRIM.

Reporting Unit Code (RUC) Status Bar:

Located at the bottom of a window, descriptive help text is displayed to the user when the window is active and an action has occurred.

Text Box:

A rectangular box within a dialog box, into which users type the information, deemed necessary to complete an action.  This box may be blank when it first appears, or it may contain text.

Title Bar:

The Title Bar is a component of a window or dialog box that shows either the name of the application running in the window or the dialog box.  The title bar in the currently selected window is a different color or intensity than the title bar in an inactive window.
Transaction:

A Transaction is a single Unit Diary entry, one Type Transaction Code (TTC).

TRECON:

TRECON is an acronym for Transaction Reconciliation.  The TRECON is the diskette or file created from the MCTFS Master File and is used to reconcile the local CUDDB with the MCTFS Master File.

User:

The end user, anyone authorized access to data via the UD/MIPS application.

Window:

Framed areas in which users can run applications, view a file list or document, or perform a task.  Windows can be opened, closed, sized, or moved.
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631

CUDDB Postings
325

CUDDB Reconciliation
195

Cycle Tracking Criteria Selection
367

D
Database Preferences
189

DD Form 1561  STATEMENT TO SUBSTANTIATE PAYMENT OF FAMILY SEPARATION ALLOWANCE
539

DD Form 216 MC  ENLISTED E2 – E5 PROMOTION WARRANT
537

Delete a Courier
236

Delete a Note
291

Delete DFR
393

Delete Diaries
237

Delete Scheme/Group/List
276

Delete Transactions
237

Deleting a RUC
169

Deleting an ELSIG
115

Deleting TTCs from the List of Assigned TTCs
389

DEPENDENT (Active or Reserve) Situational
265

DFR Cycle Notes
360

DFR Cycle Reconciliation Log
361

DFR Cycle Tracking Report
362

DFR Report
359

DFR Section Reports
363

Dialog Boxes and Buttons
33

Diary Feedback Report
368, 369

Diary Feedback Report Summary
355

Diary Lists
237

Diary Notes
371

Diary Statistics Report
370

Diary Status/Notes
336

digital IDs
202

digital passports
202

E
ECCO Accession
236, 255, 256, 304

Edit a Note
291

Edit a Transaction
236

Edit an Individual Type Transaction
292

Edit List
279

Edit Note
296

Edit Volume Transactions for Diary
297

ELSIG Control Officer
153

ELSIG Current Privileges
146

ELSIG Default Privilege Management
144

ELSIG Issued
132

ELSIG Report
140

ELSIG Report with Privileges
142

Enter SSN
303

Enter Transaction Dates
289

Exception Report
365

Exception Report Selection
398

Export
162, 163

Export Couriers
340

Export DFR Notes
394

Export ELSIG(s)
124

Export Scheme
277

Export Sections
181

Extract
164

F
Failed Transactions
289

FAP/TAD Situational
269

File Directories Preferences
189

File Transfer
176

File Transfer Service
194

File Transfer Service Preferences
189

Filter
317

Filter Data
236

Filter Name
318

Fitness Reports
434

By Grade Report of Personnel
434

Fitness Report Due List
434

FitRep for OIC NCOIC
436

Flag Transactions
236, 307

Forms Monthly Statistics Report
534

From TAD Excess/FAP Checklist
439

G
General Advisory
385

Generic Import
313

Glossary
691

H
HAMS Accession
248

Hardware Requirements
14

Higher Headquarters
444

Highlight All Transactions
236

I
Identify Unit of Work
309

IIADT Orders
622

Import
165

Import Couriers
340

Import DFR Notes
395

Import ELSIG
127, 128

Import Scheme
278

Import Section
182

Import Tickler File
231

Import Transactions
236

Import/Export Files
167

Impromptu
628

Inbound Roster Report
261

Individual Query View
527

Initial Depot Join TTCs
613

Input TTC
391

Installing the Client
37

Installing UD/MIPS
37, 48

Installing UD/MIPS Enterprise Client
37

Intelligent Forms Print Options
535

Intelligent Forms Selection
530

J
JOIN (Active or Reserve) Situational
267

Joins
597

JPAVS
216

L
LCPL Eligible Report
446

List Name Conflict
129

Load DFR
392

Local Datalink Account
179

Lock or Unlock Diaries
335

Login
21

Logout
24

M
Maintain Unit Field Statistics
447

Make a Diary Note
337

Make Courier
343, 344

Manage Electronic Signature
115

Manage ELSIGs
115

Manage TTC/SEQ For List
134

Manpower
448

Manpower Report Utility
449

Marine Leaders Notebook
450

Marksmanship View
506

Mass Deletion
168

Master Electronic Signature
130

Master ELSIG Login
130

MCAIMS
218

MDSSII
221

Member Information
246

Members
410

Members with COMRATS/BAH/Government Quarters
453

Members with No COMRATS
454

Modify CO ELSIG
122

Modify ELSIG
120

Modify ELSIG for a CO
122

Monthly Management Report
455

Multiple Column Sort
315

Multiple Status and Note Change
388

MultiZip
346

MultiZip Couriers
236

MultiZip File
346
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682

NAVMC 10522  COMMUTED RATIONS ACTION
550

NAVMC 10592  SELECTED MARINE CORPS RESERVE CERTIFICATE
552

NAVMC 10922 (REV. 5-95)  DEPENDENCY APPLICATION (1751)
554

NAVMC 11116  MISCELLANEOUS MILITARY PAY ORDER/SPECIAL PAYMENT AUTHORIZATION
558

NAVMC 11200 (Rev 6-94)  RESERVE MISCELLANEOUS MILITARY PAY ORDER
560

NAVMC 3  LEAVE AUTHORIZATION FORM
542

NAVMC 71  CERTIFICATE OF GOOD CONDUCT
548

New Form
546

New Record
532

New Scheme/Group/List
273

New Section Name
184

O
Oracle Login
22

Orders
622, 623, 624, 625, 626

P
Page 11
600

Page 3
602

Part II Rejected Transactions
372

Part II Transaction Detail
374

Part III Advisory/PUREX
377

Part III Transaction Detail
379

Part IV Transaction Detail
386

Pay Inconsistencies and LES
456

Pay/Dependent View
508

Pending Tickler Transactions Report
232

Personal View
510

Personnel Information
457

Personnel Management
460

Personnel Tempo
463, 464

Personnel Tempo Computation
402

Personnel with Composite Score
465

Personnel without Composite Score
467

PFC Eligible Report
469

Physical Fitness Reports
470

Personnel Who Failed or Were Not Required to Take a PFT
470

Personnel Who Have Not Taken a PFT But Are Required To
470

Personnel Who Passed a PFT
470

Place in a Unit of Work
236

Platoon Alpha Roster Selection Criteria
591

Platoon Roster
599

Predefined TTC-SEQ Lists
390

Preferences
189, 190, 191, 193

Database
189, 190, 191

File Directories
189

File Transfer Service
189, 190, 191, 192

Scheduled Events
191

Prepare a Diary for Certification
336

Preparer ELSIG
155

Print Courier Reports
333

Print Orders
615, 616

Promotion
471, 472

public-key certificates
202

Pull-Down Menus
32

Purpose
11

R
Receiving Barracks
587

Receiving Barracks Roster
589

Receiving Barracks Roster Report
605

Reconciliation
195, 196

Record of Emergency Data Report
474

Record of Emergency Data View
514

Record of Emergency Data/Family Readiness Roster
473

Recover an Archive
236

Recover Archived DFR
397

Recruit Accessions
570, 582

Recruit Transfer Orders
623

REDS
281, 473, 474, 514

REDS Situational
281

Reject an Accession Diary Transaction
240

Release From IIADT Orders
624

Rename Scheme/Group/List
274

Rename TTC List
137

Reopen a Diary
337

Report Date
533

Report Selection
406

Research Diary Report
328

Reserve
477, 479

Reserve Data View
517

Reserve Marine Combat Training Orders
626

Resetting an ELSIG
115

Restore Couriers
236

Retiree Accession
257

Reviewer ELSIG
157

Rifle Range Reports
481

Required Personnel Who Have Not Rifle Fired
481

Rifle Qualified Personnel
481

Rifle Unqualified or Exempt Personnel
481

Right Click Options for Unit Diary
239

RMGIB UA Report
483

S
Save As
125

Scheduled Events Preferences
189

School Complete
612

Search
408, 409, 410

Search for TTC
138

Section Maintenance
180

Section Report Criteria Selection
358

Section TTC Assignment
389

Security Certificates
202

Security Clearance Access
484

Select a Group
289

Select Archive
349

Select Diary
382

Select Import File
166

Select Organization
618

Select the Columns You Want to Display
236

Selected Members
610

Selecting a TTC List to Assign to the Current Section
389

Server Event Log
197

Server Login
21

Service View
519

Setting Up the Server Connection
97

SGLV 8286 SGLI ELECTION AND CERTIFICATE
565

SGLV SGLI ELECTION AND CERTIFICATE
565

SGT Eligible Report
486

Situational Maintenance
272

Situational Reporting
264

SNCO Board Report
487

Sort Columns
236

Sorting Columns for a Diary
368

SRB (Page 11) Selection Criteria
592

SRB Recruit (Page 3) Selection Criteria
593

Start School
611

Student Processes
608

Super Viewer ELSIG
158

Suspending an ELSIG
115

Switching Database Connections
109

System Goals
13

T
Tables Trecon
201

Technical Assistance
27

TFS Inbound Roster
604

TFS Inbound Selection Criteria
620

The Mouse
31

Tickler Alert
224

Tickler Export
230

Tickler Tab in Transaction Detail
289

Tickler Transaction Detail
227

Tickler Transaction List
226

Time Frame Specification
352

Track Courier
236

Training Information
488, 489

Training View
524

Transaction Detail
289

Transaction History Statement
306

Transaction Import
313

Transaction Pool
236, 237, 289

Transaction Status/Notes
304

Transaction View
300

Transfer
617

Transmit ECCO Accession
252, 285

TRECON
199

TRECON Reconciliation Log
200

Troubleshooting
25

Troubleshooting Automated Processes
212

128 Bit Encryption
213

Before Calling MISSO/MISSA
212

ELSIG Privileges Not Set
213

G-6 Involvement
213

Port 443/Firewall Issues
212

Request for Approval stays in Pending Status
213

Security Certificates
212

Server Computer Name
212

Server Not Correctly Configured
213

Unit Diary Size Limitation
213

TTC Reports
324

Type a History Statement
290

Type a History Statement as a Separate Transaction
289

U
UD/MIPS - Navigator
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UD/MIPS Catalog Columns
640

UD/MIPS Catalog Folders
633

UD/MIPS Catalog Predefined Filters
639

UD/MIPS Login
21

Unclosed Diaries
201

Understanding Windows
29

Uninstalling UD/MIPS
75, 81, 82

Unit Definition
170

Unit Diaries
335

Unit Diary Archives
236, 348

Unit Diary Couriers
340

Unit Diary Management
237

Unit Diary Reports
323

Unit Diary Tools
311

Unit Diary Transactions
285

Unit Muster Sheet
492

Unit of Work Report
326

Unit Perstat
493

Update Unit Address Record
172

Upload/Download Database
177

User Field Labels
174

User Fields
411

V
Valid Electronic Signatures
114

Validation Audit Report
260, 595

Validation Audit Report Selection Criteria
596

Validation Report
260

Version Control Number
16

View and Print Reports of CUDDB Postings
236

View and Print Research Diary Report
328

View and Print Rough Reports
236

View and Print TTC Reports
236

View Courier Reports for a Single Courier
236

View Deleted Members
175

View Members
413

View the Most Recent Changes to the Data in Diary Notes
371

Viewer ELSIG
159

Volume Transactions
297

W
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Where Condition
319

Working In Windows
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